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Serendipity Blackmagic User Manual

Copyright © Serendipity Software Pty Ltd

Reproduction of any part of this user manual is strictly forbidden without prior written permission from Serendipity
Software Pty Ltd. All company names, product names and trademarks mentioned in this manual are the property of the
respective company.

Important Notice

Every effort is made to ensure the information contained within this user manual is correct. Serendipity Software Pty
Ltd cannot be held responsible for any errors contained within this user manual and will not enter into any
negotiations for claims of compensation relating to actions taken resulting from the information provided in this user
manual for any reason whatsoever.

Serendipity Software Pty Ltd is constantly making improvements to the software and as such, this user manual may not
contain the latest information. Every effort is made to maintain the user manual and for the latest version please check
the website:

http://www.serendipity-software.com.au

If there are any errors within this user manual, please detail them in an email to: support@serendipity-software.com.au

Tutorials and HowTo documents are available on our website in the Serendipity Software Knowledge Base:

http://skb.serendipity-software.com.au/
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Product Overview

Serendipity Blackmagic is used to proof post-RIP data to either an output device, such as an Inkjet printer or to one of
several file formats.

Serendipity Blackmagic runs in a Server and Client configuration. The Server runs on a network computer and is
protected by a USB dongle. The dongle licenses the level of software and the input filters and output drivers purchased.

The Client is used as the configuration tool and monitoring application for the Server. It can be run on the same
machine, or on another locally (LAN) or remotely (WAN) networked computer. The Client connects to the Server via
standard TCP/IP network protocol and is not licensed, so it can be run multiple times on the network.

Serendipity Blackmagic has an input filter for most of the major manufacturers proprietary RIPs. The input filters read
the native RIP format and understand how jobs are assembled, the plates associated with a job and the directory
structure. RIPs that include databases and impositions are also read and understood. Jobs are proofed using the same
post-RIP data that goes to the press, thus maintaining data integrity and accuracy of the proofs.

Files are ripped once by the proprietary RIP and output as many times as desired. The jobs reside on the RIP, are
monitored by the Serendipity Blackmagic Server and are displayed by the Client in the RIPMonitor, with all associated
plates stitched together. The files can be selected and submitted for processing by the Server as desired, or can be
configured to process automatically. At the processing point, jobs are copied (spooled) over from the RIP to the Server,
leaving the original untouched. Once the whole job is spooled, the Server begins to work on the files.

Imaging is the first process to take place. Imaging interprets the file format, completes any imposition assembling
required (for supported imposition RIPs) or any merging of CT/LW files, preserves any screening on the files and
samples the jobs resolution to change it to that of the output format configured. An intermediate file format is created
at this point, called the Imaged File. The Imaged File can be viewed using the SoftProof utility. The file format maintains
all the plates associated with the job and is viewed at the full output resolution. The Imaged File can also be re-
submitted at any time for processing to the same or a different output. There is no need to spool and interpret the job
again.*

After the imaging process has completed, the job is passed to the rendering engine. This takes the Imaged File and
creates the file ready for output. The process includes applying any output characteristics such as orientation, cropping,
colour management (ICC Profiles) and creation of the configured format, whether for an Inkjet printer or a file format,
such as PDF.

The Imaged File can be rendered as many times as desired. Each time, any of the output characteristics can be changed
prior to rendering.

Once the job is rendered, it is submitted for printing to the output device or file format. Multiple output queues can be
created and multiple devices can be printed to simultaneously. Most of the output devices supported use a direct
printer driver allowing the Server more control of options, such as the selection of specific media and print directions.

The Client monitors the whole process from start to finish, showing a jobs progress in a QueueManager and
QueueStatus window. Jobs can be managed separately by placing a job on hold, releasing a job, cancelling or promoting
as desired. The processes (queues) can be paused at any time, holding all jobs from spooling, imaging, rendering or
printing. If a job fails, the error can be examined, rectified and the job retried. There are logs reporting all Server and
Client functionality and job information from first detection on the RIP to final output. The logs can be searched, filtered
or saved to a file.

The system creates a database of all configurations, calibration curves and other settings. This database can be backed-
up on demand or automatically, so a working copy is always available. It can be copied to any other Serendipity
Blackmagic as a whole database or as individual items.

*This applies to any output characteristics. If any changes are required for the Imaged File, e.g., changing plates, resolution etc, the file will need to be

re-submitted from the RIPMonitor.
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Installation

The installation section describes the process for each platform in turn.

The software is supplied on one DVD for Mac OS X, Linux and Windows versions. All versions come with a dongle and
require a dongle driver be installed. Existing installations of the software are given the opportunity to upgrade,
preserving any existing configurations.

What's on the DVD?

The DVD contains all elements required to run Serendipity Blackmagic and associated programs.

They are divided into directories, detailed below:

Agent - Contains the Agent software for all supported platforms. Choose the subdirectory that matches the
required operating system.

Docs - Contains all documentation.

Dongle - Contains the dongle drivers for Linux, MacOSX and Windows.

Drivers - Contains the Megarip PPDs for all supported platforms.

Extras - Contains additional components and print drivers loaded as part of the install process.

HTML - Contains the information required for the web browser install. This automatically launches the default
browser for installation to begin.

Linux - Contains the Serendipity Blackmagic installation packages for Linux.

MacOSX - Contains the Serendipity Blackmagic installation package for MacOSX.

Serendipity Client - Contains the Serendipity Client for all supported platforms.

Testprn - Contains Serendipity internal test prints.

Windows - Contains the Serendipity Blackmagic installation package for Windows.
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Windows Installation

Administrator rights are required to install Serendipity Blackmagic and the Serendipity Agent. If upgrading from an
existing installation to version 6.0, see “Upgrading to Version 6.0” within this manual.

Installing the Dongle Driver
The first step is to install the dongle driver.

To install:

. Remove all SuperPro USB dongles.

. On the DVD, navigate to the dongle/windows folder.

. Double click the Sentinel Protection Installer.exe file to launch the installer.
. Follow the onscreen instructions to complete the installation.

. Restart the computer when finished.

Installing Serendipity Blackmagic
The next step once the dongle driver is installed is to install Serendipity Blackmagic. There are two (2) Windows files
available for installation - 32 bit or 64 bit version. Select the appropriate file for your system to install.

. Either select and run the Blackmagic installer by clicking the link on the browser page (if it pops up as an
Autoplay when the disk is inserted), or go to the DVD and navigate to the Windows directory to run the file
blackmagic.msi (32 or 64 bit version)

. Follow the onscreen instructions to complete the installation.

Note: You can type your own path and the installation program will make the folder for you, provided your chosen
location has valid permissions. Use back slashes (\) to separate directories.

Installation of the Serendipity Agent

If you are polling a RIP (or RIP folder) on a Windows machine, the most efficient method is to use the Serendipity
Remote Agent. This runs a service on the Windows machine where the RIP is located. Serendipity Blackmagic
communicates with the Agent to poll and transfer jobs.

To install:
Either

. Select and run the Blackmagic installer by clicking the link on the browser page (if it pops up as an Autoplay
when the disk is inserted), or run the agent32.msi (32-bit) or agent64.msi (64-bit) file, located in the
/agent/windows folder of the installation DVD.

. Follow the onscreen instructions to complete the installation.

Once the installation has finished, proceed to the “Running the Software” section of this manual.
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Mac OS X Installation

Administrator rights are required to install Serendipity Blackmagic and the Serendipity Agent. If upgrading from an
existing installation to version 6.0, see the “Upgrading to Version 6.0” section within this manual.

Installing the Dongle Driver
The first step is to install the dongle driver.

To install:

. Remove all SuperPro USB dongles.

. On the DVD, navigate to the dongle/macosx folder.

. Double click the Sentinel System Driver.pkg file to launch the installer.
. Follow the onscreen instructions to complete the installation.

. Restart the computer when finished.

Installing the Serendipity Printer Drivers
The Serendipity Printer Drivers are used when setting up a Published Pagesetup for printing from a third party
application (e.g. Photoshop) directly to Blackmagic.

The installation package is located on the Blackmagic 6.0 Installation DVD:

. Navigate to the /drivers/mac folder and run the file Serendipity Printer Drivers.pkg
*  An installer window will appear. Follow the prompts to complete the installation of the drivers. The installer
will require administrator access privileges.

Installing Serendipity Blackmagic
. Go to the macosx folder on the Blackmagic installation DVD.
. Double click the file Serendipity Blackmagic.pkg to launch the installer.
. Follow the onscreen instructions to complete the installation.

Important Note: Before starting the software after installation, see the Running the Software section (Mac OS X only).

Installation of the Serendipity Agent

If you are polling a RIP (or RIP folder) on a Mac OS X machine, the most efficient method is to use the Serendipity
Remote Agent. This runs a service on the Mac OS X machine where the RIP is located. Serendipity Blackmagic
communicates with the Agent to poll and transfer jobs.

To install:

. Select and run Serendipity Agent.pkg file located in the /agent/macosx folder on the installation DVD.
. Follow the onscreen instructions to complete the installation.

Once the installation has finished, proceed to the “Running the Software” section of this manual.

Creating Dock Start Icons
To make it easy to start the Server and Client, it is recommended you create a Dock shortcut. To do this:

. Run the Blackmagic Server and Client applications from the installation location.

. Once the Server and Client icons appear in the dock, right click (or CTRL+click) the mouse and select Keep in
Dock from the menu.

*  Alternatively, drag the Server and Client icons directly onto the Dock before they have been launched.

. To remove the Dock icons, drag them off the Dock onto the desktop and release.
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Linux Installation

Installing the Dongle Driver
The first step is to install the dongle driver.

To install:

. Remove all SuperPro USB dongles.
. Navigate to the dongle/linux folder on the installation DVD.
. Double-click the sntl-sud-7.5.1-0.i386.rpm file to install the driver.

Installing Serendipity Blackmagic

Important Note: Before installing on a Linux x64 operating system please ensure the following 1686 (32-bit) libraries

are installed.

. libstdc++.1686 GNU Standard C++ Library

. mesa-libGLU.i686 Mesa libGLU runtime library

. zlib.i686 The zlib compression and decompression library

. freetype.i686 A free and portable font rendering engine

. libXrender.i686 X.0rg X11 libXrender runtime library

. fontconfig.i686 Font configuration and customisation library

. glib2.i686 A library of handy utility functions

d libpng.i686 A library of functions for manipulating PNG image format files
d libSM.i686 X.0rg X11 Sm runtime library

If the Package Installer can not locate the libraries, open a terminal window, go to the /root directory and install each
library using the following command:

yum install name of library

To install Blackmagic:

. Navigate to the linux folder on the installation DVD.

. Double-click the install.sh file and select “Run in Terminal”.

*  Aterminal window will pop-up and the installer will display the default installation directory.
. Press Enter to install or type an alternative path then press Enter.

. When the installation is complete the terminal window will close.

Note: If using an alternate install path, ensure the folder exists and that the current user has read/write/execute

permissions for the folder.

Once the installation has finished, proceed to the “Running the Software” section of this manual.
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Upgrading to Version 6.0

This section details upgrading an existing Blackmagic installation to version 6.0. The Installer automatically upgrades
the existing database to the current 6.0 format. As a precaution before upgrading, it is recommended that the
Blackmagic database and ICC profiles are backed-up using the Archives application (see Windows Upgrade or Mac 0S X
Upgrade sections for details), or by copying the database directories (see Copying the Database and ICC Folders section
for details).

Important Note: Pagesetups imported from Version 5 (and below) archives will automatically be split into Jobticket,
Media and Pagesetup data types but remain functionally linked. Version 6.0 archives cannot be opened or imported
into previous versions of Blackmagic.

Windows - Upgrading to Version 6.0
Archiving Current Installations
To Archive a Database:

. Run the existing Blackmagic Server and Serendipity Client.

. Go to the Serendipity Client Application menu > Archives (This
application is called Archiver in earlier versions).

. Select File menu > Perform Full Backup.

. Alternatively, select Edit menu > Add to Archive (all) and add all
database items to the archive file, or right-click in the Archives
window and select Add to Archive (all) > Everything from the
contextual menu.

. Once all database items have appeared in the Archives window,
select File menu > Save Archive to save the .sdb archive file to a
chosen location.

. Close the Archives application when finished.

Installing the Dongle Driver Update
Version 6 dongles (new or upgraded) require an up-to-date Safenet dongle driver in order to function.

To upgrade:

. Make sure the Blackmagic Server and Client are not running and remove any Blackmagic (or any other
SuperPro USB) dongles from the computer.

. On the Blackmagic installation DVD, navigate to the dongle/windows folder and run the Sentinel Protection
Installer.exe file. Alternatively, download and run the latest driver install from the Safenet website
(http://www.safenet-inc.com/support-downloads/sentinel-drivers/).

. Run the Sentinel installer.

i Select Upgrade and Next.

. Follow the onscreen instructions to complete the upgrade.

. Restart the computer when finished.

Installing C++ Runtime Libraries

To run correctly, Blackmagic 6.0 requires the installation of Microsoft Visual C++ Redistributable libraries that may not
be present in your Windows operating system. If these were not installed for the existing Blackmagic version, they will
need to be installed now.

To install:

. Navigate to the windows folder on the Blackmagic DVD.

o For Windows 32-bit — Run the vcredist_x86.exe file

o For Windows 64-bit — Run the vcredist_x64.exe file

. Follow the prompts to install Microsoft Visual C++ 2008 Redistributable.
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Installing the Blackmagic 6.0 Upgrade

Current Windows file /folder security and permissions makes it necessary to install Blackmagic v6.0 in the root
directory of the hard drive, e.g., C:\Serendipity\ rather than Program Files, where earlier versions of Blackmagic were
installed.

To upgrade:

Insert the Blackmagic installation DVD and navigate to the windows folder.

Run the blackmagic32.msi (32-bit) or the blackmagic64.msi (64-bit) file.

If necessary, change the installation directory to the root directory of the hard drive, e.g. C:\Serendipity\ and
click Next.

Follow the onscreen instructions to complete the upgrade.

Plug the Blackmagic dongle into an available USB port.

Start the Blackmagic v6.0 Server and the Serendipity Client.

If the installation location did not require changing, the existing database should appear once the Server and Client
have restarted, reformatted and intact in the Workbench. The Client should open with the previous versions
configuration.

If the installation location was (or needed to be) changed, or in the event the existing database is not complete, the
database backup needs to be imported using the Archives application.

To import an existing database backup:

Open the Archives application from the Serendipity Client Application menu.

In Archives, select File menu > Open Archive.

Navigate to and select the saved backup archive .sdb file. Click Open. The archive will open in the Archives
window and display all database items from the previously backed-up configuration.

Once the archive has loaded, select Edit menu > Add to Database > Whole Archive. This will import the entire
database.

Alternatively, choose individual items to import from the list and select Edit > Add to Database > Selected
Nodes.

The database items will be imported and appear in the Workbench for use.

For further information on Archives and backing-up databases, see the “Archives” section of this manual.
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Mac OS X - Upgrading to Version 6.0
Archiving Current Installations
To Archive a Database:

. Run the existing Blackmagic Server and Serendipity Client.

. Go to the Serendipity Client Application menu > Archives (This
application is called Archiver in earlier versions).

. Select File menu > Perform Full Backup.

. Alternatively, select Edit menu > Add to Archive (all) and add all
database items to the archive file, or right-click in the Archives
window and select Add to Archive (all) > Everything from the
contextual menu.

. Once all database items have appeared in the Archives window,
select File menu > Save Archive to save the .sdb archive file to a
chosen location.

. Close the Archives application when finished.

Installing the Dongle Driver
The first step is to install the dongle driver.

To install:

. Remove all SuperPro USB dongles.

. On the DVD, navigate to the dongle/macosx folder.

. Double click the Sentinel System Driver.pkg file to launch the installer.
. Follow the onscreen instructions to complete the installation.

. Restart the computer when finished.

Installing the Blackmagic Version 6.0 Upgrade
To upgrade:

. Insert the Blackmagic installation DVD and navigate to the macosx folder.

d Run the Serendipity Blackmagic.pkg file.

. Select the drive and location to install the software. The installer will choose the current installation location
by default, which in most cases is /Applications/Serendipity.

. Follow the onscreen instructions to complete the upgrade.

. Plug the Blackmagic dongle into an available USB port.

. Start the Blackmagic v6.0 Server and the Serendipity Client.

If the installation location was not changed, the existing database should appear once the Server and Client have
restarted, reformatted and intact in the Workbench. The Client should open with the previous versions configuration.

If the installation location was changed, or in the event the existing database is not complete, the database backup
needs to be imported using the Archives application.

To import an existing database backup:

. Open the Archives application from the Serendipity Client Application menu.

. In Archives, select File menu > Open Archive.

d Navigate to and select the saved backup archive .sdb file. Click Open. The archive will open in the Archives
window and display all database items from the previously backed-up configuration.

o Once the archive has loaded, select Edit menu > Add to Database > Whole Archive. This will import the entire
database.

*  Alternatively, choose individual items to import from the list and select Edit > Add to Database > Selected
Nodes.

The database items will be imported and appear in the Workbench for use.

For further information on Archives and backing-up databases, see the “Archives” section of this manual.
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Linux - Upgrading to Version 6.0
Archiving Current Installations
To Archive a Database:

. Run the existing Blackmagic Server and Serendipity Client.

. Go to the Serendipity Client Application menu > Archives (This
application is called Archiver in earlier versions).

. Select File menu > Perform Full Backup.

. Alternatively, select Edit menu > Add to Archive (all) and add all
database items to the archive file, or right-click in the Archives
window and select Add to Archive (all) > Everything from the
contextual menu.

. Once all database items have appeared in the Archives window,
select File menu > Save Archive to save the .sdb archive file to a
chosen location.

. Close the Archives application when finished.

Installing the Dongle Driver
The first step is to install the dongle driver.

. Remove all SuperPro USB dongles.
. Navigate to the dongle/linux folder on the installation DVD.
. Double-click the sntl-sud-7.5.1-0.i386.rpm file to install the driver.

Installing the Blackmagic Version 6.0 Upgrade
To upgrade:

. Navigate to the linux folder on the installation DVD.

. Double-click the install.sh file and select “Run in Terminal”.

*  Aterminal window will pop-up and the installer will display the default installation directory.
. Press Enter to install or type an alternative path then press Enter.

Note: If using an alternative install path, ensure the folder exists and that the current user has read/write/execute
permissions for the folder.

. The terminal window will close when the installation is complete.
. Plug the Blackmagic dongle into an available USB port.
. Start the Blackmagic v6.0 Server and the Serendipity Client.

If the installation location was not changed, the existing database should appear once the Server and Client have
restarted, reformatted and intact in the Workbench. The Client should open with the previous versions configuration.

If the installation location was changed, or in the event the existing database is not complete, the database backup
needs to be imported using the Archives application.

To import an existing database backup:

. Open the Archives application from the Serendipity Client Application menu.

. In Archives, select File menu > Open Archive.

. Navigate to and select the saved backup archive .sdb file. Click Open. The archive will open in the Archives
window and display all database items from the previously backed-up configuration.

o Once the archive has loaded, select Edit menu > Add to Database > Whole Archive. This will import the entire
database.

¢ Alternatively, choose individual items to import from the list and select Edit > Add to Database > Selected
Nodes.

. The database items will be imported and appear in the Workbench for use.

For further information on Archives and backing-up databases, see the “Archives” section of this manual.
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Saving/Restoring the Blackmagic Database and ICC Profiles using the File System
An alternate method for backing up the existing database and ICC profiles is to copy the relevant file folders from
Blackmagic to another location before upgrading to version 6.0.

The database items are held in a folder called defaultss.dbd in the following locations:

Mac 0S X /Applications/Serendipity Blackmagic/lib/defaultss.dbd/

Windows C:\Program Files\Serendipity Blackmagic\lib\defaultss.dbd\ (For versions 3.5.09 and below)
C:\Serendipity\Serendipity Blackmagic\lib\defaultss.dbd\ (For versions 4.0 and above)

Linux/Sun/SGI ~bmagic\lib\defaultss.dbd\

The ICC Profiles are stored a folder called ICC in the following locations:

Mac 0S X /Applications/Serendipity Blackmagic/lib/ICC/

Windows C:\Program Files\Serendipity Blackmagic\lib\icc\ (For versions 3.5.09 and below)
C:\Serendipity\Serendipity Blackmagic\lib\icc\ (For versions 4.0 and above)

Linux/Sun/SGI ~bmagic\lib\ICC\

To restore the database and ICC profiles to an upgraded Blackmagic
. First, ensure the Blackmagic Server and Serendipity Client are shutdown.
. Copy and replace the backed-up defaultss.dbd and ICC folders into the relevant locations (see above) for your
install.
. Start the Server and Client. All previous database items should now appear in the Workbench.

Important Note: Pagesetups imported from older archives will be automatically split into Jobticket, Media and
Pagesetup data types, but remain functionally linked. Version 6.0 archives cannot be opened or imported into previous
versions of Blackmagic.
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Running the Software

Once the software has been installed, launch the Server and Client to begin the configuration. The Server should be
started first and allowed to complete its initialisation process before the Client is launched. If the Client is started first,
it will attempt to connect to an active Server. If none are present, a Connect to Server window will open, waiting for an
active Server to appear on the network.

Important Note for Mac OS X Users

The Blackmagic Server and Serendipity Client (for Mac OS X) are able to run in either 32-bit or 64-bit modes. Running
both in 64-bit mode is optimal for normal usage however, not all Spectrophotometer and printer manufacturers have
converted their drivers to support 64-bit and will be unavailable for use in 64-bit mode.

New installations of the Server and Client are always in 64-bit mode by default.

Before starting the Server and Client
To switch the Server and Client between 32-bit and 64-bit mode:

. Open a Finder window.

. Navigate to the Applications/Serendipity/Serendipity Blackmagic folder.

. Highlight the Serendipity Client application and select CMD+I or right-click and select Get Info from the
menu.

. Tick the checkbox to enable Open in 32-bit mode.

. Repeat the above steps for the Serendipity Blackmagic and the C5 application if necessary.

If the Open in 32-bit mode checkbox does not appear in the Get Info window it will be version: 5.3
necessary to reset the Mac OS X Finder: Copyright: Copyright Serendipity Software Pry. Ltd.,

1994-2011
Label: x w

. Open a Terminal window.  Open in 32-bit mode
d Type or copy the following command into the screen and press Enter (with no e
line breaks):

/System/Library/Frameworks/CoreServices.framework/Versions/A/Frameworks/LaunchServices.framework/Versio
ns/A/Support/Isregister -domain local -domain user -domain system -kill -r

. The above command will make the Open in 32-bit mode option appear in the Get Info window.
o Go to the Finder window, right-click, Get Info and enable this option for the Client, Blackmagic and C5
applications.

Starting the Server
. Plug the dongle into an available USB port.
*  Launch the Server by double-clicking the Serendipity Blackmagic file in the installation a
directory, or the shortcut desktop/dock icon.

The Server window will appear, showing information about the Server software and the  Serendipity Blackmagic
initialisation process will begin.

Note: The Server will not initialise if a recognised dongle is not present on the computer from which it is run. If the
dongle is removed at any point while the Server is running, all job processing will cease and the Server will stop shortly
afterwards. Once the dongle is reconnected, close and restart the Server.
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Starting the Client
Once the Server has completed initialisation the Client can be opened.

Launch the Client by double-clicking the Serendipity Client file in the installation directory or the /" .»
shortcut desktop/dock icon.

Serendipity Client

The Client will connect to the active Server and display the default monitoring system - Jobs - on screen. From this
point, configuration of the system or loading a pre-configured setup can be done.

. Select Server menu > Server Settings (Preferences)

. Select the Colour tab.

. Click on System Specials and select Reference-Lab (or your own specials) and click OK.
. Click OK to dismiss the Settings window and apply any changes.

Manual Client Configuration

This section will explain how to setup a basic configuration in order to print a file to a printer and monitor the job
throughout the process. For detailed information on specific modules mentioned, see the relevant sections of the user
manual.

The default monitoring application - Jobs - opens with a factory standard layout, including the QueueManager,
Thumbnail and QueueStatus modules. System queues (Image, Render, Asset, Spool and AutoDetect) will be displayed in
the QueueManager. Specific queues will need to be configured for the abovementioned process.

There are five (5) sections within the Client that require configuration in order to begin processing jobs from the RIP to
the printer. These are (in no particular order):

. A RIP where the jobs are polled;

*  APagesetup and Media where jobs are processed;

. An Output where the print job will be sent; and

. An optional Jobticket, where any custom processing requirements are set.

Note: Each Pagesetup must be linked to a valid Media and Output so it is recommended to create those first, before the
Pagesetup is created.

To begin configuration:
. Select Application menu > Workbench.

Output Configuration

. Select Output from the Data Types list on the left and create a new  _
Output by selecting File menu > New. =

. The Output name “Untitled” will appear in the items list, highlighted -
for renaming. This is the name of the Output that will appear in the
Pagesetup. Select the item.

. In the Queue panel of the gray configuration area, click the Output iy AR
button and select the appropriate driver for your printer from the e :
popup list. :

. In the Destination panel, select a destination driver (i.e. the o
connection method) for your printer and enter the appropriate -
information, for example, the IP address of the printer. If USB or =y
Bonjour/Zeroconf is selected, click the Edit button to select the <
correct device/service from the Custom Settings popup window. e

. Configure any Collating or Nesting requirements as needed. See the
Workbench > Output section of this manual for further details on this option.

. OPTIONAL - After a Media is created, it can be assigned to the Output via the Change Media button. Assigning
a Media to the Output will only allow jobs submitted to that Media to print. See the Media section of this
manual for further information.

. Save the Output configuration when completed by selecting File menu > Save.
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Media Configuration
Select Media from the Data Types list on the left and create a new Media by selecting File menu > New.
The name “Untitled” will appear in the item list, highlighted for renaming. This is the name of the Media that

will appear in the Output and Pagesetup. Rename and select the item.

In the Output panel of the gray configuration area, click the Output
button and select the appropriate driver for your printer from the
popup list. This should be the same driver as was used for the Output
configuration.

Configure the print resolution to be used (if available) and the print
colourspace, e.g.,, CMYK, from the dropdown menus.

Select any custom settings for your printer. Click the Edit button to
select any options from the popup settings window. These options may
include paper type, print mode, cutting options, light ink usage. Click
Accept to close the window.

Set your Output ICC profile via the Choose ICC Profile button. In most
cases, for a new install this will be the Standard SWOP (CMYK) profile.
Optionally, load your own profile by choosing the Upload File button
and navigate to your profile. Click OK to assign the profile.

Save the Media configuration when complete by selecting File menu > Save.

Note: This Media configuration is the minimal setup required to get your proof/print workflow functioning. For
proofing work, the Media will need to be correctly calibrated. For a complete HowTo guide for configuring a calibrated
Pagesetup/Media/Output, refer to the Support / Knowledge Base section of the Serendipity Software website.

Pagesetup Configuration

Select Pagesetup from the Data Types list and create a new
Pagesetup by selecting File menu > New.

The name “Untitled” will appear in the item list highlighted for
renaming.

Rename and press Enter. Select the item.

Assign the Output created previously to the Pagesetup via the Change
Output button in the Output panel. A popup window will appear to
select the Output. Click OK when done.

Assign the Media created earlier to the Pagesetup via the Change
Media button. Select the Media in the popup window that appears
and click OK. Jobs will be printed using this Media unless another is
selected when submitting a job to print.

A Jobticket (if required) can also be assigned to the Pagesetup here.
This will process any jobs with the Jobticket properties if sent to this
Pagesetup.

Set any flow control or configure a Dropfolder via the Publish & Flow
Control panel.

Output
Output ...
. Media ...

4 Jobticket ...

Options

8-bit tiff convert

8-bit tiff convert

Priority: |0

Publish

DropFolder

/1 Location ...

Printer: |
TCP Port:

Flow Control

Hold:

Save the Pagesetup configuration when complete by selecting File menu > Save.

Jobticket Configuration (Optional)

Select Jobticket from the data types list and create a new one by
selecting File menu > New.

Rename if required and press Enter.

If the RGB and Press Input profiles for processing the job are
different to those in the System Settings, adjust them via the Colour
Management tab.

Adjust any rendering intent if required.

Configure any other sheet, effects, rotation or other options as
required and save the Jobticket via File menu > Save.

If desired, the Jobticket can be assigned to the Pagesetup created
previously. See above Pagesetup Step 6 for the location to assign the
Jobticket. Any jobs will be automatically processed with these
configured options when submitted.

Default

Auto Publication Name

Default

Mac Windows

Use port number

After Imaging After Rendering

Nest

Postacript / POF Optioms
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RIP Configuration
If the Blackmagic install requires proofing a RIP output, a RIP setup will need to be configured to poll the RIP jobs for
processing. - = - - =

. Select RIP from the Data Types list in the Workbench and create a new
RIP by selecting File menu > New.

. A warning message will appear. Dismiss the message.

. The RIP name “Untitled” will appear in the item list, highlighted for o S
renaming. Rename and select the item. e | e

d In the Driver panel of the gray configuration area, click the RIP Driver St
button and select the appropriate RIP driver for the CTP RIP input from pea T o
the list of licensed drivers. el

. Configure the RIP driver options by enabling checkbox options and/or -
choosing Custom Settings by clicking the Edit button.

i Tick the Enable Polling checkbox in the Polling panel. Set a poll interval time, for example, 2 minutes.

Note: Some RIP drivers and polling methods require the use of a Job Genie in order for the Blackmagic RIP setup to
recognise incoming RIPped files. See the Workbench > Job Genie section of this manual for further details. Also, refer to
the Support - Knowledge Base section of the Serendipity Software website for tutorials on creating your own
customised Job Genies.

. Choose the method the RIP setup will use to connect to the RIP output folder from the dropdown menu in the
Polling panel, for example, Localhost. Enter any Hostname/IP details if required.

. Enter the file path to the RIP folder in the Paths panel. To enter a path, click the New button below the panel.
Click Browse on the popup window and navigate to the RIP folder to be polled. Click OK to save the path.

. If required, setup Stripe Paths.

. Click the Test button at the bottom of the Testing panel to Save and Test the RIP setup. The Testing panel will
show a Polling OK result to confirm the RIP path is valid. Alternate messages will notify you if the RIP path is
invalid or if no RIPped files currently exist in the selected folder.

This completes the basic configuration of Blackmagic. For information on how to see polled RIP jobs and submit them
for proofing, see the Modules > RIP Monitor and Serendipity Client Menu Items > Submit Menu sections of this manual.

Monitoring Jobs - Configuration
Once the base configuration is complete, a monitoring application needs to be configured so jobs can be managed
throughout the system.

There are two (2) types available - the Jobs (default) or the Monitor application.
Jobs

This is the default application, launched when the Client is started for the first
time.

The Jobs application has a pre-configured set of tabs available for monitoring
various processes throughout the entire workflow. The default tab layout
includes the QueueManager, Thumbnail and QueueStatus modules. See the
“Jobs” application section within this manual for further information.

L gl BSOS

Any Outputs created in the earlier configuration will automatically appear in the
QueueManager module.
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The RIP Monitor will need to be added as a tab in order to poll jobs:

. In the Jobs application, select the Tabs menu > Add Tabs option.

. A window will appear with various factory default layouts available for use in the Jobs application.
. Select the RIP Monitor tab layout from the list. An example screen will appear to the right.

. Click Add. The RIP Monitor tab will appear in the Jobs window.

*  Available RIP queues can be polled by selecting them from the dropdown list and clicking the Poll button three

(3) times consecutively.
. Jobs appearing may now be submitted for processing.

Additional pre-configured Tabs may be added to the Jobs application as required. See the “Jobs” application section of

this manual for further information.

Monitor

The Monitor performs the same workflow monitoring functions as the Jobs application and was the default application
for this purpose in previous versions of Blackmagic, before the Jobs application was introduced. Monitor allows the

user to customise the size and layout of tabs and job management modules.

. Select Application menu > Monitor to open a Monitor window. The
default view will include a Queues tab and a Logs tab.

. The Queues tab contains the QueueManager, Thumbnail and
QueueStatus modules.

. The Logs tab contains the ClientLog and ServerLog modules.

If you would prefer to have any new output queues automatically added to
the QueueManager for future use, enable the Auto Queue Order checkbox
via the Toolbar (spanner icon).

A RIPMonitor tab will need to be added to the Monitor in order to poll jobs:

o Select Tab menu > New Tab to create a new tab for the RIP Monitor.

e v A b Y o 3100

. Rename the tab to RIP Queues or similar to differentiate it from the other =~ =

tabs.

. Select Layout > Add RIPMonitor. A module window will appear for the

RIPMonitor.

d The window may be resized and positioned by selecting Layout > Edit.
Select the window corner and resize it by dragging the mouse. Select

Layout > Use when done.
. Click the spanner icon to expand the Toolbar.

. If no jobs appear in the RIP Queue, click the Poll button three (3) times

consecutively.
d Jobs appearing may now be submitted for processing.

Additional Tabs and Modules may be added to the Monitor as required. See the Monitor section of this manual for

further information.
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Submitting Jobs

There are various methods available for submitting files for printing when using the Serendipity Client.

The Submit Menu
Selecting Submit > Files will present the file chooser window to select the file for processing.

Once a file is selected, the option to choose which Pagesetup/Media/Jobticket combination will be used is displayed.

Flow control can be enabled to hold jobs after imaging or rendering, along with number of copies and publication
options.

For complete information on the Submit menu, see the Serendipity Client Menu Items section of the manual.

DropFolders
DropFolders may be created via the Pagesetup in the Workbench application.

A DropFolder is an allocated folder where files can be dropped into it for automatic processing. A Pagesetup will need
to be published in order to access its DropFolder.

Important: Any files dropped in to a DropFolder should be copies, not originals, as they will be auto-deleted from the
folder once sent for processing.

For further information on the configuration of a DropFolder, see the Pagesetup section of the manual.

Third Party Applications
Supported file types may be submitted to the Serendipity Client for processing directly from third party applications,
like Adobe Illustrator or Photoshop.

The Pagesetup will need to be published as a print destination, allowing the design applications to see it and print to it
directly.

For the configuration of a published Pagesetup printer, see the Pagesetup and/or the Publishing a Pagesetup sections of
the manual.

Studio
The Studio application allows for the manual placement and nesting of files.

Once a job layout has been created, it is submitted for printing via the Studio menu. The option to select the
Pagesetup/Media/Jobticket combination will be displayed before the job is sent for processing.

For complete details on the Studio application, see the Studio section of the manual.

Desktop Submit
There is a further option when submitting an image to Blackmagic, available from the right-click (contextual) menu.

Selecting an image file from the desktop or Finder (Mac) / Windows Explorer (Win) and right-clicking will display the
following menu options:

. Open With > Serendipity Client - Opens the selected file in the Client using the SoftProof application.
. The following will appear in the Services menu option for Mac OS X, standard right-click menu for Windows:

. Submit Asset (Serendipity Client) - Sends the selected file to Blackmagic as an Asset for use in Studio.

. Submit (Serendipity Client) - Sends the selected file to Blackmagic for processing. The Submit window will
appear to select the Pagesetup/Media/Jobticket processing combination.

*  Preview (Serendipity Client) - Open the selected file in the Client using the SoftProof application.
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The Serendipity Blackmagic Server

The Blackmagic Server runs on the machine where the dongle is installed. The Server handles the processing of all jobs
through the system and must be started before the Client is launched.

As the Server starts, it checks to ensure a valid dongle is installed on the machine and which modules are enabled
(licensed). The Server calculates the speed of the machine it is running on and checks the integrity of the database
before loading it.

Once the Server is up and running, a clock keeps track of the duration the Server is operational.

Server Options
The window displays the Server information and various options once it is running.

Serendipity Blackmagic Menu Options
. About - Shows information about the Server. Clicking More/Less info shows or hides valid dongle options,
including the versions of the current drivers.
. Quit - Quit the Server application.

File Menu
. Stop Server - Stops the Server from running without quitting Serendipity Blackmagic.
. Start Server - Starts the Server if it is in a stopped state.
. Restart Server - Restarts the Server.
. Update Dongle - Allows users/administrators to update the dongle with activation codes to enable various
input and output licenses. See the Dongle Updater section for further information.
. Close - Closes the window. If the Server is running you are warned and asked to confirm Server shutdown.

Startup Options

. Start Server on Launch - The Server will start once the application is launched.

. Restart Server On Crash - Restarts the Server automatically after a crash.

. Start as Cluster Node - Starts the Server as a Cluster Node to be used by another Blackmagic Server for imaging
and rendering tasks.

. Important: Do not use this option before reading further information in the Applications > Clustering section
of this manual.

. Start in Safe Mode - This option starts the Server but ceases all job processing and RIP polling tasks. Safe Mode
is used for maintenance in the event a RIP queue, Pagesetup or other database item is corrupted, or is
functioning incorrectly. Once maintenance is complete, the Server will need to be restarted in normal mode.

Help Menu

. Update Options - Configure a time for Blackmagic to periodically check for software updates.

. Check for Updates - Choose this to immediately check for any software updates.

. Install Local Updates - Allows users to manually update the Serendipity software package by downloading
(-pax) package files. See the Installing Manual Updates section following for further information.

d Install Additional Software - Opens the Serendipity Updater application on the Additional Software tab listing
any new and uninstalled software components and/or printer screening drivers. Each item can be ticked for
installation.

d Rebuild Additional Software - This option is normally only to be used upon request by Serendipity Support.
This option will run a fresh software scan that may require components to be downloaded and installed.

d Backup Server - Perform a complete backup of the Server including the Workbench database (defaultss.dbd
and ICC folders), Calcheck History database (databases folder) plus Server settings and preferences.

d Restore Server - Import settings from a previously saved Server backup file.

For further information on the automatic software update functions, see the Serendipity Updater section of this
manual.
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Media Catalogue

The Media Catalogue is a built-in feature designed to assist in the creation
of new Pagesetup, Media and Output configurations, as well as allow for
modification of existing Pagesetup and Media configurations.

The Media Catalogue accesses the Serendipity Software website in order to
download and install Media configurations for use within the Serendipity
Client.

Write access to the Workbench is required in order to use Media
Catalogue, along with access to a Blackmagic Server and the internet.

. Create New - Create a new Pagesetup, Media and Output
combination for use in the Serendipity Client.
. Modify - Modify an existing Pagesetup and Media configuration.

Create New
Add a Pagesetup, Media and Output to the Workbench.

. Printer driver - Select the output driver to use. A dropdown menu
will display a list of available drivers.

. Media window - Once a driver has been selected, any available
Media’s for download will be displayed. Clicking on the name will
display the properties of the configuration to the right.

. Back - Go back to the previous screen.

. Next - Continue to the Next configuration screen.

. Close - Close the Media Catalogue.

Setup for Media window

. Pagesetup - The name of the Pagesetup being created. Rename as
required. If the name already exists a red cross will appear next to

the field on the right.

. Media - The name of the Media selected as per the previous
screen.

. Output - Use an existing Output from the Workbench or Create
New.

. Use existing - Select the Output to use from the dropdown menu.
This will overwrite the current configuration.

. Create new - Enter a name for the Output. If the name already
exists a red cross will appear next to the field on the right.

i Select Bonjour Printer - Displays a list of available bonjour
printers to assign to the Output.

. Select later - Creates the Output with no destination set. This
should be configured in the Workbench in order to send jobs to a
printer.

com.au9100 - Demo.

0 Media Catalogue - swdovel

Create New

Kj Create & new Output, Media, and Pagesetup configuration.

Modify

L o) Assign 2 new Media 10 an exist: Pagesety
k-*j s et Tt

O Media Cataiogue (Create) - admin@golem.swdevel serendipity-software.comau-9100 - Demo (3

Prisger Orver: | [pson Stylus Fro 7990/ 7940/9900/9910, FX-HE000/H10000

% roparty
Product Version

Medis
E230n7900-52Pro0l240 o

Tl 1 item

Setup for Uec s
Pagesetugr [£p30n7900-S2e7ro0f2 400
Ve
Output (o) use existing || create new

Epa0n 7900

Output: | use axisting () eraate new

0100 7900-514P1001240

select bomgour printer  (e) select later

. Create - Creates the Pagesetup, Media and Output in the Workbench. Confirmation will appear when done.

Modify

Modify an existing Pagesetup and Media configuration. A Pagesetup with
an Output using the driver to be modified must exist in the Workbench in
order to make changes to the configuration.

. Printer driver - Select the output driver to modify. A dropdown
menu will display a list of available drivers.

o Media window - Once a driver has been selected, any available
Media’s for download will be displayed. Clicking on the name will
display the properties of the configuration to the right.

. Back - Go back to the previous screen.

. Next - Continue to the Next configuration screen.

. Close - Close the Media Catalogue.

Mesa
Canom-PF6450-5emC250
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Setup for Media window

Pagesetup - The name of the Pagesetup being modified. Select
from the dropdown menu. Only Pagesetup’s relevant to the
selected printer driver will appear in the list. If a Pagesetup
does not exist, a red cross will appear next to the field on the
right.

Media - The Media selected from the previous screen that will
be assigned to the Pagesetup. This is a read only field. If a
Media exists with the same name a yellow warning will appear
to the right. The option to rename this (if required) will
appear once the Modify button has been pressed.

Back - Go back to the previous screen.

Close - Close the Media Catalogue.

Modify - Modify the selected Pagesetup with the Media.
Warning messages will appear if there are any duplications
with names. These may be edited or overwritten as required.

(2] (s} Item Already Exists In Datab [2) (8]

Satup for Media

Pagesetup:

Medle

Setu for Mesia

Pagesetup: | 4900

Rack Cote

Item Already Exists In Database

A Gradation Curve called "linearisations/Epson4900-SemiGloss170" already exists. A Media called "Epson4900-SemiGloss170" already exists.

Please select an appropriate option below.

Please select an appropriate option below.

New Name |linearisations/Epson4900-SemiGloss170] New Name |Epson4900-SemiGloss170|
Overwrite Use Existing Overwrite Use Existing
Always Overwrite Always Use Existing I Cancel Always Overwrite Always Use Existing | cancel |

If there are no current Media configurations available for the selected Output driver, the following message will appear:

® O O Notifier - Media Catalogue - admin@golem.swdevel.serendipity-softwar...

€3 No Media Available

There are currently no media available for your printers.

Please check again later.

19/12/2014 1:00 pm

Dismiss
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The Serendipity Updater

The Serendipity Updater provides a simple and convenient way of updating Serendipity Blackmagic and standalone
Serendipity Clients.

. . 000 Software Update 7
The Updater tracks your current software installation status ekl .
and automatically checks for available software updates, bug hssae sehvwaisurdas for Reskenes
fiXeS l’nalntenal’lce patCheS and new drivers ‘A’ Serendipity Blackmagic version 6.0 is installed in /Applications/Serendipity/bmagic
) . -
New updates are listed along with release notes, previously FTTIITS M Acditional Software | installed Updates |
installed updates are logged in the Updater, and notes can be [Name Version  Date Posted Size
. . Update 1 1.0 14 August 2015 10:34 am 28.79MB
v1ewed at any time. Update 2 1.0 28 August 2015 1:26 pm 47.19MB
5¢50600 L1 Yesterday 11:49 am 9.63MB
5¢30600 LY Yesterday 11:49 am 10.84MB
L. . . scf2000 1.1 Yesterday 11:49 am 5.35MB
Note: The Serendipity Updater requires access to the internet 570600 Ll Yesterday 11:49am 11148
. . . Quickeal 1.0 21 August 2015 2:52 pm 19.37MB
to function. Updates are not downloaded or installed until Galibration_Form 1.0 21 August 2015 2i52 pm_ 104.02M8
initiated by the user, as the Server and/or Client are shutdown
as part of the update process.
Update 2
ENHANCEMENTS
The fOllOWlng update funCthnS are aVallable in the Help menu - An Additional Software tab/function has been added to the Serendipity Updater application. This allows
. . . users to select and/or automatically download individual licensed Epson HTM drivers, Canon Media libraries,
future softws h: uired. w perf full recov i llation usi
of the Blackmagic Server application and/or the Help menu of  and fuure software ennancements as required. Users can now perform a fll(or recovery)instalation using a
the standalone Serendlplty Client: ~ Finer print modes for the EPSON SC-50600 and EPSON SC-70600 printer drivers using the HTM module.
- New drivers for Canon iPF810, iPF815, iPF820, iPF82S, iPF83x, iPF84x and iPF85x printers.
. Update Options - Configure a time for Blackmagic to Notnow.] |

periodically check for software updates.
. Never - The software will not check for updates.
*  When (Time/Day) - Configure a time and day to automatically check for any software updates.
. Notify when updates are available - A message will appear

- PSS g o
onscreen when updates are available to install. 800 Software Update
. Check for Updates - Choose this to immediately check for Check for Updates
any software updates. when: |Every 3| [1 1) [oay. 2

Day | Mon | Tue | Wed

at [1238em  |[1]
~ | Thu | Fri | Sat | Sun

__| Notify when updates are avail

When configuring a time/day for checking for updates via the Server Cancel | [ 0K

Help menu, a restart of the Server is required for any changes t0 take |
effect.

Additional Software tab
This section will list any uninstalled or new drivers or components that have not been installed.
Items can be selected and installed individually as required.

Note: The Serendipity Client installed on the Blackmagic Server machine is updated as part of Server updates and does
not gain access to the “Check for Updates” Help menu option. If Secure Mode is active, users can be configured to
receive an email when software updates are available. See the Accounts Admin section of this manual for further
information on email configuration.
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The Blackmagic Dongle Updater

The Blackmagic dongle licenses the level (version) of software and enables the use of any input filters (RIPs) and
output drivers that have been purchased. If any additional licenses are activated, the relevant dongle will require
updating in order to access them.

Dongle Updater

The Dongle Updater is a built-in feature, accessed via the Server File menu >
Update Dongle option. Key Code 1

Key Code 2

To avoid any abuse of the software, the dongle activation codes can only be
used once and may only be entered against the assigned dongle serial
number. Any updating should be completed by your relevant Server
administrator.

Important Note: Before updating any dongles, please ensure your Server is
in Stop mode.

Updating the Dongle —n <<=
Before updating the dongle, an email must have been received with the new
codes. This will either be sent from Serendipity Software directly, or via a Dealer of the product.

Two (2) codes are required for entry in order to update the dongle, referred to as Key Code 1 and Key Code 2.

The codes are located in the “Dongle reprogram string” field in the email and are separated by a space.

The first, long string is Key Code 1. The second, shorter string is Key Code 2.

To update the dongle:

Plug the current USB dongle into the computer and run the Server application.

Select the Server File menu > Update Dongle. The Server will stop. If there are any Clients open, a Connect to
Server window and/or disconnection message may appear.

A window will open for the Dongle Updater.

Enter Key Codes 1 and 2 into the relevant fields. It is best practice to copy and paste the codes to avoid any
keying errors. DO NOT copy the space between the codes.

Once the codes have been entered correctly, the Update Dongle button will enable. Click it.

A confirmation message will appear after the dongle has been successfully updated and a Server restart is
required.

Quit the Server application and restart. The dongle is now updated and any new filters or drivers will appear in
the Client for use.

When Updating from Version 3 or Prior - Before Restarting the Server:

Go to the installation directory for Blackmagic on the computer.

(for example: Applications/Serendipity/Serendipity Blackmagic)

Open the lib folder.

Open the printers folder.

Sort the files by date.

Delete all old files ending in *v.so

Once the files have been deleted the Blackmagic Server can be restarted.

Failure to remove the old files from the printers folder will noticeably slow down the Server when it is restarting.
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The Serendipity Client

The Serendipity Client is a graphic user interface (GUI) used for configuration, maintenance and monitoring of the
Blackmagic Server.

The Client can be installed and run locally on the same machine, or from any supported computer on the network using
TCP/IP protocol. There is no limit to the number of Clients that can be connected to the Server, and each Client will
have its own settings, specific to the user.

Once installed, the Client connects to a Blackmagic Server and loads the settings from the Server into the Client
interface. Any Client can access the job management information and view the current status. The configuration can be
open to all users or protected via Secure Mode, which allocates specific access for created users and user groups. For
more information on how to setup access, see the Secure Mode section of the manual.

Look and Feel

There is a common theme and functionality to the Client. There are many ways to complete the same task, such as
configuring a Pagesetup from the QueueManager. Various options are available using the right mouse click to bring up
other contextual menus. This will vary depending upon the section of the Client interface being used.

Anywhere there is a chooser to select an item from the database, a search field will be indicated by a magnifying glass.
Entering text in the search fields filters the list, showing only the matching items. N O
The search can be inverted with CMD+SHIFT+I (Mac) or CTRL+SHIFT+I (Win) to - -
hide the matching items. The search box will turn black to indicate inverse N
searching. Pressing ESC will dismiss the search.

Search

There are two (2) main sections to the Client - The Workbench and the Jobs application.

. The Workbench is used to configure the various parts of the Server. This is used to create queues, setup input
paths and various calibration functions.
. Jobs (an application) is used for managing and viewing jobs as they pass through the system.

The Applications and Modules add functionality and provide tools for managing the Server and the jobs passing
through it. There are also various menu options containing system utilities and preferences.

Workbench

The Workbench is where the main software configuration takes place. RIPs, Medias, Pagesetups, Output paths, Colour
Sets and Colour Correction Curves can all be setup here.

When items are created or changed in the Workbench they are saved to a database read by the Server each time at
startup. The database can be backed-up and copied to other
(Version 6.0) Blackmagic Servers.

The Workbench is a split window. The Data Types list the database
item categories that can be selected for creation or editing. The
items list show the available database items within each Data Type.
The gray area shows the settings and options for each item.

frernnt

The Data Types section has two (2) views - Browse & Search.

Browse allows the user to view and select any of the database items i
for display. The tab containing the magnifying glass flips to a Search
window, which acts like a filter, showing any items containing the search text.

000 Workbench - adn
| Browse & | Items & Type Modified
% serendipity specials Special Colour Set  5/03/09 11:29 AM
Find items containing serendipity tiff output RIP 5/03/09 11:29 AM
—_ % serendipity tiff separated Job Genie 23/10/08 5:04 PM

seren
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Menu Options
Application

Edit

Access all available Applications via this menu. Each application will open in its own separate window.

System Settings (Windows OS) - Access the System Settings (Preferences) for the Serendipity Client. This
option is available under the Serendipity Client menu for Mac OS X users.

Quit (Windows 0S) - Quits the Serendipity Client application. This option is available under the Serendipity
Client menu for Mac OS X users.

Files - Select files to submit to a Pagesetup/Media/Jobticket combination for processing.

Files for Deimposition - Submit files directly for de-imposition, assigning the files to one or more imposition
signatures.

Files As Imposition - Submit files directly as an imposition, assigning the files to one or more imposition
signatures. This option is only available for Veripress/Blackmagic Softproofing Add-On and allows jobs to be
de-imposed on the fly (see Touch Console for details).

Files As Asset - Select files to send to the Studio application Asset queue. Assets will appear in the
QueueManager queue as thumbnails but are not processed until submitted for printing from the Studio
application.

ICC Target - This is the standard option that should be used when calibrating a printer Media and submitting
an ICC target to generate an output ICC profile. Files submitted using this option utilise the Paper Profile,
Linearisation LUT and Correction LUT in the Media but are not ICC corrected.

Note: This is the standard option for submitting an (EPS or TIFF) ICC target chart used for creating an output
ICC profile when calibrating a printer Media.

ICC Target without Colour correction - Submit an ICC Target to a selected Pagesetup/Media/Jobticket
combination. All ICC options and colour correction curves are disabled. A message will appear to confirm the
option before submitting.

Test Prints - Submit one or more internal test prints to a selected Pagesetup/Media/Jobticket combination.
Test Prints as ICC Target — Submit one or more internal test images as an ICC target (as per option above). This
allows users to store a commonly used ICC Target chart in the “/lib/testprints” folder for easy access when
calibrating Media.

New - Create a new item in the database.

Save - Save changes to the database.

Duplicate - Make a copy of the currently selected item.

Revert - Reload the last saved version of the currently selected item.

Delete - Delete the currently selected item.

Print - Print the details of the currently selected item.

Get Info - Opens a popup window displaying General and Ownership information for the chosen database item.
The General panel displays the type, created and modified timestamps for the item. The Ownership panel
displays the User and Group permissions for the item.

Note: The User and Group will be listed as “admin” for normal installations. If Secure Mode is active (see Server
Settings and Accounts Admin), a user with sufficient privileges can make changes to the item permissions with
respect to other users. When in Secure Mode the admin user login is able to change the user or group to which
an item belongs. If multiple items are selected the admin user can make a mass change to the permissions of all
items.

Show Orphans - Shows any item currently in the database not being referenced by any other item.

Add to Archive - Add the selected items into a new Archive window. See the Archives section for further
information.

Export as C5 Pack - Allows users to export Media files from the Workbench to a specified location for use with
the C5 application.

Export / Import Folders - Allows users to export or import the folder structure used within the Workbench. It
will not import or export the contents.

Undo - Undo the last change. There are multiple undo options and this is configured via the Client Settings
section.

Redo - Redo the last undone change. There are multiple redo options, depending on the undo status and
configuration in the Client Settings.

Find - Opens a text box at the bottom of the Workbench panel to locate the search text on the screen.
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Split Vertical/Horizontal — Changes the view to either Vertical or Horizontal split on the screen.

Show Type Column - Used in conjunction with Show Usage to display the type of data listed.

Show Modified Time Column - Displays the last modified time for the items listed.

Show Usage - Displays the items within the database the currently selected item uses, e.g., a selected Pagesetup
would show the Media and Output it currently uses.

Reverse Usage - Reverses the usage shown above. (was called Show Referrers in previous versions).

Organise Data Types — When enabled, this option will organise the Data Types in the Workbench list into
related categories. This is the default view.

Modules

Server

Access all available Modules via this menu. A floating window will appear for each separate module opened.

Server Settings — Access the System Settings or Preferences for the Blackmagic Server. For more information
see the Server Settings section of the manual.

Connect to Server - Select a Blackmagic Server to connect to on the available network.

Resume/Pause Processing - Allows users to pause or resume all job processing and print queues. Queues
pause after completion of the current task.

Accounts Admin - Allows an authorised administrator to create, modify and manage user accounts and groups.
Chatterbox - Chat to other users connected to the same Server with this option. The Chatterbox window will
display the Clients connected to the Server. A nickname may be entered in the Client Settings, otherwise the
machine name is used. If the users name cannot be selected, the user has selected the Away option and is not
available.

Broadcast Message - This allows messages to be sent to all users connected with a Client to the same Server.
Selecting the Broadcast option displays a message window to type into and send. The message is displayed on
the users window for a short time and will automatically dismiss if it is not acknowledged by clicking OK.
Download PPD - Download the Megarip PPD from the Server to the desired location. This saves having to get
the PPD from the disk. Use the PPD when installing a local printer. When installed, the Megarip PPD (Postscript
Printer Description) is selected as the printer driver when setting up a Blackmagic Published Pagesetup as a
print destination for third party applications.

Window

Bring All to Front - Shows any open window of the Client and can be selected to bring it to the front.
Cycle Through Windows (CMD+" or CTRL+") - Cycles through the open windows within the Client.

Server Info - Provides information about the Server, including version, platform, speed, processors, hostname,
IP, product and vendor.

What'’s This - Select this and click on any part of the interface to display a short help description.

User Manual - Open a PDF of the Blackmagic manual.

Media Catalogue - Open the Media Catalogue to download and install Pagesetup/Media/Output configurations
in the Workbench. See Media Catalogue section for further information.

The following three (3) options will appear when using a standalone Serendipity Client:

Update Options - Configure a time for Blackmagic to periodically check for software updates.

Check for Updates - Choose this to immediately check for any software updates.

Install Local Updates — Allows users to manually update the Serendipity software package by downloading
(-pax) package files. See the Installing Manual Updates section following for further information.

Backup Client - Perform a backup of the Client settings. A window will appear to choose a location to save the
file. The backup will save Client preferences, folder structure within the Workbench and Client layouts. This
does not save Jobs, database items or ICC profiles.

Restore Client - Import settings from a previously saved Client backup file.

Contextual Menu (Right Click)
In addition to selected File menu options listed above, the following options are available via the contextual (right-
click) menu:

New Folder - Folders are a great way to organise the data types list items. Folders are Client based, meaning
each user can have their own folders if desired.
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. New Folder with Selection - Places any selected items into a new folder.
. Remove Folder - Removes the selected folder, placing items within the folder back in to the general item list.
. Open/Close Selected Folders — Expand or collapse the selected folders to show or hide the items within.

Note: Folders in the items list are internal to the Serendipity Client, used to organise database items. They are not
operating system file folders.
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Workbench Data Types

There are nineteen (19) data types (databases) within the Workbench that can be used and configured to accurately
process jobs. Each will be explained in detail. The data types are:

. Bookfilter — Allows for the polling and mapping of planning files for softproofing large multi-section or multi-
edition jobs. This is a standard feature for Veripress and available as a Softproofing Add-on for Blackmagic.

. Calcheck Chart - Used to provide a validation check for a hardcopy proof or a monitor.

. Camera - Setup a camera ICC profile for use with the SoftProof application when viewing RGB images.

. DotGain Curve - Used to compensate for or represent dot gain on the final output.

. Gradation Curve - Used to adjust colour in a job by applying a curve to the individual process colours.

. [CC Tweak Set — Build up a library of colours that need “tweaking” for accurate output.

. Job Genie - A programmable file search filter used by some RIP input filters for polling and stitching together
jobs and publications.

. Jobticket - Controls the input screening, resampling, ICC matching, rendering intents, effects, fitting or scaling
to be applied to incoming jobs.

. Media - Used to control configuration settings for Output, Colour Correction, ICC profiles, Screen Printing &
Output Screening.

. Output - Determines where processed jobs are to be output, as files, to a printer, or a remote location.

. Pagesetup - Where the desired output, media and alternative job submission methods are assigned.

d Pagesetup Pool - Print to one or more Pagesetups.

. Paper Profile - Used to define the paper and ink characteristics of the Media being used by the output
driver/device.

i Press — Contains the colour and dotgain attributes of a press. Used by the SoftProof application to show the
effects of printing a job on a particular press.

d Regular Expression - Used in conjunction with the RIPs for autoproofing jobs based on matching particular
rule sets.

. Replace Colour Set - Used to match and replace certain colours as they pass through the system.

. RIP - Configure a polling path and auto proof settings for RIP data proofing.

. Signature Group - Create or import signatures for de-imposition.

. Special Colour Set - Used to identify and match colours when jobs are polled and processed.

Data Types - User Interface and Context Menu

The Bookfilter, Media, Output, Pagesetup Pools, Press, RIP and Signature Data Types have multiple configuration panels
or sections governing the different functions they control. These data types have a row of buttons or tiles across the top
of their configuration panels allowing the user to instantly jump to the section named. If any of the panels are not
required, they can be hidden by using the “X” in the top right corner of each. To show any hidden panels, click on the
panel name in the row and it will appear. Shift+click will hide them again.

A contextual (right-click) menu is accessible in any of these individual sections, allowing the user to access the Find
function, Jump to another section, or change the background colour of the panel for easy identification.

Pagesetup and Jobticket have a slightly different layout with clickable menu headers.
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Bookfilter
The Bookfilter (Available for Veripress/Blackmagic Softproofing Add-On) is used to setup an appropriate

driver to read planning files in order to put finished publications together, greatly improving the speed, efficiency and

automation of softproofing in publishing press environments.

Bookfilter works similarly to a Job Genie based RIP queue in Blackmagic, but
rather than polling for RIP jobs, it polls for publication planning files.
Publications in the planning files are then displayed in the BookMonitor and may
be selected for softproofing. Publications displayed in the BookMonitor can be
expanded to show a list of pages and filenames associated with each page as
defined by the planning file. The Bookfilter maps the page filenames to processed
jobs in the QueueManager. When the publication is selected for softproofing, the
Bookfilter searches the QueueManager for matching jobnames and collects them
into a single publication. Any missing pages will appear as red in the page
navigator.

Driver

Job Name

Testing

Polling

Paths

Book Driver - Select the appropriate driver for the planning file format
used.

Enable polling - Enable or disable the polling of planning files.

Language Encoding - Set the encoding to match your system to display filenames correctly.

Poll Interval - Configure how frequently to poll for planning files. The Poll Interval should be set according to
your specific requirements. Setting the Poll Interval too short can flood the network with polling requests
(packets) causing it to slow down. Setting it too long can take a long time to show stable files ready for
submission.

Fast Polling - This will automatically poll two (2) more times as soon as one (1) automatic poll has completed.
It will not wait for the next scheduled Poll Interval before it polls again.

Log Statistics - Log the polling statistics in the Server log. The log message reports “Started automatic poll on
<date>" when polling starts and “Completed automatic poll on <date>" when finished.

Show Books Newer Than - When activated, this option sets the Bookfilter to display only polled publication
planning files with time signatures newer than the specified (days/hours/min) time in the BookMonitor.

Note: Older planning files are hidden from view, not deleted.

Job Genie - Select a Job Genie to apply if required. A Job Genie may be used optionally to remap the Publication
and/or Jobnames in the polled planning file.

Connection - Specify the method used for polling. The options are:

Agent - The Serendipity Agent is installed on the RIP where the files are located. This is used for polling and
submission of the files into Blackmagic.

Hostname/IP - Enter the hostname or IP address of the computer where the files are located and where the
Agent is running.

Localhost - This is used to poll a hard drive local to the Blackmagic install or mapped network drive on the
same machine.

FTP - Uses File Transfer Protocol (FTP) to poll and transfer the files to Blackmagic

Secure FTP (SFTP) - Uses Secure File Transfer Protocol to poll and transfer the files to Blackmagic.

File Transfer Priority - Specify the priority to be used for transferring files to Blackmagic. Adjust from Lowest
to Highest or anywhere in between.

Specify one or more paths to the location of the publication planning files. The options available are:

Testing

New - Adds a new path to the Paths field. Selecting this displays another window to type the path or browse to
locate the folder containing the jobs. Browse will only work if the connection method has been specified and is
valid.

Delete - Deletes the selected paths.

Delete All - Deletes all paths from the list.

Once the configuration is complete, test the parameters are correct. The configuration must be saved before a test can
be done. If it is not saved, a prompt will appear to “save and test”. A test poll checks the connection, path validity and
job presence. Messages appear in the window to alert you to any problems or give confirmation of a valid configuration.
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Calcheck Chart

The Calcheck Chart data type is where charts are configured and stored for use in colour validation checks.

The charts are comprised of user-created or imported colour patches, along with target standards and tolerances.
These items are saved to the database and can be used and/or adjusted at any time. The Calcheck Chart is then used in
conjunction with the Calcheck application to provide a

validation check for a hardcopy proof or a monitor. ) o (e (i) () (ST (B (S

Once the chart is setup, it normally never needs to be
changed; the standards to be used are saved with the chart.
When reading the chart with the Calcheck application, simply
load it and measure. If you wanted to use a different standard,
this is done in the chart and not the Calcheck.

The chart can be attached to the job as it passes through the -

Jobticket and Pagesetup, or printed from the Calcheck. o

The window shows a list of the patches on the right and

colour information on the left. For each patch selected its Lab
values, delta tolerance and patch type can be adjusted. The
overall target preferences are specified in the lower half of the left panel.

Toolbar Options

The following options are available via the Toolbar at the top of the panel. Any option can be shown or hidden by
ticking/unticking it in the contextual (right-click) menu within the Toolbar. The Configure Toolbar option in the menu
also allows the order of the buttons/options to be set.

New Colour - Create a new colour in the list with default* values. Values and colour names can be adjusted as
desired.

Delete Colours - Deletes the selected colours from the list.

Duplicate Colours — Makes copies of the selected colours. Use shift or control keys for multi-selection.

Rename Colours - Pops up a renaming window, allowing for name changes on one or more colours
simultaneously.

Import Patches from Files* - Import a patch set from a colour data file, such as those of colour standards or ICC
profile makers.

Reorder Patches - Reorder the patches. Selecting this will display another window to select one or more
colours and drag them into a new order. Use the up and down arrow keys and shift or control to multi-select.
Generate Patches from ICC - Select an ICC profile from which to create a set of patches. Selecting this option
displays a file chooser to select an ICC profile. A prompt will appear for the number of patches to generate. The
minimum number is 16 and maximum is 512.

Add Colours From Library - Add colours to the currently selected Calcheck Chart from a Special Colour Set.

*Note: When creating or importing new colours, they are stored with the default tolerance settings. This is user
configurable and should be set before the patch set is created.

Patch Definition

On the left are a series of controls used to define each patch. Selecting a patch from the list
will load the colour into the colour match box at the top and load the Lab/CMYK values into
the respective fields. To change the value, simply type the new number into the relevant
field.

L 78.88

a -2.63

b 33.13

Lab (or CMYK) - The Lab (or CMYK) value for the selected colour. e Tolerance [0
Ae tolerance - Set the maximum Ae value for the selected colour. ot Tolerence 20
AH tolerance - Set the maximum AH value for the selected colour.

AC tolerance - Set the maximum AC value for the selected colour.

Patch Type - Identify important patch types from the set. The options are:
Paper - Select the patch that represents the paper being checked.
Cyan/Magenta/Yellow/Black - Identify a patch for each colour from your set.
Gray - Used to identify gray patches in the chart.

Generic - Most patches are generic and are classified as generic if they don’t fall into one of the above types.

AC Tolerance 4.00

Patch Type | Generic m

Note: When generating patches from an ICC profile, the patches are automatically assigned the correct type.
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Target Standards ( .
There are three (3) standards that can be used to compare against a proof. Ae AH AC

These are Ae, AH and AC.

The first standard Ae is always enabled. The other two standards must be enabled for the results to appear on the
Calcheck. To enable, select the tab and tick the Target checkbox.

For each standard, specify the limits used for a pass and fail status. For Ae, also choose which of the Ae standards are to
be used - deltaE, CIE94, CIE2000, CMC(1:1) or CMC(2:1).

Important Note: The correct standard to be tested must be selected and saved with the chart. Only that standard will
be tested for a pass or fail. If you want to check another standard, change it here and save it again. For example, if you
are checking deltaE and you want CIE2000, you will need to change it, save and re-measure.

The limits are:

*  Average - For all the patches in the chart that will be measured by Calcheck, the average must be below this
value for a pass.

. Maximum - This is the default value used when creating or importing patches. This value is only used for
assigning maximum tolerance for the import. When the target is measured, the tolerance set per patch is the
one used to determine a pass or fail status.

. Standard (Std) Deviation - The standard deviation across all the patches must not exceed this value.

The Calcheck will only report a pass for a proof or monitor if all patches in the target chart are within tolerance.

. Patches Per Strip - Specify how many patches are printed per line, allowing the use of existing target standards
such as the Fogra Media Wedge.

Spectrophotometer
Use one of the supported online instruments to measure colours directly into the Calcheck Chart.

To measure colours:

. Select an instrument from the dropdown menu and click on Activate. The device must be connected and turned
on.

o Follow the on-screen instructions, as some devices require calibration before measuring.

*  When complete, click the Turn Off button.

. If the Lab text option is chosen, you will be prompted to choose a file to import. The format must be Lab values,
space or tab delimited and no header information.

Note: If importing characterisation data from one of the ICC profile packages or colour standards, use the Import
Patches From Files option.

Patches
This section of the Calcheck Chart window displays the patches in the set. Each patch shows its respective colour, name
and Lab values. There is also a patch type and the tolerances for each
standard. The tolerances are assigned when the patches are created or
imported and are based on the settings on the left.

I !
I 0:
I o
I

A tolerance setting can be altered by selecting the colour and entering
a new value in the relevant box.

B The Chart type can be altered via the dropdown menu above the patches and
Chart type | Lab # ress ICC Prof a Press ICC Profile will appear if allocated. The Press ICC Profile button only
becomes available for CMYK chart types.

Search

Above the patches list is a search box. Enter a string to filter out any patches not required and locate those that are. All
fields within the panel are searched. The search can be inverted using CMD+SHIFT+I (Mac) or CTRL+SHIFT+I (Win).
The box will appear black when the inverted search is enabled.
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( Camera
' The Camera data type is used to define an RGB (or Camera) ICC profile colourspace for use when viewing RGB
images in the SoftProof application. Users can configure whether the default Camera profile or image embedded ICC

profile is automatically selected and applied to an RGB image when opened in SoftProof. See Applications > SoftProof >
SoftProof Settings for further details.

Coto Vangement

Colour Management Colour Masagemant
*  Camera ICC Profile - Select the ICC profile to assign. S
*  Rendering Intent - Select the rendering intent to be used. oy —
. Black Point Compensation - Enable/Disable Black Point : Cudeck Gt ) ete
Compensation.

. Calcheck Chart - Assign a Calcheck Chart for Camera colour verification checks using the Displays application.

‘ DotGain Curve

A DotGain Curve can be used to compensate for or represent dot gain on the final output. In
this section, curves can be created for application to a Pagesetup in order to change the
output.

The curve may be applied for two (2) reasons:

. After the initial calibration you may find that the resultant output is either slightly
too dark or slightly too light. A DotGain Curve can be applied to the process or
specials (or both) to make the print lighter or darker; or

. To represent a press or printing process dot gain on the proof.

Toolbar Options

The following options are available via the Toolbar at the top of the panel. Any option can be shown or hidden by
ticking/unticking it in the contextual (right-click) menu within the Toolbar. The Configure Toolbar option in the menu
also allows the order of the buttons/options to be set.

. Trace Saved Curve - A green line appears, showing where the curve was last saved and where the curve has
been edited.

. Invert Curve - Invert the selected curve. An inverted curve can be used to compensate for the colour
characterisation or platesetter dotgain curves output by a platesetter RIP, returning jobs to a linear state for
proofing.

. Dotgain Table - Enter values manually to adjust or create a curve.

. Import from CSV - Import values from a CSV file. The file must contain exactly 23 values for each colour as
defined in the Dotgain table editor.

Note: The Process and Special DotGain curves only apply to CMYK input jobs. RGB jobs will not be affected.
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A

Gradation Curve
A Gradation Curve is used to adjust colour in a job by applying a curve to the individual process colours. The

Gradation Curve can be applied to a Media either as a Linearisation Curve or as a
Correction Curve. A Linearisation Curve is normally applied as part of the early

calibration stage and this is recommended. A Correction Curve is applied if a small

amount

of fine-tuning is required after normal calibration procedures.

Toolbar Options

The following options are available via the Toolbar at the top of the panel. Any option
can be shown or hidden by ticking/unticking it in the contextual (right-click) menu
within the Toolbar. The Configure Toolbar option in the menu also allows the order of
the buttons/options to be set.

A

Trace Saved Curve - A green line appears, showing where the curve was last saved and where the curve has
been edited.

Invert Curve - Inverts the selected curve.

Gradation Table - Enter values manually to adjust or create a curve.

Preview Curves - Displays a window with all curves in their respective colours so they can be assessed in
relation to each other. This is updated dynamically as changes are made.

Lineariser - Loads a Linearisation Curve directly into the Lineariser application.

ICC Tweak Set

Build up a library of colours that need “tweaking” (adjusting) for accurate output with the ICC Tweak Set
data type. A tweak set alters colours during the ICC mapping stage from input to output profile and is

selected on a per Media basis.

The ICC profiles are not edited in any way and the tweak set can be
selected as desired. Each colour requiring alteration is selected and

adjusted by adding to or subtracting process colours from it, or making it - -

lighter or darker. An accurate visual representation is shown on the

screen and the point in the colourspace can also be viewed. Colours can ComT
be created manually or by entering the CMYK or Lab values, or input
automatically using an online Spectrophotometer.

The interface is split into two parts - the left side shows the input values ..
and the right side shows where any adjustments (tweaks) have been

made.

Options

Colourspace - Choose between Input Profile or Lab input. If the profile selected is RGB, the sliders will change
to RGB. If CMYK, the sliders will change accordingly.

Influence - Choose the area around the specified colours to be affected. This is determined as a scale of 1 to 5,
with 1 being the least influence and 5 the greatest.

Tweak Value - Use the CMY sliders to add or subtract from the colour being adjusted.

Rendering Intent - Choose the rendering intent that the colour is to be altered in from either Perceptual,
Colourimetric or Saturation. This must match the rendering intent of the Jobticket for the mapping to work.
New Tweak - Create a new tweak in the rendering intent selected.

Copy - Available via the right click menu. Used to copy the selected tweaks.

Paste - Available via the right click menu once an item has been copied. Used to paste the copied tweak from
the clipboard to the rendering intent selected.

Change White Point - Change the white point of the paper. Select the button and enter the X,Y,Z points. If a
Spectrophotometer is connected, the white point can be measured directly into the system.

Zoom - Zoom in and out of the Lab colourspace to see the point being tweaked in relation to the whole space.
L-value - Move up and down the L-value to see the point being tweaked in relation to the lightness. Reset the
value by clicking the ReCentre button.

ICC Profiles — Choose the input and output profiles being used to tweak. These must match the ones selected in
the Media, as they are stored with the tweak set and are used during the mapping process.

Spectrophotometer - Choose an online Spectrophotometer to read values directly into the tweak set. Once
selected, press the Activate button to connect and take measurements. If the device is being used by another
application (including a Serendipity application), it will fail to connect. Quit or disconnect all others first.
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Job Genie

Plate separated, single-bit screen TIFFs have become predominant in print industry workflows. The TIFF

Based (Generic) input filter is designed to poll jobs from RIPs that produce 1-bit TIFF files; one file for each
process or spot colour plate of a particular job.

While the TIFF Based (Generic) input filter has a limited intelligence and can recognise standard filenames, such as
Jjobname_plate.tif, it will not understand or be able to correctly poll a filename like /371P1S1CCyan.tif.

The Job Genie utility allows for the configuration of a TIFF Based RIP input filter to poll and recognise any filename
convention, no matter how unique or complex, and stitch the 1-bit files into single jobs. Job Genie can also be used to
rename files to have more user-friendly onscreen names, or group files together into a single publication. The
configuration window is split into two (2) sections. The column on the left is used to enter a Task (see Tasks below).
The main panel displays the five (5) tabbed sections requiring consideration when setting up each Task. After it is
created, the Job Genie is selected in a RIP queue using an input filter such as TIFF Based RIP (User Configurable) to poll
the chosen directories for the defined filenames.

Tasks

A Job Genie is made up of one or more user-defined tasks. Each task specifies how the job filenames are collected; how
they are defined and grouped; how the job names will be displayed in the RIPMonitor; and if the jobs will be proofed as
a publication when submitted for processing.

Important Note: More than one task may be required to collect all the files in a given path if the naming varies. Jobs are
constructed in the order of the tasks. Once a Jobname is matched by a given task, it is removed from subsequent
searches, so the order of the tasks is very important. To change the order of a task, select it with the mouse and drag it
to the desired position in the list.

Interface Options
. Log - Enable or disable to display the matching process in the ServerLog for the task selected. This can be
useful to debug problems where configurations are not matching files properly. It is best to turn logging off for
a Job Genie that is functioning correctly to avoid the ServerLog becoming too large or cluttered.
. Add - Add another task to the list.
. Duplicate - Copy the selected task to a new one.
. Delete - Delete the currently selected task.

Tabs - (1) Collect Files

This tab specifies how the files are sorted and collected by the input filter. One or more search parameters can be
entered, with each one comprising of an Action type, a Match criteria and a search

String. i

It is not necessary to enter anything in this first tab if all the files in the RIP input
filter path are valid for collection and proofing.

As with tasks, each collection action is performed in order. Once a file has been
excluded by a task, it is not looked at again so the order of the actions is very
important.

Action Options

. Ignore Files — Do not include any files matching the definition specified
when the input filter collects the ready for sorting.

. Ignore Directories — Do not look in directories matching the definition specified when collecting files ready for
sorting.

. Descend Directories — Only look in directories specified by the definition when collecting files ready for sorting.

. Include Files in Directories - Include all files in the definition specified directories when collecting files ready
for sorting.

d Include Files - Only collect files as specified by the definition.

Note: Of the above actions, Include Files in Directories has precedence over all other actions. If this is matched, files and
directories at the same level are ignored. Files and directories within the directory matched are then subjected to a
search, governed by any other specified action.
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Definition Options

Ending With - Any file or directory as specified in the action with a name ending with <this text>.

Beginning With - Any file or directory as specified in the action with a name beginning with <this text>.
Containing Text - Any file or directory as specified in the action where a name contains <this text>.

Named - Any file or directory as specified in the action explicitly named <this text>.

Add - Add the action and definition specified to the list of files to collect.

Apply - Apply any changes to the currently selected action and definition in the list.

Delete - Delete the currently selected action and definition from the list.

Filename Length - Specify a minimum and maximum filename length when searching for any files for sorting.

Note: The Add, Apply and Delete buttons are only available if there is a change to an existing entry. If actions are not
added or applied to the list before a save, the list is not updated.

Tabs - (2) Filename Break Down
Most job filenaming conventions contain common elements defining the job’s name, section, page or publication; and
specific file markers or unique elements identifying things such as plate colour.

This tab allows you to specify the construction of a filename. This is done by

breaking it down into parts and giving each part a user-defined name. Once all
parts of the filename are identified, they can be grouped together to make a
complete job.

Options

Case Sensitive Matches - Used to match case when the criteria for

matching contains user specified input. For example, Part contains

specific words, Match to separator and the Truncate option. If any of

these are used and Case Sensitive Matches is selected, only those

characters matching the specific case entered are matched.

Read Direction - The direction in which the filename is read. Click the

arrow to change read directions.

Parts - This is a block diagram showing the breakdown of the job. Each part is given a name and identifies a
section of the filename. Clicking the Read Direction arrow changes the order of the parts to show which part is
going to be read first. If creating a new Job Genie, parts will not appear in the diagram until they are created.
Add - Add parts to the list.

Apply - Update the selected part with changes.

Delete - Delete the selected part from the list.

Part Name - Specify a name for the part you are about to describe. Meaningful names are useful when choosing
the groups later.

Part Contains - Specify from the list what the part will contain. Choose from:

Any Character - The part can contain any valid character.

Numbers Only - The part may only contain numbers.

Hexadecimals Only - The part must only contain hexadecimal characters (0-9, A-F).

Specific Words - Specify a word or characters in the text box that the part must contain.

Match - Choose what point in the filename you are going to match to. This may be a specific separator or end of
string, for example, read along the filename until this point, looking for valid part matching specified above.
Choose from:

To Separator - Enter a character in the text box to specify as a separator, i.e., continue reading the part until
you reach this separator.

To End of String - Match everything from this point to the end of the filename (string).

To Numeric Separator — Match everything from this point until you find a number.

To Non-Numeric Separator - Match everything from this point until you find anything that is not a number.

To “.” (full stop) Separator - Match everything from this point until you find a full stop.

To “-“ (hyphen) Separator — Match everything from this point until you find a hyphen.

To “_” (underscore) Separator - Match everything from this point until you find an underscore.

To “$” (dollar) Separator - Match everything from this point until you find a dollar sign symbol.

To “” (space) Separator — Match everything from this point until you find a space.

Number of Characters - Match the number of characters specified in the text box. A further option is available
if this is selected:

Truncate from Character - Choose a character to identify in the filename and remove all characters from the
point onwards. For example, if you have a large number of 0’s in a group, you can choose to remove those 0’s
from the group so they are not displayed.
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Note: The To Separator and Truncate from Character options allow multiple entries separated by commas, where each
entry searches for a match, i.e., you can specify “To Separator a, b, ¢’ where if any of the separators a, b or c are matched
it is valid.

Separator Options

Separators are the characters that determine the end and beginning of a part. For example, with cyan.tif the full stop
between cyan and tif is the separator. As this is part of the filename, you still need to decide what to do with this
separator. There are three (3) options:

. Discard Separator - Ignores the separator.
. Include Separator with this Part - Includes the separator with the part being described.
. Include Separator with the next Part - Includes the separator with the next part described.

Example: With a filename such as job.cyan.tif where we parse the name in the forward direction, we describe the first
part as name to separator full stop (.) and the next part as plate to full stop (.)

Discard Separator creates the two parts as job and cyan.

Include Separator with this part (for name) would produce a part as job.

Include Separator with next part (plate) produces a part as cyan. This is only used if the separator is a character you
want to display in the RIPMonitor, such as a page marker.

The most commonly used option is Discard Separator. In the above example, if the option Include Separator with Next
Part was used, we could not identify the colours, as it will be called .cyan

Tabs - (3) Jobname + Plate
This tab allows you to configure which parts should be grouped together to complete a job and which part identifies the
plates of the job. You can specify how the plates are described and control specific mapping.

Job Grouping
d Only group files in the same directory as job - Check this box to group filenames together in a directory. Files in
different directories will not be grouped.

This is used when job directories are created containing all the plates.
Sometimes the filenames vary for the name of the job, but because
they are all placed in one directory per job, they can be grouped
together. e (W)

d Group files with parts - This displays the parts created in Tab (2) -
Filename Break Down. Select the part or parts that make up the job
name by clicking the tiles onscreen.

d In most cases, the file part defined as the plate should not be chosen,
as this would group files with the same plate together, rather than
combining the different plate files into one job.

Plate Identification
This tab is where you define which part created in Tab (2) - Filename Break Down is the plate part and how it is
written in the filename.

. Plate Part - Select the part of the filename that describes the plate colour from the dropdown list. The list
contains the part created in Tab (2).

Plates are:

. Defined by words - The plate names are complete names, for example, cyan, pantone 252.

. Defined by numbers - The plates are defined by numbers, for example, 0 is cyan, 1 is Magenta etc. If this is
selected, two other options are available:

. Starting Plate Number - Enter the number the plates start at. This is usually 0 or 1.

. Plate Order - Choose the plate order between KCMY+specials or CMYK+specials.

. Map Letters C, M, Y, K to Process Names - If the plates are named with just letters, for example, cyan is
represented as c, selected Defined by words and choose this option.

. Strip leading zeros from colour names - Sometimes colour names have multiple zeros before the plate number.
This option can be used to remove these.
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Plate Mapping
You can map plate names so they appear correctly in the RIPMonitor and are able to be matched to colours in the
System Specials colour set (see Server Settings - Colour Management). A list of plates requiring mapping can be

created.

Case Sensitive Mapping - Select this if the mapping should check for case.

Add - Add the mapping to the list.

Apply - Apply changes to the currently selected mapping.

Delete - Delete the currently selected mapping from the list.

Prefix number literals with user text — Add a prefix to numbers you are polling. For example, if the colour is
called 254, you can prefix the word pantone in front of the number, making the special plate become pantone
254,

Tabs - (4) Publication + Pages

This tab is where parts can be identified from the Filename Break Down as a Publication and a Page. This can help with
autoproofing, as a job can be automatically filtered and gain all the attributes available to publications, such as grouping
in the QueueManager and the Pages pane in SoftProof.

Page numbers are:

Defined by words - Attempts to assign page numbers from words/letters

in the selected page number part.

Defined by numbers - Assign page numbers from the selected numerical

page number part.

Defined by sequence 1A, 1B, 2A, 2B - Use the standard press imposition

numbering system to assign page numbers from the select page number

part. E.g. 1A=1, 1B=2, 2A=3, 2B=4 and so on.

Defined by sequence 1A, 1B, 1C, 1D..2A, 2B - Use this multi-web press

imposition numbering system to assign both section and page numbers

from the selected page number part. The numerical component is assigned

as the section and the letter is assigned as the page where A=1, B=2, C=3

and so on. Alternatively, this page sequence definition will recognise a page number part comprised of a single
letter, assigning pages A=1, B=2, C=3, D=4 and so on.

Page number part - Select the part that identifies the Page number from Jobname, Colour, Extensions or None.
Case Sensitive Mapping - Select this if the Publication, Section or Edition mapping should check for case.

Publication Tab

Publication Part (dropdown) - Select the filename part defined as the Publication.

When files are submitted for processing via the RIPMonitor, all jobs with a common Publication Part will be
submitted to the QueueManager as one publication and will be viewable as such in SoftProof. None means no
Publication Part is being used.

IN / OUT - Optionally remap Publication abbreviations to full names. For example, smh IN becomes Sydney
Morning Herald OUT.

Section Tab

Section Part - Select the filename part defined as the Section Part from the dropdown menu. The default is
None, meaning the Section Part is not being used.

Various publications, such as newspapers, are comprised of several separate sections. The pages of these
sections often use a filename convention where the page numbers represent the number within the section -
not the page number within the whole publication. The Section Part makes it possible to proof a publication
made up of multiple sections and offset the pages of each section appropriately to allow viewing of the
complete publication in the correct page order.

IN / OUT - If used, the Section Part requires section names be entered although IN and OUT can be the same.
Page Offset - If required, enter a page offset value for the section, for e.g., pages 1, 2 and 3 of a section with an
offset of 10 would become pages 11,12 and 13.

Edition Tab

Edition Part (drop-down) - select the filename part defined as the Edition part. None means no Edition part is
being used.
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It is common for newspapers and other publications to be printed in several editions, with some or all pages
specifically printed for different locales or updated across the day. This part allows editions of a publication to
be defined and grouped separately for Softproofing.

IN/OUT - optionally re-map edition abbreviations to full names, e.g. CE IN becomes City Edition OUT.

Note: Using Publication and Section Parts with Bookfilter

In the case of a Job Genie being created for polling planning files using Bookfilter, the Publication, Section and Edition
parts can be used to re-map their respective filename parts to more coherent or user-friendly names for display in the
BookMonitor. Section Page Offset is not utilised in this instance, it is simply for renaming.

Edition parts defined for incoming RIP jobs can be matched to editions in particular planning file formats (such as IFRA
Track) polled using the Bookfilter. These are used if the planning file publication (Book) pages require a fallback to a
master edition when an edition specific page has not been produced on press and so is not present in the
QueueManager.

Tabs - (5) Display

The Display tab allows you to configure how the Jobnames are displayed in the

RIPMonitor. Click the Parts tiles to add the filename parts to the Jobname, Publication

Name and (optional) Section Name strings. Parts can be entered in any order. P

Any other text to be shown in the RIPMonitor can be entered as part of the string.

For example, clicking a part named Page will show <Page> in the string. This will
display the page number only in the RIPMonitor. It may be useful to add “Page:” s
before the <Page> part so the RIPMonitor will display as “Page:1”.

Display Specification - Shows the parts created in Tab (2).

Jobname String - Shows the string that will be displayed in the Name column

of the RIPMonitor and QueueManager. You can enter any valid character or

use filename parts.

Job Directory - (Buttons) Allows you to enter the job directory into Jobname, Publication and/or Section String
fields.

Publication Name String — Shows the string that will be displayed in the Publication column of the RIPMonitor
and QueueManager (in Publication view). You can enter any valid character or use filename parts.

Section String - Shows the string that will be displayed in the Section column of the RIPMonitor. You can enter
any valid character or use filename parts.

Edition String — Shows the string that will be displayed in the Edition column of the RIPMonitor. You can enter
any valid character or use filename parts.

Check the Serendipity Software KnowledgeBase for HowTo’s on creating a Job Genie:

http://skb.serendipity-software.com.au
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Jobticket

The Jobticket consists of configurable options used to manipulate an incoming job for the desired output. A
Jobticket can be linked to a specific Pagesetup configuration or created on-the-fly via the Submit dialog window.

Manage

Colour Management Panel ™ Always Use ICC Black Point Compensation

Manage

Honour Embedded ICC Profiles Retain Pure Black

Always Use ICC - Enable to always use the assigned ICC profile for jobs e

submitted to the Jobticket, Pagesetup and Media combination. If this is * Proie... | monitors/AdbeRGR1998 ke

not enabled, the ICC profiles selected are only used in colourspace Revdering ntenc: | Jstasve Colowrimente
conversion. This is the default option for any new Jobtickets created. Press nour

Honour Embedded ICC Profiles - Enable to use an ICC profile . roflae] foora-thond-Sestsote/SOMed 2 ek

% Inks

embedded in a submitted TIFF, JPEG or EPS file as the input match
profile. When enabled the embedded file profiles will always take
precedence over any Match ICC assigned.

Process Grayscale as Black - When enabled this option converts and
processes grayscale PSD, JPEG, BMG, TIFF and PNG files submitted to
the Jobticket as Process Black (K). Verity

Print Calcheck

Rendering Intent: | Relative Colourimetric

Press inks Preview

Note: The TIFF Image output driver has an option to embed an ICC profile into

TIFF file

s that are output by Blackmagic.

Black Point Compensation - This setting is designed for use when

processing input from large gamut sources such as photographs and RGB images. Black Point Compensation
enhances shadow details in these images; assists when viewing shadowed areas in non-ideal or everyday
lighting conditions; and prevents flooding in CMY gray areas.

This setting only functions when using colourimetric rendering intents and when Always Use ICC is enabled.
Black Point Compensation should not be used for normal CMYK proofing jobs which are generally well within
the gamut of an output device (inkjet printer).

Retain Pure Black - When ICC profiles are used, all colours - even solids - are made up of a mix of different
colours. Selecting this option uses only black for areas containing just black. When enabled, the following
options become available:

All - Uses black ink only in areas defined as Black.

Text - Uses black ink only in elements defined as Black text. This can improve the clarity and sharpness of the
text.

Note: This option is not always suitable for use with printers using light black inks, as many of these inks tend to have a
non-black hue.

RGB Input Profile - Select an RGB input ICC profile. This is used to convert data input from an RGB source to
Lab for colour management.

RGB Input Rendering Intent - Select the rendering intent to use. Options include:

Perceptual - All colours are moved proportionally to each other so the eye perceives the colours to be correct
(i.e., colours out of gamut move into gamut, and those in gamut move proportionally to those out of gamut).
Relative Colourimetric - Those colours out of gamut are moved into gamut, and those in gamut are left
untouched.

Absolute Colourimetric - The colours are left alone so those out of gamut cannot be reproduced. Adjusts the
white point of the media to match that in the input ICC profile.

Saturation - Those colours out of gamut move into gamut, but all colours increase in saturation as a result.
Press Input - Select a Press profile. This is a Match ICC profile and is used to convert input data from CMYK to
Lab. This can be a multicolour profile or CMYK.

Inks - Define a press ink set for a multicolour press ICC profile if the selected profile does not contain process
ink names. Selecting this option displays a Special Colour Set chooser to select a pre-defined press ink set or to
create a new set.

Important Note: For multicolour profiles to work, you must create the same colour names used in the ICC and have

them in

the same order. The order for the ICC is specified during ICC creation. This is independent of the actual press

order. Change the order by dragging the colours around the set. The order is specified as the Colour (left column), order

descend

ing.

Serendipity Blackmagic User Manual - Version 6.0 42



Press Input Rendering Intent - Intent - Select the rendering intent to use. Options include:

Perceptual - All colours are moved proportionally to each other so the eye perceives the colours to be correct
(i.e., colours out of gamut move into gamut, and those in gamut move proportionally to those out of gamut).
Relative Colourimetric - Those colours out of gamut are moved into gamut, and those in gamut are left
untouched.

Absolute Colourimetric - The colours are left alone so those out of gamut cannot be reproduced. Adjusts the
white point of the media to match that in the input ICC profile.

Saturation - Those colours out of gamut move into gamut, but all colours increase in saturation as a result.
Press Inks Preview - When a colour set is chosen via the Inks button, a preview of the colour swatches will
appear.

Upload ICC - This is available on all of the ICC choosers. If the ICC profile is located somewhere other than the
default ICC folders, use this function to upload it to the Server ICC folders in order for it to be used. As this is a
Client-side option, use this function for moving ICC profiles from the machine they were created on to the
Server. This can be either on the LAN or WAN as a remote machine.

Print Calcheck - Select this to attach a calibration strip to every job passing through this Jobticket. The Calcheck
results (green pass or red fail) will change the colour of the job information shown in the QueueManager when
the job is processed (see image below).

Chart - Choose the chart for use from the popup window of Calcheck Charts.

Device - Choose the device used to measure the strip with. This creates the chart for the correct device.

Note: The Calcheck Chart is a Data Type in the Workbench. This is where the chart is created. Use the Calcheck
application to measure it and produce a report.

Process & Resampling Panel
Processing

Resolution - Select either 8-bit or 16-bit processing for any
incoming job submissions.

Processing

Note: Blackmagic V6 is able to accept files submitted in a 16-bit format.

Resolution: 8Bit (s) 16 Bit

The files are normally processed and rendered in standard 8-bit colour, Resampling

which for many workflows is sufficient for proofing. 16-bit processing

improves render quality and can be useful for finding artifacts within a job. MHethod: | Flered : 1
When 16-bit is enabled, files submitted to the Jobticket in 8-bit are e —
upscaled to 16-bit for processing. 16-bit mode requires more system Antiaiasing: | None : f
memory for imaging/rendering jobs and produces larger output files.

Resampling
Configure the method for sampling incoming data and changing the resolution from the input to that of the output. The
options are:

Nearest Neighbour - The fastest method but less accurate. Choices are made as the closest pixels from input to
output and can result in jagged edges or stepping effects.

Bilinear — A medium quality sampling method and can take longer than Nearest Neighbour. Bilinear takes the
weighted average of 4 pixels from input to output. Best for use with screened data.

Bicubic - High quality sampling method which takes longer to calculate than Bilinear. Bicubic uses the
weighted average of 16 pixels from input to output.

Filtered - Serendipity’s own sampling method, giving the highest quality. It takes longer to process than
Bicubic and uses an averaged area from input to output. This setting provides better resampling for contone
data, such as Postscript and PDF. Filtered is the default setting.
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. Antialiasing - Choose from 2x2, 3x3, 4x4 or None. Antialiasing is designed to smooth jagged edges and is used
when the Output does not have sufficient resolution to display edges smoothly. The values increase the amount
of pixels used for Antialiasing. The default setting is None.

Fit & Rotate Panel

Fitting @
Fitting
*  None - Fitting method is turned off. Method: - (ghlone
. Fit Width/Fit Height/Fit Width & Height - Shrinks jobs to fit
within the set dimensions; proportions are maintained. Override Media Size @

. Scale Factor - Scales jobs by the amount specified. Width: (0.0 in

. Tiles - Tiles a job that is larger than the width & height Height: (0.0 in
specified. If required, an overlap can also be entered. Useful
for large posters or billboards.

. Best Fit Width/Best Fit Height/Best Fit Width & Height - As
Fit, but will shrink or enlarge jobs to fit/fill dimensions
entered while maintaining proportions.

. De-Imposition - Can be used to take an imposed file like an 8UP, de-impose it into 2UPs or singles and print it
on a smaller printer; or produce a single page PDF file. If this option is selected, a further Signature Group
button becomes available for selection.

Rotation

Method: | None

Note: If the Fit or Best Fit options are chosen and the width & height fields are left at 0, the Fit will default to the media
width and height as defined in the Media assigned to the Pagesetup and Jobticket combination when printing (see
Media for details).

. Override Media Size - When enabled, values entered in the width and height fields will override the Media
width and height settings when the job is processed (see Workbench > Media).

Rotation
J Rotation - Choose from None, Auto, 90, 180, or 270 degrees. Automatic rotation may be selected to best fit the
job using the media width and height specified.

Note: Auto Rotation is very useful for saving media but if a job is rotated it takes longer to process - the larger the job,
the longer the process time. Rotation takes place at the beginning of the Rendering phase and will affect cropping,
margins and so on. If auto-rotating when nesting (See Nesting in the Output datatype), it is advisable to have Sheet Auto
Rotation turned off, otherwise the job rotation will be calculated twice, again increasing the process time. Increasing
system memory can also improve processing times.

Centre & Size Correction Panel Centring
Centl‘ing Centre: Vertically Horizontally

Override Media Size @

. Centre - Select between Vertically or Horizontally. Use this to
centre a job at any time. In particular, use it when printing to a
double-sided printer to help match the front and back sides. size Correction

Enable Size Correction @

Size Correction
J Enable Size Correction — When enabled, enter a width and
height factor to compensate for media stretch or paper feed
errors by specifying a correction amount. See the Serendipity
Software KnowledgeBase for an article outlining how to calculate the correction amount.
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Crop & Pad Panel Cropping ©
Cl‘opplng Imaging
Auto: Trim Whitespace
Imaging Rendering
Left: 0.0 in
. Auto Trim Whitespace - Remove any whitespace around a Top: [0.0in
submitted job automatically during the imaging phase of RIGE:H{0.0 In
processing_ Bottom: 0.0 in
Rendering Padding
Left: 0.0 in
Apply cropping to the submitted job during the rendering phase. Values Top: [0.0in
can be entered for Left, Top, Right and Bottom. Right: [0.0in
Bottom: (0.0 in
Padding

Add whitespace to a submitted job by entering values in the Left, Top, Right and/or Bottom fields. Any padding will be
applied to the job after the Imaging and Rendering cropping effects (if any).

Padding will increase the overall size of the final job when output.

Effects Panel

Rendering Effects

Various effects may be applied to jobs passing through the Jobticket.
Effects are applied in the order they appear here. Some effects have
separate attributes for customisation and can be edited once they are in

the Applied Effects column. i oge

The Effects are:

Border - Place a border around the job. Line width and colour
can be specified.

Centering - Centre the job in the specified page area.
Convolution Matrix - Design your own filter effect according to
a pre-defined mathematical operation known as convolution.
Cropmarks - Place crop marks around a job. Line width, length and clearance can be specified.

Edge Detect - Remove all content and just leave the edges.

Fotoba Cut Marks - Prints user-configurable cut marks around jobs for subsequent cutting/trimming by
Fotoba Digital Print Cutter devices.

Image Overlay - When enabled, this effect allows a Blackmagic Image, JPEG, PNG, PPM, Photoshop or TIFF file
to be placed anywhere on the job. Settings include width, height and opacity for the overlayed image plus
options to allow it to stretch and rotate with the job.

Margins - Specify margins around the job.

Mirror - Mirrors the job.

Negative - Renders the job as a negative.

Pagenumber - Place the page number in the middle of the page as a watermark. Scale factor and opacity can be
configured, and choose between page number of the job or the page number of the signature (when using De-
Imposition).

Rectangle - Draw a rectangle around the job inset at the desired distance, line width and colour.

Registration Marks - When enabled, this effect will add registration marks at each corner of the submitted job.
Line width, Inner and Outer Radius are all configurable. This is not available when using the Studio application.
Signature Decorations - Place page lines (from the signature) and page numbers on the job. Further options
are available. Choosing lines for pages will print a line around the page. Lines for spreads will print a line
around paired pages (spreads).

Slugline - Place job information on the job. There are a number of options available via the Edit button. If using
a narrow format paper and the full slugline doesn'’t fit, select Custom Slugline and turn all options on. This will
show an item per line. Within Custom, fields selected will only be printed if they are relevant to the job. The
Slugline may also be mirrored - a useful option when printing to film using a white ink printer.

Imagieg Efects
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. ThruBlack - Set a black threshold level above which black areas are removed from an image on rendering. This
is useful when printing an image containing black onto a black surface.

. Unsharp Mask - Apply an unsharp mask to the job. The Unsharp Mask affects the edges within an image and
can be controlled with the available parameters. The radius tells us how large an area to affect around the
edges. The larger the radius, the greater the effect and the longer it takes to process. If the preview resolution
is high, a given radius will have less effect than if the resolution is lower. If the detail is quite fine, a smaller
radius should be used. Higher radius values can also cause halos at the edges. The threshold gives a level that
should be affected where 0 affects more of the image and 255 very little. The amount states the size of the
change, where a higher value is a greater change at the edges.

*  Watermark - Place a watermark across the job. The scale of the watermark is proportional to the size of the
job. 100% represents the same size as the job in the smallest direction. If the stretch option is selected,
horizontal and vertical sides are stretched to the scale amount. The watermark will be scaled in an anamorphic
manner. EPS files only.

Logo

Position a company logo, sign-off slugline or colour bar for checking consistency anywhere around the job. The logo
passes through the same colour management as the job and can therefore be verified. The file is not rotated during
output (except if Auto Rotate When Nesting is enabled in the Output). If the logo file is positioned along the left or right
sides, the EPS file should be created in the appropriate orientation.

. Enable Logo - Turn the Logo effect on or off.
. Dimensions - Enter the print dimensions of the Logo.
. Logo File - Select this to choose a Logo file.

Imaging Effects
Any checked effects will be applied to the job during the imaging phase of processing, before any rendering effects are
applied.

. Mirror - Mirror the job.
. Negative - Negate the job.
. Discard Alpha - Discard any alpha channels in the file when processed.

Colour Sets
IHPUt Colours Panel * Special Colour Set ... None
Colour Sets
@ Replace Colour Set ... None

Configure any colour correction sets or curves to be used for any processed jobs.

Colour Curves
. Special Colour Set - Select a Special Colour Set from the list of available

sets. Preview the set, edit, or create a new one. @ Cyan DotGain ... None
. Note: If a Special Colour Set is assigned in the Jobticket, it will override the @ Magenta DotGain ... None
default system specials. @ Yellow DotGain .. None

. Replace Colour Set - Select a Replace Colour Set from the list of available
sets. Preview the set, edit it, or create a new one. @ Black DotGain ... None
Colour Curves @ Specials DotGain ... None
. Cyan/Magenta/Yellow/Black DotGain Curves - Selecta C, M,Y or K DotGain Sanicalingaiationmmm  None

Curve to be applied. Preview the curves, edit them or create new ones.

d Specials DotGain Curve - Select a DotGain Curve to be applied to the Special
Spot Plates only. One curve affects all Special Colours the same way. Preview the curve, edit it or create a new
one.

d Device Linearisation Curve - Select a Device (platesetter) Linearisation
Curve to be applied. Preview the curve, edit it or create a new one.

Input Screening

Handeg:  Preserve | Real Dot Technology

Input Screening Panel

Input Screening determines how the screening on the input data is handled. There
are two (2) choices - Preserve and Descreen. An example preview image will
appear for the selected type.

Override Mandling

. Preserve - Preserves the dots from the incoming data so the same dots on
the final job are shown on the proof. Further choices are:

d Real Dot Technology - Used to preserve the dot structure.

d Fast-2 - Similar to RDT but a faster method.
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. RDT Smooth 1, 2 and 3 - This is RDT with progressive levels of smoothing.

Note: Fast-2 should be used where the dot structure is not very important. It will preserve the dot but is a quick, low
quality method. The sharpest dot structure will be achieved using RDT, however you will sometimes get introduced
moire, caused by the head weaving of the printer, the resolution and the screen ruling of the original file.

. Descreen - Descreens the incoming data with either:
. D-Dot - Removes the dots; or
. Fast - Quick descreening algorithm

Note: D-Dot is used where the output job is being sent to a photocopier or similar device, with a front-end RIP that
applies a screen of its own. If you did not remove the dot, the job would be double screened, producing poor output. Use
Fast for all other methods when the incoming screening is not to be preserved.

. Override Handling - Override the descreening mode selected with
other modes for the plates. This is needed so that, for example, if RDT is
used for all plates except Black (which uses RDT Smooth-2) you will
avoid getting moire.

Colour Keys

Enable Colowr Keys @

Colour Keys Panel

This module allows for the merging of some plates and separation of others
from a single job submission. For example, merge the CMYK plates together and
print the 3 specials as separate jobs, or create progressive proofs with C, CM,
CMY, CMYK, CMYKS], etc.

. Enable ColourKeys - Select this to turn the module on.

. Plates - Shows a list of available plates.

. Add - Adds the selected plates to the Plate Combinations list.

. Progressive - Used to make progressive proofs. After adding the first plate to be used in the proof, click the
Progressive button one or more times to cumulatively add plates to the Plate Combinations list. The
progression will start with the first plate on the Plates list by default if a first plate is not selected.

. Deselect - Deselects any plates currently selected in the Plates list.

. Remove - Removes the selected Plate Combination from the list.

. Remove All - Clears the Plate Combination List.

Postscript / PDF Options

Postscript / PDF Options Panel Use Bounding Box For Page Size
The following options are only used when the incoming data is Postscript: Sinple RS 0, CMYic conversion

Fail on RGB Images
Antialiased Subsampling
Disable PDF autoseparation

. Use Bounding Box for Page Size - Some Postscript jobs do not place a Kot s
page size in the job information. Checking this will use the bounding LeR MO Ion Ao ERR e ol
box as the page size.

. Simple RGB to CMYK Conversion - This is a compatibility mode from older versions of the product. Images are
converted from RGB to CMYK quickly using a basic method. The colour is not very accurate and is not
recommended for contract proofs.

. Fail on RGB Images - Causes a job to fail if it contains RGB images. If this is not checked, the jobs will process
but RGB images will be ignored and not printed.

. Antialiased Subsampling - Used to assist in the rendering of some fonts.

. Disable PDF Autoseparation - Turns off autoseparation for PDF files.

. Render in RGB - Allows Postscript file data to be processed in an RGB rendering mode, with a wide gamut
suitable for digital photographic proofs/prints.

. Use CMYK simulation from PDF for unknown colours - Allow the CMYK simulations from PDF files to be
substituted for unknown spot colours. This is the default option for any new Jobtickets created.

Note: An Unknown Specials colour set can now be assigned in the Server Settings. This allows unknown special/spot
colours included in PDF or Postscript jobs to be automatically added to the set.
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Media

The Media data type contains all of the settings controlling the output of jobs as they pass through the
Blackmagic colour management system (CMS) for proofing. Settings configured here are those directly
related to the Output device, Colour Correction, ICC Profiles, Screen Printing and Output Screening.

A Media can be one of several assigned to a Pagesetup, with an additional Jobticket which controls the input screening,
resampling, rendering effects and intents of incoming jobs. All jobs are submitted to a combination of Jobticket,
Pagesetup and Media destinations. When submitting, the user selects the Pagesetup to be used, at which point a list of
compatible (user-created) output Media types in the database become available for selection. A default Media is
assigned to a Pagesetup, so if a job is submitted without a specific chosen Media, the job will output to the default Media
settings. An Output data type can optionally have a Media type assigned to it, in which case only jobs submitted to the
Output using the assigned Media will be printed. All other jobs are held in the QueueManager until the assigned Media
is removed from the Output, or the held jobs’ Media type is assigned to the Output.

Important Note: Older version Pagesetups, when opened in version 6, are automatically split into Jobticket, Pagesetup
and Media types. Version 6 archives cannot be back ported.

Output = e st
. Output Driver - Select the desired output driver from the popup list. S e —
Those available will depend upon the options enabled on the dongle. == :
The selected driver affects the options made available for Resolution
and Colourspace. -
. Resolution - Select or enter the desired resolution (DPI). If the output is
a printer, only the supported resolutions are available. If it is a file
format, your own value can be entered. G e
. Colourspace - Select the output colourspace as desired. The selections — e e
will change depending upon the chosen output driver.
. Media Width/Length - Sets the width and length of the Media. Only jobs
submitted with a width and length equal to or less than the assigned P —
values will be printed. Jobs of greater width and length will be held in e ST
the QueueManager until an appropriate Media, or new width and length S
values are assigned.

. Note: Media Width/Length values override the width/length settings in the Nesting section of the Output,
meaning jobs will not nest or print until within the width/length settings of the Media to which they were
submitted.

. Cut Sheet - Enable this if the Media being printed to is Cut Sheet. The media to be used is selected from the
dropdown menu.

*  Total Sheets - Enter the number of cut sheets loaded in the printer. Jobs will stop printing to the Media and be
held in the QueueManager when MediaStatus has tracked that the assigned number of sheets have been used. A
Total Sheets value of zero (0) assumes an unlimited sheet availability for tracking. Sheet count is reset using
the Reset Counter button in the Usage panel.

. Manage Custom Page Sizes - Create and manage custom page dimensions for use. Any page sizes created here
will also appear in the Studio application > Media Panel > Page Size section.

. Printer Margins - Optionally set the Top/Left/Bottom/Right margins for the selected printer. These values
should be the hardware margins of the printer, defining the maximum limit of printable area. The margins are
utilised by Blackmagic when functions such as image placement and centring are used.

. Custom Settings - These options will vary, depending on which output driver has been selected. For example, if
JPEG is chosen, the quality may be specified in the customise section. If an Epson device is selected, items such
as paper types, ink types and cut methods become available.

Note: Borderless Printing - If available to the printer model, users can choose Borderless Printing in the custom
settings. If selected, Media width (and the image Fit setting) needs to be set to 6mm wider than the actual paper width.
When using Borderless Printing, up to 3mm of the image will be lost from the left and right sides of the image and 1mm
lost from the top and bottom of the image.
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Spotcolour Mapping
Some printers feature inks, such as metallic and white, intended for signage  ®Petcclour merping

and display; to replicate a press process or substrate; to act as a primer; or for Map colour [PANTONE 877 C ey T
printing on transparent media. These device spot inks are handled outside the e RETE T
normal colour management process and are not included in the output ICC PANTQNE Cool Gray A CEEmhits

colourspace for printing.

The Spotcolour Mapping panel is used to remap incoming job spot/special

colours to a printer device spot channel, e.g. remapping could be configured to

print any incoming job areas covered by the spot colour “PANTONE Cool Gray Cadd ) Chpply ) (Delete )
1 C” using the printer’s white ink.

. Map Colour - Enter the name of the spot/special colour to be remapped.

. To band (dropdown) - Select the white or metallic ink (printer dependent) to which the colour will be
remapped.

. Add - Add a mapped colour to white/metallic to the remap colour list.

*  Apply - Apply a name or colour remap change to the colour selected in the colour list.

. Delete - Delete the selected colour/remap from the colour list.

Colour List
The colour list has the following sort columns:

. Colour - The name of the spot colour to be remapped.
. To band - The printer device spot ink to which the colour is being remapped.
. DotGain Curve - The dotgain curve applied (if any) to the listed printer device ink.

Adding DotGain Curves

To assign an output dotgain curve to a listed printer device ink remap double-click or right-click on the colour in the
colour list and select a dotgain curve from the popup window (see Workbench > DotGain Curves for more information
on curves).

Calcheck Info
A Media can have its calibration status checked using the Check Media  cucheckinto
option within the Calcheck application (see Applications - Calcheck for more PRI e | o | o &
info rm ation) . Ep50n7900-Semiglons 170-720x1440 27/08/00 .25 MM
, _ L o s v
This panel displays the current Calcheck calibration status of the Media, with vesow ce 123
the following information displayed: S o oz
Bt Sa 15 o dell
i Chart - The Calcheck Chart used for verification. Isoconed v 6c39 seore 7257

o Date - The date and time of the Calcheck.
. Score - An internal calcheck rating from 1 to 100.

AE, AH and AC tabs show the following data for each of the standards (if measured):

. ACyan, AMagenta, AYellow, ABlack, AGray, APaper
i Pass or Fail - As designated by a green tick or red cross.
. A Average, AMaximum, AStandard Deviation

Usage
The Usage panel shows the amount of media used based on the values entered for Media Length (above).

¢ Usage Meter - Bar showing the amount of media used. Text
under the bar shows the exact amount as “Used X Units of
Total Units” (percentage %).
. Logged Period - Time period (date and time, from and to) the
Media has been tracked since the last reset.
d Printed - Number of jobs and total printed area of jobs tracked since the last reset.
. Reset Counter - Reset the usage count for the Media.
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Colour Correction
There are three (3) options for use to manipulate or fine-tune the colour to
achieve the desired results: Colour Correction

ST IS T S—
@ Paper Profile ... Epson7900-EpsonProofing

. Correction LUT - Select a Correction LUT to be applied in the form S
. . . A Linearisation LUT ... Epson7900-EpsonProofing
of a Gradation Curve. Preview the curves, edit them or create new =
A Correction LUT ... None

curves. WA CorrectioiETwm
. Linearisation LUT - Select a Linearisation LUT to be applied in the

form of a Gradation Curve. This is normally done as part of the

standard calibration process with the use of the Lineariser. Preview the curves, edit them or create new curves.
. Paper Profile — Select a Paper Profile to be applied. If the output is to a printer, this is also part of the standard

calibration process.

ICC Profiles
ICC Profiles are used to match colours from one device to another, for example, a Press to an Inkjet. It does this by
mapping an input to an output colour.

1CC Profiles

. Output ICC Profile - Select an output profile. This is the printer R Pesspicn 130l e
or other output profile and is used to convert Lab data to the el
output colourspace. This output could be RGB, CMYK, CMYKOG,
or N-Colour, depending on the output device chosen and the
detected colourspace.

. Output ICC Tweak Set — Select a Tweak Set from the available list. Lists can be previewed, edited or new ones
created.

. Device Link Profile - Select a device link profile. If the job passing through does not match the colourspace of
the Device Link Profile, the standard input and output profiles selected will be applied.

Oevica Link

# Device Link Profile ... | None

Upload ICC - This option is available on all of the ICC choosers and is used to upload an ICC profile from a local or
network folder location to the internal Blackmagic ICC folder.

To Upload an ICC Profile:

i Click the Upload File button.

d Browse to the location of the ICC file.

i Open the file.

. Select the location to save the file (lib/icc is

TR

default) =
. Click OK
i Save the setup (Media/Pagesetup etc) once the file

has been uploaded.

Screen Printing

The Screen Printing mode separates a job into single plates and prints them as black. This is designed to print with a
halftone dot onto a clear film media. To increase the density of the output,

choose a combination of inks. This option can be used to produce films for use  Screen Printing

in the Screen Printing industry. Sl bt
" Cyan [ Magenta I Yellow [ Black
. Enable Screen Print Mode - Turns the Screen Print mode on or off. T Light Cyan [ Light Magenta [ Light Black

¢ Ink Combination - Select the inks to be combined for a single  iaht Lgh Black

separation output.

In Screen Printing mode, all jobs are separated and there must be a Paper Profile where only one dot for each colour is
turned on.
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Output Screening

Apply screening to the output file if desired. This is only available if the output driver selected supports screening.

There are two (2) methods available - FM Screening or Halftone.

FM Screening Variations
. Stochastic - Standard Stochastic Screening.

. Stochastic-2 and 3 - Stochastic Screening with progressively increasing amounts of

Output Screening

Method: [ FM Screening 64

(® Stochastic

noise mixed in. This is done to overcome some artifacts caused by Inkjet printers. O Stochastic-2

. Stochastic Fast - A fast version of the Stochastic Screening mode. Slightly lower

quality than Stochastic.
. Error Diffusion - Error Diffusion Screening. May enhance edges within images.

() Stochastic-3

() Stochastic Fast
(O Error Diffusion
() Ordered Dither

. Ordered Dither - Ordered Dithering Screening. Applies a threshold map on the pixels

displayed, causing some of the pixels to be rendered at a different colour.

Halftone Options (Traditional Rosette Dot)

. Dotshape - Choose the dot shape to suit your requirements from Round,
Inverted Round, Elliptical, Inverted Elliptical, Diamond, Euclidean or Line.

. SuperCell - Select this to choose SuperCell screening instead of standard
halftone. Produces a much better quality output than standard halftone.
This is the default option for Halftone Screening when enabled.

*  AngleDegrees - Enter the desired angle for each plate.

. Screen,LPI - Enter the desired screen ruling for each plate.

d Defaults - Use this to select the default values based on the output
resolution.

Output Screening Override

Screen one or more colour plates for any incoming jobs using different methods or with different characteristics than

the defaults configured in the Output Screening panel.
Output Screening Override

s Cyan
The list on the left of the panel displays the process colour plates m::uE =

and special plates (S1-S8) available for screening override. g?:

Plates List

- . Gray
Override List Orange *

<1

Override
. Plates Column - Lists the plates that have been selected

for screening override.

. Type - Lists the selected screening type for the listed plate along with
details such as screening angle, LPI and dot shape.

. Remove Button - Removes the selected plates from the override list
reverting them back to the default output screening option.

. Edit Button - Edit screening options for the selected plate. Options are
detailed in the Output Screening section above. Double-clicking on the
plate in the Override List will also open the edit options window.

Type
SuperCell (105*, 133LPI, Inverted Elliptical)
Stochastic-3

| AN Output Screening Override
Method: | Halftone 3
Dotshape: | inverted Elliptical 8] ¥ SuperCell

Angle, degrees Screen, LA
105.00 133.00

Cancel ) Ok )
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Output
The Output data type determines the output format of processed jobs and where they are sent to for printing
(or file output). The Queue panel sets the output driver used and allows auto-cleaning of job Output queues.

The printer connection or file destination is configured in the Destination panel. The Collating section has options for
Nesting and Duplexing. Maintenance allows for automatic printer maintenance functions to be configured.

Queue

Queen
Output Driver - Select the output driver from the popup chooser o .| i S o 901910101, PR30
window. Drivers available will depend upon the options enabled on the S

dongle. The selected driver affects the options in a Jobticket and Media e macte

pointing to it. sk

Media - Select this to optionally assign a Media to the Output. A chooser ISR Pt

window will appear with Media displayed matching the Output driver S

type. The options as set in the selected Media are displayed for view, can Keeo MostRecant (010

be edited or a new Media can be created. adeteondingd TR CACCR DHCL

Status - Choose whether an Output Queue is Active (able to

print/output) or Inactive (Print/Output is paused). This can also be controlled from a QueueStatus module.
Monitor printer status - Enabling this option allows a QueueStatus module Show Printer Monitor Status to
display current status, ink levels, warnings and error messages for the Output printer. Available to compatible
printer drivers only.

AutoClean - Configures Blackmagic to automatically delete printed jobs from the Output queue based on times
and/or number of completed jobs in the queue. Auto-cleaning is performed the next time a job is submitted
after an auto-cleaning condition has been met. Options include:

Job History - Keep Most Recent - When enabled, set a number of jobs. Blackmagic will keep that number of
most recent printed jobs in the Output queue, automatically deleting any excess jobs.

Note: If this option is enabled and the number of jobs is set to 0, jobs will be deleted from the queue immediately after
printing.

Job History — Keep Jobs Newer Than — When enabled, Blackmagic looks at the time signature of printed jobs
and deletes any jobs in the queue older than the specified (days/hours/min) time.

AutoPause - Select a time duration the queue should pause after processing a job. Used for double-sided
plotters so there is a pause in sending the next job, giving the plotter time to turn a sheet ready for the back
side to be printed, or time to load another sheet.

Note: The Change Media option is used as both a safeguard against paper wastage and a workflow control method. If a
Media type is assigned to the Output, only jobs submitted to the Output using the same Media will be printed. All other
jobs are held in the QueueManager until the Media they were submitted to is assigned to the Output. If no Media is
assigned, all jobs sent to the Output are printed.

Destination
The Destination determines the method of delivery of the output job to the final destination. Depending on the
destination driver selected, there may be some additional options available.

Destination Drivers

Bonjour/Zeroconf - Select this to output to a Bonjour/Zeroconf network destination. The local network is
polled for Bonjour/Zeroconf devices. Choose Edit and select the appropriate destination from the dropdown
list.

Command/Script - Select a script or command to be run once a job has completed.

Epson FireWire - Only available on the Mac OSX version. Windows users should use the Local Print Queue
option and print to an installed printer, configured to use FireWire.

FTP - Send a completed job to remote machine using FTP.

Local Device - If a printer is connected as a serial or parallel printer, send a file directly to the device with this
option.

Local Folder - Choose a local folder to send the output file to. Enter the path or select Choose to browse and
select a folder. The folder must exist and have write permissions.

Local Print Queue - Print to a local print queue. Use this to print to a Windows printer on another machine. In
the path location enter \\machine\printer where <machine> is the name of the Windows machine with the
printer attached and <printer> is the exact name of the printer. The printer must be shared.
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. LPR Port - Use LPR to print jobs to printers accepting it. Enter the Hostname/IP address of the printer and the
path. Not all devices require a path to be entered. This is a good option for Epson printers with a network card.
This method is faster than TCP/IP printing for these devices.

. Nowhere - This is used for internal testing purposes or for softproofing workflows. Files created by the print
driver are not sent anywhere; they are left in the default raster location. A print time for simulation can be

entered.
. Secure FTP (sftp) - Send the job to a secure server using FTP.
. TCP/IP Port - Print to a networked device over TCP/IP.
. USB Printer - Print to a printer connected via USB. Cotition e | Ousieira_ i8]
Collating e

Collating is a method of gathering various outputs and grouping them together. There are
two (2) methods of collating available, depending on the output driver selected. If an
output driver that supports Duplexing is selected, the additional Duplexing collation
method becomes available. Otherwise, the only option is Nesting.

Duplexing
Duplex jobs with multiple pages to form double-sided printing. This is only available for printers supporting duplexing
modes.

. Add Separator Page - Adds a blank page between duplexed sets. This is useful when de-imposing and
duplexing perfect bound jobs. A blank page is inserted after the Maximum Jobs is reached for duplexing to
begin.

. Top Page - Determine if the top page is an odd or even number.

. Maximum Wait Time - Set the time to wait before duplexing begins. If the MWT is reached and the back side of
the pages has not yet been processed, the queue will begin to duplex any available pages. This will result in
single pages where the back are not yet completed.

. Maximum Jobs - Set the maximum number of jobs for duplexing. If this value is reached, duplexing will begin.

Nesting
Nest multiple jobs together for a single output to save media and time.

. Enable Automatic Nesting - Set the queue to nest jobs automatically when the configured conditions (such as
Maximum Wait Time) are met.

. Auto Rotate When Nesting - Enable auto rotation when nesting Rl s s it
occurs. If this is enabled, make sure the option in the Jobticket is e
set to None. There is no need to spend processing time rotating a e —
job if it is rotated at nesting time.

. Minimise Cuts - When automatic nesting is active this option _n et =
will align the nested jobs in a way that minimises the number of ==
horizontal and vertical cuts required to separate the individual jobs after printing. Note: This option may use
more media (paper) when nesting.

. Copies - Specify the number of copies for nesting. For example, if there are 7 jobs making up a nest and enter 5
in the copies field, 5 copies of the same 7 jobs will be nested and printed.

i Maximum Wait Time - Specify how long to wait before nesting begins. Once reached, nesting will begin and
any job waiting to nest will be nested into a single job. The start time is determined by the first job that appears
waiting to nest.

i Minimum Paper Coverage - Specify the minimum paper coverage to be reached by jobs waiting to nest before
nesting will begin. Once reached, any waiting jobs will be nested into a single job.

d Maximum Jobs - Specify the maximum number of jobs in a nest. If there are more jobs in the queue than the
number specified, that number of jobs will nest and the remaining jobs will stay waiting to nest until the
criteria is met again.

. Media Width - Specify the media width. This is required for nesting to work.

. Gap Between Jobs - Enter the size of the gap between jobs in the nest.

*  Minimum Total Height - Specify the minimum total height of a nest, i.e., if the combined height of the jobs
waiting to nest reaches this value, nesting will begin.

e  Maximum Total Height - Specify the maximum total height of a nest, i.e., if the combined height of the jobs
waiting to nest reaches this value, nesting will begin.
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Note: If a Maximum Height is set, the Nesting algorithm will look at all the jobs waiting to nest and fit the most jobs
between the minimum and maximum heights. If the available jobs can not cover the defined Paper Coverage (if set) of
paper without exceeding the maximum height, jobs will not nest. If no Paper Coverage minimum is set, any job that
would make the nest exceed the maximum height will be left in the queue - the other jobs will be nested. Any single job
exceeding the Maximum Height will also not print. If a job is too large, the nesting parameters and/or the printer media
must be changed. This makes it possible to effectively and efficiently nest using Cut Sheet media.

Maintenance
The Maintenance panel allows Blackmagic to be configured to automatically perform printer maintenance functions.
This is not available for all printer drivers.

Maintenance functions can be performed at regular time intervals; after a set number of print jobs; or after printing
linearisation charts and ICC targets.

Maintenance

Options include:

When: | Every s 1 ./ | Day s at 12:00AM
. When - Select Every from the dropdown menu to activate time- rtorm Ao 5 Cocck 3 Gean ol et et o s ot
based maintenance, with configurable time and day fields.
Multiple days of the week can be selected. vy (0|3 jobs princes
. Perform Actions: Partovm Actons

. Calcheck - When enabled, the printer will print a Calcheck Chart
as specified by the user.

. Clean Print Head - When enabled, the printer will clean the print Purform Actions: Print Nozzi Paern
head.

. Print Nozzle Pattern - When enabled, the printer will print a nozzle check pattern to verify all print nozzles are
clean and functioning.

. Nozzle Check - When enabled, the printer will perform a nozzle check.

. Every - Enter a number in the field or use the arrows to set the selected maintenance to be performed after the
defined amount of print jobs.

. Perform Actions:

. Calcheck - When enabled, the printer will print a Calcheck Chart as specified by the user.

. Clean Print Head - When enabled, the printer will clean the print head.

. Print Nozzle Pattern - When enabled, the printer will print a nozzle check pattern to verify all print nozzles are
clean and functioning.

. Nozzle Check - When enabled, the printer will perform a nozzle check.

d After printing:

i Linearisation Chart - When enabled, the printer will print a nozzle check pattern immediately after printing a
linearisation chart. If the pattern is incomplete, the print head will need to be cleaned and the chart reprinted.

. ICC Chart - When enabled, the printer will print a nozzle check pattern immediately after printing an ICC
Target Chart. If the pattern is incomplete, the print head will need to be cleaned and the chart reprinted.

i Calcheck Settings - Specify the Calcheck Chart to be printed when the above Calcheck option is enabled.

. Note: The Calcheck Chart will only print if there is a valid Media attached to the Output via the Change Media
button. If the Calcheck fails, the output will be made inactive automatically.

i Pagesetup - Select the Pagesetup to use when processing the Calcheck Chart maintenance option.

After printing || linearisation chart || 1ICC chart

Printer Maintenance
This panel is used to manually execute a printer maintenance function or test print on enabled output devices.

Select the desired maintenance function from the dropdown menu.

Printer Maintenance

. Execute - Initiate the selected printer maintenance
function or print.

Print Nozzle Check Pattern and F/W version t| | Execute

Printer Maintenance
+/ Print Nozzle Check Pattern and F/W version & Execute
Auto Nozzle Check without Metallic Ink

Auto Nozzle Check with Metallic Ink

Bidirectonal Adjustment

Unidirectional Adjustment
Paper Feed Adjustment
Head Alignment
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Pagesetup
A Pagesetup is where the desired output, media and alternative job submission methods are assigned.

Output
. Output - Selects the Output method and assign its configured
properties to the Pagesetup.
. Media - Select the default Media settings and assign its
properties to the Pagesetup. If a job is submitted to the
Pagesetup without a specific Media, the job will output using  °°to

Output
Output ... 8-bit tiff convert
& Media... 8-bit tiff convert

& Jobticket ... | None

these default Media settings. priority: [0 z
. Jobticket - Select the default Jobticket settings and assign its Auto Publication Name
properties to the Pagesetup.
i Options:

. Priority - Assign a priority to a Pagesetup. The lower the number, the higher the priority. Numbers can be
negative for a higher priority. The default is 0. Jobs waiting to Image or Render will be processed by higher
priority Pagesetups over those submitted to lower priority queues.

. Auto Publication Name - Create unique publication names for each job passed through the Pagesetup. Use this
feature for duplexing from PDF or PS files. Submitting a multi-page document as one job will allocate all pages
with the same publication name.

Publish
Allows Pagesetups to be published on a network as a Drop Folder, or as a network print destination for printing from
another software application. To Publish a Pagesetup, it is necessary for the Serendipity Megarip PPD to be installed on

the same system on which the Blackmagic Server runs (Server menu > e

Download PPD).
DropFolder

*  Publish DropFolder - Allocate a folder where files can be s e Lol
dropped in for processing. Valid File Types include Postscript, Printer: (7] Mac Windows
PDF, JPEG, TIFF Image, Serendipity Blackmagic Image, EPS, PNG, TCP Port: [ Use port number
pSD Flow Control

*  Location - Select a folder as a DropFolder. The folder must exist fioid: EARSrimaging A Rerideiing
and have read/write permissions. Nest

. Default - Reset the DropFolder location to the default one
(Serendipity Blackmagic installation directory/drop/<”"Pagesetup Name”>)

d Printers - Choose to publish the Pagesetup as a network print destination, allowing third party applications to
print directly to it.

. Mac - Enable to publish the Pagesetup as a Bonjour/Zeroconf network destination for Mac OS X and Linux.
Note: When adding a new printer through System Preferences on Mac OS X, select the Bonjour address
(pagesetup name@computer name) as the printer and Serendipity Megarip PPD as the driver.

. Windows - Choose to publish the Pagesetup as a Windows local printer port destination. See the Serendipity
Software website for details on how to create the Windows printer.

. TCP Port - Choose to publish the Pagesetup to a TCP Port, allowing it to be setup as an IP printer destination,
or as a destination for other Serendipity Blackmagic Servers.

. Activate Port Number - Enter the TCP port number the Pagesetup will publish to. It is necessary for the port
number to be 10000 or over and for each Pagesetup to have a unique port.

. Note: When adding a new printer through System Preferences on Mac OS X, select IP printer, HP Jetdirect -
Socket for the protocol. The address should be in this form - computername:10063. Select Serendipity Megarip
as the driver.

. When adding a new printer through Windows:

*  Select Create a New Port - Standard TCP/IP Port.

. Enter the computer’s network name in the Host ID field.

. When Windows requests additional info for the port, select Custom Settings.

. Rename the Port Name if desired.

. Set the Protocol to Raw and the Port Number to the one set in the Pagesetup to be published.

. Select Serendipity Megarip as the driver. If the driver is not already installed, choose Have Disk and get the
driver (megarip.inf) from the Serendipity Installation DVD, found in the drivers/win/’0S Version’/ directory.

. Flow Control - Select whether to hold the submitted file after Imaging or Rendering in order to prioritise jobs
or make rendering attribute changes before releasing. Options include:
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Hold After Imaging - Hold jobs submitted to the Published Pagesetup after imaging has completed. Held jobs
can be released to continue processing via the QueueManager toolbar or contextual (right-click) menu.

Hold After Rendering — Hold jobs submitted to the Published Pagesetup after rendering has completed. Held
jobs can be released to continue processing via the QueueManager toolbar or contextual (right-click) menu.
Nest - When enabled, this option will nest jobs submitted to the Published Pagesetup according to the criteria
defined in the Output used by the Pagesetup/Media.

Note: The Nest function only requires that the Output used has nesting parameters defined. The

Output itself can have nesting disabled for normal use. This makes it possible to create multiple nesting or non-
nesting Published Pagesetup’s to print via the same Output.

Asset Queue as a Published Pagesetup
The Asset Queue automatically publishes itself on the network in multiple ways:

Drop Folder - Files placed in the Asset Drop Folder are automatically placed in the Asset Queue. The drop
folder location is /Serendipity Blackmagic/drop/asset drop

Printer - The Asset Queue is published as a Bonjour/Zeroconf network destination address (asset
drop@computer name). Jobs printed to this Bonjour destination (see above) are placed in the Asset Queue.
TCP Port - The Asset Queue publishes itself to TCP port number 9104. Jobs printed to this TCP port (see above)
are placed in the Asset Queue.
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Pagesetup Pools
The Pagesetup Pools data type is used for printing to one or more Pagesetups. Load balance between
multiple Pagesetups, or print to multiple Pagesetups simultaneously. These can be published in the same

way as an individual Pagesetup, or the Pool can be set to auto-proof from a RIP configuration.

Publish
Allows Pagesetup Pools to be published on a network as a Drop

Publish
Publish DropFolder

Default

Folder, or as a network print destination for printing from another

software application. To Publish a Pagesetup Poo], it is necessary for

Prirter Mac Windows

TCP Port: _ Activate port number

the Serendipity Megarip PPD to be installed on the same system on Flow Contst Lok e magog ()t Rt
which the Blackmagic Server runs (Server menu > Download PPD). o s
. Publish DropFolder - Allocate a folder where files can be ey
dropped in for processing. Valid File Types include b it Arn

v POF
£p10n790..n270-RCE

None

#¥8300s .. 85 Otigh)

) By Number of Jobs

Postscript, PDF, JPEG, TIFF Image, Serendipity Blackmagic
Image, EPS, PNG, PSD.

Location - Select a folder as a DropFolder. The folder must
exist and have read/write permissions.

Default - Reset the DropFolder location to the default one
(Serendipity Blackmagic installation
directory/drop/<"Pagesetup Pool Name”>)

Printers - Choose to publish the Pagesetup Pool as a network print destination, allowing third party
applications to print directly to it.

Mac - Enable to publish the Pagesetup Pool as a Bonjour/Zeroconf network destination for Mac OS X and
Linux. Note: When adding a new printer through System Preferences on Mac OS X, select the Bonjour address
(pagesetup pool name@computer name) as the printer and Serendipity Megarip PPD as the driver.

Windows - Choose to publish the Pagesetup Pool as a Windows local printer port destination. See the
Serendipity Software website for details on how to create the Windows printer.

TCP Port - Choose to publish the Pagesetup Pool to a TCP Port, allowing it to be setup as an IP printer
destination, or as a destination for other Serendipity Blackmagic Servers.

Activate Port Number - Enter the TCP port number the Pagesetup Pool will publish to. It is necessary for the
port number to be 10000 or over and for each Pagesetup Pool to have a unique port.

Note: When adding a new printer through System Preferences on Mac OS X, select IP printer, HP Jetdirect -
Socket for the protocol. The address should be in this form - computername:10063. Select Serendipity Megarip
as the driver.

When adding a new printer through Windows:

Select Create a New Port - Standard TCP/IP Port.

Enter the computer’s network name in the Host ID field.

When Windows requests additional info for the port, select Custom Settings.

Rename the Port Name if desired.

Set the Protocol to Raw and the Port Number to the one set in the Pagesetup Pool to be published.

Select Serendipity Megarip as the driver. If the driver is not already installed, choose Have Disk and get the
driver (megarip.inf) from the Serendipity Installation DVD, found in the drivers/win/’0S Version’/ directory.
Flow Control - Select whether to hold the submitted file after Imaging or Rendering in order to prioritise jobs
or make rendering attribute changes before releasing. Options include:

Hold After Imaging - Hold jobs submitted to the Published Pagesetup Pool after imaging has completed. Held
jobs can be released to continue processing via the QueueManager toolbar or contextual (right-click) menu.
Hold After Rendering - Hold jobs submitted to the Published Pagesetup Pool after rendering has completed.
Held jobs can be released to continue processing via the QueueManager toolbar or contextual (right-click)
menu.

Nest - When enabled, this option will nest jobs submitted to the Published Pagesetup Pool according to the
criteria defined in the Output used by the Pagesetup/Media.

Note: The Nest function only requires that the Output used has nesting parameters defined. The Output itself
can have nesting disabled for normal use. This makes it possible to create multiple nesting or non-nesting
Published Pagesetup Pools to print via the same Output.

Prints To All Pagesetups

fimorzzzzsEEgernddr
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Job Queuing
Job Queuing is used to configure how incoming jobs are managed by the Pagesetup Pool.

*  Priority - Assign a priority to a Pagesetup Pool. The lower the number, the higher the priority. Numbers can be
negative for a higher priority. The default is 0. Jobs waiting to Image or Render will be processed by a higher
priority Pagesetup Pool over jobs submitted to lower priority pools.

* Pool type - Decide what sort of pool to use. There are two (2) options:
o Load Balancing - Spread the jobs across the Pagesetups selected in the pool.

= By Print Area - Calculate the area of each job and the queue with the least amount of print
area queued is sent the next job.
= By Number of Jobs - The queue with the least number of jobs is sent the next job.

Load Balancing is ideal for printing to multiple printers of equal quality, using the same media, with the priority being
to proof jobs to the next available printer. Each printer is calibrated separately to ensure quality. “By Print Area” is
more efficient, as the larger the print area the longer it will take to image, render and print. Queue loading is
determined at the time of imaging. If a print queue is paused, jobs will be sent to active queues.

. Prints to All Pagesetups - Choose to print to all Pagesetups selected in the pool.

The option Prints to All Pagesetups is ideal to print a job locally and remotely. One Pagesetup can be configured to drive
a local printer and another can create a JPEG image and transmit it to a remote Serendipity Blackmagic. Alternatively,
create a PDF file to send to a customer at the same time as printing a hardcopy.

Pagesetups
This displays all Pagesetups configured in the system. The sort columns show the Output, Jobticket and Media used by
each Pagesetup.

Tick boxes are available to select which Pagesetup will be included in the Pool. A context menu for each Pagesetup in
the list allows the user to edit any or all selections of the highlighted Pagesetup, it’s assigned Output or Media.
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Paper Profile
. Configuring a Paper Profile is a fundamental part of calibrating a printer for optimum colour output. The
profile is assigned to a Media and matches paper and ink characteristics to the output driver, resolution,
colourspace and custom settings of the Media.

The user interface for Paper Profile comprises of a toolbar containing options and functions to assist in creating the
profile; and a tabbed panel where the printer’s dot sizes (Density
Patches), Ink Limits are configured.

Toolbar Options =ik E il
The following options are available via the Toolbar at the top of the 1ol B e S
panel. Any option can be shown or hidden by ticking/unticking it in XTI i !!
the contextual (right-click) menu within the Toolbar. The Configure :.,, .
Toolbar option in the menu also allows the order of the i E P
buttons/options to be set. v B

. Measure Patches - Use this to measure a printed density 0. e [} e E visn !
chart using a supported Spectrophotometer. After selecting, T o
choose an online instrument to be used from the popup list.

When the device is ready, the measuring window becomes
available. If instructed, calibrate the instrument and begin patch measurement.

. Change Media - Change the Media currently assigned to the Paper Profile.

. Print Density Chart - Prints a density chart containing the patches currently turned on. Where patches are
turned off, there will be a space on the output print.

. Print Density Chart (All patches) - Prints a density chart containing all patches, irrespective of their on/off
state.

. Prink Inklimit Chart - Prints an ink density chart containing all enabled limits as one job to the selected Media
and Pagesetup.

. Print Inklimit Chart (Separate Jobs) - Prints an ink density chart for each enabled ink limit colour combination
as a separate job, using the Media and Pagesetup selected.

. Configure Inklimit Chart - Configures the combinations of inks to be tested for ink limits. Select which colours
will be printed, the start and end ink percentage points and step increments.

* Note: If you have a combination selected but insufficient patches to fill the row, an empty chart will be printed.
For example, if you select to print 3 ink limit and have 2 colours selected, only the chart border will be printed.

d Preview Graph - Show a graph of the patches currently turned on. See the Graph section for more information.

e  Sift and Sort - Enable or disable this option to Sift and Sort the patches in legacy Paper Profiles (from previous
versions).

d Reorder Inks - Change the order of the inks in the paper profile to match the order used in the ICC profile.
Often used for N-Colour profiles. Highlight the ink channel in the list and move using the up and down arrows,
or drag and drop inks to the required position.

*  Configure Ncolour - Available for Ncolour Paper Profiles. Opens the Ncolour Ink Configuration popup interface
used to customise a printer ink set. This option allows the user to profile printers loaded with non-standard
replacement ink sets (see Ncolour Ink Configuration below).

. Upgrade - Upgrades a legacy (pre-version 6.0) paper profile to the current version.

Contextual Menu (Right-Click)
All of the above options are available via the right-click menu, in addition to:

. Downgrade - Enables the Paper Profile to be downgraded to allow compatibility with earlier software versions
(v3,v4.0.01,v5.1, v5.2-5.4)

Density Patches
This area shows the patches making up the Paper profile. Each patch represents a dot size or combination of dots

available to the printer being profiled. 1 >\>< 3 3
1:95.13 | 16115, [ERERTA |1 35.6,
The number of ink channels shown and the number of patches shown for each 5 2 7 S
.ch_annel Wlll vary, depe.ndlng.on v.vhether the prlnter has variable dot capability; o008 e
if it has light inks; and if the light inks are configured to be treated as separate or s e
. . . Light Magenta Lab: 70.288, 53.162, -22.144
combined channels. These options are selected in the Output and Custom — :,g:’;“n‘(;;z%s‘,%
Settings of the Media chosen when creating the Paper Profile. ; - = ki i

Before densities have been measured, all patches will be turned on and will have %% %7 @20 sae
default (L value) densities. These densities are updated by data input from the Measure Patches option.
p y p
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. Patches can be turned on or off by clicking the upper half of the patch.

. Click the lower half of the patch to manually enter (L value) densities for that patch number. Pressing Enter or
TAB stores the value and moves to the next patch for entry.

. Hovering the mouse over the patch number displays a tooltip, providing information about the patch including
default or measure Lab values.

Sift and Sort Options

When enabled, the Sift and Sort options for each ink channel allow users to set the maximum ink coverage for the
channel and display the channels name. For legacy paper profiles created in previous versions of Blackmagic using
patches with Density values rather than Lab values, this option also allows users to set the patch order and sift for the
optimal combination of dots for the ink channel.

. Sift - This is a legacy option, available to older paper profiles create in previous versions of Blackmagic. Sift
uses one of several intelligent algorithms to select a suitable dot combination based on the density readings
taken and the output device selected. When used, the popup DotSieve Algorithm Selector presents the available
device/ink Sift options. The Sift selected patches can be switched off or changed if alternate patches are more
appropriate.

. Maximum Ink - This field sets an ink coverage limit for the ink channel by introducing white space into areas of
coverage higher than the set limit. The default setting is 100%, i.e., no limiting. Maximum Ink is a “low level”
setting applied during screening.

. Sort Order - This is a legacy option available to older paper profiles created in previous versions of
Blackmagic:

. Patch Number - Sort the patches in patch numbered order.

. Colour Density - This is the density of the colour, sometimes called Real Density. It is the colour content of the
patch.

. Visual Density - This describes how dark the colour is, i.e., how much light the colour is absorbing, measured as
Black. This sort option is not available for Black, where colour and visual density are the same.

Note: Turning off an Ink Channel
When Treat Light Inks as Separate Channels or N-Colour options are enabled, the user has the option to turn off one or
more of the printer ink channels.

Some inks - often Cyan and Magenta - produce patches with a high colour Cyan density INE 2 2 ‘*‘~>_<~"”/
density while not being very dense visually. During the process of calibrating " 9" L:94.94 | [126035| |L:57.54] |1 20.53
a printer, if you find that even the small dot (patch 2) of an ink has a colour cyan density SHIE ENVAIEVZIEN4
density too high to enable that colour to pass a particular calibration & L9515 | 15105 13878 130,80,

standard, you can turn off that ink channel by de-selecting all the Density

patches for that ink. This should only be done where multiple inks of a particular colour are available. For example, if
patch 2 of the Cyan is still colour dense, you can switch Cyan off and use only Light Cyan.

Switching off an ink channel will have effects through the calibration process, in particular, when configuring Ink
Limits. When configuring the ink limit chart, the number of available inks will need to be reduced and the disabled ink
channel should not be used in any of the combinations on the Ink Limit Chart.

Aann, a faper Profie Craph

Paper Profile Graph
The graph shows the dots selected for each colour. The position on the graph -
gives a proportional representation showing where the dot starts to turn on
or off, and their relative proximity to other dots. Turn the individual colour
graph plots on or off by checking the tick boxes under the graph. Hovering the
mouse over a point on the graph displays a tool tip, giving information about
the dot.

¥ ¥a ¥a ¥ Me Ve Ve ¥ e Ve

If a colour is not shown on the graph but the check box is ticked, the dots
selected are most likely a poor choice and may not be valid; or that the ink
channel has been turned off by not choosing any of its dots (Separate Ink
Channels only).

Separation Control

Separation Control displays where a light ink mixes with standard (or
heavier) inks within a process ink channel. For example, the coverage level
where Cyan is printed and where light Cyan finishes.

¥ We Ve ¥ P e Ve
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Manual Separation Control is available when the Paper Profile is linked to a Media for a printer that has light inks
enabled and the Treat Light Inks as Separate Channels option is enabled. These settings are in the output Custom
Settings of the Media.

The graph displays the portion of each ink used at ink coverage levels and where the inks start and cross over. To view
individual inks on the graph, click the ink colour checkbox at the bottom of the screen. Click an ink twice to toggle all
graphs on or off. Shift+click to display selective graphs. The sliders on the left show the inks where control is allowed,
i.e,, those with light inks as well as heavy inks.

The graph on the right changes as you adjust the sliders to see the effect of different values. To view individual inks on
the graph click the ink colour check boxes at the bottom of the screen.

Note: For v5.2+ Paper Profiles, optimal Separation Control settings are determined automatically if the Ink Start
Control values are set to 0%.

NColour Ink Configuration
The Ncolour Ink Configuration interface is used to customise a printer ink set, change ink names, define ink colours,
light inks and device spot inks.

Used in conjunction with the Reorder Inks function, this option allows
the user to profile printers loaded with non-standard replacement ink
sets.

The interface contains two (2) panels - the Ink List Panel and the Ink |
Configuration Panel. K :

Ink List Panel

The Ink List panel displays a list of the inks available for customisation
in the N-Colour Paper Profile. Each of the printer’s inks is defined in Cancl | [0
three (3) columns:

. Name - The user defined name for the ink channel. This defaults to the original name. Click in the text field to
rename the ink.

. Original — The name of the standard ink channel for that ink slot.

. Type - The process, light or custom (n-colour) ink channel type the ink occupies for the purpose of creating an
ICC Output Profile for the printer.

Contextual Menu (Right-Click) Options:
. Revert All - Revert all ink channels to the printer defaults.
. Revert Channel - Revert the currently selected ink channel to the printer default.

Ink Configuration Panel

The Ink Configuration panel is used to display and edit the properties of each of the printer ink channels for the N-
colour Paper Profile. Click on each ink to view or edit.

The upper part of the panel has two (2) dropdown menus allowing the user to select what channel the ink occupies for
ICC profiling the printer; the lower halfis a colour picker panel allowing the ink’s display colour to be defined.

. Colour is a... - This is a dropdown menu to select the ink type from Cyan, Magenta, Yellow, Black, Custom (N-
colour), Light, Light Light and Device Spot Colour.

. Light Ink - This dropdown menu activates when a Light ink option is selected in Colour is a... Select an ink from
the list.

. Spot Generation - This dropdown menu activates when Device Spot Colour is selected in Colour is a... Select a
generation mode for the printer device spot channel from Fill, Auto (Opaque Media), Auto (Transparent
Media), None.
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Colour Picker Panel ———

This section is used to change the colour of the ink channel as it is displayed in : LRI
the Serendipity Client interface. Altering the ink colour to one closer resembling R

the custom ink in the printer aids in identifying the ink when measuring patches ;
for the paper profile; when linearising; or when examining ink channels in the b mie L L L

SoftProof window. ~me i s : E!
HEE

Select from Lab, CMYK, or RGB colourspaces. Use the sliders (or type in the =T 2 !E
number fields) to define the ink colour. Ni=le

l !
P e 32 (e x (e
[ 2 i 0

0o LMW LTAN Leam

Double-click in the colour swatch to select a colour from a Special Colour Set.

RGB has the option of using the “Pick from Screen” button, allowing the user to
click a colour anywhere on the display to define the ink colour. RGB Pick From Screen Paper Profile Example

Note: Device Spot Colours and Spot Colour Mapping
Some printers (or custom ink sets) feature inks, such as metallic and white, intended for signage and display; to
replicate a press process or substrate; to act as a primer; or for printing on transparent media. These device spot inks
are handled outside the normal colour management process and are not included in the output ICC colourspace for
printing. These colours are printed in one of two ways:

1. Automatically, according to the Spot Generation method assigned to them in the dropdown menu; or
2. Asaspot colour mapped to a plate in an incoming job (see Media - Spotcolour Mapping).

Mapped plates will always override the automatic spot generation method when printing. i.e., a job with a spot colour
configured in Media to be remapped as “white” will only print white in the areas defined by the spot plate.
N-colour mode allows any ink in the printer to be assigned and printed as a Device Spot Colour.

Ink Limits

The Ink Limits tab has controls for limiting the ink mix of the channels applied in the Paper Profile. The number of ink
channels varies depending on whether the printer has light inks and whether they are being treated as separate or
combined channels. The window to the right displays a summary of the driver configuration from the selected Media.

Options Ovnae Ptchs Ak Sapuntion Contre

*  Yule Nielsen Number - Set the YN number for the I e e
paper being profiled (if known). The default is 2. ' M ion P50 Prnten s Ml S

. Ink Limits - Set the ink limits for the Paper Profile. e L
These are determined after printing a chart and T somo
observing the percentage of coverage at which the i e p—
mixture of inks causes problems. Enter the value for Rt re—
each ink combination. ey it oot l

e Algorithm - Choose the type of ink limiting: S

e Standard - Simple ink limiting based on ink .~ .
percentages.

o Enhanced - Like Standard, but optimised for variable
dot printers. It uses intelligence to calculate the ink limits based on dots used.

. Linear 3.0 - This setting adds the ink coverage for any area then proportionally limits, according to the ink
limit range it falls within. For example, with 3-ink set to 300% and 4-ink set to 400%, if a 6-ink area of an
image has a coverage of 320%, it will limit the area according to the 3-4 ink range.

. Linear 4.0 - (Default) This method limits inks based on the number of inks being used for an area. For example,
if 5-ink is set to 390%, any time 5 inks are laid down their coverage will be limited to 390%.

. Linear, favour Black - As more ink is laid down and a colour area approaches Black, this method limits CMY
proportionally more than Black, preventing wetness and inversion in shadowed areas.

. Lowpass - No limiting is imposed until the coverage for combined number of inks reaches the set limit, at
which point any higher ink coverage is clipped to the ink limit.

. Lowpass, favour Black - The same as Lowpass, but favouring Black, limiting it proportionally less than CMY as
colours approach Black.

d Media Information - This side of the screen displays information about the driver and Media configuration
important to the Paper Profile.
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Press
The Press data type is used to emulate the properties of a press for softproofing. Each Press configuration can

be assigned a press ICC profile, dotgain curves, press sheet dimensions, the number of ink keys, ink and paper
characteristics; all combining to produce accurate onscreen softproofs.

The Press can be switched on-the-fly while softproofing to instantly show how a job will look if printed on a different
press or on different stock.

Dimensions
Enter the size of the printable sheet area of the press and its number of  aen
Ink Keys. The Key Width is calculated from these values.

Colour Management
This panel is where the Press ICC profile is assigned, along with any process CMYK, spot colour or device (platesetter)
dotgain curves required to reproduce the colour performance of the press.

Replace Colour Set - Select a Replace Colour Set to be applied. :
Press ICC Profile - Select a press ICC. This can be one created on 2 o KC Pofie None

the press or a printing standard ICC which is used as the target or —— -
match profile. ® Veiiow DotCam Carve —_)  None
CMYK DotGain Curves - Select individual C, M, Y, or K DotGain O Pu O O e
Curves to be applied. i

Specials DotGain Curve - Select a DotGain Curve to be applied to I
any special or spot colours.
Device Linearisation Curve - Select a device (platesetter) DotGain

Curve to be applied.
Calcheck Chart - Select a chart to verify the SoftProof’s calibration
status.

Paper Colour - Three (3) options are available:

None - Do not change the paper colour;

ICC Profile - Use the white point from the press ICC profile and apply as the paper colour; or

Custom - Enter your own value for the paper colour. Use a Spectrophotometer to measure the paper white
directly into the configuration.

Ink and Paper
Configure the ink and paper properties of the press to simulate their effects on the screen in the SoftProof application.

Maximum Ink Weight - Enter a value for the maximum ink weight. This value is used by the InkKeyViewer to
show excess ink.

Stretch Factor - Enter a compensation factor to allow for stretch. It can be used for distortion simulation or
anamorphic scaling, where one direction will distort more than the other.

Note: The easiest way to calculate stretch is to draw a rectangle 1m x 1m and print it. Measure the rectangle and enter
the value. If the size is 98cm, enter 0.98. If the size is 102cm, enter 1.02.

Back Page Opacity - Enter a value between 0 and 100%. This controls the amount of show through of the back
page through the front page when reverse page viewing in SoftProof.

Back Page DotGain Curve - Select a DotGain Curve to apply to the back page when using the Show Back Page
option in SoftProof.

Back Page Rotation - Select the relative orientation of back page when using Show Back Page in SoftProof.

Top Page - Choose Even or Odd. This is used to determine which page backs onto which, so the correct back
page is shown when requested.
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Regular Expression
The Regular Expression data type is assigned as a filter to an auto-proofing RIP queue. Here, the user

constructs a set of rules whereby only files with a particular naming structure will be submitted for auto-proofing.

EXpI‘ESSiOIlS EtxnveSSgensl ['lgnore items 14 using | all of the following 4]
Similar to the Job Genie, the Expressions (search tasks) are entered IR vach S

. . . . . begins with total
and displayed in the left list. Each expression is made up of one or does not contain brick

more strings used to match or ignore files.

The Expressions are handled in the order they appear in the list. If
the first expression matches a job name and that expression rule is
to ignore items, the job is not passed to the next expression for
further consideration. Expressions can be reordered by selecting
the item and dragging up or down the list as required.

(" Add

( Duplicate )

- \ n y
Delete does not contain ]

List Options
. Add - Adds a new expression to the list.
. Duplicate — Makes a copy of the currently selected expression.
. Delete - Removes the currently selected expression.

Match

Specify what to match and the rules to apply. Enter one or more strings to match and apply different rules to each.

Match options:

. Match Items - Matches the strings entered. If no other expressions exist, the job is submitted for auto-proofing.
. Ignore Items - Ignores anything that matches the strings entered. If a job name matches, it is ignored and not

submitted for proofing or passed to other expressions for further matching.

*  Any of the Following - The match is true if any string match conditions are met. If there are two or more match
strings in the one expression and either of them match a job name, the Match Items or Ignore Items rule is

applied.
*  All of the Following - The match is only true if all string match conditions are met.

String

Enter the string to match in the text field at the bottom of the screen. This is a job name or part of a job name. The

match depends on one of the following conditions, selected with the string:

. Contains - The job name contains the entered string.

. Begins With - The job name begins with the entered string.

. Ends With - The job name ends with the entered string.

. Is - The job name matches the entered string exactly.

. Does Not Contain - The job name does not contain the entered string.

. Does Not Begin With - The job name does not begin with the entered string.
. Does Not End With - The job name does not end with the entered string.

. Is Not — The job name is not the entered string exactly.

Match String Options
*  Add - Adds the match string to the list.
d Apply - Apply changes to the selected match string in the list.
. Delete - Removes the currently selected match string from the list.
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Replace Colour Set

The Replace Colour Set is used to match and replace certain colours as they pass through the system. Match

and replace process or spot colours and choose to match by name or position. Colours can be created directly
or imported from popular desktop applications, or a Special Colour Set.

There are a few uses for the Replace Colour Set. It is used to create a digital = —
blue line, which replaces all colours with varying hues of blue allowing traps ﬁ ——
to be easily seen. It can also be used for replacing special colours where the ——

name varies, such as Pantone 101C and Pantone 101CVC. ety [T = Z

Toolbar Options —

The following options are available via the Toolbar at the top of the panel. , e -
Any option can be shown or hidden by ticking/unticking it in the contextual _ =

(right-click) menu within the Toolbar. The Configure Toolbar option in the e

menu also allows the order of the buttons/options to be set.

. New Colour - Creates a new untitled colour in the list. Click on
either the Match Plate or Original name to change it. S =

. Delete Colours - Deletes the selected colour/s.

. Duplicate Colours - Makes a copy of the selected colour/s.

. Rename Match - Rename one or more Match Plates using a popup Find and Replace tool.

. Rename Original - Rename one or more Original replacement colour names using a popup Find and Replace
tool.

. Add Colours From Library - Select one or more colours from a Special Colour Set within Blackmagic to be
added to the Replace Colour Set.

Alternatively, this window may be opened by double-clicking on an empty area of the list panel; or double-click
on a selected colour in the list to open the Add Colours window and replace it with the chosen colour.

. Import Colours From Files - Import colours from compatible third party applications, CGATS/ISO 12642 files
or previously exported colour sets. N-Colour swatches will not import unless an N-colour ICC profile with
matching process colour channels is first assigned to the Special Colour Set. If CMYK swatches are imported to
an N-Colour set, extra colour channels with 0% values will be added to match the colour space.

. Export Colours To File - Export the colour swatches to a CGATS/ISO 12642 file. If the set contains a mix of
CMYK/N-colour and Lab colours, you will be prompted to export either CMYK/N-colour or Lab colours. The file
standard limits exported colours to one colourspace.

. Export Colour Set To File - Export the entire Replace Colour Set to a file. If the set contains a mix of CMYK and
Lab colours, you will be asked whether to export CMYK or Lab.

. Preview Set - Opens a popup window listing all the Replace Colours in the set with colour properties and
replacement method.

d N-Colour Profile — Assign a multi-colour ICC profile to the Replace Colour Set.

Note: If an N-Colour multicolour ICC profile is assigned to the set, users will have the option to adjust colours in an Lab
or N-Colour colourspace, as defined by the ICC profile (e.g., Lab or CMYKOG). Colours for each Replace Colour Set can
only be defined in Lab and/or a single other colourspace. If no N-Colour profile is assigned, colours are adjusted using
either Lab or CMYK values.

All the Toolbar options can be accessed via the contextual (right-click) menu available in the colour list panel.

Replacement Method Tabs
There are five (5) tabbed panels where colours are created or imported when making a Replace Set. Each tab performs
a specific replacement function.

Tab 1 - Process
Specify any of the Process CMYK colours to be replaced. Each of the process colours listed in the panel has:

* A swatchbox showing the replacement for the process colour (left). Double-click this box to import a
replacement colour;

*  An editable naming field for the process colour; and

. A Reset button for the colour of the process plate (lower right) and a Cancel button to switch off replacement
for that process colour (upper right).

Process colour replacement is set to Off for all 4 colours by default.
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Tab 2 - Exact
When using the Exact replacement method, only incoming colours precisely matching the Match Plate name will be
replaced with the new colour. Matching is not case sensitive.

Tab 3 - Partial
When using the Partial replacement method, any incoming colours are replaced with the new colour if any part of the
name matches the Match Plate name. Matching is not case sensitive.

Tab 4 - Position
The Position method replaces any incoming Special colour in a particular plate position with the new colour.

The Exact, Partial and Position panels have a Search box at the top right used for locating colours in the replacement
list. The list itself has a series of sort columns detailing properties of each replacement colour.

Colours can be selected and dragged to another position within the list. This is useful in Position replacement where the
plate position is important. The order of the columns can be changed by dragging them to the desired location and the
headers are configurable via a context menu. The available columns are:

. Match Plate - Shows the replacement colour swatch. The Exact or Partial name in this field is the one to be
matched to the incoming colour being replaced. In the case of Position replacement, the name shows the plate
position. Click on the name to change it.

. Values - Shows the colourspace values of the replacement colour.

. Original Name - The original name of the replacement colour in the Match Plate swatch. Click on the name to
change it.

. Space - The colourspace of the replacement colour plate.

. Mode - The Paint Mode of the colour: Overprint, Knockout, Primer, Opaque or Transparent.

. Tint - The tint or intensity of the colour.

. DotGain Curve — The name of the DotGain Curve applied to the plate (if any).

. Weight (g/m?2) — The Press Ink Weight of the colour in g/m? (if assigned).

Tab 5 - Remaining
Allocate one colour to replace Special Plates that are not matched by anything else. This only replaces special colours
and not CMYK process colours. This panel has a similar interface to the Process panel.

Colour Adjustment Panel

View and adjust the colourspace values and plate properties of a selected colour. The name of the colour selected is
shown at the top. A window displays the Original colour and Modified colour as adjustments are being made. A
correctly calibrated monitor with an assigned Match ICC profile will display an accurate representation of the colour/s.

Available adjustment options are:

. Colourspace — Choose between Lab or CMYK (or multicolour if an N-Colour ICC profile has been assigned to the
Replace Colour Set). The sliders change accordingly for making adjustments to the Lab or CMYK/N-Colour
values. These can be entered directly or fine-tuned using the up/down arrows.

. Paint Mode - Choose the Paint Mode for the colour. The diagram shows the Paint Mode, Opacity and Tint of the
selected colour. Choices are:

. Overprint

. Knockout

. Primer

d Opaque (adds an opacity % slider)

. Transparent

. Tint - Adjust the intensity of the colour by adjusting the slider, entering a tint value or using the up/down
arrows.

. DotGain Curve - Choose a DotGain Curve to apply to the colour.

Note: A DotGain Curve applied to a replacement colour takes precedence over global Process or Specials DotGain
Curves assigned to a Pagesetup. The Pagesetup curves are ignored for the colour.

. Weight - Optionally assign an Ink Weight (in g/m?) to the selected colour. This weight is used in the
InkKeyViewer (SoftProof) and in Calculate Ink Weights (QueueManager).

. Spectrophotometer - Choose a supported Spectrophotometer to read colour values directly into the Special
Colour Set.
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RIP
Different RIPs store their files in different formats and in different locations. The RIP data type is used to
configure how and where Blackmagic polls for these RIPped jobs.

Driver =
This panel is where the driver used to poll and interpret the incoming file
format is selected. The driver must match the type of RIPped file to be polled.
Options available in other sections of the RIP configuration may change G e e e —
depending on the RIP input filter selected.

* RIP Driver - Select a RIP driver (input filter) from the popup chooser
window. The list of available drivers will depend upon the licenses enabled on the dongle.

Custom Settings - Depending on the driver selected, there may be specific parameters requiring setup for a valid
configuration. Use the Edit button to set up these parameters.

Polling

Polling is the method used to look for files. The configuration for polling the RIPped files is set up in this section. When
polling, Blackmagic looks in the specified location (defined under Paths) for files matching the RIP driver selected. A list
is compiled and sent back to Blackmagic for display in the RIPMonitor. It takes three (3) successful polls before a file is
shown in the RIPMonitor and the files must be stable (not changed since the last poll).

The available options are:

. Enable Polling - Turn polling on or off.

. Poll Interval - Configure how frequently to poll for files. The Poll Interval should be set according to any
specific requirements. Setting the Poll Interval too short can flood the network with polling requests (packets)
causing it to slow down. Setting it too long can take a long time to show stable files ready for submission.

. Fast Polling - This will automatically poll two (2) more times as soon as one (1) automatic poll has completed.
It will not wait for the next scheduled Poll Interval before it polls again. Files may appear incomplete in the
RIPMonitor if there has not been sufficient time between polls for a job’s complete set of plates to finish the RIP
process.

. Log Statistics - Log the polling statistics in the Server log. The log message reports “Started automatic poll on
<date>" when polling starts and “Completed automatic poll on <date>" when finished.

. Ignore Mod Time - Ignore the modification time on the file. Useful for Harlequin RIPs that update the
modification time on the file when moving the job between the Held and Active queues.

. Job Genie - Assign a selected Job Genie to the RIP. This options becomes available when using a TIFF Based RIP
(User Configurable), PDF or Postscript input filter. If used, only files defined as valid by the Job Genie will
appear for submission in the RIPMonitor (see the Job Genie section for further details).

Connection
The connection specifies the method used for polling. The options are:

. Agent - The most efficient connection method. This option connects to a Serendipity Polling Agent installed on
the system where the RIP files are located.

i Localhost - Polls a directory path on the computer where the Blackmagic Server is installed.

i FTP - Uses File Transfer Protocol (FTP) to poll and transfer the files from the RIP to Blackmagic.

. Secure FTP (SFTP) - Uses Secure File Transfer Protocol to poll and transfer the files from the RIP to
Blackmagic.

File Transfer Priority
This specifies the priority to be used for transferring files from the RIP to Blackmagic. Adjust from Lowest to Highest or
anywhere in between.

Sometimes a high priority can affect the RIP performance, especially on older RIPs. This can cause problems, such as
RIPs pausing. If this happens, reduce the priority level.

Paths
Specify the paths to the RIPped files residing on the RIP. This may be a single path or multiple paths and can be made
up of striped paths. The path structure is dependent upon the RIP driver selected. The options available are detailed
below.
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. New - Adds a new path or stripe path to the Paths field. Selecting this displays another window to type the
path or browse to locate the folder containing the jobs. Browse will only work if the connection method has
been specified and is valid.

. Delete - Deletes the selected paths.

. Delete All - Deletes all paths from the list.

Most RIP drivers use recursive polling, i.e., they will poll down the directory structure into sub directories from the top-
level directory specified in the path. The more sub directories to be searched, the longer it takes. Specify the path as
close as possible to the files for quicker results.

Stripe Paths

Some RIPs place jobs on different drives, but in the same location. They can add more drives to a RIP, giving it a new
mount point, for e.g., E:/RIPJobs, F:/RIPJobs and G:/RIPJobs. These all have a common path of RIPJobs, but are “striped”
across 3 drives, therefore specify the drives (E:, F: and G:) in the Stripe Paths and the path (/RIPJobs) in Paths.

Note: This is important for RIPs sharing plates from single jobs across multiple drives, for e.g., Cyan & Magenta on E
drive and Yellow & Black of the same job on F drive. If this is not setup as a stripe, the plates will not be stitched
together.

AutoProofing

Jobs can be submitted manually from the RIPMonitor as desired. Alternatively, configure the RIP to have jobs submitted
automatically via the AutoProof facility. This way any new job that appears, if stable and meets the specified criteria,
will be submitted for processing. The options available are listed below.

. Enable AutoProofing — Turns AutoProofing on or off.

. Printing - Specifies how the jobs are to be printed. Options are:

. Copies - Specify the number of copies to be printed. Default is 0.

. Use Pagesetup - Print to the selected Pagesetup.

. Use Pagesetup Pool - Print to the selected Pagesetup Pool.

. Choose - Select an existing Pagesetup or Pagesetup Pool. The chooser allows you to create a new one if
necessary.

Criteria
Select certain conditions that must exist before a job is automatically submitted. The options are:

. Delay (seconds) - The length of time to wait to see if a job changes prior to submitting. A job may change as
other plates are RIPped and added to the job. A suitable amount of time needs to be specified in order to
ensure a complete job is submitted.

*  Minimum Plate Count - Specify a certain number of plates that must exist before a job is submitted for
AutoProofing.

. Must Have - Select which process plates must exist in the job before AutoProofing.

. Filter - Select a filter to use for AutoProofing. See the Regular Expression section for further information on
Filters.

. Delete Jobs From RIP After AutoProofing - Delete jobs after a successful AutoProof. This is only available when
jobs are locally hosted (Localhost polling). This may be used when a temporary file is created, for example,
when adding halftone dots to unscreened data.

. Hold After Imaging - Places the job on hold in the Rendering queue after imaging has successfully completed.

d Hold After Rendering - Places the job in a held state in the Output queue after rendering has successfully
completed.

Job Filtering
This is only available when the RIP driver is set to poll imposition RIPs. Specify if AutoProofing should be carried out on
All Jobs or just Imposed Jobs.

Testing

Once the configuration is complete, it must be saved before a test can be done. If it is not saved, a prompt will appear to
“save and test”. A test poll checks RIP connection, Path validity and job presence. Messages appear in the window to
alert you to any problems or give confirmation of a valid configuration.
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Signature Group b
Import or create groups of Signatures, defining the page,

sheet and size parameters of press impositions. The imposed
files can then be submitted for de-imposition from the RIPMonitor and
separated during processing into smaller groups or individual pages to
fit the printer, or to view a publication in its intended form.

e

panels used to configure the Signatures. A display panel shows the

The interface has a toolbar with various options and a series of five (5) — I
layout of the selected signature(s) to the right. |

Toolbar Options

The following options are available via the Toolbar at the top of the -
panel. Any option can be shown or hidden by ticking/unticking it in the

contextual (right-click) menu within the Toolbar. The Configure Toolbar

option in the menu also allows the order of the buttons/options to be set.

Group - Groups two or more pages together. Pages must be the same size and alignment. The Group button is
only available when valid pages are selected.

Ungroup - Ungroup a group of pages. Only available when a group is selected.

Suppress Pages - Suppress the selected page or pages (marks it as not for print).

Auto Paginate - Automatically allocates page numbers to the signature. This will include any page currently
suppressed.

Offset Page Numbers - Offsets the selected page numbers by the desired amount. Enter the offset value to be
added to or subtracted from the page numbers.

Edit Page Numbers - Edits the page number of those selected. Tab moves to the next selected page. The page
numbers can also be edited by clicking on the page.

Pair Pages - Automatically pairs the pages along the long sides. The pages must match, the headers must be in
the same position and they must be joined (no gaps). If there is a gap, the manual pair option must be used.
After pairing use the Close Page Number Gaps option if needed. See below for further information.

Pair Pages Horizontally - Pairs pages in the horizontal direction.

Pair Pages Vertically - Pairs pages in the vertical direction.

Rotate Selected Signatures - Rotates the selected signatures by the amount chosen. The options are:

90 Degrees Clockwise

90 Degrees Counter Clockwise

180 Degrees

Rename Signatures - Selecting this displays a rename box to search for and replace names. Options are:

Find - Enter the characters to find in the list.

Replace With - Enter the text to insert in place of the characters found. Use any valid characters, including
spaces. If nothing is entered, the characters found are deleted if one of the rename options is selected.

Ignore Case — Choose whether the match is case sensitive.

Wrap Around - Continue from the top of the list when the bottom is reached.

Rename All - Rename all items that are found.

Rename Selected - Rename the selected signatures if the characters are found.

Rename Current - Rename the currently selected signature if the characters are found. If more than one
signature is selected, the first one in the list is checked for a match and renamed if true.

Find Previous - Searches backwards.

Find Next - Searches forwards.

Prefix With/Append - Two options to add characters before or after the names.

Import Signatures - Import a signature made by another application. The available types are:

DynaStrip - Files are usually named with a sheet number and a .dsf extension.

Preps - Files are Prep Templates.

Krause - Files usually end in a number, such as jobname.001.

JDF - Files usually have a .jdf extension.

Facilis - Files are usually named with a .dai extension.

Selective Import — Enable this to choose or alter any/all Signatures from the source file prior to import. The
following options are available:

Group Pages - Group the pages together as they are imported. The pages must be the same size and align for
grouping. The diagram shows a pink line around individual pages when they are not grouped or around all
pages when they are grouped. Pages must group for pairing to work.

Inclusive - This option attempts to group pages with parameters/alignments differing by very small amounts.
Rotation - Choose to rotate the signatures during import.
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. Offset Page Numbers - Offset the page numbers of those signatures imported by a number.

. Imported ]JDF files generally need to have the Offset Page Numbers set to 1, otherwise the first page will begin
at 0. This can be changed after import if necessary.

. Top Align / Left Align - Optional ways of viewing the interface, depending on the display and preferred layout.

. Close Page Number Gaps — Use this to close the page numbers after pairing. When pairing a large publication,

the lowest page number of the pair is used as the resultant paired page number. This usually produces gaps in

the page numbers. Close Page Number Gaps closes the gaps so pages are sequential.

Import Language Encoding - Select the appropriate language encoding for the signatures so the names can be

displayed correctly in the native language. This is set from the contextual menu (right click).

Signatures signatures
This panel lists all of the Signatures in the group. The Plate, Sheet, Grid and Page options for &= [
the selected Signature are shown in the configuration panels on the screen. 63
4-61
Signature Options: .:_,253

. New - Creates a new untitled signature.
. Delete - Removes the selected signatures from the list.
i Duplicate - Makes a copy of the selected signatures. Dupiicate

Signatures can be multi-selected or dragged and dropped to another position in the list (for de-imposition purposes).
When multiple Signatures are selected, all will be shown in the display panel. The Plate (if in use), Sheet and Pages
settings can be edited to make mass changes to all selected Signatures.

Display Panel
Signatures selected from the list are displayed in this panel, with all Plate, Sheet and layout properties as defined in the

configuration panels visually represented. If multiple signatures (or pages) are selected, differing parameter values will
be shown by bold, underlined field titles in the configuration panels.

The display panel is interactive and is used to:

. Select one or more individual “pages” within a signature for editing == (BT B
in the Pages panel;

. Select pages for grouping or ungrouping, pairing, or page offset;

d Show where pages of multi-selected signatures fit within a
publication in a bottom Page Navigator panel. Pages belonging to =~ =** By sseed

the signatures are shown in green; pages from non-selected S e Ea
signatures are shown in red; doubled-up pages are shown in purple. B - S e

Selecting all signatures makes it simple to check the integrity of the
Signature Group. o SCIC7)_ s s[BLn] i nLwL] %

+  Select a page from the Page Navigator to highlight which signature it~ # » © & @ & « « « o « o © &
belongs to.

When viewing multiple signatures, the thumbnail sizes can be increased or decreased with the cmd+/- keys (Mac) or
ctrl+/- (Win).

Plate
Turn the Plate options on or off by selecting the Use Plate tick box.

The Plate settings are:

o Width

. Height

*  Centre Offset - The value to offset the centre by. This is dependent upon the gripper position.
i Gripper Size

o Gripper Position

The plate width and height will alter the press Sheet size if the plate size is larger. If the plate size is smaller, the press
Sheet size is not affected. A plate size larger than the sheet size will appear with a red line outline within the signature
preview panel.
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Sheet

Enter the dimensions of the press sheet in this panel. The options are:

Grid

Width
Height
AutoFit - Changes the press sheet size so the pages fit.

This panel is where the grid of pages that make up the imposition signature is defined or edited. The options are:

X and Y Position - This sets the top left position of the selected group or page in respect to the top left of the
press sheet.

Page Size - Select the size of the single page selected from one of the pre-set page sizes or choose Custom.
Manage Custom Page Sizes - This option allows users to create and manage custom page sizes for use. Any
page sizes created here will also appear in the Media > Cut Sheet page size options in the Workbench and in
Studio.

Page Width - Enter the width of the single page selected. The pre-set page sizes automatically complete this
field.

Page Height - Enter the height of the single page selected. The pre-set page sizes automatically complete this
field.

Orientation - Select the orientation of the selected page between

Portrait or Landscape. x 5o mr Y Gomm

Columns - Enter the number of columns for the signature.

Rows - Enter the number of rows for the signature.

Gutter X and Y - Enter the size of the gutter for the signature. If a gap is
selected first, the value is applied to the selected gutter only. To apply a

value to All, Even or Odd, select it from the pull down menu first and e X100 mem o |
then enter the value. Press Enter to apply the value. o Nooe———
Delete - Deletes the selected pages or groups. Deae Dugtesie New

Duplicate - Duplicates the selected page or group. This is positioned at

top left (X=0, Y=0).

New/Place - Creates a new page or group. Selecting this changes the button to Place. Enter the page attributes
as desired and click Place to position the page or group. Press Esc to cancel.

Number - Enter the page number of the selected pages.

Top Bleed - Enter the amount of top bleed to apply to the selected pages.
Bottom Bleed - Enter the amount of bottom bleed to apply to the selected pages.
Left Bleed - Enter the amount of left bleed to apply to the selected pages.

Right Bleed - Enter the amount of right bleed to apply to the selected pages.
Page Head - Select the position for the head of the currently selected pages. The diagram shows the change.
The page head is indicated by a line and folded corner. Choose between:

Page Head Up

Page Head Down

Page Head Left

Page Head Right
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Special Colour Set

Blackmagic uses special colour sets to identify and match colour plates when jobs are polled and processed.
Special colours can be created manually, or imported from one of several popular applications. A library of
sets can be built up for use in different proofing situations.

Colours can be created in Lab and a CMYK or N-Colour colourspace, read directly into the system using an online
Spectrophotometer, or imported from a CGATS file. Each colour can have its ink Paint Mode or Press Ink Weight set and
have an individual DotGain Curve assigned to it.

The interface includes a Toolbar with general creation and import options; a panel showing the list of colours in the
Special Set; and another to adjust the properties of a selected colour.

Toolbar Options

The following options are available via the Toolbar at the top of the panel. Any option can be shown or hidden by
ticking/unticking it in the contextual (right-click) menu within the Toolbar. The Configure Toolbar option in the menu
also allows the order of the buttons/options to be set.

New Colour - Creates a new untitled colour in the list. Click on the
name to change it.

Delete Colours - Deletes the selected colours.

Duplicate Colours - Makes a copy of the selected colours.

Rename Colours - Rename one or more colours using a popup Find
and Replace tool. 2
Add Colours From Library - Select one or more colours from any

other Special Colour Set created within Blackmagic. '
Import Colours From Files — Import colours from compatible third —
party applications, CGATS/ISO 12642 files or previously exported =
colour sets. N-Colour swatches will not import unless an N-colour

ICC profile with matching process colour channels is first assigned

to the Special Colour Set. If CMYK swatches are imported to an N- s
Colour set, extra colour channels with 0% values will be added to —
match the colour space.

R 0000137333 722F I

Export Colours To File - Export the colour swatches to a CGATS/ISO 12642 file. If the set contains a mix of
CMYK/N-colour and Lab colours, you will be prompted to export either CMYK/N-colour or Lab colours. The file

standard limits exported colours to one colourspace.
Reorder swatches — Change the order of the colour swatches as they appear in the list.

Note: Swatch order can be important as a Pantone plate being matched from a number will be assigned the

first colour when matching the number in the set list.
N-Colour Profile - Assign a multicolour ICC profile to the Special Colour Set.

Note: If an N-Colour multicolour ICC profile is assigned to the set, users will have the option to adjust colours in an Lab
or N-Colour colourspace as defined by the ICC profile (e.g.,, Lab or CMYKOG). Colours for each Special Colour Set can
only be defined in Lab and/or a single other colourspace. If no N-Colour profile is assigned, colours are adjusted using
either Lab or CMYK values.

All Toolbar options can be accessed via the contextual (right-click) menu available in the colour list panel, as well as:

viet oot

Print - Prints the colour list of the Special Colour Set, with colour swatches and details for

each colour (see below).

Print and Match Colour - Make adjustments to a selected special colour using printed

swatch charts with variations of the colour.

Present Colour - Opens a resizable pop-up window displaying the selected colour along

with its set and colour names. This option is useful for visually matching softproof special Sassadyty specls
colours on screen.

Print Swatch - Print user configurable colour swatch charts of Special Colour Sets. See below section for

further information.
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Colour List Panel
This panel has a Search box at the top right for locating colours in the set list. The list has a series of sort columns,
detailing properties of each special colour.

The order of the columns can be changed by dragging them to the desired location and the headers are configurable via
a context (right click) menu. The available columns are:

. Colour - Gives a visual representation of the colour.

. Name - The colour plate name (used to match the colours). Click on the colour name to change it.
. Space - The colourspace of the plate.

. Values - Shows the colourspace values of the colour.

. Mode - The Paint Mode of the colour (Overprint, Knockout, Primer, Opaque or Transparent).

. Tint - The tint or intensity of the colour.

. DotGain Curve — The name of the DotGain Curve applied to the plate (if any).

*  Weight (g/m?) - The press Ink Weight of the colour in g/m? (if assigned).

Double-clicking on an empty area of the list panel will open an Add Colours To Library window, allowing for colours to
be added to the set. Double-clicking on a selected colour in the list will open an Add Colours From Library window to
replace it with a chosen colour.

Colour Adjustment
View and adjust the colourspace values and plate properties of a selected colour.

The name of the colour selected is shown at the top. A window displays the Original colour and the Modified colour as
adjustments are made. A correctly calibrated monitor with an assigned Match ICC profile will display an accurate
representation of the colours.

Available adjustment options are:

. ColourSpace - Choose between Lab or CMYK (or multicolour if an N-Colour ICC profile has been assigned to the
Special Colour Set). The sliders change accordingly for making any adjustments to the Lab or CMYK/N-Colour
values. These can be entered directly or fine-tuned using the up/down arrows.

. Paint Mode - Choose the Paint mode for the colour. The choices are:

. Overprint

. Knockout

. Primer

. Opaque (Adds an Opacity % slider)

. Transparent

. Tint - Adjust the intensity of the colour by adjusting the slider, entering a tint value, or using the up/down
arrows.

. DotGain Curve - Choose a DotGain Curve to apply to the colour.

i Note: A DotGain Curve applied to a special colour has precedence over global Process or Special DotGain
Curves assigned to a Pagesetup. The Pagesetup curves are ignored for the colour.

d Weight - Optionally assign an Ink Weight (in g/m?) to the selected colour. This weight is used in the
InkKeyViewer (SoftProof) and in Calculate Ink Weights (QueueManager).

. Spectrophotometer - Choose a supported Spectrophotometer or file format to read or import measured values
directly into the Special Colour Set. TS pr———————T e

Print and Match Colour
. Print and Match Colour is a tool used for visually matching special
colours used in proofing to original print material, accessed via a - o i s G
button in the Special Colour Set toolbar.
. The window has two (2) main panels - an upper Match Chart panel cone
and a lower Colour List panel.
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Match Chart Panel

. The upper panel displays three (3) swatch charts comprised of variations of the colour selected in the Special
Colour Set. The selected (target) colour is the centre colour of the middle chart (chart 2).

. Any of the 27 patches can be selected to save as a new special colour, to save over and replace the originally
selected colour, or set as the target (centre) colour for printing a new swatch chart set.

*  Variation - Controls the level of variance the swatch chart colours have from the original colour. Variation
value steps in 0.5 increments from 0.5 to 10. The units represent L*, a* and b* variations from the Lab value of
the original colour. Use the slider, up/down arrows, or type in the text field to change the current variation.

. Set Target - Sets the currently selected colour patch as the Target (centre of chart 2). Swatch chart colours will
change to variant colours of the new Target colour.

. Print Match Chart - Prints the three (3) swatch charts displayed in the Match Chart panel for visual matching
with original print/press material.

. Note: The 3 swatch charts are printed as individual jobs and can be nested to save paper (see Output -
Nesting). Charts should be oriented with the bars and text to the top for patch selection. Charts may not be
nested in order so take note of the (1, 2, or 3) bars when selecting a patch in the interface.

Colour List Panel
The lower panel has two (2) tabs - Variations and Colour.

Variations Tab
This tab list includes a Colour Patch and Lab values for the original (Target) colour and the 26 variant colour patches.

A colour selected in the Variations list will be highlighted by a box in the Match Chart panel. A colour selected in the
Match Chart panel will be highlighted in the Variations list.

Colour Tab

This tab fills the panel with the currently selected colour variant. This option is useful for visually matching softproof
special colours on screen.

. Save - Saves the currently selected Target colour (centre of Chart 2) over the original special colour, replacing
it.

. Cancel - Cancels the Print and Match process without saving, closing the window.

. Save As - Saves the currently selected Target colour (centre of Chart 2) to the set as a new special colour. Enter
a name for the colour and click OK. Default name is that of the original colour followed by an asterisk (*).

Print Swatch

Print user configurable colour swatch charts of Special Colour Sets. All swatches are processed as individual spot plates
as they would be when included with a normal job allowing users to see how a spot colour will print to a particular
Media.

Colour Swatches print at a size and spacing determined by the user, the name of the colour (and optional Lab or device
values) are printed below each patch. The following fields are available to configure the swatch chart:

d Patch Width - Enter the printed width for the colour patch.

. Patch Height - Enter the printed height for the colour patch.

d Include Colour Values - Enable to print colour Lab or device values below each colour patch. A larger vertical
spacing value may be required to accommodate the additional text.

. Horizontal Spacing - Enter the horizontal spacing to apply between each patch.

d Vertical Spacing - Enter the vertical spacing to apply between each patch.

d Margin - Enter a value for the margin to be left around the printed swatch charts.

. Patches Per Row - Enter the number of patches to be printed on each row of the chart.

. Patches Per Page - Enter the total number of patches to be printed per chart “page”. A multiple of the patches
per row is recommended. Each page is submitted as a separate job and is able to be nested. Multi-page charts
are grouped into publications in the QueueManager.

. Cancel - Cancel the print swatch operation saving any settings entered.

d OK - Send the swatch chart to the Submit Pagesetup/Media popup window for printing based on the settings
entered.

Note: As all colour patches are processed as individual spot plates, for large charts users can speed up imaging and
rendering times by submitting charts as multiple pages (jobs) rather than a single, large job.
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Screen Printing

The Screen Printing functionality within the Media data type is designed for printing film separations on an Inkjet
printer.

Files submitted for processing are separated into individual plates. Each plate is printed as a black separation with a
halftone dot applied at the colours respective screen angle.

Printing to film generally requires the output density to be higher than that for normal proofing. Higher densities are
achieved by increasing the print resolution, or by assigning one or more inks to be laid over the black dots.

Configuration

The configuration is very similar to a standard setup to print to a device. The Output configuration is the same and the
appropriate Media and Jobticket are created to control the page parameters. A very basic Paper Profile and
Linearisation are also created to complete the setup.

Output Configuration
The Output for the printer is set up normally.

An Output Driver is assigned; Destination Driver selected; and Collating options are enabled (if required). Once the
Output is created, the Media configured for screenprinting (see below) should be assigned so only screen print
separations will print to the film.

Media Configuration

. Output Driver - Select the driver as set up in the Output created for the screen printing configuration.

. Resolution - Choose an appropriate resolution.

. A higher density can be achieved with a higher resolution, however, it is slower to process and print. A lower
density may produce sufficient density, depending on the printer and media used.

. Colourspace - Select CMYK

. If using the Black Ink Combination only, choose Gray as the Colourspace, as this may result in slightly faster
processing. However, in this mode inks cannot be mixed to produce a denser output. Selecting CMYK and
configuring a Paper Profile will allow the choice to use Black only of a mix of colours at a later stage, without
having to recreate a Paper Profile.

. Custom Settings - Select the appropriate media, choose Uni-directional or Bi-directional and turn the Use Light
Inks option off.

. Bi-directional is faster but may produce slight banding or may not be as dense as printing Uni-directionally.
Using Light Inks will affect the patches in the Paper Profile. In Screen Printing mode, only one patch can be on
per colour.

. Screen Printing - Enable Screen Print Mode and select Black for the Ink Combination (and any others
required).

. Once this option is selected, jobs submitted to this Media will always be separated and printed using the
selected colours. One or more inks must be selected from the available choices. If Gray is selected as the
Colourspace, only Black will be shown as a choice.

. Output Screening - Select Halftone and tick the SuperCell option. Choose the preferred dot shape and enter the
screen angles and rulings.

. SuperCell gives a better-shaped dot and the round dot tends to be more commonly used. The default angles of
15, 45, 75 and 90 are shown by clicking the Defaults button, however, these can sometimes produce
undesirable effects, mostly caused by the Yellow plate. To counteract this, offset all angles by 7.5 degrees to
make them the following:

. Cyan - 22.5 degrees

. Magenta - 82.5 degrees

. Yellow - 97.5 degrees

d Black - 52.5 degrees

d Special - 52.5 degrees
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Paper Profile Configuration
In Screen Printing mode only one patch can be turned on per colour. Therefore, the value for the patch does not matter
- which one chosen does.

four (4) patches for each colour. The first patch represents the media and the other L: 100.0q |1£72.00, ,L{’;:z}&
three the dot sizes (small, medium and large). A dot size for each colour must be 1 N S/ 7
y ,
L: 85.00

chosen. If the Colourspace is Gray, Black will be the only available ink.

For a variable dot printer, when the Use Light Inks option is turned off, there will be ! g 3\//
L: 16.00

/

|L: 100.04 170.00.| |1£'55.00,
7] 7]
The image here shows an example using the patch 4 of Black and patch 2 of each Cyan, ! 2 NS /
. > X
Magenta and Yellow. There is no need to measure the value for the patches, the default L 100.00 [T |65 33 [1<4800.
values are sufficient. Comparative densities are not relevant when only using one dot 1 2 \3\ Y4 \4\//
(patch). /\ .

L:100.00 L:96.34 1<92.68 L 89.02

In testing it was found that a combination of large Black (patch 4) and small Magenta

(patch 2) produced good results. If too much is used, for example - large Black, large Cyan and large Magenta - the
result is wet output and the dots tend to “fill in” the shadow area. Large dots of a colour like Cyan will produce film
looking blue instead of black. Black should always be the dominant colour.

Ink Limiting
There is no need to enter any Ink Limiting as the plates are separated, so there is no mixing of 2, 3 and 4 inks.

Linearisation
As Screen Printing mode prints only Black separations, the creation of a simple Linearisation (Gradation) Curve to be
applied to the Media is all that is required.

The Linearisation Curve can be created in one of two ways:
Method 1. Using the Lineariser application and a supported Spectrophotometer:

. Open the Lineariser application.

. Select the Media used for screen printing and print a chart for the Spectrophotometer to read. Only the Black
channel patches will be printed and measured.

. Measure the values using a connected instrument and save the chart.

. The linearisation curve will be automatically assigned to the selected Media. Check this by viewing the Media in
the Workbench to make sure the curve is assigned to the configuration. See Applications > Lineariser for more
information.

Method 2. Manually Creating a Linearisation Curve:

. Select the Gradation Curve data type in the Workbench.

. Create a new Gradation Curve, selecting the screen printing Media to be used.

. Edit the Gradation Curve by selecting the Black curve. Click on the curve and drag it to the desired shape,
adding more curve points if required.

d Save the Gradation Curve.

. Select the screen printing Media in the Workbench and assign the Gradation Curve using the Linearisation LUT
button in the Colour Correction panel.

Summary

The above is a guide to configure a setup to print film separations for use in the Screen Printing industry. Run some test
jobs to choose the most suitable patches, ink combination and resolution for the device and media being used. If a
different resolution or colourspace is selected or the light inks are used, a new Paper Profile will need to be created.
Trying different dot sizes will mean adjustment of the Paper Profile - changing which patch is turned on in each
channel.

During the testing period many combinations of ink (colours), dot sizes and resolution were tried. Different output
devices and media will produce varying results, so a combination of patches and ink mixing may work better. The
higher resolution (1440dpi) produced the most dense output at around 4.18D, but takes longer to RIP and print. By
running at a lower resolution (720dpi), the jobs processed quicker but the density drops to just under 3 at around 2.8D.
This is often acceptable for many applications, but will vary depending on the media and device used. Testing will prove
the most suitable setup. The most commonly used settings were CMYK colourspace, with an ink combination of Black
and Magenta. This used the large Black (dot 4) and the small Magenta (dot 2) in the Paper Profile and gave a slight
reddish tinge to the Black, which is desirable in the Screen Printing industry.
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Modules

Modules are informational windows used for managing jobs as they pass through the system and to monitor Server and
Client activity. Modules are arranged and utilised in a pre-configured format in the Jobs application; are able to be
added and configured to a tabbed window as part of a Monitor layout via the Layout menu; or started up individually as
standalone windows from the Module menu.

There are twelve (12) modules to choose from:

BookMonitor - Similar to the RIPMonitor, this module displays a list of Books compiled via the Bookfilter. This
module is only available in Veripress and the Blackmagic Softproofing Add-on.

ClientLog - Displays a log of Client messages that may be generated during normal Client operations.
ClusterStatus — Monitors the progress of Imaging and Rendering tasks on the Server and any active Cluster
Nodes.

DropZone - A place to drag and drop files for processing.

MediaStatus - A window showing the current calibration status of a Media data type and a progress bar
showing the amount of media (e.g. Paper) used.

QueueManager - View and manage jobs after they have been submitted for processing.

QueueStatus - A progress meter showing the current status of active jobs on the selected queue.

RIPMonitor - Displays the files polled using RIPs configured under the RIP data type within the Workbench.
ServerLog - Displays any system, error and polling messages from the Server.

Status - Shows the disk status (usage) of the Server processing areas.

Thumbnail - Displays a thumbnail of jobs as they image or render.

VirtualPress - Available within the RIPMonitor module. Allows for the assignment, alteration and management
of plates to polled RIP jobs.
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BookMonitor

The BookMonitor module (available for Veripress/Blackmagic Softproofing Add-on) displays the publications polled
from planning files using the BookFilter data type. The publications can be expanded to show a list of pages and
filenames associated with each page.

The module allows for quick viewing of large multi-section or multi-edition publications, such as newspapers. When
View Original, Rendered or FlipBook are selected for a publication in the BookMonitor, it searches the chosen queues in
the QueueManager for filenames matching those in the page list and assembles them on-the-fly for proofing in the
SoftProof or FlipBook applications. The Page Navigator in both applications (SoftProof & FlipBook) will show any pages
missing from the publication (those that have not yet arrived from the RIP).

Toolbar Options 1 S R
The following options are available via the Toolbar at the top of the panel. " :
Any option can be shown or hidden by ticking/unticking it in the B

contextual (right-click) menu within the Toolbar. The Configure Toolbar —

option in the menu also allows the order of the buttons/options to be set.

. Expand/Collapse Books - Expand or Collapse the selected Books
(publications) to list individual pages. Double-clicking a
publication in the display panel will also expand/collapse the
page list.

d Poll - Poll the selected BookFilter for any planning files. Once
polled, a list of the available planning file publications will be
displayed.

. Toggle Bookfilter Polling - Enable / Disable

. Show BookFilter Menu - Enable / Disable a dropdown menu.

. Show Bookfilter List - Enable / Disable

. View Original - Opens the Imaged Preview of the selected publication in SoftProof.

e View Printed - Opens the Rendered Preview of the selected publication in SoftProof.

d View FlipBook - Opens the selected publication in FlipBook.

d Queue Order - Select this to choose the Output queue in the QueueManager the Bookfilter will search for
matching Imaged or Rendered job pages.

d Calculate Ink Weight - Open the Ink Weights calculator window for the selected publication.

Note: Books (publications) can be opened in one of two ways. Selecting the Book title, then View Original/View
Rendered will open the Book at the first available page. Expanding a Book, selecting a specific page, then View
Original/View Rendered will open the Book at the chosen page.

View Options
The following sort columns can be selected using the contextual (right click) menu on the sort column header bar in the
Display panel:

. Name - the name of the Publication / Page sourced from the planning file.

. Section - lists the section to which a page belongs as defined by the planning file or by a Bookfilter Job Genie.
. Page - The page number of the page file as defined in the planning file.

. Date - the Date/Timestamp of the planning file.

. Date of Issue - the publication date of the publication/page as defined in the planning file.

. Files - the directory path and name of the source planning file for the Book.

. Edition - lists the edition to which a page belongs as defined by the planning file or by a Bookfilter Job Genie.

The order of the columns can be changed by clicking and dragging them to the desired position, or by using the
Configure Headers option under the contextual (right click) menu. The columns can be manually resized by dragging
the header divider bar to the desired width, or resized to fit content by double-clicking the divider bar.

The contextual menu also has options to Edit BookFilter, change the Colour Scheme of the BookMonitor window, pick
Font Options and choose the Language Encoding of the incoming poll data.
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ClientLog

The ClientLog displays any messages that pop up during normal Client === — —

operation. There are different levels of message, from informative to
serious errors. All messages are held for a user-determined length of

time.

Fetch back log - Displays the log for the time specified. For
example, it retrieves and displays the last 4 hours of messages.
Choose the time from the pull down list.

Trim older lines - Trims the log based on the time selected in
Fetch back log. If this is set to 60 minutes, the log file is trimmed
back so only the last 60 minutes remain.

Export - Allows you to export the log to a file.

Note: When you export the log file you can choose to export everything in view or select entries to export. Use the
filtering options and Fetch back log choice to limit the view before exporting. Selecting export displays a chooser,
allowing you to enter a name and select the location to save the file. You can choose to save the file as html or as a tab
delimited text file.

Filtering Options
You can choose which messages to display in the log and which to hide by ticking checkboxes for one or more of the
following filters. All messages are saved to the log, even if filtered.

Question - Used for messages that ask questions, for e.g., “Job contains unassigned colours. Do you want to add
them to VirtualPress.”

Information - Used for messages that tell you something, for e.g., “Job has a duplicate plate.”

Warning - Used where the message has a higher importance and (usually) the Client failed to do something,
but operation can continue, for e.g., “Failed to save new password. Old password will continue to be used.”
Critical - Used for serious errors that will most likely affect operation, for e.g., “Failed to load rendering .dll.”
You will normally be required to take action to rectify these errors before continuing.

Search - You can search the log for jobs or messages. Enter the text of characters you want to search for and
the ClientLog only displays the lines that match the search.

Display Options
The following sort columns can be selected using the contextual (right click) menu on the sort column header bar in the

log:

Type - The level of the message reported. For e.g., Question; Information; Warning or Critical.

Date - The time the message was reported.

Source - The module or application that reported the message.

Summary - A summary of the message that was reported.

Command - Internal command used to communicate messages to and from the Server by the Client.

Error - An error code reported by the Server. This is useful for de-bugging problems.

Action - The action taken by the user relating to the message. For e.g., the button pressed when the message

popped up.

The order of the columns can be changed by clicking and dragging them to the desired position, or by using the
Configure Headers option under the contextual (right click) menu. The columns can be manually resized by dragging
the header divider bar to the desired width, or resized to fit content by double-clicking the divider bar.
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ClusterStatus
The ClusterStatus is a monitor allowing you to see the current Imaging and Rendering status of jobs on any active
Master Servers or Cluster Nodes:

eNeo e swdevel ipity-software.com.au:9100 - De...

Clustering - Open the Clustering application to manage the
Cluster. TR e AR
Refresh - Update the status. — = =
Increase Inset (+) - Increases the gap between the list items.

Decrease Inset (-) - Decreases the gap between the list

items.

Font Options - Allows you to change the size of the text.

DropZone

A DropZone is a place where you can drag and drop files for processing. The user selects Pagesetups with Media and
Jobticket information, Pagesetup Pools or the Studio application Asset queue to add to the DropZone as a DropSpot.
These DropSpots accept the same file formats as the DropFolder (Postscript, PDF, JPEG, TIFF Image, Serendipity
Blackmagic Image, EPS, PNG, PSD).

The available contextual menu options are:

AN Droplone - odevel. @ity-software, 9.

Add DropSpot - Select one or more Pagesetups/Media to add to the
DropZone. Selecting this displays a chooser window, showing all available

Pagesetups/Media. s . 4
Add Asset DropSpot - Adds a DropSpot for the Asset queue. Assets are = e
then manually laid out, nested and printed using the Studio application o
(See Applications - Studio for more information). Aose

Reorder DropSpots - Displays a reorder window. Select one or more
DropSpots in the list and drag them to a new location, or use the up and
down arrow keys to move the position. Click OK when finished.

Increase DropSpot Inset (+) - Increases the size of the DropSpot.

Decrease DropSpot Inset (-) - Decreases the size of the DropSpot.

Font Options - Allows you to change the size of the text.

Additional contextual menu options are available for individual DropSpots:

Remove DropSpot - Remove the selected DropSpot.

Edit Pagesetup - Edit a section of the selected Pagesetup, all sections or create a new one.
Edit Media - Edit a section of the selected Media, all sections or create a new one.

Edit Jobticket - Edit a section of the selected Jobticket, all sections, or create a new one.
Change DropSpot - Allows you to change an existing DropSpot.

Set Copies - Set the number of copies for every job dropped on the DropSpot.

Note: This feature can also be accessed by double-clicking on the DropSpot.

Set Colour - Select a colour from the list for the currently selected DropSpot.
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MediaStatus
The MediaStatus module has two (2) functions:

To show the current calibration status of a selected Media data type. For the calibration status to be shown or
updated for a Media, it must have been Calchecked using the Calcheck Media menu option (see below) or the
Check Media option in the Calcheck application.

To show how much of the media (e.g. Paper) has been used. A meter is displayed graphically, detailing the
percentage used. For the Usage meter to function, values for the
Media Length or the number of sheets loaded must be entered
in the Output section of the Media data type. % Sotont1aStoin reof: 728! <opy

Used 9.47 m of 0.00 mm ( 0%) Reset Counter

ANO MediaStatus - @localhost:9100 - Demo (time limited) 57 days left

Each Media displayed in the MediaStatus window has the following

Logged Period: 9/12/09 3.33 PM - 12/05/10 4:46 PM

information: Printed: 22 Jobs (7.99 m?)
BRI ae | an | ac PAs
* Medla Name Epson11880-FograProof-720dpi copy 10/12/09 11:00 AM
. Calcheck Status - Toggled via the Calcheck Info option (see A
below). Displayed as one or more Ticks/Crosses to the right of Magenta 8¢034 /
the Media name, showing a Calcheck Pass or Fail against the s S Tk
user-defined AE, AH, or AC. Hover the mouse over each to Gray 86093 Maximum prevn
show a tooltip displaying the AMax and AAvg values. Poper o et
. Usage Meter - Bar showing the amount of media used. Text ISOcoated v2_eciF39 Score: 86.44

under the bar states the exact amount used as a percentage of

the total units.

Reset Counter - Resets the usage count for the Media.

Logged Period - Time period (date and time, from and to) the Media has been tracked since the last reset. This
information is shown/hidden using the Show Extended Info option.

Printed - Number of jobs and total printed area of jobs tracked since the last reset.

Calcheck Info - Displays the complete Calcheck summary information for the selected Media resulting from the
last Calcheck. Includes the Calcheck Chart used, internal Calcheck score, Date/Time of Calcheck and Avalues.

A contextual (right click) menu has the following options:

Change Media - Change the selected Media for display in the status window.

Edit Media - Edit all or part of the selected Media. Copy it, or create a new one.

Calcheck Media - Opens the Calcheck application. Once a chart has been printed and measured, the results are
saved to the Media and the Calcheck Info for the Media is updated in the MediaStatus window.

Media Order - Allows you to configure which queues are viewed by the MediaStatus window. Move Media
between the Available and Showing columns in the popup chooser.

Show Extended Info - Show/Hide the Logged Period and Printed information for the selected Media.

Show Calcheck Info - Show/Hide the full Calcheck Info summary for the selected Media.

Metric Units - Toggle between Metric or Imperial units for measurements shown in the MediaStatus window.
This is enabled by default.

Increase /Decrease Status Width - Increase or Decrease the width or all Media panels in the window.

Font Options - Allows you to change the size of the text in the window.
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QueueManager
The QueueManager displays information about submitted jobs and the jobs’ current status. Queues can be viewed
simultaneously, showing job progress through Imaging (where the incoming file is interpreted and its resolution
sampled for conversion to the print resolution); Rendering -
(where colour management, cropping, rotation and effects are 2) - i et G
applied for printing); and Printing. e S

(R

The QueueManager also allows jobs to be manipulated in a
number of ways, such as holding, promoting, deleting and
reprinting.

AU}I ED

View Options
There is a lot of information available for viewing about each
job as it passes through the system.

The following sort columns can be selected using the contextual (right click) menu on the column header bar in the
QueueManager display panel:

. Name - Job name. . Copies - When multiple copies of a job are sent

. Process Time - Time taken to run the last for printing, this column counts down the
process on the job. number of jobs left to print.

. Status - The jobs current status. . Screening - The screening applied to the job.

. Source - The source of the submitted job. . Thumbnail - Shows a thumbnail of the job.

. Date - The date and time the job was d Job ID - The internal Blackmagic ID number
processed. for the job.

. Jobticket - The Jobticket used to process the . Node - The Server or Cluster Node the job was
job. processed on.

. Media - The Media used to process the job. . Signature Group - The signature group used to

. Pagesetup - The Pagesetup used to process the de-impose the job.
job. . Signature - The signature within the group

. Queue - The output queue the job was sent to used to de-impose the job.
for processing. . Page - The page number of the job.

. Size - The size of the job (disk space used). . Publication - The publication name.

. Width - The width of the job . Notes - The number of notes saved with the

. Height - The height of the job. job.

. DPI - The imaged resolution of the job. . Section - The section of the publication.

. Output Colourspace - The colourspace of the . Comment - Indicates by displaying a speech
output file. bubble whether a job has an attached

comment.

. Edition - The edition of the publication.

The columns can be manually resized by dragging the header divider bar to the desired width, or resized to fit content
by double-clicking the divider bar.

Toolbar Options

The following options are available via the Toolbar at the top of the panel. Any option can be shown or hidden by
ticking/unticking it in the contextual (right-click) menu within the Toolbar. The Configure Toolbar option in the menu
also allows the order of the buttons/options to be set.

. Queue Order - Allows you to configure which queues are viewed by the QueueManager - Available & Showing.

. Render Queue Thumbnails - Enable or disable thumbnails for the Render Queue in the Thumbnails view of the
QueueManager.

. Show Idle Queues - Show/Hide entries in the QueueManager for idle processing queues.

. Group by Queue - Enable/Disable the grouping of jobs by Queue before other column sorting is applied.

. Queue Icons - Display the pre-Output queue to which the job currently belongs. These include Autodetect,
Spooling, Imaging, Rendering, Wait and Asset.
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There are a number of actions that can be performed on a job. Options become available when one or more jobs are
selected. Only actions valid for the job status are shown. For example, the action to Nest Now is only available if the job
has a status of Waiting to Nest.

The following are available in the Toolbar or by selecting job(s) and right clicking to access the context menu:

Job Info - Shows information about the currently selected job (or jobs). The Job Info contains all details of how
the job was processed and displays a thumbnail preview of the job and its configuration. A dropdown toolbar
at the top of the Job Info window has the following options: Print Portrait, Print Landscape, Print to PDF
Portrait, Print to PDF Landscape. Prev/Next buttons at the bottom of the Job Info window are used to display
the info for the previous or next job in the QueueManager.

Note: Job Info & thumbnail can also be displayed by double clicking on the job. If multiple jobs are selected, double
clicking will display info about all in the window. Holding the control key (Win) or command key (Mac) will allow the
font size to be adjusted via the mouse wheel for easier viewing.

Job Ownership - Opens a popup window displaying General and Ownership information for the selected job.
The General panel displays created and modified timestamps for the job. The Ownership panel displays its
User and Group permissions.

Note: The User and Group will be listed as “admin” for normal installations. If Secure Mode is active (see Server
Settings and Accounts Admin), a user with sufficient privileges can make changes to the job permissions with
respect to other users. When in Secure Mode, the admin user login is able to change the user or group to which
a job belongs. If multiple jobs are selected, the admin user can make a mass change to the permissions of all
jobs.

Modify - Allows various attributes of the job to be modified. These include:

Name - Change the name of the job.

Publication Name - Change or add a publication name.

Page Number - Change the page number of the job.

Copies - Change the number of copies of a job.

Change Media - Change or assign a Media associated with the job.

De-Imposition - Change or assign a Signature and Signature Group to a job.

Render with new Jobticket - Resubmit a job with status “Done” to be rendered again using a different Jobticket
configuration.

Comment - Opens a popup window allowing the user to enter comments about the job. When the Comments
sort column has been selected in the View options, a speech bubble in the column indicates the job has a
comment. Opening the Job Info will display the comment directly below the thumbnails.

Reprint - Displays a window to reprint a job or jobs.

Cancel - Cancels the currently processing jobs.

Delete - Deletes the currently selected jobs.

Hold - Holds the currently selected job. Only available when the status is “Waiting”.

Release - Releases a currently selected Held job.

Retry - Retries a failed job.

View Errors - Views the errors of the selected job if the status is listed as Failed.

Rush Jobs - Moves the currently selected jobs to the top of the current queue for processing next. The status
must be listed as Waiting. Jobs currently being processed will be completed first.

Note: Rush Jobs will move the job up the current queue only. If the job is in the imaging queue and Rush Jobs is
selected, the job moves to the top of the imaging queue. Once complete, it will move to the bottom of the rendering
queue. You will need to Rush Jobs again to move it to the top of the rendering queue.

View Original - Views the Original/Imaged file for selected jobs in the SoftProof application.

View Printed - Views the Printed/Rendered file for selected jobs in the SoftProof application.

Render Again - Submits the selected jobs to the rendering queue for processing. Only available when the status
is “Done”.

Move to Pagesetup - Moves the selected jobs to another Pagesetup. This will send the jobs to the rendering
queue again with the attributes of the selected Pagesetup. View the Pagesetup, edit it, or create a new one prior
to submitting the job.

Copy to Pagesetup - Copies the selected jobs to another Pagesetup. This will send the jobs to the rendering
queue again with the attributes of the selected Pagesetup. View the Pagesetup, edit it, or create a new one prior
to submitting the job.
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. Move to Queue - Move a job with a “Done” or “Waiting to Print” status to another output queue with the same
print driver.

. Nest Jobs - Submits the selected jobs to be nested. This sends the job to the rendering queue to re-render for a
nest. The Collating section of the Output is used for the nesting parameters.

. Nest Now - This is available when the selected job has a status of Waiting to Nest. Only one job needs to be
selected and all jobs with a Waiting to Nest status will be nested.

. Duplex Now - Duplexes any job that has a status of Waiting to Duplex. Only one job needs to be selected and all
jobs with a Waiting to Duplex status will be duplexed.

. View FlipBook - Opens the selected job or publication in FlipBook. If the selected job is part of a publication, all
pages will be shown.

. Select Publication - Selects all the pages/jobs in the QueueManager belonging to the same Publication as the
selected job.

. Refresh All Queues - Updates the queues.

. Export - Allows you to export data from the selected job. The available formats are:

. CIP3 - Exports job information to a file in CIP3 format at the selected resolution. You can also select the
orientation before exporting. Further options are:

i Version 2.1

i Version 3.0

. Rotations

. Surface - Choose front or back.

i Compress Preview - Choose if the preview should be compressed. Some presses are unable to handle files in
compressed format.

i PDF - Exports the selected job in PDF at the resolution entered. Further options are:

. Compressions - JPEG, ZIP or LZW. For JPEG and ZIP you also have control on the level and quality of
compression.

i Photoshop - Exports the selected job as an Photoshop (.psd) file at the resolution entered with an option of
Packbits or no compression.

d Postscript (separated) - Exports the current job as a separated PS file.

. Tiff Multichannel - Exports the current file as a multichannel Tiff.

d Calcheck Job - Launches the Calcheck application to check a job’s calibration status. The jobname is stored and
the results can be exported or printed. Measurement results from the Calcheck are stored in the Job Info. The
Job information shown in the Queue will change —
colour to match with the result of the Calcheck
once completed (green pass, red fail) .

. Calculate Ink Weight - Displays the Ink Weights window with the selected job’s ink weights and coverage
shown.

. Pause/Resume Printing/Processing - Pause or Resume the output queue of the selected job at their current
stage of processing or printing (Imaging, Rendering, Nesting or Printing). Incomplete jobs in paused queues
will display in red.

. Change Output Media - Change the Media assigned to the output queue for the selected job. Once re-assigned,
all jobs held awaiting the new Media will begin processing.

Configuration Options
The following options are available from the right click (contextual) menu within the QueueManager window:

. Queue Colour - Select a colour for the currently selected Queue for easy identification.

. Queue Order - Allows you to organise the queues into your preferred order, or adjust any settings.

. Joblist View - View the queue in Joblist mode. This is the same as selecting Show > Jobs.

. Publication View - View any publications in the queue. This is the same as selecting Show > Publications.

. PrintGallery View - View the jobs as thumbnails. This is the same as selecting Show > Thumbnails.

. Edit Output - Allows you to edit the Output and not the job. For changes to be effective, resubmit the job for
printing or rendering, depending on the attribute changed.

. Edit Media - Allows you to edit the Media the job was processed with. For changes to be effective, resubmit the
job for imaging or rendering, depending on the attribute changed.

. Edit Pagesetup - Allows you to edit the Pagesetup the job was processed with. For changes to be effective,
resubmit the job for imaging or rendering, depending on the attribute changed.

. Edit Jobticket - Allows you to edit the Jobticket the job was processed with. For changes to be effective,
resubmit the job for imaging or rendering, depending on the attribute changed.

e Edit RIP - Allows you to edit the RIP of the source file (where the job was submitted from if a configured RIP).
For changes to be effective, resubmit the job or refresh polling.
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. Edit Signature Group - Allows you to edit the Signature Group used for de-imposing of the currently selected
job. For changes to be effective, resubmit the job for de-imposition.

. Auto Queue Order - When this option is enabled, the QueueManager displays jobs for all existing process and
output queues. Any new queues created will be shown automatically.

Important Note: When editing any of the items from here, you are editing the queue for all future jobs, not just the
currently selected job.

The bottom of the screen contains the following options:

. Show - Show certain jobs in the QueueManager. Select any or all of the options to filter jobs. Choose from:

. Jobs - Display all jobs as text line entries.

. Thumbnails - Display all jobs as thumbnails. This is the same as the Print Gallery mode.

. Publications - Displays any publictions to which jobs belong. When viewing in this mode the bottom of the
QueueManager list panel displays a Page Index (See SoftProof > Page Index Panel for more information).

For any of the above display modes, further filtering is available:

*  Active - Jobs currently processing.
*  Waiting - Jobs with a status of Waiting.
. Done - Completed jobs.

Search - Find jobs that are in the queue. All jobs matching the search text will be displayed. All elements of the jobs are
searched against, not just the name, so this can be a useful filtering tool. The search can be inverted with cmd+shift+I
(Mac) or ctrl+shift+I (Win). The search box will turn black to indicate when the inverse search is selected.

QueueStatus
The QueueStatus module is a progress meter that shows the current status of active jobs on the selected queue. The
Printer Status Monitor option is also available within the QueueStatus module for specific printers.

The look and feel can be adjusted for the QueueStatus module and the queue it is monitoring. The options are available
by right clicking on the window.

Note: Not all options listed are available on all QueueStatus windows. Some are only available while the job is in
progress.

. Cancel Job - Cancels the currently active job and is only available when a job is active.

. Job Info - Displays info about the currently active job.

. Pause Printing/Processing - Pauses the queue so no further jobs will process. Any job currently active in the
queue will finish. The text in the window changes to red, showing the paused state.

. Resume Printing/Processing — Takes a queue out of a paused state. Any waiting jobs T
will now be processed. Canon Printes maitor st e

. Note: The Pause/Resume function can be toggled using the tick box to the left of the
progress bar. This function also affects the Output for the queue, changing the status to
Active/Inactive. Inactive Output’s are displayed in red in the Workbench > Output >

| Status: Idle

1 Mar 6 13116:41 2015 |«

window listing compatible Media. Options for each Media are displayed for view, can
be edited, or a new Media can be created. Only jobs sent via the selected Media will
print. Other jobs will be held in the QueueManager with a status of “Waiting for Correct
Media” until their Media is selected. If No Media is assigned - the “None” option - all
jobs sent to Output are printed.
. Change Queue - Allows you to choose which queue the status window will show. e 1
. Edit Output - Allows you to edit the output or create a new one. You can only edit if ot
the queue is showing an output. If the queue is set to Spooling, Auto Detect, Imaging or
Rendering you can only make a new output.
. Thumbnail - Turns on/off a mini thumbnail on the printer queues only, which gives an
indication as to how much of the current job has printed.

[tems list.
. Change Output Media - Change the Media assigned to the Output using a chooser |
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. Show Printer Status Monitor - Displays the printer status, ink levels, warning and error messages for the
selected queue. Printer status is checked and the QueueStatus is updated:

. Every 60 seconds - Printer Idle.

. Every 15 seconds - Printer Busy (Printing).

. Every 5 minutes until connection restored - Printer disconnected from network or turned off.

. Note: This feature is only available to compatible printer drivers and when the “Monitor Printer Status” option
in the Output is enabled.

. Font Options - Allows you to change the size of the text.

. Queue Order - Select which queues you wish to view. Selecting this presents you with a chooser window
showing two lists - The Available queues on the left and the Showing queues on the right. To move queues
between lists, select one or more and drag from one list to another. Alternatively, double click to move between
lists. The order of the queues in the Showing list determines the order of display. Queue Order can be used to
show multiple Queues in a single QueueStatus window.

. Increase/Decrease Indent - Increases or decreases the size of the QueueStatus in view.

Double clicking the QueueStatus window displays a floating QueueManager window showing that queue. This has the
full functionality of the standard QueueManager.

RIPMonitor

The RIPMonitor displays the RIPs that have been configured under the RIP section of the Workbench. Jobs that have
been successfully polled are displayed and can be expanded to show any associated plates. These jobs can then be
submitted to a Pagesetup/Media for processing.

View ‘«:.l., == = —— ) (i) o 0 (50 W e g M e

. Toolbar - Contains job handling functions and
viewing options.

. Jobs — This is the large window to the right and
displays all successfully polled jobs from the
selected RIP.

. RIP List - A list of all the configured RIPs,
allowing the user to select each in turn to
display any jobs. This is on the left side of the
window and can be shown or hidden as
desired. Active RIP queues are displayed in black; inactive are red.

. RIP Menu - This is a pull down list at the top of the window of RIPs configured and shows the current selection.
Hiding the RIP Menu will also hide the Polling On/Off drop down selector.

Note: If you only have one RIP configured it is better to hide the left RIP list and top RIP menu as there is nothing else to
display. This will provide more room to view your jobs.

Toolbar

The following options are available via the Toolbar at the top of the panel. Any option can be shown or hidden by
ticking/unticking it in the contextual (right-click) menu within the Toolbar. The Configure Toolbar option in the menu
also allows the order of the buttons/options to be set.

Queues  Frintualiery |CKIF LOGS

1 Expand Jobs ) ( Collapse Jobs ) ( Submit... ) (" Submit For Deimposition... ) ( Submit As Imposition... Submit As Asset... VPress... ) MCroup By Job ( Poll MToggle RIP Polling ™ Show RIP Menu

¥ Show RIP List

. Expand/Collapse Jobs - Show/Hide the plates associated with the selected jobs. Double clicking a job will also
expand or collapse the plate view for the selected job.

. Submit - Submits the selected jobs for processing. This pops up a chooser to select which Pagesetup/Pagesetup
Pool and Medias to send the job to.

. Submit As Asset - Select files to send to the Studio application Asset queue.

. Submit for De-Imposition - Submits the jobs for de-imposition. This pops up a choose to select which Signature
Group will be used to de-impose the job and which Pagesetup/Media combination will be used.
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. Submit As Imposition (Veripress/Blackmagic Softproofing Add-on Only) - Submits the job in it’s original form,
but attaches a Signature Group via a popup chooser to allow the job to be deimposed on-the-fly using the De-
Imposed Pages button in the Veripress SoftProof Touch Console (See the “Touch Console” section for more
information).

. VPress - Adds the selected jobs to the VirtualPress. For further information see the “VirtualPress” section.

Note: The text in the Submit, Submit for De-Imposition, Submit as Imposition and VPress buttons will show in italics if
the job selected has unrecognised or unassigned plates. The plates will need to be assigned using VirtualPress.

. Group By Job - Keeps the plates in their respective job group when they are copied into the VirtualPress (see
below note).

Important Note: If you have multiple jobs selected for copying into VirtualPress, when this option is ticked they are
kept as their respective jobs. If this is un-ticked, all the jobs and plates selected are copied in as one job. This is useful if
you are polling a RIP and the plates are shown as separate jobs, with one plate each.

. Poll - Initiates a manual poll of the selected RIP.
. Toggle RIP Polling - Turns the polling on or off for the selected RIP. When the RIP is in the off state, the name in
the RIP list turns red.

Note: The RIP jobs list is cached and may require clearing. To do this, turn the RIP off and on again and click on the Poll
button three (3) times consecutively.

. Show RIP Menu - Shows or hides the RIP pull down list at the top of the window.
. Show RIP List - Shows or hides the RIP list on the left.

Contextual Menu Options
The following are available via the contextual menu (right click) from within the job Display panel:

. Edit RIP - This enables the user to edit the RIP selected. Choose to edit a single section or all sections of the
configuration. Alternatively, you can create a new RIP.

. Colour Scheme - Choose a colour for the module.

. Font Options - Choose the preferred font size.

. Language Encoding - Choose the language encoding for the operating system. This allows jobs to display
correctly in the RIPMonitor in the native language.

Display Panel View Options
The display panel columns can be configured to show specific information by right-clicking on the header titlebar. The
following are available for display:

. Name - Job Name (and plate names if expanded).

. Size - The size of the job (disk space used).

. Date - The data and time the newest plate belonging to the job was RIPped.

. Path - The directory path to the RIPped file for an assigned job plate. This information is visible when the
polled job is expanded.

. Publication - The publication to which the job file belongs as defined by the Job Genie.

. Section - The section to which the job file belongs as defined by the Job Genie.

. Page - The page number of the job as defined by the Job Genie.

. Edition - The edition to which the job file belongs as defined by the Job Genie.
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ServerLog
The ServerLog shows messages from the Server.

Fetch back log - Displays the log for the time specified, e.g., it retrieves and displays the last 4 hours of
messages. Choose the time period from the dropdown list.

Trim older lines - Trims the log based on the time selected in Fetch back log. If this is set to 60 minutes, the log
file is trimmed back so only the last 60 minutes remain.

Export - Allows you to export the log to a file. Selecting

this displays a window with further options as detailed

below:

Destination File - Choose the filename and location

where the file is to be saved. Use the Browse button to

navigate to your preferred location.

Message Lines - Choose to save all messages in the log

window or only those that are highlighted. This way you can save just a few lines if desired.

Format - Choose the format to save the file in, either html or plain text. The plain text file is saved with tab
characters between the columns.

Cancel - Revert to the Server window without saving any changes.

Save - Save the file based on the settings selected.

Configure Filter - You can filter messages in the log. Choose between the following options:

Completed Jobs - Shows messages about completed jobs.

Polled Jobs - Shows messages about polled jobs.

Errors - Shows errors from the Server.

Search - You can search the log for messages. Enter the text of characters you want to search for and the
ServerLog will only display the lines matching the search.

Display Options

Status

Module - The Server function that generated the message.
Routine - The operation within the Server function.

Date - The time the Server called the module.

Message — The message resulting from the routine.

Status shows the current disk status (usage) of the Server processing areas, such as spooling, temporary directories and
DropFolders. Editing the ss.conf file in the installation directory under the “etc” folder can change disk locations.

The available options are:

Spool &

Update - Checks the disks and updates the view. Print I

Preferences - Sets the Status window preferences. A further option e
available is:

OSTemp &

Update Interval - Sets the time between updates.
Colour Scheme - Changes the colour of the Status window. Dropfolders &
Font options - Allows you to change the size of the text.
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Thumbnail

This module displays a thumbnail of jobs as they are imaging and rendering. Thumbnail progress is updated at the
same time as the Imaging or Rendering QueueStatus is updated.

The following options are available from the contextual menu (right click):

Show Imaging - Show the Imaging thumbnail, denoted by “gears” in each inset.

Show Rendering - Show the Rendering thumbnail, denoted by a “paintbrush” in each inset.
Normal Thumbnail - Displays the default size thumbnail.

Large Thumbnail - Displays a large thumbnail.

Small Thumbnail - Displays a small thumbnail.

Each active Thumbnail module may only show either Imaging or Rendering, not both. The module window displays as
many Thumbnail insets as there are simultaneous Imaging/Rendering tasks configured in the Server Settings.

VirtualPress

VirtualPress gives users the ability to manage the plates of the job. You can drop plates, change plate colours and merge
plates from other jobs. If a job contains an un-allocated plate (i.e., no colour), use VirtualPress to allocate a colour,
unless a Replace Colour Set is selected containing the plate.

The History keeps jobs that have been imported into R

VirtualPress. Any changes or additions are kept so the St R e
jobs can be resubmitted at any time without having to

recreate the changes. The history is held while the

Client is running. Once the Client has quit, any history o
is purged. A 'Submit' button to the bottom left of the ===
Virtual Press allows multiple VPress History items to e =
be selected and printed simultaneously. ‘ - ‘

o1

Mold after imaging Mol ahter rendering

Quick Submit shows a pull down list of the configured Pagesetups. Clicking this button submits the selected
job to the Pagesetup shown. The option to Hold After Imaging or Rendering is also available.

Edit Plate Colour displays a colour editor, allowing you to change the colour attributes for this plate only. The
edit is not stored anywhere and does not affect the Special Colour Set. This option is also available when right
clicking on a plate.

Choose allows you to select a colour from the colour libraries. This is only available for special plates. You can
also double click the plate in the list to choose a colour from the libraries.

Reorder Plates allows you to change the order of the process plates. Plate position is used for Overprint,
Knockout, Opacity and Transparency simulation. The order of the list dictates the order the plates are merged
and can affect the job where plates have attributes such as Opacity. The button will appear in italics when the
order has been changed from the original.
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Applications
The applications available within Serendipity Blackmagic add functionality to the Client and provide additional tools for
managing the Server and your jobs.

There are fifteen (15) Applications available, including the Workbench and Monitor. All are accessible via the
Applications menu in the Client. Some, such as Calcheck, can be launched via other Applications or Modules.

The available Applications are listed here with further details on each following:

. Archives - Make partial or complete backups of your Workbench configurations.

d Calcheck - Verify the calibration status of a printer.

. Clustering - Allocate and manage Imaging and Rendering tasks across multiple computers and networks.

. Densitometer — Measure and display density readings taken with a Densitometer or Spectrophotometer.

. Displays — Create ICC profiles for system monitors for accurate onscreen colour softproofing.

. FlipBook - Display a publication as a 2D or 3D virtual book.

. Jobs - Display jobs before, after and during processing and allows users to manage jobs through the system to
plot their progress with a pre-configured user-interface.

. Lineariser - Create a Linearisation curve for use with a Jobticket or Media.

. Monitor - Display and manage jobs as they pass through Blackmagic (see the “Monitor” section for more
information).

d Press Agent - Interface with press console controls to load/reload softproofs.

. SoftProof - Proof jobs onscreen.

. Spectro - Display, compare and/or save colours measured using a Spectrophotometer.

. Studio - Designed for the manual nesting or tiling of jobs.

. Touch Console - Use a touch screen to load, manage and proof jobs within the SoftProof application.

*  Workbench - The principal configuration tool for Blackmagic (see the “Workbench” section for more
information).
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Archives
The Archives application allows you to make backups or archives of your Workbench configurations. Individual items
or complete systems can be archived for safekeeping. Stored items can be loaded for adding to the Blackmagic

database. This can be used for copying a database to another Server, or =
for recovery from failure or corrupt configurations. You can configure

the Archives app to automatically backup your settings on a regular
basis.

Important Note: Archives cannot be back-ported to previous versions,
i.e., version 6 archives cannot be used with version 5. Version 5
archives can be used with Version 6 however, and will be
automatically allocated to their respective databases when loaded.

File Menu Options

Open Archive - Open a previously saved archive. A chooser
window allows you to browse and select an archive (.sdb) file.
An archive can also be opened:

By dragging the .sdb file into an open Archives application.
Double-clicking an .sdb file.

Right-clicking on an .sdb file and selecting Open with > Serendipity Client; or the Preview (Serendipity Client)
option.

Save Archive - Saves the archive to a compressed (.sdb) file.

Close Archive - Closes the currently opened Archive.

Perform Full Backup - Adds all Workbench data types to a new Archives window. Once done, you are
prompted to choose a name and location to save the file. Once saved, the Archives window is dismissed.
Automatic Backup Preferences - Allows you to configure the frequency, time and location that a system backup
is performed. The options are:

What Day - Choose a day of the week, every day, every number of days or never.

What Time - Choose the time the backup is performed.

Location - Choose the location the archive should be saved to.

A check is performed when the Client is first started and every hour afterwards to see if a backup should be performed.
The Client must be running for a backup to take place. The table gives you a guide as to when a backup would occur in
different scenarios.

Auto Backup Time Client Started Client Quit Time Backup Performed
Monday 2am Monday 9am No When Client is started - 9am
Tuesday 12:10pm Tuesday 9:30am No Tuesday 12:30pm
Everyday S
Tuesday 8:20am No When Client is started - 12:20am each day
12am Midnight
Wednesday 11pm Thursday 8:30am No The following Wed at 11:30pm
Sunday 10pm Monday 8am Friday 5pm Never

Edit Menu (and Context Menu) Options

Add to Archive (All) - Select everything or all of a particular data type, for e.g., All Pagesetups.

Add to Archive (Selection) - Allows you to select individual items from the database to add to the Archive.
Selecting the type, for e.g.,, Gradation Curves, displays a chooser with all the Gradation Curves allowing you to
choose one or more to add to the Archive.

Add to Database - Choose to add items from the Archive to the database. You can add the whole Archive or
selected items.

Remove from Archive - Remove the selected items from the Archive.

Collapse - Collapses the selected items if they are expanded.

Expand - Expands selected items if the item contains references (denoted by a ‘+’). For example, a Pagesetup
will contain at least a Media and an output. Expanding the Pagesetup will display the other items connected
with it.

Open/Save/Close Archive - Open, save or Close the Archive as mentioned previously.
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Calcheck

The Calcheck application is used to verify the calibration status of a printer, .-
ensuring proofs are printed accurately.

Calcheck Charts are generated by either manually defining or importing Lab
or CMYK values. Each chart represents print/press standards against which
the printer and media are to be checked (see the Workbench > Calcheck Chart
section for more information).

The selected Calcheck Chart is printed from the Calcheck application to the
Pagesetup and Media being used to proof jobs. Alternatively, the chart can be

‘ TR
1
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assigned to a Jobticket to print with each proofing job. The chart is then
measured, using a supported Spectrophotometer.

After measuring the chart, the results are displayed in the Calcheck window.

A pass (green tick) or fail (red cross) is determined by whether the measured

patches fall inside the tolerances defined in the Calcheck Chart. The results

can be printed as a label or a complete report to a system printer. If a Media

or job was loaded into Calcheck before measuring, the results will be saved to v
the Media Calcheck Info, or stored in the job’s Job Info (see below).

The Calcheck application is made up of a Summary Panel, Measurements

Panel,

optional Info and Calcheck History panels, and a

Device/Spectrophotometer dropdown menu.

Summary Panel

This panel is viewed by selecting the (left) cross/tick button at the top right of the Calcheck window. It displays
Summary information about the completed Calcheck. This information is also available for view within the MediaStatus
module, the Calcheck Info section of a Media, or the Job Info window of jobs that have been calchecked. The following
information is displayed:

The panel title bar shows the Calcheck Chart used for the check.

AAll/Ae/AH/AC - These buttons switch between summaries of the respective A standards. The buttons
available depend on which A standards are defined in the chart for the Calcheck. The Ae summary values listed
are CIE76 by default. This can be changed to CIE94, CIE2000, CMC(1:1) or CMC(2:1) by setting the
measurement standard in the Calcheck Chart.

Job/Media - The Job or Media being calchecked. The field displays N/A if a Calcheck is done without assigning
a Job or Media to it.

Date - The date and time the Calcheck was completed.

ACyan/AMagenta/AYellow/ABlack/AGray/APaper - The A values for the significant CMYK process, gray and
paper (substrate) patches are displayed here.

Pass/Fail - Displays a green tick (pass) if all the measured patches fall within the A tolerances as defined in the
Calcheck Chart. A red cross (fail) is displayed if any patches measure outside the defined tolerances.

A Average - The average delta of the patches measured in the Calcheck.

A Maximum - The maximum delta measured for any patch in the Calcheck.

Ao - The standard deviation of the patches (from the A Average).

Score - The relative quality of the printed Calcheck as compared to the reference values. Rated from 1-100.

Measurements Panel
The Measurements panel contains the detailed reference and measurement data for each colour patch in the Calcheck
Chart used for the check. Colour patches that pass are shown in black, those that fail are shown in red.

The following sort columns are available, depending on the Astandards defined in the Calcheck Chart:

Name - The name of the colour patch.

Colour (ref) - A colour swatch of the reference colour in the Calcheck Chart.

Colour (meas) - A colour swatch of the measured colour.

Lab (ref) - The reference Lab values of the colour patch in the Calcheck Chart.

Lab (meas) - The measured Lab values of the colour patch.

Ae max - The maximum Ae (CIE76, CIE94, CIE2000, CMC(1:1), CMC(2:1)) tolerance value for the patch as
defined in the Calcheck Chart.

Ae - The measured Ae (CIE76) of the colour patch.

CIE94 - The measured Ae (CIE94) of the colour patch.
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CIE2000 - The measured Ae (CIE2000) of the colour patch.

CMC(1:1) - The measured Ae (CMC(1:1)) of the colour patch.

CMC(2:1) - The measured Ae (CMC(2:1)) of the colour patch.

AH max - The maximum AH tolerance value for the patch as defined in the Calcheck Chart.
AH - The measured AH of the colour patch.

AC max - The maximum AC tolerance value for the patch as defined in the Calcheck Chart.
AC - The measured AC of the colour patch.

Device/Spectrophotometer Panel
This panel allows you to choose which measuring instrument is to be used.

History Panel

Spectrophotometer - Select the Spectrophotometer to be used for measurement from a list of supported
instruments.

Configure - Choose the measurement condition (M0, M1 or M2) to apply when measuring the Calcheck Chart.
The default is MO. This option is only available to instruments supporting this function.

Measure - Initialises the chosen instrument and opens a popup window to select which Calcheck Chart is to be
measured. Measurement begins after the chart is selected. The data from a chart measured by a third party
software package can be loaded for a Calcheck be selecting CGATS/1S012642 file from the instrument list. The
file must have been saved in an appropriate format.

Print Chart - Opens a chooser window to select the Calcheck Chart for printing, and the Pagesetup, Media and
Jobticket combination to submit the chart to. The chart will be printed in a configuration suitable for reading
by the chosen instrument.

When Calcheck History is enabled in Server Settings, the History panel can be
accessed via the hourglass button in the top right of the Calcheck application
window. This panel displays all Job and Media Calcheck results stored in the
historical database. Calcheck measurements that passed verification are
displayed in green, those that failed are shown in red. Calcheck histories can be
exported as .csv files for use in reporting.

Options

Back - Returns the application to the Summary, Measurement, or Info

panel (the last panel viewed).

Refresh - Refreshes the History panel, updating the listed items to reflect recently added items or a changed
date range.

Job/Media - Drop down toggle. Switches the History panel between Job and Media History views.

Time Period - Drop down menu. Choose the time period - Today, 1 week, 1 month, or Date Range - of Calcheck
results to display in the History panel. If Date Range is selected “from” and “to” date fields will become
available.

Search - Enter text to search for specific history items from those currently displayed.

The following sort columns can be selected using the contextual (right-click) menu on the column header bar in the
History item list:

Job View Only

Job ID - An internally assigned ID number of the job.
Job Done Date - Date and time the job was printed.
Pagesetup, Media, Jobticket and Output - Database items used to print the job.

Media View Only

Media - The Media for which the calcheck was performed.
Output Driver - The output driver used to print the calcheck chart.

Job and Media View

ID - Calcheck record number.

Calcheck Date - Date and time the calcheck was performed.

Chart - The calcheck chart against which the Job/Media was measured.
Score - Calcheck score (from 0-100).
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. Pass - the pass or fail status of the Job/Media.

. Ae Type - the Ae formula used in the Calcheck chart (Delta E, CIE94, CIE2000, CMC(1:1), CMC(2:1))

. Ae Cyan / Ae Magenta / Ae Yellow / Ae Black / Ae Gray / Ae Paper / Ae Average / Ae Max / Ae o (std deviation)

. AH Cyan / AH Magenta / AH Yellow / AH Black / AH Gray / AH Paper / AH Average / AH Max / AH o (std
deviation)

. AC Cyan / AC Magenta / AC Yellow / AC Black / AC Gray / AC Paper / AC Average / AC Max / AC o (std
deviation)

The bottom of the History panel has the following options:

. - (Delete item) — Deletes the currently selected item(s). A warning message will appear to confirm as deletion
from the database is permanent.

. Load - Loads the details of the history item, switching the view to the last selected panel (Summary,
Measurements or Info). Double-clicking on a job will also load details.

. Export All / Export Selection - Export all or selected history items from those currently displayed to a .csv file.
A Choose Columns window will pop-up to select which of the available columns to export, followed by a file
window to name and save the file.

Backing up Calcheck History

Important Note: The calcheck history database is backed-up as part of the Backup Server operation (Server window >
Help menu > Backup Server). It is not included in (.sdb) backups performed using the Archives application.

Info Panel R
When Calcheck History is enabled in Server Settings, an Info panel can be
accessed via a button at the top right of the Calcheck window.

When Job details are loaded from Calcheck History, this panel displays the
complete Job Info (see QueueManager) for the job. If the job still exists in the
QueueManager, imaged and rendered thumbnails are also shown.

If Media details are loaded, relevant details of the Media database item are
displayed. ——

Menu Options
The following options are available from the Calcheck menu or the contextual menu (right click) from within the
Calcheck application:

. Load Media - Select a Media to load into Calcheck. Any Media that have been calchecked previously will display
complete results of their last Calcheck. A new chart can be printed and/or new measurements taken and the
results updated to the Media.

. Check Media - Select a Media to be measured. This option assumes a Calcheck Chart for the Media has been
printed. It immediately opens a window to select the chart for measuring and initiates measurement on the
selected Spectrophotometer. On completion, results are saved to the Media and previously calchecked Media
will be updated.

. Load Job - Select from a list of previously calchecked Jobs sitting in
the QueueManager. Once loaded, complete results of the job’s last
Calcheck are displayed. A new chart can be printed and/or new
measurements taken and the results updated to the Job Info.

. Check Job - Select any job currently in the QueueManager to be
measured. This option assumes a Calcheck Chart for the job has been
printed. It immediately opens a window to select the chart for
measuring and initiates measurement on the selected
Spectrophotometer. On completion, results are saved to the Job Info
and previously calchecked jobs will be updated.

. Print Label - Print a summary label of the currently displayed
Calcheck results to a system printer.

. Print Report - Print a Calcheck report on the job / media, or choose to save as a PDF.

1S0conted v2_eciF39

Tottware

v

Epson7000-Semig ... 70-720x1440-lab 20008 517 AM
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Page Setup - Allows the user to configure the label printing properties for the Print Label option above.

Show Graph - Displays a representational graph of the Ae for each patch of the currently loaded Calcheck
result. Checkboxes toggle pass/fail views. Results can be displayed in one of three formats, selected via
dropdown menu:

Show Error Bars - Shows two (2) coloured spheres, joined by a bar for each patch positioned in a 3D Lab
colourspace. The dull sphere represents the reference value for the patch; the shiny sphere is positioned based
on its Lab values in the colourspace. The relative distance between spheres shows the Ae between them.

Error Plane - Shows a line of coloured spheres representing each patch, lined up in order. The larger the
sphere, the higher the Ae.

Error Spheres - Shows a coloured sphere for each patch position in a 3D Lab colourspace. The larger the
sphere, the higher the Ae.

Show History - When Calcheck History is enabled this toggles to the History panel of the Calcheck window
application.

Contextual Menu Options

Export - Export the colour patch data from the display panel to a text file.
Import - Import colour patch data into the Calcheck application from an exported text file.
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Clustering
Clustering is the ability to share the workload of processing jobs across multiple devices. Slaves or cluster nodes can be
installed on other machines on the network and jobs can be sent to them from the Master for processing.

The Clustering application allows you to add and manage these cluster nodes. They can be enabled for use in imaging,

rendering or both.

As a node device starts up, its speed is calculated. When a job is
submitted for processing, the Master machine has priority as no
network traffic is required. If the Master is busy processing

= e T

another job, the job can be sent to the fastest available node. The
node processes the job and once completed, sends it back to the

Master. It is then ready to accept another job. Nodes can be

installed on any machine on the network.

Running a Cluster Node requires a separate Blackmagic dongle. If you have extra Blackmagic dongles, any Server can
act as a node if it is started as a Cluster Node (see “The Blackmagic Server” section for more information).

Note: In this mode, the Server can only be used as a Node (slave) for another Server. It is recommended that the
database be backed-up and job queues cleared before a Blackmagic Server is started as a Cluster Node. This avoids any
conflicts with existing job IDs or settings.

Master Panel
This panel displays information about the Master Server machine.

Product - The Serendipity Blackmagic software in use.

Version - The Server software version.

Hostname - The network name of the Master Server.

[P Address — The network IP address of the Server.

Speed - The relative speed of the Server, calculated by Blackmagic.

Processors - The number of CPUs in the Server machine.

Platform - The operating system/kernel version of the software.

Process Imaging/Rendering/Schedule Last - Check whether the Master Server is to perform any Imaging or
Rendering Jobs. The Schedule Last option allows nodes to have priority over the Master when jobs are
processing. This is advantageous when polling large RIPs, as it allows the Master to concentrate on gathering
the list of jobs and displaying them.

Cluster Nodes
This list shows nodes that are available and running on the network. Information about each node is displayed in the
window. Online nodes are displayed in green; offline nodes in red.

The following sort columns can be selected using the contextual (right click) menu on the column header bar in the
Cluster Node panel. Columns can be reordered by dragging and dropping them into the desired order, or by using the
Configure Headers option in the contextual menu.

The sort options are:

[P address - The network IP address of the Node. Checkboxes become available to enable the node and select if
it is to be used for Imaging and/or Rendering tasks. Once enabled, the Master handles the clustering in the
most efficient manner possible.

Hostname - The network name of the Node.

Speed - The relative speed of the Node calculated by Blackmagic.

Platform - The operating system/kernel version of the Node machine.

CPUs - The number of CPUs in the Server machine.

Product - The Serendipity Blackmagic software being used for the Node.

Version - The Server software version of the Node.

Processing Pool - Optionally choose a Pagesetup Pool (see the Workbench - Pagesetup Pool section) for which
the Node will perform image and render tasks.

Image - Shows the number of simultaneous Imaging tasks that can be performed by the Node. Click on the field
to change the number.
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Render - Shows the number of simultaneous Rendering tasks that can be performed by the Node. Click on the
field to change the number (see the Server Settings for details on Imaging and Rendering task settings).

Refresh - The Refresh button polls the network for active Nodes and registers any Nodes in the list that are offline.

Cluster Node activity can be monitored in the ClusterStatus module (see the Modules - ClusterStatus section for more
information).

Menu Options
The following options are available from a contextual (right click) menu within the Cluster Node panel:

Add Node - Add a Cluster Node that cannot be seen. Sometimes Nodes on subnets cannot be detected. Selecting
this allows you to enter the hostname or IP address of the Node and add it to the list manually. The Node to be
added must be running.

Add Processing Pool - Select, change or remove the current Pagesetup Pool for which the Node performs
Image and Render tasks.

Remove All Offline Slaves (Nodes) - Remove a Node from the list that has gone offline.

Remove Node - Available for offline Nodes only. This option removes the selected Node from the list.
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Densitometer

The Densitometer application allows you to measure and display density readings with a supported
Spectrophotometer. When measuring a patch, the densities of all four process CMYK colours making up the patch are
read.

The Last Measured panel in the top half of the application window shows the density and dot percentage values for the
dominant process colour of the measured patch, with the values of the other three colours to the right. The values can
be recorded and saved to a file if desired.

Note: The Densitometer application is a utility allowing you to use a Densitometer or Spectrophotometer that does not
have a display to read values. This can be as a one-off reading to compare densities, or you may want to read values and
export them for plotting on a graph. There is no requirement to use this for the normal operation of Serendipity
Blackmagic.

Densitometer/Measurement/Paper Options
*  Yule Nielsen Number - Enter the YN number for the paper you are reading (if known). The default is 2.0.
. Densitometer - Choose one of the supported instruments from the available list.
. Instrument Default Density Standard - Select your desired density standard from the available list.
. Activate/Deactivate - Connect or disconnect the chosen device.
. Add - Add the measured values to the list. This appears after the Densitometer has successfully connected.

To begin measuring:

. Select a Densitometer from the dropdown list and click the Activate button.
. The status field is shown when the device connects without error.
. Follow any instructions when prompted - Calibrate, Measure Cyan Solid, etc.

Measure Targets

In order to read percentage tint values of any plate, you must first read the paper white and the solid density value for
that colour. The Measure Targets menu or contextual (right click) menu allows you to measure the solid reference
densities for the process colours and the paper white. With these values stored, colour percentages can be calculated
and displayed. You can measure or update an individual Solid density or Measure All Targets.

Colour List
This is a list of readings taken if the Add is enabled. Each reading is appended to the list and the values measured are
displayed. The columns can be resized or reordered as required by dragging the header to the preferred position.

The columns are:

. Name - The name of the colour read. Defaults to “Untitled” but can be changed by selecting the name and
entering a new one.

J Colour - Shows the dominant colour read, i.e., the one with the highest density value. This may not be the
colour you perceive it to be, but the contents making up the colour are recorded and the colour is calculated
and shown.

. Density - The density value for the colour. This is the highest density read from C, M, Y and K. It shows the
density of the colour stated in the Colour column.

. Cd/Md/Yd/Kd - The C, M, Y and K densities of the colour read.

i Dot% - The dot percentage of the colour shown in the Colour column.

i C%/M%/Y%/K% - The C, M, Y and K percentage values for the colour measured. If any of the % columns are
blank, the reference paper white or solid density for that colour has not been measured.

Export
You can export the values from the Colour List to a file. The available options are:

¢  All-Saves all entries in the list.
i Selected - Save the selected entries in the list only.

Selecting either of these options displays a window allowing you to choose the values to be saved. The choices are:

i Name - Save the name of the colour.
. Colour Density - The highest density reading regardless of colour.
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Cyan/Magenta/Yellow/Black Density - The density reading of the chosen colour. For e.g,, if Cyan is selected,
the Cyan density for each reading is taken. This is the value displayed in the Cd column of the list.

. Colour Percentage - The percentage reading of the highest density read as o0 0o .
displayed in the Dot% column. Export Values
. Cyan/Magenta/Yellow/Black Percentage - The percentage reading of the ] Name
chosen colour. For e.g., if Cyan is selected, the percentage of Cyan for each [J Colour Density. [ Colour Percentage
reading is taken. This is the value displayed in the C% column of the list. [1iCyan Density BN -liCyan Percentage
"1 Magenta Density | Magenta Percentage
The percentage values must be present for the values to be exported. If they are not, LlellowBessiy - lvellow bereeniage
the exported file will show a 1% value in place of the reading. O faseimetty, Lhifiack feiventas
Order Values: CMYK [
*  Order Values - Choose whether to export the file in CMYK or KCMY order. N v ™
. Separate Values With - Choose to separate the values with either a tab () @D

character or a space.
Cancel - Cancels the Export action.
Export - Displays a file chooser allowing you to enter a name and select a location to save the file to.
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Displays

The Displays application uses a supported Spectrophotometer to calibrate and create an ICC profile for a selected
monitor or light booth. Suitable graphics monitors can be calibrated to match a chosen print gamut, allowing colour
accurate softproofing of print material and can be verified at any time to ensure correct colour output.

Creation of a profile is very simple, requiring a supported instrument and a few minutes of time. The
Spectrophotometer is placed on the screen to be calibrated. A series of adjustments are made to the screen gamma,
white point and brightness (if available). Measurements are taken, from which an ICC profile is created and saved in
Blackmagic and the operating system as the native display ICC profile.

Note: The Displays application creates a profile for use with the Match ICC profile assigned to the monitor in Server
Settings. Ensure the correct match profile is set before creating the monitor profile (see the Server Settings - Colour
section for details).

The Displays interface comprises of a function list (left) and a multi-purpose display area (right) that will change
depending on the function selected.

The function list is made up of the following selectable items:

Calibration

bl . Calibration - Lists each connected display available for calibration.

Calcheck . Calcheck - Lists each connected display available to calcheck.

. History - Lists the calcheck history (reference only) of each connected display.

. Ambient - Measure the ambient and white point of the light source.

. Light Booth - Appears only when a light booth is connected and will list each connected
device.

Calibration
The Calibration function displays currently connected monitors and their calibration status.

By clicking on the Calibration header, each connected monitor shows the following details:

. The name of the Display, viewable screen dimensions in mm x mm, and its B
identification number (in a multi-display environment). m@ iMac (520 mm x 320 mm)
¢ Pixels (width/height). Pixels 1920 x 1200
. Resolution 93.78 x 95.25 DPI
¢ RESOIUtl.Ol’l (DPI) ICC Profile iMac-070911.icc
d ICC profile. Status OK
° CalCheCk Status Last Calibrated 7/09/11 1:09 PM
. ’ . Calibration Expires Never
o Last Calibrated (time). tahan callbraten d

d Calibration Expires (time period).
. Hardware Calibration (supported or not for the particular display).

By clicking on the Display name, calibration options and settings available for the monitor are shown. These include:

. Brightness - Only available if hardware calibration is supported and selected for the monitor (see below).
Choose to set the brightness level in either:

. Candela - Brightness in cd/m?2 vigpnen

*  Setthelevel from 0-100% < B

. Calibration Tolerance - Enter a value in this field or use the slider to set >
the tolerance (in cd/m2) for monitor or light booth brightness
calibration.

. Measure - Click to use a connected Spectrophotometer to measure and display the brightness (cd/m? and
white point (K) of the monitor. Follow any onscreen instructions for the selected instrument. The reading is
constantly updated, allowing the user to manually adjust the brightness using the monitor’s own controls. This
option is only available if the Use Software Calibration option is selected or is the only mode available (see
below).

. White Point - Select the white point temperature for the monitor. Choose from:

. Custom - Type in the field provided or use the slider to enter a custom temperature in Kelvin (K).

<d/m? Calibration Tolerance 10.00 . cd/m!

%

o) 0o
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D50 - Sets the white point to D50 (5003 K/Horizon Light).

D65 - Sets the white point to D65 (6504 K/Noon Light).

Native - Sets the Displays application to use the monitors native white point.

Gamma - Select the gamma correction to be used for the monitor.

Custom - Type in the field provided or use the slider to enter a custom gamma value between 1.0 and 2.6. The
Custom button will auto-select if a non-standard gamma setting is chosen. Note: If either 1.8 or 2.2 are chosen,
the 1.8 or 2.2 buttons will auto-select.

1.8 - Select this to set the gamma correction value to 1.8. This button will auto-select if 1.8 is chosen via the
Custom field/slider option.

2.2 - Select this to set the gamma correction value to 2.2. This button will auto-select if 2.2 is chosen via the
Custom field/slider option.

Options

Use Hardware Calibration - When supported, this option uses the monitor’s own internal hardware for
calibration, allowing the screen brightness to be adjusted automatically.

Use Self Calibration - Available on some high-end graphics monitors. Uses the monitor’s own internal
hardware and calibration routines for calibration.

Use Software Calibration - Calibration is performed using the Displays application software.

Instrument (offline/online) / Instrument Name - Displays the currently activated instrument.

Instrument - Select from the list of supported rsremen o)
Spectrophotometers to use for display calibration. i St e
Display Type - Select the type of display being calibrated - o>

from LCD, CRT or RAW.

Monitor Identification Number - Click to popup an identification number in the centre of the screen for the
display to be calibrated.

Calibrate - Click this button to start calibrating the selected display to the chosen settings and create the
display ICC profile. Follow any onscreen instructions for your instrument. When calibration is complete, a file
chooser will popup to name and save the ICC profile. The profile will be saved as the operating system native
ICC profile for the display and will appear as the Native Profile in Serendipity Client Preferences > Colour
Management (see System Settings for more information).

Save Profile - Opens a file chooser (as above) to save or rename the ICC profile.

Information Panel - Appears while the ICC profile is being generated, showing the progress and final results of
the calibration process.

Calcheck
The Calcheck function displays Calcheck status summaries for all attached monitors, as compared to the values defined
in the Calcheck Chart assigned to the SoftProof Default Press and

Camera setting. o ..
Ao [ S
Clicking on the Calcheck header allows users to quickly view whethera |[/&: S s
display is currently calibrated for softproofing a particular press — —
profile. See Applications > SoftProof; Workbench > Press for details. . -
o — =
Note: If a Calcheck summary is blank, this means: E
=
o No Calcheck data exists for the monitor; o E—
. That the current Calcheck for the monitor was measured |} o /
against a different Calcheck Chart than the one assigned to the |
SoftProof Default Press; or s o
. No Calcheck Chart has been assigned to the default Press. R
SoftProof | M Default Press B -
Press M Auto SoftProof Press Marutes Camepter (offaoe)
Calcheck Chart ~ ISOcoated_v2_eciF39 -..-.::: :4:’ : ..l :

The top section of the display area shows:

SoftProof - The currently selected Default Press or Default Camera configuration.
Calcheck Chart - The Calcheck Chart assigned to the above configuration.
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The remainder of the display area shows the current Calcheck status of each connected monitor. Information includes:

. Process Colour/Gray/Paper delta values

*  Average/maximum/standard deviation delta values
. Display name (top left)

. Timestamp of the last Calcheck (top right)

. Chart and Instrument used (bottom left)

. Overall Calcheck score (bottom left)

Note: In cases where multiple areas of a screen have been calchecked, the summary will display the worst results from
across all calchecked areas.

Clicking on a Display name under the Calcheck header (e.g., iMac) will allow the user to perform a Calcheck on the
chosen monitor.

The main part of the display area (white box) will show the detail or summary of the Calcheck as it is performed.

The top section above the main area has the following options:

. A All - Shows all of the A results measured, as defined in the Calcheck Chart. OAIT| Ae | AH | AC

. Ae - Shows all of the Ae results only. The Ae standard used
(DeltaE/CIE94/CIE2000/CMC(1:1)/CMC(2:1)) is selected in the Calcheck Chart (see Workbench > Calcheck
Chart for details). CIE2000 is a recommended standard to use for display verification.

. AH - Shows all of the AH results only.

. AC - Shows all of the AC results only.

. Summary button - Shows Calcheck summary results. X‘/

. Detail button - Shows results for each measured patch of the Calcheck Chart.

The lower section of the main display area contains the following:

¢ Screen Area buttons - These buttons enable the user to look at — ‘ _ ——
results from one of the nine (9) defined areas of the monitor G| G| L B | B | f o | B |
screen. The buttons are grayed out (cannot be selected) if a
screen area has not been calchecked. Areas that have been checked will enable the button and show whether
the area passed (green) or failed (red) a Calcheck.

. Instrument (offline/online) / Instrument Name - Displays the currently activated instrument.

. Instrument - Select which supported Spectrophotometer is to be used for the Calcheck.

. Measurement Type - Select which area of the screen to Calcheck or Calcheck the whole (3x3 grid) screen. The
middle centre of the screen if the default option for standard Calchecks.

History

By clicking on the History header, users can see at a glance the Calcheck summaries for all attached monitors. This is
useful for keeping track of any changes in your monitor’s performance

(i.e., drifting).

Information includes:

. Process Colour/Gray/Paper delta values

*  Average/maximum/standard deviation delta values
. Display name (top left)

. Timestamp of the last Calcheck (top right)

. Chart and Instrument used (bottom left)

. Overall Calcheck score (bottom left)
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These summaries show Calcheck results for the monitor(s) in relation to the Calcheck Chart used at the time of
checking (shown at the bottom left of the summary). The summaries are independent of the currently assigned
SoftProof Default Press / Calcheck Chart although, in most cases they will match the current Calcheck summaries (see
above section).

Clicking on a Display name under the History header (e.g., iMac) will allow the user to review past results of Calchecks
for the monitor. The window shows a sort list of previous Calcheck results, with the time and date the Calcheck was
performed and the Calcheck Chart used. Selecting a history item will display a summary or the detailed results.

Calcheck history within the Displays application is only kept for a period of 30 days from creation for each history item.

Ambient

By clicking on the Ambient header, the option to select a supported
Spectrophotometer becomes available to measure the ambient (cd/m?2) e x 1673510, 17046, 102 3
and white point (K) of the light source, e.g., a light booth or room.

. Instrument (offline/online) / Instrument Name - Displays the
currently activated instrument.

. Measure - Select from the list of supported ambient-mode
Spectrophotometers to use for measurement.

Note: For some Spectrophotometers, after initial instrument calibration,
an ambient light filter will need to be attached before measurement.

The lower, white area displays constantly updated measurements.

Light Booth
By clicking on the Light Booth header (when available), any currently connected
light booths will be shown.

. : . Displ t Normlicht
Each connected light booth shows information on: ORI s enoe

Pixels

Resolution

. Name/Model {ce Profila
o Driver Status
i Driver Version Last Calibrated

Calibration Expires
Driver File Name just-booth.so

Clicking on a light booth name under the header will make calibration options
Driver Version 1.02

available for the booth. These include: H S
ardware Calibration

. Brightness - Choose to set the brightness level in either:

. Candela - Brightness in cd/m? v
e Setthelevel from 0-100% e
. Instrument (offline/online) / Instrument Name - Displays the —
currently activated instrument. Iiment Gt Crv-One H
. Instrument - Select which supported Spectrophotometer is to e
be used for the light booth calibration. hiemd eminanc o 495.16 i/, Whimpoinof 0066 X

*  Adjust - Click this button to calibrate the brightness of the
selected booth. Follow any onscreen instructions.

Note: For some Spectrophotometers, after initial instrument calibration, an ambient light filter will need to be attached
before placing it in the booth and commencing the booth adjustment.
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FlipBook

The FlipBook application allows you to view a publication as a virtual book. In Blackmagic, a publication is defined as a
group of pages with the same publication name. This is a collection of book or magazine signatures that have been de-
imposed, but a publication may consist of any number of pages.

A M O FlipBook<2> - swievel. i oftware.com.au:9100 - NFR (not for resale)

Publication Pagination

FlipBook allows you to load the publication and flip through
pages as you would with a real magazine or book. This enables Name: Publication 123016680 (Pages)  Stanpage: 3 (1] TopPage:  Qfven © 0dd
you to check that your de-imposition has worked correctly, that

pages are in the correct order, orientation and if there are any g
duplicates. Larger views of the pages can be called up and the
whole publication can be exported to PDF or as a QuickTime
movie.

FlipBook can be opened in three ways:

. From the Application menu of the Serendipity Client.
Publications can be dragged and dropped from the
QueueManager into the FlipBook window and will open

automatically.

*  From the QueueManager application by selecting a job 19532 COLE TEXTSE Geosmeg s SN I 35532 COLE - TEXT cE GAcaacn) mage 7
and choosing View Flipbook. The View FlipBook option —_—_—
is only available if the job has a publication name. 3 EMAC ST o] 10 u[ 1] ) 1l 15[ 1] 18

. From the BookMonitor application by selecting a
Publication title and choosing View FlipBook (Available
for Veripress/Blackmagic Softproofing Add-on Only). If the pages for the selected publication title have not
been imaged or rendered in the QueueManager yet, the FlipBook will open but will not show any pages.

The FlipBook window comprises of four (4) main panels - Publication, Pagination, Page View and Page Index.

Publication Panel
This panel contains the name of the Publication being viewed.

Pagination Panel
. Start - Enter the page number for the starting page or use the arrows to select the first page number of the
FlipBook. If the first page loaded is page 1, you cannot alter the start page number. If the first page loaded is
greater than 1, you can enter a lower value as the start page number. This can be used if you are viewing a part
publication where the first pages have not been processed.
. Top Page - Choose whether the top page of the FlipBook is Even or Odd.

Page View Panel
This panel is where the FlipBook pages can be viewed. When a FlipBook is opened, the pages of the publication are
loaded and displayed in 2D (two-dimensional) view. There are various ways to navigate through the publication:

. Clicking on the page of the image - If you click on the right page, you move forward through the publication.
Clicking on the left page moves backwards.

. Clicking on the pages in the Page Navigator Panel - displayed below the Page View panel. The view jumps to
the page (pair) you select.

. Space Bar - The space bar moves forward to the next pair of pages. Hold the shift key and press the space bar
to move backwards.

. PageUp/PageDown - Use these buttons on the keyboard to navigate forwards and backwards through the
publication.

. Arrow Keys - Use down or right arrow keys to move forward through the publication and left or up to move
backwards.

d Scroll Bar - Moving the scroll bar below the image moves forwards or backwards through the publication.
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Page View (Contextual Menu)
There are various options available from the context (right click) menu:

. Open Publication - Opens a QueueManager showing all jobs processed in the system. Select a job or publication
job to load and click OK.

. Reload Publication - Reloads the current publication with files from the queue. This is used if additional files
have been processed as part of the publication, or changes have been made and the publication needs to be
updated.

. Choose Press - Select a Press configuration to apply to the job currently (and subsequently) loaded into the
FlipBook. (see Workbench - Press for details).

. Job Info - displays the Job Info information about the currently selected page. (see Workbench - QueueManager
for details).

. Swap Page with - This allows you to swap the page currently selected with another page from the same
(currently loaded) publication.

. View Original - opens and views the imaged file of the selected page in the SoftProof application.

. View Printed - opens and views the rendered file of the selected page in the SoftProof application.

. View 3D - toggles between a 3D or 2D view of the publication. Three dimensional viewing shows the page
turning as you navigate through. The turning speed can be adjusted FlipBook Settings.

. 3D mode adds 2 sliders on the right side of the Page View. The first alters the angle at which the 3D virtual
book is viewed, the second zooms the view in and out.

Note: The performance of the page turning may vary depending on the size of the thumbnail being viewed and the
performance of the graphics card.

*  View as Calendar - Only available in 3D mode. Changes the flip axis to horizontal so pages flip up and down in
the same manner as a calendar.

. Export - Exports the FlipBook as a PDF. Select the resolution, compression type and quality. Choose between
exporting the whole book or a range of pages.

. Export as Spreads - Exports the FlipBook as a PDF but as spreads. The same options as above apply.

. Export as Movie (3D view mode only) - Exports the FlipBook as a QuickTime movie. After selecting this there
are three further options:

. Codec Type - Choose the preferred compression type from the menu.

. Quality - Choose the preferred quality.

. Keyframe Spacing - Choose how often a keyframe is saved.

The settings you choose will affect the size of the movie, the quality and the compatibility with other applications.
There are many Codec types available and not all work on all systems. Commonly used types are Apple MPEG4 and
H.264 avcl. Increasing the quality setting also increases the file size. This is also true for the keyframes. The more
keyframes, the better the quality but the larger the file size. Trial and error will provide you with the desired result.

. Render Queue Thumbnails - View the Rendered thumbnails in rather than the default Imaged thumbnails.
Page Index Panel

The Page Index displays a numbered box for each page making up the loaded Publication. It allows for direct navigation
to any page by clicking on it.

The page boxes are colour coded:

Light Green indicates the pages are loaded into the FlipBook and can be viewed. These show as dark

green when selected.
2 3

Purple indicates there are duplicate pages, i.e.,, they have the same publication name and page ’
numbers. Dark purple indicates the pages are selected.

Clicking on these pages allows you to select and view the alternative page:

1r —I ===l == 1, ==als ——1I 1r ==

“ 19532 GOLF TEXT.job (IMPOSITION) Page 7

22
38 3 19532 GOLF TEXT.job Page 007 (IMPOSITION 07)
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- Light Red indicates the page is not in the FlipBook. This occurs when there are other pages
[ 116 ” 11 7] greater than the numbers displayed. This could be due to the imposition signature not yet being
rendered. As they render, you can simply reload the publication to update the pages.

The status colours are updated whenever Reload Publication is selected.

A bar directly above the Page Index displays the Job Name for each currently viewed page on the left and right sides
respectively. Pages with more than one version will show a dropdown to select which version to view. The Page
Numbers being viewed are shown in the centre of the bar.

Menu Options
The following are available from the FlipBook File Menu:

. Open Publication

. Reload Publication
. Export

. Export as Spreads
. Export as Movie

Two other options are also available:

. Edit Touch Console Ul (Veripress/Blackmagic Softproofing Add-on Only) - Opens an Edit Interface window
allowing for the configuration of the buttons enabled (and visible) for control of the FlipBook in the Main
screen of the Touch Console (see the Applications — Touch Console section for more information). Enable or
disable buttons by clicking on them. Those disabled will appear with a red cross and will be excluded from the
Touch Console when using it to view a FlipBook.

The Toolbar has a Preview toggle to see how the Touch Console controls will appear and a Reset button to
restore and enable all buttons.

d FlipBook Settings — Configure the FlipBook viewing options and press configuration.

View Options
. Allow Multiple Windows - Enable or disable. Allows multiple Publications to be opened and viewed in separate
FlipBook windows. If disabled, a newly opened Publication will replace the one currently being viewed.
. Page Order - Choose between reading left to right or right to left.
. Flip Time (3D) - Select the speed for the flipping of pages when in 3D mode.
. Render Queue Thumbnails - Enable or disable render queue thumbnails.
. Show Borders (2D) - Enable or disable the borders when viewing in 2D mode.

Press Configuration
. This panel allows you to view or change the Press configuration FlipBook uses to display Publications.

Fleloon Senngs Voo Settngs

o Prees Cantgurasion

#age Ocer: (31 g

View Menu
These options are also available from the FlipBook View Menu:

i View 3D
. View as Calendar
. Ink Weight - Opens the Ink Weights window displaying the FlipBook publication’s ink weights and coverage.

Serendipity Blackmagic User Manual - Version 6.0 106



Jobs

The Jobs application is used to display jobs before, after and during processing and allows users to manage jobs
through the system to plot their progress.

The Jobs application consists of an easy to navigate user- 1 () (o) (St e e et e o e e ol
interface, with tabs and layouts available for various
monitoring functions. Tab layouts may be added or managed
according to individual preferences and are saved at the Client
level, allowing different users to display information
appropriate to their location and workflow.

Jobs is the default monitoring application and will be run
automatically on launch of Blackmagic after the initial
software installation.

Menu Options
Tabs Menu
. Add Tabs - Add a new tab to the Jobs main window. Select from a list of factory default layouts. New tabs can
be imported for use via the Manage Tab Library option.

The factory default tab layouts available are:

. Job Queues (default loaded view)

. RIPMonitor - Adds a tab with the RIPMonitor module.

. Book Monitor - Adds a tab with the BookMonitor module (Blackmagic SoftProofing Add-on Only).

. QueueStatus - Adds a tab with multiple QueueStatus modules.

o Status and Drop - Contains the MediaStatus, Status, QueueStatus, DropZones and ClusterStatus modules.

. Logs - Contains the ServerLog and ClientLog modules.

. Jobs - Contains the QueueManager module with the Jobs view selected.

. Jobs and Drop - Contains the QueueManager module, a DropZone and a QueueStatus module.

. Assets - Contains the QueueManager module with the Assets queue selected.

. Drop Area - Contains the DropZone module with Assets dropspot added by default. Right-click to add any
additional dropzones to the Drop Area tab.

. ServerLog - Contains the ServerLog module only.

. Rename Tab - Rename the selected tab.

. Manage Tab Library - Add, remove or preview tab layouts for the Jobs application. There are eight (8) layouts
available as standard (factory).

d Close Tab - Close the currently selected tab.

View Menu
i Previous tab - Opens the previous tab window.
d Next tab - Opens the next available tab window.
. Titlebars - Show or hide the titlebars for each module within the Jobs application tabs. This will show or hide
all titlebars in all tabs and is not limited to the currently selected tab.

Job Queues Tab
The default tab layout (Job Queues) for the Jobs application contains the following modules:

. QueueManager (See QueueManager section for further information on features and use).
. Thumbnail - Imaging Preview

. Thumbnail - Rendering Preview

. QueueStatus - Imaging Queue

For information on each module, see the Modules section of this manual.
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Lineariser
The Lineariser application creates a Linearisation Curve for an output device (printer). Assigned to a Media after paper
profiling, it brings the output device to a known (linear) state. This means a 50% Cyan will print at 50%.

The user first prints a stepped wedge chart for a selected Spectrophotometer/Densitometer to the output device in the
colourspace specified by the Media. The chart is measured and
the resulting curve is saved, assigned to the Media and a History

recorded. ~EEE ':::EEEEEEE
TEDNDEEEEEEEE

At this stage, ICC profiles can be created and applied for
accurate colour representation. If the printer output varies due

to ink batches or head wear, a quick re-linearisation process is =
all that’s required to get back to the same linear state initially
created. The original ICC profiles can be re-applied to achieve

the same colour output.

The Interface
The Lineariser window is made up of a Toolbar and a number of panels - Available Media, Linearisation History,
Measurement, Advanced Options, Spectrophotometer or Densitometer information and Curves display.

Toolbar

The following options are available via the Toolbar at the top of the panel. Any option can be shown or hidden by
ticking/unticking it in the contextual (right-click) menu within the Toolbar. The Configure Toolbar option in the menu
also allows the order of the buttons/options to be set.

. Customise Patches - Allows for the selection of patches to be used in the Linearisation
Chart. Choose which Patch Percentages using the numbered buttons. Total number of SR e
patches selected is displayed. D nnnD NG

. Restore Defaults - Restore the patch selection to the default 23 patches per channel. Fleforulatal

. Use Lab - Toggles between Density and Lab measurement modes. Lab mode for
linearisation is required for printers with built-in Spectrophotometers.

. Measure Patches - Initialises the connected Spectrophotometer. Follow any
instructions in the status bar to measure the chart.

. Submit Linearisation - Save the data in the Measurement panel to the Media being
linearised. A popup will request a name for the curve.

. Reset Linearisation - Regenerates the linearisation chart to match the loaded Media’s colourspace and paper
profile. Normally only used in the event of a channels mismatch popup warning when printing a linearisation
chart.

LR R IR

w
"
" w
.-

Note: If viewing curves loaded from a Version 3.x or earlier database, the options will be unavailable until the Update
Legacy Curves option is selected from the Measurement panel contextual menu (see below).

There is no need to update Version 3 curves if your printer is performing satisfactorily. However, there have been
significant improvements made to the Lineariser so it is worth considering re-linearising with Version 6.

Available Media
This panel displays a list of available Media. Select a Media to view its current linearisation curves and data, or to
linearise a new Media.

Any changes made are applied to the currently selected Media.

Linearisation History
Shows a list of all the linearisations performed for the selected Media, allowing the user to track the performance of the
output device.

The following sort columns can be selected using the contextual menu on the column header bar. Column order can be
changed by dragging and dropping the columns into the desired order, or by using the Configure Headers option in the
context menu:

. Date - Date and time the linearisation was measured.
. Type - Shows whether each linearisation curve was measured in Density or Lab mode.
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The panel has one (1) button:

Trim To - Trims the number of stored histories to the value shown from oldest first.

The following options are available from the context (right click) menu within the History list:

Show Charts - Launches a separate window that plots the linearisation history of the Media/Gradation Curve
on various charts (See below for further information on the available charts). Checkboxes at the top of the
window allow you to choose which ink channel to view. Shift+click to view another channel at the same time.
Double click a channel to see all.

Revert to this Date - Reverts the linearisation curve assigned to the Media to the selected, historical
(previously measured) curve.

Unload - Unloads the historical curve data being viewed in the Measurement panel and loads the currently
assigned curve.

Measurement

Curve Name - Displays the name of the Linearisation Curve currently selected. This can be the saved curve
assigned to the Media or a selected History item.

Last Linearised - Located top-right above the measurement panel, Last Linearised displays the date and time
the printer/media combination was last linearised.

The display shows the colour-coded linearisation patches for each ink channel. The patch number and the Dot % it
represents are listed across the top of the panel. Measured Values (Density or Lab) are shown within each patch. If no
values are present, the Media has not yet been linearised.

Advanced Options (Density)

Yule Nielsen Number - Enter the YN number if you know what it is for the media in use. The default is 2. The
Yule Nielsen number or N-Factor is used to compensate for dot spread on different media types. This is
basically a “fudge factor” added to the standard Murray-Davis formula used to calculate dot area from a density
reading. An N-Factor of 1 means no compensation is made and just the Murray-Davis equation is used. An N-
Factor of 2 seems to work well with most media types. As adjustments are made, the curve preview on the
graph will change, showing the effects of the value entered. Further information on the Yule Nielsen Number
can be found below.

Maximum Densities Override - Enter a value to limit the top end density for each of the process colours. The
default is 0 (no override). As adjustments are made, the curve preview on the graph will change, showing the
effects of the value entered. Further information on Maximum Densities Override can be found below.

Advanced Options (Lab)
Choose from three (3) ink limiting options for each channel:

Default - Standard option, the gradation curve is graphed per the measured ink % patches.

Max. Chroma - The end point of the gradation curve is set to the point at which the chroma (a* and b* values)
of the measured patches stops increasing. This option is suitable for C, M, Y or any other non-black (K) channel.
Min. L - The end point of the gradation curve is set to the point at the lightness (L*) of the measured patches
stops decreasing. This option is suitable for Black (K), Light Black or gray channels.

Densitometer/Spectrophotometer

Device - Select the appropriate instrument from the pull down list of devices.

Note: The Embedded Printer Spectro option is only available when in Lab measurement mode (Use Lab
enabled).

Configure - Choose the measurement condition (M0, M1 or M2) to apply when measuring the Calcheck Chart.
The default is MO. This option is only available to instruments supporting this function.

Instrument Standards - Choose from the list which instrument standard is to be used for measurement. This
will only appear when Use Lab is not enabled.

Measure - Connects to the selected instrument and prepares to read patches. The patch window changes to a
measuring window and the instrument list changes to a text field where instructions are displayed.

Print Chart - Print the appropriate chart for the selected instrument to the Media selected. You will be
prompted with an options window with the following:

Cancel Printing - Cancels the action and returns to the previous window.

Don’t Apply. Print to Linearise - This will disable all colour management except for Paper Profile. Use this to
make a Linearisation Curve.

Yes. Print to check Linearisation - This applies all colour management so you can check a Linearisation.
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Curve
This panel shows the Linearisation Curves for each ink channel.

Select individual channel checkboxes to view a channel. Shift+click to add more channel curves to the view. Double click
a channel to show all curves.

Show Charts

Selecting Show Charts will display another window with a chart for each channel in the linearisation curve. At the top of
the window is a series of tick boxes, one for each colour. Selecting one displays the single colour and hides all others.
Selecting another box changes the graph to that colour. Select the same colour again and all graphs will be displayed.
Use SHIFT+Click to show more than one graph.

Chart Types
There are five (5) chart types available for selection:

Density / History - Plots the date of the curve on the X-axis and the density values for each
patch on the Y-axis. If the density begins to drop off, it will be displayed in the chart.

Density / Patches - Plots the patches along the X-axis and the density on the Y-axis. For each
patch in the history, a point is placed on the graph. If the density for a given patch does not
vary greatly, the points will appear on top of each other. Where there is some change, a line
will appear between points.

Dot % / History - Plots the date of the measurements on the X-axis against the dot
percentage on the Y-axis. The points on the chart represent the patches. For any patch, the
effective dot % and how it varies across the history is shown.

Dot % / Patches - Plots the patch number along the X-axis against dot percentage on the Y-
axis. A diagonal line from 0 to 100 is shown as a guide to a linear curve. This graph will show if
the patches are generally higher or lower than a linear measurement, as well as differences
over the course of time.

Dot % Delta / Patches - Plots the patch number along the X-axis against the dot percentage
delta on the Y-axis. It shows the percentage difference from the target. For example, if the °*
target is 40% and the measured value for that patch is higher or lower, the error is shown in

the graph.
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Yule Nielsen Number
The Yule Nielsen Number is essentially a “fudge factor” applied to the standard Murray-Davis formula used when
calculating dot percentage area from density.

The value is used to compensate for various media types, as some react differently to others in the way a dot will
spread on a particular media and thus affect the dot percentage value. It is sometimes helpful to change the YN number
(and some manufacturers will quote a YN number for a given media) but this is rare.

The YN formula used for calculating the dot percentage is:

-dot

YN
1-10 dot is the value of the density being measured
Dot %= — x100%
'Sf;% solid is the density of the solid patch

1-10

Therefore, a YN value of 1 has no effect on the dot percentage area. A value other than 1 will compensate for the dot
spread on the media. If the YN is greater than 1, the Dot % decreases and if the YN is less than 1, increases.

. i ““
T.hlS can be seen from the graph on the YN=1 1 yn=2 1 YN=05
Lineariser: # y ‘

The curves display the compensation; therefore if the YN number is less than 1 the dot percentage calculated is
increased so the curve applied will go down. The reverse is true for a YN number greater than 1.

For most of the testing done during initial development, the value of 2 (the default setting) seemed to work well. It was
also noted on occasions, better results were obtainable by setting different values for each process colour.

Note: As the ICC profiles are created after Linearisation, any value entered will be used for printing the ICC chart and
will affect the output. This means when the ICC profiles are applied, the same YN number must always be used in the
Lineariser to obtain correct results.

Maximum Densities Override
The Maximum Densities Override allows the user to cap the top end density to any value less than the maximum value
read.

If a value less than the highest value measured is entered, the curve will change. The top end will move down and the
rest of the curve will adjust to compensate for the new end position. The values in the middle of the curve will also
change.

Pros and Cons

There are various arguments for and against setting a maximum density override. In general, the Match ICC profile
would set the maximum density values so there should be no need to set them here. However, some users have found it
to be an advantage to set the values to the target densities required for the final proof output and in doing so, have
achieved very good results.

Reducing the density of the output used to print the ICC chart will affect the gamut. However, as the gamut of a press is
generally smaller than that of a proofing device, this may not have any noticeable effects.

It is desirable to drop the top end densities of the output prior to ICC creation, as sometimes there is a need to boost the
values after ICC is applied. This should only be used as a last resort and is not desirable as a general rule. If the top end
densities drop, the ICC profiles are generally to blame and therefore should be corrected.

Note: It is the Match ICC profile that has the biggest bearing on the output and sets the output top end densities.
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Monitor

The Monitor application is an alternate user-configurable version of the Jobs application, central to the Serendipity
Client interface (see Applications > Jobs). Like Jobs, it displays jobs before, during and after processing and allows users
to manage jobs through the system to plot their progress. The Monitor .. [

provides feedback from the Server and Client via logs. Modules can be ~— ==="""= = ™~ LR L
added and configured to suit specific requirements. See the Modules : ; e | | | [ [TT] e -

section for further information.

AR Sane S
The Monitor consists of one or more user-defined tabs. Modules are CEN_IEEINEEETE
added, positioned and sized according to individual preferences. .. i o vy oy b= o
Settings are saved at the Client level, enabling Serendipity Clients on § ‘ - 5:_ -

different systems or in different departments to display information — - =

appropriate to their location. —— = —

The Monitor can be in one of two modes - Edit or Use. e {5

Edit

This mode allows the user to move and resize modules on a tab. The mouse pointer changes to a cross when in Edit
mode. Resize a module by grabbing the corners or sides and dragging to the preferred size. Click anywhere in the
modules and drag it to the desired position. Modules close together will snap-to each other.

While in Edit mode, all Modules have a contextual menu available (right-click) with the following options:

. Remove (Module) - Removes the module from the Monitor tab.

. Set Size For (Module) - Allow the user to enter a width and height (in pixels) for the selected module via a
resize popup.

. Duplicate (Module) - Duplicates the selected module. The duplicate has all the size, layout and configuration
options of the original.

. Use Layout - Switches the Monitor to Use Mode.

Use
This is the normal user mode. It locks the module sizes and position and allows you to configure the modules
preferences and manage jobs. Select this after Editing to use the configured layout.

Menu Options

Layout
. Edit - Switches the Monitor to Edit Mode (see above explanation).
. Use - Switches the Monitor to Use Mode (see above explanation).
. Dynamic Update - Enables or disables updates to the modules while in Edit mode.
. Show Titlebars — Shows or hides module titlebars.
. Add Modules - See the “Modules” section for further information on each module.
. Load - Loads a previously saved Monitor configuration.
. Save As - Saves the current Monitor configuration.
. Search UI (User Interface) — Activates a search bar for finding buttons and functions in the current Monitor tab.
. Note: Module Toolbar functions can only be searched if the toolbar is open.

. New Tab - Creates a new tab.

. Rename Tab - Renames the currently selected tab.

. Duplicate Tab - Duplicates the currently selected tab and all modules within it.

. Choose Tab Colour - Allows the user to select a colour for the currently selected tab.

. Choose Tab Image - Allows the user to select an image for the currently selected tab background. Valid types
are PNG and JPEG. It is recommended a large image not be used, as it will take up memory.

. Clear Tab Colour/Image - Reverts to the default background colour.

. Remove Tab - Deletes the currently selected tab.

. Remove All Tabs - Deletes all tabs.

. Next/Previous Tab - Switches to the next or previous Monitor tab (right or left).

Reordering Tabs
Tabs can be moved to a new position by clicking on and dragging the tab to the desired place in the order. A red pointer
appears, showing the drop point between two tabs.
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Press Agent

The Press Agent application allows Blackmagic (available via the Blackmagic Softproofing Add-On) to be connected to a
Press console through a network port. After selecting the appropriate Press Agent Driver, a press operator can load or
turn softproofing jobs/pages using press console buttons.

Other options include interfacing with a press desk camera. The press operator turns a hardcopy page on the press
desk - Press Agent will use the page recognition data from the camera/console to automatically load the correct left and
right pages, or page spreads.

Press Agent - sdmin@goiem swdevel serendoity-software.com 2u:9100 - NiR (not for resale)

Log Configure Headers
The Press Agent window has a central Log panel to show
events/messages/commands received from the press console

while the Agent is active.

v Press
v Date
v Message

The following sort columns can be selected by using the
contextual (right click) menu on the column header bar. Column 10 tems
order can be changed by dragging and dropping the columns, or ... n Comer) ot
by using the Configure Header option from the contextual menu:

. Press - The Press console that generated the event/message/command.
. Date - The date and time of the event/message/command.
. Message - The event/message/command generated by the press console.

Log Options
. Fetch Back Log - Displays the log for the time specified. For example, it retrieves and displays the last 4 hours
of messages. Choose the time from the dropdown list.
. Trim Older Lines - Trims the log based on the time selected in Fetch Back Log. If this is set to 60 minutes, the
log file is trimmed back so only the last 60 minutes remain.
. Export - Allows you to export the log to a HTML or tab delimited text file.

Interface Options
d Press Agent Driver - Select the required Press Agent Driver from the dropdown list of supported press
consoles.
. Configure - Opens a Configuration pop-up for the selected Press Agent Driver. Available options vary
dependent upon the press console driver.
. Configure is not available while the Press Agent is running. Hit Stop if settings need to be changed.
. Start/Stop Button - Starts or stops the Press Agent.
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SoftProof

The Softproof application is used to proof a job on the screen. There are many tools available to check every aspect of
the job at any stage of production or processing. SoftProof can be used in conjunction with or instead of a hardcopy
proof. Using a calibrated monitor and configured press settings, proofs can be viewed and verified onscreen with
precise colour accuracy.

All job plates are shown and can be turned on or off, or changed as desired. Colour attributes and plate characteristics
can be changed to see the effects of different printing processes, including paper types and the effects of show-through
from the reverse side. The data can be exported to various file formats, including CIP3 and PDF. An Ink Key Viewer can
display a job as it would be on the press, with the values for each key shown. The ink weight can also be calculated and
over-ink areas identified. The proof can also be verified using the Displays application to give a pass or fail status in
accordance with chosen colour standards.

Layout
The SoftProof application consists of a large, central viewing window for jobs; a visual Tools menu on the left and a
View panel to the right; a Navigation Thumbnail at the top right; and a status bar along the bottom of the window.

Navigation Thumbnail

This thumbnail shows the entire image loaded for softproofing. The area currently shown in the
main viewing area is represented by a rectangle on the thumbnail. Mouse over and left-click to
view a new area of the proof.

Status Bar

This bar shows the information about the currently loaded proof, the SoftProof Press Setting and the current
calibration status of the monitor in relation to the

Press Setting (see Applications > Displays for more  SoftProof - Nested job 19078 (Printed preview) 50% « Auto Softproof Camera
information on screen calibration).

The left of the bar displays:
. Jobname (Original/Printed Preview) and current zoom level %
The right of the bar displays:

. Current Press or Camera settings, along with the Embedded ICC Profile for the image (if applicable). Use the
tick box to override the currently selected Press or

Camera profile and enable the embedded ICC Profile. - At saftproot Camera | (V] Embedded ICC Profil: Adobe RGB (1998)

Clicking on the Press or Camera profile button will popup a menu with the option to choose
another Press/Camera setting if available. [- Auto Softproof Camera | i

. . . v’ @ Auto Softproof Camera
When Calcheck Managed is enabled (Client Preferences > Colour Management) a small tick @ sRCB V4 ICC

or cross representing the Calcheck status will be displayed in the status bar at the bottom

right of the SoftProof window. Ghoose Canens...

Hovering the mouse pointer over the cross or tick shows a tooltip (when Tooltips are enabled) displaying information
including:

. The ICC Profile used by the monitor (normally created using the Displays %;}E;e‘;?,‘gm/mom
application, Calibrate option). |Expies: Never

. The Calcheck Chart assigned to the Press/Camera Settings currently used in '~
SoftProof and the current Calcheck Status of the monitor.

/home/mandy/Library/ColorSync/Profiles/iMac-070911.icc
Va
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Click on the Tick/Cross to popup a menu with the following options:

. Calibrate - Begin calibration of the monitor using the current settings and Spectrophotometer assigned in the
Displays application. Once calibrated, the monitor ICC profile is -

. . . X
automatically saved as the operating system default replacing the ik
pI‘eViOUS ICC profile. | Calcheck monitor (MediaWedgeV3 I1SOcoated_V2_eci (Fogra39 ))

Note: When calibrating or calchecking, the Spectrophotometer assigned in the Displays application for either tasks
should be connected and ready for use. If the instrument is different to the assigned one an error will occur, ceasing the
operation. It is recommended to check the appropriate Spectrophotometer has been assigned before using the Calibrate
or Calcheck Monitor functions (see Applications > Displays).

. Calcheck Monitor (Chart Name) - This option will open the Displays application and begin a Calcheck of the
softproofing monitor using the Calcheck Chart assigned to the current Press settings. The chart is named in
brackets. The pass/fail status may change as a result of the check. Detailed results can be viewed in the History
area of the Displays application.

Note on Spot Colours: When performing a monitor calcheck from the SoftProof application, any special/spot colours
included in the currently loaded job are measured and added as extra patches to the end of the Calcheck Chart.

Tools
M . Pan (H) - Navigate around the image by clicking and dragging the job around the screen.
* . Zoom (Z) - Zoom in or out of the job. Clicking the mouse zooms twice the current percentage factor.
SHIFT+Click will zoom out half the percentage factor. Click and drag over an area to zoom it.
= . Note (N) - Create, manage and delete notes.
iy . Measure (I) - Take a measurement on the image. Use the shift key to draw straight lines.
] . Crop (C) - Crop an image and resubmit it.
=y . Guide (G) - Display guide lines on the image to check for alignment. Change the orientation by
i pressing SHIFT. ESC will remove the guides.
' . Spectro (X) - Take measurements of the job being viewed. A popup window will appear displaying
ﬁ the Lab/Lch/XYZ/Density values at the point the Spectro cursor is onscreen.

Veripress/Blackmagic Softproofing Add-On only — Additionally, the Spectro Tool gives the user the option to
choose an instrument which can be used to measure a hard proof. The measurement taken is compared to
the softproof and the deltaE displayed onscreen.

SoftProof Widgets
There are four (4) sliding widgets available from the left panel of icons in the SoftProof viewing window.

J These include:
[} *  Channels (Shift+C)
. Publications (Shift+P)
‘l . Ink Keys (Shift+])
o . Get Info (CTRL+I / CMD+I)
Channels Widget

The Channels Viewer shows the channels or plates of the job currently being
viewed in SoftProof. Plates can be turned on or off by clicking the relevant
coloured checkbox to the left of the plate name and can be reordered by clicking g,
and dragging to a new position. The plate colour and associated attributes can be
changed by double-clicking and choosing another Special Colour Set from the Tocal ok
library, or edited for that SoftProof instance only.

RRRAR
" an
Fta
{.-
8
2

ol 4
3
=

. Name - The plate name. The checkbox indicates whether or not the plate
is displayed.
. Value - The percentage of colour at the point of the cursor in the window.
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Total ink displays the total amount of ink at the point of the colour selector, i.e., the sum of all plate
percentages. For RGB it will show the relative RGB values only.

The contextual menu (right-click) reveals additional options for non-RGB jobs only:

Choose Plate Colour - Select a plate colour from a Special Colour Set for the selected channel. Double-clicking
will display the same Special Colour Set window.

Choose Paper Colour - Select a colour from the Special Colour Set to use to simulate the paper colour. Once set,
the option to revert becomes available.

Edit Plate Colour - Displays a colour editing window to edit the selected colour for the current SoftProof
instance only. The edits are not stored in a library.

Apply a Replace Colour Set - Select a Replace Colour Set to apply to the job. Any plates matching the set will be
replaced.

Revert All Plates to Press Settings — Changes all plates back to the press configuration currently selected.

Apply Blueline Set - Replaces all colours with varying shades of blue to see any traps or bleed issues.

Publications Widget

When softproofing a job that forms part of a publication, additional controls and
view options are available:

i

. S Page
e Bes Page

Single Page - Display just the single page selected. Disabling this option s dusiviy

enables the following:

Show Back Page - Display the reverse side of a page through the page

currently loaded, as if the final print was being held up to the light. The

Back Page Opacity setting in the Press Settings controls the amount of

show-through.

Show Page Spread - View the spread of the selected page, for example, pages 2 and 3 as a spread.

Edit Imposition - When an imposition flat is loaded, changes can be made to the Signature Group here without

closing SoftProof. Any alterations can be viewed using Signature Overlay.

Show Signature - Overlays the signature used to de-impose onto the image. This is only available if the job has

been de-imposed.

Show Deimposed Pages - When an imposition flat is being viewed, SoftProof will show all available pages

when this is enabled. Each page from within the imposition may be previewed via the Page Index tab.

(o Megar —e

Ink Keys Widget
The Ink Keys icon will display the Ink Key Viewer containing the loaded image in the SoftProof window.

At the bottom of the window will be a series of ink keys. Colour bars give a
graphical display of the proportion of each ink contained within the job across the

keys.

For each key selected, the relative percentage of ink for each of the plates is
shown. An information panel runs down the right side of the window. The top of
the panel shows information about the currently loaded Press Settings. Job view
and placement can be changed and ink weight can be calculated for any job.

Colour checkboxes - Positioned above the image, these show the inks or '

plates used in the job. Cllcklng on one will turn the gthers (?ff and leave the — fr—)
ticked colour on. SHIFT+Click allows for multi-selection of colours.

Double-click to show all.

Ink Keys - The keys at the bottom of the window show the inks selected to be viewed on a graph. The scale of
the graph varies, depending on the amount of ink in the job. Hovering over or clicking on an ink key will display
the key number and its ink values at the bottom of the information panel.

Press Settings — Shows the values for the currently loaded press. Click the box to show or hide the details. Press
settings used are selected in the Default Press panel of the SoftProof Settings.

Show Excess Ink Weight Area - Display areas exceeding the Maximum Ink Weight setting as defined in the
Press configuration.

Max Ink Key Value - Set the size of the ink keys to match your press. Ink values are calculated based on the size
entered. If the size is 100, percentages are displayed.
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. Sheet Placement - Show the job as positioned on the press sheet defined in the configuration. The job can be
centered (selecting the Centre checkbox), or offset from the left (X) and bottom (Y). De-selecting this displays
the whole job in the viewer and changes the ink keys to show total ink amounts for the job.

. Ink Weight Calculator - Calculate the amount of ink required to print (x) number of copies.

i Print Run Size - How many to print.

. Ink Weight (g/m?) - Enter the weight of the ink used in grams per square metre.

. Calculate - Based on the values entered for ink weight and print run size, the total weight of ink for each colour
will be calculated for the loaded job and displayed in the ink value area.

Contextual (right-click) menu options include:

. Show Ink Key Table - Shows a separate window, listing the ink key values of all keys for each plate. These can
be printed using a local printer or exported to PDF.
. Export Tab Delimited - Exports the values for the keys and ink values to a tab delimited text file.

Get Info Widget n
The Get Info icon will display job information about the currently viewed image in SoftProof - e

how it was processed, what Pagesetup and Media were used and other useful processing ==
information. Click the icon again to hide the panel.

Loupe
The Loupe is available via the sidebar menu. Once opened, the Loupe will appear
with the default setting “Loupe to Mouse” enabled.

and d
our horse

-\gmng B o

Loupe Options (accessed via the Spanner icon):

. Screened Pixel Readout (Veripress/Blackmagic Softproofing Add-On
only) - Toggles the HUD between crosshair point measurement of ink
percentages and a square for measuring area average dot percentages.
The square resizes depending on the zoom level to always cover an area
equal to a full halftone cell at the LPI defined in the SoftProof Settings.

. Screening LPI - Enter the desired value for screen ruling for SoftProof in
Lines Per Inch (LPI). The defaultis 150.

. Loupe to Mouse - This is enabled by default. The mouse pointer location
is used as the reference point for the Loupe display. This allows you to
position the Loupe off image and use the mouse to display the relevant
part of the image within the Loupe for proofing.

. Rulers — Turn rulers on or off. The rulers will appear in the Loupe window with measurement units displayed.
The rulers are centered or at the mouse pointer location if held over the Loupe window.

ucing quality
t materials and glesigns, and
ure your horsg is properly

Ty oepe—

fNO Loupe Options

__ Screened Pixel Readout

OEDEOD N E A

Screening LPI | 150

W Loupe To Mouse
__ Rulers
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The Loupe is moved around the SoftProof by left-click and holding to drag it.

The Loupe can be resized by clicking on the button with 3 lines (see image) and dragging outwards. The mouse scroll
wheel will also increase/decrease the Loupe size when the mouse is positioned over the window.

A number of display and control options are available via the buttons at the bottom of the Loupe window:

+ (button) - Click to increase the zoom factor of the Loupe. The zoom factor is displayed at the bottom centre
of the Loupe. Note: 100% = the resolution at which the proof was originally imaged, i.e., 1 screen pixel is 1 job
pixel.

- (button) - Click to decrease the zoom factor of the Loupe.

Spanner - Opens the Loupe Options window.

Eye - Displays the HUD (Heads Up Display) showing the CMYK dot percentages at the centered crosshair or
within the average percentage box. If the image is RGB, the relevant R, G and B values will be displayed.
Show/Hide Channel HUD Toggle (Veripress/Blackmagic Softproofing Add-On only) - Show or hide the
SoftProof Channels Widget. Only visible when a job contains too many plates to fit in the Channel panel of the
HUD.

SoftProof Menu Options
File Menu

Open Files - Load an image file directly into SoftProof. Supported file types are Canon RAW format (CRW),
JPEG, PNG, PPM, Serendipity Blackmagic Image, TIFF and Adobe Photoshop PSD.

Open Jobs - Load completed jobs into SoftProof. The Imaged (Original) or Rendered (Printed) file may be
viewed.

Save - Save the preview as a Blackmagic Image File. This can be submitted or placed in a hot folder, or on a
DropSpot.

Export - Export data from SoftProof. The available formats are CIP3, PDF, Postscript (Separated) and TIFF
Multichannel.

Submit - Submit the current preview, including any onscreen changes, to a Pagesetup/Media/Jobticket. This
re-images and re-renders the job at the current image preview resolution. If the resolution is restricted in
Server Settings then the limited resolution will be used.

Submit ICC Target - Submit the current preview, including any onscreen changes, to a
Pagesetup/Media/Jobticket as an ICC Target. The preview submitted uses the Paper Profile, Linearisation LUT
and Correction LUT in the Media but is not ICC corrected.

Edit Touch Console Ul (Veripress/Blackmagic Softproofing Add-On only) - Opens an edit interface window to
allow the configuration of the enabled (visible) buttons for control of SoftProof in the Main screen of the Touch
Console. Buttons are enabled or disable by clicking on them. Any disabled will appear with a red cross and will
be excluded from Touch Console when using it to view softproofs. The Toolbar has a preview checkbox to see
how the Touch Console controls will appear and a Reset button to restore and enable all buttons.

SoftProof Settings - Opens the preferences for SoftProof, allowing for configuration of default viewing
conditions. See below for further information.

SoftProof Settings

The SoftProof Settings allow you to select viewing preferences including how to load a job, and the quality and press
settings used to produce accurate proofs. The settings window is split into four (4) tabs — View Options, Image, Default
Press and Default Camera.

View Options Tab e oo I T et Camers

Window e

e Allow Multiple Windows - When enabled, allows jobs to be opened and =
viewed in separate SoftProof windows. If disabled, each job viewed will e Bl i - S
appear in a tab running along the top of the same SoftProof window. If a job atieeipniallc i
is dragged and dropped into SoftProof from the QueueManager, it will == e—
replace any open image in the viewing window selected. = :

. Status Bar Size - Select the size of the status bar text from Small, Medium or i::«:-_«
Large. i

. Rulers - Show or hide the rulers. Sty

d Scrollbars - Show or hide the scrollbars.

. Image Centring - Select to align any images opened in SoftProof either ] (R

Horizontally or Vertically or both.
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. Max Preview Resolution — Set the maximum preview resolution for SoftProof for both Imaged and Rendered
options. The default is zero (0), which is the full job resolution of the output file.

On Load

. Honour Embedded ICC Profiles - When enabled, this will honour any embedded ICC profiles when viewing the
image in SoftProof.

. Rotation - Control the orientation of jobs when they first load. The option None leaves the job in its imaged or
rendered orientation.

. Zoom Level - Select the default zoom setting. All fitting zoom modes calculate the size based on the monitor
resolution. This is set in the Colour Management tab of the Client Settings.

. Show Back Page - (Checkbox) Toggles whether publications with consecutive pages will open in SoftProof
displaying back page show-through (based on Press settings) by default.

. Show Spreads - (Checkbox) When enabled the publication pages open in SoftProof as part of a spread pair
alongside the previous/next page.

Publications

. Enable Pager Thumbnail - Enable or disable the thumbnail viewer when viewing a publication. When enabled,
a thumbnail of the page appears when the mouse pointer hovers over the page number box.

. Enable Pager Sections - When enabled a Section label/button is displayed above
the pages in the SoftProof Page Index panel. This allows for loaded multi-section pos =
publications to be viewed one section at a time, displaying the page range within 7 > IElE
each section. Clicking the section label bar will open a menu to choose which
section to view or to view all sections.

All Sections
Image Tab gg;
. Resampling Algorithm - Set the resampling algorithm for jobs as they are viewed in ——

SoftProof.

i Screening LPI - Enter the desired value for screen ruling in lines per inch (LPI). The default is 150.

i Merge Spot Colours in (Veripress/Blackmagic Softproofing Add on only) - Choose from either RGB or CMYK as
the colourspace in which on-screen spot colours are merged. Using RGB can produce better spot colour
matches on-screen.

. Unsharp Mask - The Unsharp Mask feature allows SoftProof previews to be sharpened onscreen. The
sharpening applied is controlled via the following settings:

d Amount - Choose the amount (from 1-500%) of edge sharpening. The higher the value, the more contrast
between pixels around the edges. Default value is 180%.

. Radius - Define the width (from 1-100 pixels) of the edges that the filter will sharpen. The higher the value, the
wider the edge. The appropriate value to be used varies depending on the resolution of the softproofed image.
Lower resolution images require a smaller radius value. Higher resolution images require a higher value.
Default value is 3 pixels.

d Threshold - Specify the difference in brightness (from 0-255) that must be present between adjacent pixels
before the edge is sharpened. A lower value sharpens edges with minimal contrast difference. Higher values
sharpen when adjacent pixels are very different in contrast. The default value is 15.

Default Press
The default press tab allows the selection of a Press configuration from the database to be applied to the loaded jobs
and for all subsequent jobs loaded in SoftProof.

Press 1 - The default press used for softproofing jobs.

Press 2 - Assign an alternate press configuration for publications that include pages printed on a different stock, e.g.
glossy magazine covers.

An information window shows the settings of the currently loaded Press setup. Configurations are managed in the
Workbench and contain information such as size, number of keys and colour information.

Default Camera

The default camera tab allows for the selection of a Camera configuration from the database to be applied to any loaded
jobs using an RGB colourspace. If Honour Embedded ICC Profiles in the SoftProof Settings is unchecked and the RGB
image contains an ICC profile, the default camera configuration will be used in its place.

Serendipity Blackmagic User Manual - Version 6.0 119



An information window shows the settings of the currently loaded Camera setup. Camera configurations are managed
in the Workbench and contain information such as the ICC profile to be used, rendering intents, black point
compensation and Calcheck Chart reference.

View Menu
Select menu items are also available as icons within the SoftProof window (see image).

Tabs - Control the tabbed viewing of images in SoftProof.

New tab - Opens a new, empty tab ready for a job. Use the Open Job option or drag and
drop a job from the QueueManager to view it.

Close Tab - Close the currently selected tab.

Next Tab - Loads the next available tab.

Previous Tab - Loads the previous tab.

Show Tab - Show/hide the tabs listed at the top of the screen.

Get Info - Display information about the softproofed job and how it was processed.
Show Page Boundary - Display a red line around the page area of the job.

Show Notes - Display any notes attached to the job.

Screened Pixel Readout (Veripress/Blackmagic Softproofing Add-On only) - Toggles the HUD between
crosshair point measurement of ink percentages and a square for measuring area average dot percentages. The
square resizes depending on the zoom level to always cover an area equal to a full halftone cell at the LPI
defined in the SoftProof Settings.

Ink Weights - Opens a window displaying the ink weights (source and

AlS[0]9]E]
|| @ (%5

print inks) for the job. Tabs <
Go To Page - Opens a popup window to enter a page number to display in © Get Info 32|

SoftProof. Only available for publications. B Show Page Boundary P
Proof Colours - For use with RGB images only. Automatically select a Press  , = show Notes 3N
Configuration to display onscreen what the RGB image will print like using ® Screened Pixel Readout  *
a specific Press profile. The selected Press will appear in the status bar at & Ink Weights 0%l

the bottom right of the screen. Clicking the status bar button will allow you © Go to Page e
to adjust which profile is used.

Zoom In/Out - Zoom in or out of the image. Holding down CMD (Mac) or Q Proof Colours #P
CTRL (Win) and scrolling the mouse wheel over the image will allow for @ Zoom In %+
zoom in and out functions. Q Zoom Out 50—
Show All - Fit the entire job into the SoftProof window. %2 Show All %0
Show Actual Pixels - One pixel of the screen is equal to one pixel of the job. & Show Actual Pixels %1
This is shown at 100%. This view mode has the quickest load time as R Show Actual Print Size 382
resampling for scaling is not required. s Fit Width 53
Show Actual Print Size - Show the print size of the job. t Fit Height 304
Fit Width/Height - Fit the job to the height or width of the SoftProof

window. 90 CW

90 CW - Rotate the image 90 degrees clockwise. 4+« 90 CCW

90 CCW - Rotate the image 90 degrees counter-clockwise. () 180

180 - Rotate the image 180 degrees. DR

Revert Rotation — Undo any rotation made to the image in SoftProof. 4 Invert

Invert - Invert (negate) the image. (W] Mirror

Mirror - Mirror the image. 1 Autocrop

Autocrop - Remove any whitespace around a job. There must be a ® Unsharp Mask

completely clear area on any one side of the job. 25 Use Press 2

Unsharp Mask - Apply an unsharp mask to the image. This will affect the

edges within the image. Settings for the unsharp mask can be set via the (1 Full Screen F
SoftProof Settings. Thumbnails oT
Use Press 2 - Switch between Press 1 and 2 as configured in the SoftProof 5 Page Index X
Settings for non-RGB images viewed in SoftProof. = Notes ON
Full Screen - Switch between full screen mode and window mode.

Thumbnails - Select the Thumbnails tab within the SoftProof window. £ Loupe L

Page Index - Select the Page Index tab within the SoftProof window.
Notes - Select the Notes tab within the SoftProof window.

Loupe - Display a virtual loupe on top of the loaded image. The loupe can be resized and magnification level
changed if required. The current magnification is shown at the bottom of the Loupe; 100% means 1 screen to 1

job pixel.
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Thumbnail Panel
The thumbnail panel displays a small image of any jobs currently open in SoftProof. Clicking on the
relevant image will switch the SoftProof preview to that window.

L ]
om

g Notes Panel EREE
Notes gives users the ability to draw a text box on the imaged Alao/Ew
or rendered SoftProof to make a note. The note is attached to 50

the job file and remains attached until it is either deleted or the job is
removed from the system. There is no limit to how many notes can be
created, and they can be shown or hidden as required.

m e
30
Check ink for red

Notes cannot be attached to files opened in SoftProof via File Menu > Open
Files. The file needs to be submitted as a job before any embedding of notes can take place.

When creating a note with the Note Editor, a configurable arrowhead pointer option is available along with the existing
area marker for a more precise commentary on the job. The User and Group of the note creator are also displayed (see
Secure Mode). Notes can be edited or the anchor adjusted by double-clicking on the Note.

The Note panel displays any notes attached to the job currently selected in the main viewing window. There is also a
Note column in the QueueManager showing the number of notes attached to a particular job. The Notes icon on the left
menu bar is used when adding Notes to the softproofed image. The Notes icon in the right panel is used to display or
hide any notes on the image.

. Show Notes - Show or hide the notes on the preview. Notes can also be toggled by clicking the icon on the right
panel (see image above).

. Text - The text making up the note.

. User / Group - The User and Group responsible for the note.

Page Index Panel

The Page Index panel displays a numbered box for each page making up the loaded publication. This
allows for direct navigation to any page by clicking on the page number. Hovering the mouse over a page
number will pop-up a thumbnail for the page. The “T” hotkey toggles the thumbnails on or off.

The page boxes are colour coded:

Light Green indicates the Publication pages are loaded and can be viewed. These show as dark green

when selected.
2 3

Purple indicates there are duplicate pages, i.e., they have the same publication name and page
numbers. Dark purple indicates the pages are selected.

S 1|

Clicking on these pages allows you to select and view the alternative page:

“2- 19532 GOLF TEXT.job (IMPOSITION) Page 7

22
38| 3 19532 GOLF TEXT.job Page 007 (IMPOSITION 07)

Light Red indicates the page is not yet available for viewing in SoftProof. This normally occurs
l 116 ” 11 ﬂ when there are page number gaps if pages have not yet imaged or rendered; or when processing

a de-imposed publication with known (signature defined) page numbers. As the missing pages
image/render, close and re-open SoftProof to update the publication pages.
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Spectro - -
The Spectro application allows for the measurement of colours with a
Spectrophotometer. The accuracy of the measured value can be viewed against S
an imported value when mapped through a selected ICC profile.

The window is split into two sections. The right side allows for the import and
viewing of a Special Set, which is used as the comparison base. The left side :
displays the measured values. Selecting a particular measured value matches ) et

the closest colour of the imported set, giving it relative deltaE values. These : ————

can also be filtered to only show the closest matches for better viewing. s 5 (=

H '
B R 2R AR 3 Tk
£8 £5: 12 R410 ]

Options

. Load Set - Select a Special Colour Set to load. This is the set used to compare measured values with. Choose
from any of the Special Colour Sets created.

. Match ICC - Select a Match ICC profile.

. Rendering Intent - Select the rendering intent for the Match profile.

. Spectrophotometer - Select your device from the list of supported Spectrophotometers.

. Configure - Choose the measurement condition (M0, M1 or M2) to apply when measuring the Calcheck Chart.
The default is MO. This option is only available to instruments supporting this function.

*  Activate - Connect to your selected device. Once connected, the pull down device list will change to display any
status messages from the device and the values measured.

. Turn Off - Disconnects the connected Spectrophotometer. Alternates with the Activate button.

. Add - Select this to append to the list for each reading. If this is not selected, the last reading is updated. This is
available after the device has successfully connected.

. Ae - Select the value of deltaE to display for when comparing measured colours with those in a loaded set. This
is used in conjunction with the Show All Swatches option.

. Show All Swatches - Select this to view all swatches. By de-selecting this, only those swatches below or equal
to the deltaE value entered will be displayed. Colours within the defined tolerance values will show in blue.

Measured / Loaded Set Panels
The Measure and Loaded Set panels show the following information:

. Colour - A swatch visually representing the colour.
. Name - The name of the colour. This can be edited by clicking in the name field.
. Values - the Measured (Lab) values of the colour or the (colourspace specific) values of the Loaded Set colour.

The Measured Panel displays these additional data fields:

. Lch - the Lch values of the measured colour.
. Lab (above the list) - shows the Lab values of the currently selected measured colour.
*  Xyz (above the list) - shows the xyz values of the currently selected measured colour.

In addition, the Loaded Set panel displays the following:

. Ae/CIE94/CMC (1:1)/CMC (2:1)/Delta L/Delta a/Delta b - These columns list the relative delta’s of the loaded
set colours when compared to the selected, measured colour.

. Space - The colourspace of the colour (Lab or CMYK).

. Mode - The paint mode of the colour.

i Tint - The tint value of the colour.

. DotGain - The dotgain curve assigned to the colour (if any).

Export Menu
The Export menu allows for the measured values to be exported to a space or tab delimited file. Save all or only selected
entries and select the format for export:

. Lab - Export just the Lab values.

*  XYZ - Export just the XYZ values.

. Lab XYZ - Export the Lab values followed by the XYZ values on the same line.

*  XYZ Lab - Export the XYZ values followed by the Lab values on the same line.

. Separate Values With - Choose if the values are to be separated with spaces or tabs.

A contextual (right-click) menu in the Measured / Loaded Set panels has the option to Delete (a selected colour); Delete
All (measured colours); Print (the measured/loaded set to a system device); and Font Options.
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Studio o e e o e

The Studio application allows for the manual nesting or tiling of jobs
that are processed and output by Blackmagic.

Any jobs to be nested or tiled are submitted to an asset queue before
they can be used in Studio.

Unlike other queued jobs, assets exist only as placeholder thumbnails
until a nest or tiled job is submitted for printing from Studio.

Submitted assets are visible in the Asset Queue in the QueueManager
and remain, even after printing, until deleted via Studio or the
QueueManager. =

Studio Interface
Studio is made up of four (4) main sections:

Asset Panel - Displays any submitted asset files available for nesting and/or tiling.

Templates Panel - A list of available templates that can be loaded and modified from a library of saved
templates.

Media Panel - Define the printable media (paper) area for nesting and access tiling options.

Layout Area - Where any jobs (assets) are placed for nesting and/or tiling.

A toolbar is available for quick access to a range of options and functions listed in the Studio menus. The toolbar can be
toggled on or off and may be positioned at the bottom or to the right in the Studio screen (see Studio Settings).

Sections of the toolbar can be hidden by right-clicking on the toolbar and unticking the appropriate section.

& Bl 06 o0 = [H Alignment

O i - B Orientation, Rotation

'?E‘] L:E : Auto arrange with/without rotation
a8 o Lock / Unlock

ﬁ 4{1- ﬁ x @ Step & Repeat, Canvas Wrap, Marker, Crop mode, Box Properties, Clear Layout, Print

om
a0 Group / Ungroup
Q RA & @ 0O Zoom In, Zoom Out, Fullscreen, Fit All, Fit Tiling Document, Print Size, Fill with Tiling
N ¢ d
ocument
C Undo / Redo
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Asset Panel
The Asset panel displays all jobs that have been submitted as an asset to the Asset Queue. Any assets that appear may
be used in Studio for nesting or tiling. The assets are low resolution placeholder thumbnails
until such time as the nest is submitted for print. Place assets in the Layout area by selecting
from the list and drag+drop. Assets can be selected singularly or in multiples.

0837_Gpg

b s 422000

. List View - Display assets in text form (filename/jobname). A thumbnail preview of
the image will appear at the bottom of the panel when highlighted in the list.

. Small Thumbnail - Display the assets as small thumbnail images with the jobname
listed beside them.

. Large Thumbnail - Display the assets as large thumbnail images only. aQ

4242jpg

The Asset header bar has the following view options: . b

4283 jpg

A search field is available at the bottom of the panel. Enter text to find a jobname containing the search string. Non-
relevant assets are temporarily filtered out of the view as the string is typed. This search field will not be available
when Large Thumbnail view is selected. Clear the search box to view all assets again.

Templates Panel

Templates are a useful tool for anyone needing to make repeat prints using a specific layout for
the available media. Studio gives users the opportunity to create and store a library of templates,
set to specific sizes, styles and orientations.

Loading Saved Templates
Templates (nesting layouts) can be loaded from the template library by double-clicking the name of the saved template.

Assets dragged in to an empty frame are resized to fit or fill, are rotated and cropped according to the frame settings. A
single asset dragged in to a selected frame grouping will be duplicated and placed into every frame within the group.

Creating Templates

Templates can be created from an existing asset file or by utilising the Step and Repeat function within Studio. Both
methods are outlined below. Media dimensions, guides and frame positions are saved.

Create a Template from an Existing Asset

. Select Submit menu > Files as Assets to add the job as an asset.

. Navigate and select any files to use in Studio. Once the asset appears in the Asset panel they are ready to be
used.

d Select an asset and drag+drop it in to the Layout area.

. Adjust the size and properties for the frame if required. The frame may be copied and pasted in the Layout area
for quick duplication, or use the Step and Repeat function.

. Save the template when finished. This does not save the images within the frames, only the empty frame and its
various properties. The saved template will appear in the Templates list. Click the text to rename as required.

. To load the template, double-click the name. An empty frame set of the nest will appear in the Layout area,
ready to accept any asset files dropped in to the frames.

Create a Template using Step and Repeat o —
Frame Width: [7.0 in
*  Go to the Frame menu > Step and Repeat option, or select the Step and Repeat icon Frame baight: 501
in the toolbar. Hertzoral Repest 1
*  Enter the required dimensions, spacing and number for horizontal and vertical L
distribution. Frames will automatically appear in the Layout area as values are trsimilo 07 s
entered. e i) @)

i Select OK when done.
. Select single or multiple frames and adjust their properties as required via the Box Properties option.
. Save the template when finished and rename it as required.

Note: If the Step and Repeat function is used when there are multiple frames selected with varied sizes, all frames will
be repeated in the Layout area. The size dimensions in the Step and Repeat window will not be editable.
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Media Panel
The Media panel is used to configure the onscreen representation of the printer media as a guide for job placement in
the Layout area.

Layout Area
The Layout area is where any jobs (assets) are placed for nesting or tiling.

The area is surrounded by a ruler, marked with the user-defined measurement
units and appropriately scaled to the current zoom level. All assets and frames are
shown at accurate, relative size.

The dark gray area is the work surface onto which assets are placed and positioned.
The lighter gray area is the defined, printable media area (see Media panel). When
Tiling mode is enabled, the edges of the total area to be tiled appear on the work
surface as a red outlined box.

Media

Page Size - Select a pre-configured page size from the dropdown menu or
enter custom dimensions.

Manage Custom Sizes - This option allows users to create and manage custom TR 12010
page sizes for use in Studio. Any page sizes created here will also appear in Heignt: |12.01n
the Media > Cut Sheet page size options in the Workbench and in the
Signature Groups > Grid page size section.

Width - The width of the media being used for printing. If Tiling mode is
enabled, this is also the tile width.

Height - The height (length) of the media being used for printing. If Tiling mode is 4 -
enabled, this is also the tile height. Note: The Height can be left at zero (0) when
using roll media as the Layout paper guide will automatically adjust the length as

Page Size: Custom

Tiling:

O Tiling Settings

assets as placed. If set to 0 when tiling, the height will snap to the image placed in e

the tiling area. Heignt: [0.0in

Tiling - Enable / disable Tiling mode. Click the Settings button to configure Tiing Overiap: (0.3937 in
options.

Set‘:jmgs - Opens document settings which must be configured when using Tiling Concer) (GEEN
mode.

Width - Total width of the area to be tiled. This is a required field.

Height - Total height (Iength) of the area to be tiled.

Note: The height can be left at 0 in which case the document height will snap to the image placed in the tiling
area.

Tiling Overlap - Enter the image overlap amount for each tile.

Menu Options
Studio Menu

Save New Template - Saves the current frame layout to the template library. The template can be renamed by
clicking on the “Untitled” text. Only empty frames are saved, not the images within them.

Save Template - Saves the current nesting layout to the selected template in the library, overwriting any
existing data.

Remove Template - Remove the selected template from the library list.

Export Template - Export a saved template or templates to a user-defined location.

Import Template - Import saved templates. The imported template, or templates if multiple layouts exist in the
file, will appear in the library list when loaded.

Print / Print Tiles - Displays a chooser window to select a Media and Pagesetup combination to send the job to
for processing.

Studio Settings

Cloak Submitted Frames - Locks images and frames after they have been submitted for processing, preventing
changes. Cloaked images will appear shadowed.

Auto-place - Allows for automatic placement of assets on to the Layout area when dragging and dropping
them. The default position is top left (0,0). If a job has already been placed in the area, the auto position will
align with the left side of the frame.

Frame Spacing - The distance (gap) between jobs being auto-placed in the Layout area.
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. Minimise Cuts for Auto-arrange - Aligns auto-arranged frames in a way that minimises the number of
horizontal and vertical cuts required to separate the individual jobs after printing. This option may use more
media (paper) when nesting.

. Snap to Grid - Allows for assets to snap to a user-defined grid spacing,
measured from the left ruler. The asset frame will snap to the closest
defined grid position, taking into account any auto-place spacing

8.0 0 Studio Settings

Cloak Submitted Frames |

Settings. Auto-place [V

*  Grid Size - Define the snap-to-grid size for frame placement in the 00
Layout area. Minimise Cuts for Auto-arrange [V

*  Cropmark Type - Select the type of cropmark to apply to any cropmark Snap To Grd |
enabled frames. Choose from Default (Standard), Paper-saving or Grid Size 0.0in
Border. —

. Visual Warning - Enabled by default. Options include:

. Overlap - Display a dashed line around any assets placed in the Layout Visual Warming ggt:xwms
area that have overlapping frames. =

o Out of Bounds - Display a dashed line around any assets placed in the Tooloar | Bottom

Layout area that are outside the defined media.
. Toolbar - Set the location of the toolbar to either bottom (default) or
right side of the Studio screen.

Cancel | | OK

Edit Menu

. Undo - Undo the last change made. The amount of available undo levels is configured via the Client Settings (0
= Operating System default level).

. Redo - Redo the last undone change. The amount of available redo levels is configured via the Client Settings (0
= Operating System default level).

. Cut - Cut the currently selected frame to the clipboard.

. Copy - Copy the currently selected frame to the clipboard.

. Paste - Paste the frame/s in the clipboard to the Layout area. Paste is centred at the current mouse pointer
position.

. Delete Assets - Delete any selected assets from the Studio application and the Asset Queue.

. Delete Layout Assets - Delete any assets currently in the Layout area from the Studio application and the Asset
Queue.

i Create Crosshair (SHIFT+1) - Create a frame in the Layout area containing a configurable crosshair. Click on
the E box within the Frame panel in the Box Properties window to view further options.

. Create Horizontal Line (SHIFT+2) - Create a frame in the Layout area containing a configurable horizontal line.
Click on the E box within the Frame panel in the Box Properties window to view further options.

. Create Vertical Line (SHIFT+3) - Create a frame in the Layout area containing a configurable vertical line. Click
on the E box within the Frame panel in the Box Properties window to view further options.

. Create Colour Box (SHIFT+4) - Create a frame in the Layout area containing a configurable colour. Click on the
D box within the Frame panel in the Box Properties window to view further options.

Note: For all Create options a 1x1 inch frame will appear at the current mouse pointer location if using the shortcut
keys. If selected from the menu, the frame will appear in the centre of the current Layout view.

Frame Menu

. Bring to Front - Move the selected frame to the front (top) layer of the nesting layout.

. Bring Forward - Move the selected frame one layer forward (up) in the nesting layout.

. Send Backward - Move the selected frame one layer backwards (down) in the nesting layout.

. Send to Back - Move the selected frame to the back (bottom) layer of the nesting layout.

. Edit Crop - The selected frame will enter Crop mode. Double-clicking on a frame will also enter Crop mode.

. Group - Group multiple selected frames for movement, deletion, locking or asset multi-drop. Grouping is
ignored if auto-arrange/ auto-arrange with rotation are used.

. Ungroup - Ungroup any currently grouped frames.

¢ Align Left - Align selected frames along the left edge of the leftmost box in the selection.

*  Align Right - Align selected frames along the right edge of the rightmost box in the selection.

. Align Top - Align selected frames along the top edge of the uppermost box in the selection.

¢ Align Bottom - Align selected frames along the bottom edge of the lowest box in the selection.

*  Align Horizontal Centre - Align selected frames along the averaged horizontal centre line of the frames.

*  Align Vertical Centre - Align selected frames along the averaged vertical centre line of the frames.

. Orient Up / Down - Alter the frame orientation to either upright or upside down (180 degrees).
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Orient Right / Left - Alter the frame orientation to either right or left by 90 degrees from the upright position.
90CW - Rotate the frame and contents 90 degrees clockwise.

90CCW - Rotate the frame and contents 90 degrees counter-clockwise.

Lock - Lock the selected frames. Locked frames appear transparent and cannot be edited until unlocked.
Unlock All - Unlock all currently locked frames.

Decloak All - Decloaks all frames. Allows for movement, deletion or editing of frames that were locked/cloaked
after submission (only available when Cloaking mode is active).

Select All - Selects all frames in the nest layout area for grouping, ungrouping, movement, locking or deletion.
Frame properties may be adjusted and will affect all selected frames and their positions within the Layout area.
Select Inverse - Deselects currently selected frames while selecting all previously unselected frames.

Step and Repeat - Create a set of user-defined frames for image placement, oar copy dimensions of existing
frames and repeat them across and down the Layout area. Step and Repeat can also be used to create an empty
template. If an asset is placed into a frame prior to step and repeat, both frame and asset are repeated when
selected.

Auto arrange - Automatically arranges (nests) the images placed in the Layout area to fill the media
dimensions.

Auto arrange with Rotation - Automatically arranges (nests) the images placed in the Layout area to best fill
the media dimensions by appropriately rotating the frames.

View Menu

Zoom In - Zoom in to the Layout area view. Holding down Z+left click will also enable this mode.

Zoom Out - Zoom out of the Layout area view. Holding down Shift+Z+left click will also enable this mode.

Note: Holding down CMD (Mac) or CTRL (Win) and scrolling the mouse wheel over the image will allow for
zoom in and out functions.

Fit All - Scales the Layout area view to show all frames currently in the nest.

Fit Tiling Document - Scales the Layout area view to show all assets and frames within the dimensions as
defined in the Media Panel > Tiling Options.

Print Size - Shows the nest in the Layout area at actual print size.

Fill with Tiling Document - Scales the Layout area, filling the view to the shorter width or height dimension as
defined in the Media Panel > Tiling Options.

Clear Guides - Clear any guides from the Layout area.

Guides - Enabled by default. Create a guide by clicking in the horizontal or vertical ruler section of the Layout
area and dragging the guide to the desired location. See the “Guides” section for further information.

Box Properties - Popup a floating window displaying the Frame and Contents properties for any assets and
frames placed in the Layout area. The window can remain open, floating above any assets for quick access to
precise editing of frames and images. See the “Frames vs Content” section for further information.

Clear Layout - Clears the Layout area of all frames and assets, including resetting the Media panel dimensions.
Full Screen - Toggle between a windowed or full screen view.

Sidebar - Toggle the view of the sidebar containing the Asset, Template and Media panels.

Section Headers - Toggle the headers of each section within the sidebar on or off.

Toolbars - Toggle the toolbar on or off. Select which sections of the toolbar to show or hide by
ticking/unticking the available sections.

As an added option, holding down the spacebar will allow for panning around the Layout area when moving the mouse,
similar to navigation used in graphics applications. The mouse cursor will change to a hand when this mode is enabled.

Guides

Guides are a useful tool when placing asset images into the Layout area for printing. Enabled by default, guides are
created by clicking in either the horizontal or vertical rulers of the Studio Layout interface and dragging a guide in to
the desired location. Guides are saved with a template design in the library.

To move or reposition an existing guide - CTRL (win) / CMD (mac) + click on the guide and drag it to a new
location.

To snap guides to grid - CTRL / CMD + shift + click on the guide and drag it to a new location. The guide will
snap to the closest grid point.

To remove all guides - Select View menu > Clear Guides.

To remove a single guide - CTRL / CMD + click on a guide and press delete (not backspace), or CTRL / CMD +
click + drag the guide back in to the appropriate ruler.

To enter a precise location for a guide - CTRL / CMD + double-click on a guide to open a dialog box and enter
the ruler location for either horizontal or vertical guides.
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Note: If Guides and Snap to Grid are both active, the asset frame will snap to the guide first if the frame edge is closest,
otherwise it will snap to the grid point. Guides are ignored if Auto arrange or Auto arrange with rotation options are
used.

Frame vs Content
Assets placed in the Layout area are always contained within a separate frame.

The Frame controls the size, position, style and orientation. All frames will have a floating info bubble on the
top right side displaying the width and height dimensions of the frame, plus the orientation. This is viewed
when selecting a frame or hovering the mouse over it and will update dynamically when resizing with the
mouse.

The Content relates to the actual asset placed inside the frame. If an asset is dropped into the empty Layout area, it is
automatically assigned a frame.

Both Frame and Content can be edited via the Box Properties popup window.
Frame Properties

. Left - The offset distance of the frame from the left guideline. Offset is measured from the top left corner of the
frame.

. Top - The offset distance of the frame from the top guideline. Offset is measured from the top left corner of the
frame.

. Width - The width of the frame. This field will lock when Canvas Wrap is
selected. £

. Height — The height of the frame. This field will lock when Canvas Wrap is Lo [ooid
selected.

. Lock Button - Locks the current proportions of the frame size if resized along R oo o
one dimension. The locked proportions are overridden by free resizing with the 3

Hoght [8setsn
mouse within the Layout area. Frames can be unlocked and resized to any C,o,m:ksv C
required dimension. Overpint: |

. Cropmarks - Enable to add cropmarks (as defined in Studio Settings) to the Stye: | Frame
selected frame. Cropmarks are enabled by default when Canvas Wrap mode is in
use.

. Overprint - Enable to convert the selected frame to overprint mode. Not available when using Canvas Wrap.

. Style - The style of frame, for example, Frame, Canvas Wrap or Marker. Click the ... button to configure options
for Canvas Wrap and Marker modes.

. Canvas Wrap - Convert the selected frame to a canvas wrap. Configure properties via the ... button.

. Marker - Convert the selected frame to a marker. Configure properties via the ... button.

Content |

Top: |0.0in

Content Properties

Content within Studio refers to the actual assets placed within a frame. Content is e [0
editable when in Frame and Canvas Wrap modes. It is not available for Marker mode. Top: 0.
Width: 55833
. Left - The offset distance of the asset image from the left edge of the frame. This . =

Height:  8.3646

is available when in Crop mode. ——

. Top - The offset distance of the asset image from the top edge of the frame. This v
is available when in Crop mode. g

. Width - The width of the asset within the frame.

. Height - The height of the asset within the frame.

. Lock Button - Locks the current proportions of the content if resized along one dimension. The locked
proportions are overridden by free resizing with the mouse. Content can be unlocked and resized to any
required dimension when in Crop mode.

. Scaling - The method of scaling used for an asset placed within a frame.

o None - The asset is shown at actual size inside the frame, irrespective of what size the frame is.

. To Fit - The entire asset image is rescaled and shown within the frame proportions.

i To Fill - The asset expands to fill the frame, scaling to show as much of the image as possible given the
proportions and centring options of the frame.

. Custom - The dimensions and frame offset for the asset are independent of the frame (similar to Crop mode).
This method is automatically selected when in Crop mode.

Centring:
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Centring - When enabled, any selected frames will have their asset centred within the frame. This is useful for
reverting to the original placement when undoing any cropping.

Orientation - The angle applied to the content (asset) within the frame. If custom scaling is used and the asset
has different dimensions to the frame, only the asset orientation will be adjusted.

Canvas Wrap
The Canvas Wrap mode allows for the asset to be transformed in to a canvas print, ready for stretching around a
wooden (or other) frame.

Cropmarks are enabled by default when Canvas Wrap mode is in use. This is to assist in cutting the canvas. Set the type
of cropmark to be used in Studio via the Studio Settings option.

Note: Cropmarks (Standard) will take up extra space around a job when selected for use, changing the position of the
job on the media and the total size of the job once rendered. Paper-saving cropmarks will not expand the overall
rendered job size.

Canvas Wrap Options

Front width — The width of the front of the canvas.
Front height - The height of the front of the canvas.
Frame thickness — The thickness of the canvas frame (wooden or other). The

default size is 1.25in. e (=
Back wrap - The length of canvas to wrap around the back once the canvas is
stretched around the frame. The default size is 20mm. This will remain as an e

unprinted area unless Print Back Wrap options are selected.
Print Back Wrap - Prints the currently selected wrap style to the back wrap in

addition to the frame sides of the canvas. I
Wrap style - The style of canvas to create. Further options are:
Gallery - This is the default canvas style, stretching the image to expand to the Cunce | [ Soe | (BT

frame thickness as defined.

Mirror - Mirror the edges of the image to the frame thickness as defined.
Colour - Select a colour to fill the frame thickness as defined. Double-click the colour display box to select a
colour from a Special Colour Set (Blackmagic only), or create a colour using the Lab, CMYK or RGB sliders.
Note: If the colour selected does not match the colourspace of the image, a preview will not be available for
viewing using the SoftProof application.

Pick from screen (eyedropper button) - Activates an eye-dropper tool to select a screen/image colour to apply
to a Colour wrap style. Hover the pointer to see RGB values and a colour swatch of the current colour. Left-click
to select. This option is only available when using RGB as the selected colourspace.

Save - Saves the Canvas Wrap configuration but will not change the size of the asset (image) to fit the
dimensions specified if they have been altered.

Fit & Save - Fit the asset to the configured Canvas Wrap settings and save the layout, returning to the Studio
screen.

Note: If multiple canvasses are to be printed, a quick and easy method of duplicating a finished canvas is to use the Step
and Repeat function.

Marker
The Marker mode allows for the placement of a frame containing a style of marker in the Layout

area.

Crosshair (Shift+1) - Create a frame containing a configurable crosshair.
Horizontal Line (Shift+2) - Create a frame containing a configurable horizontal line.

Crosshair (Shift+3) - Create a frame containing a configurable vertical line.

Colour Box (Shift+4) - Create a frame containing a configurable colour.

Note: For all create options, a 1x1 inch frame will appear at the current mouse pointer position if using the shortcut
keys. If selected from the menu the frame will appear in the centre of the screen.
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When in Marker mode, click on the ... box within the Box Properties popup window to view settings for each marker

style.
Options include:

. Marker Type - Select from Crosshair, Horizontal Line, Vertical Line or Colour Box.

. Line Thickness - Set the thickness of the line for Crosshair, Horizontal and Vertical Line options. Does not apply
for Colour Box.

. Line Colour - Select a colour for the line or box as selected above. Double-click the colour display box to select
a colour from a Special Colour Set (Blackmagic only), or create a colour using the Lab, CMYK or RGB sliders.

. Pick from screen (eyedropper button) - Activates an eye-dropper tool to select a screen/image colour to apply.
Hover the pointer to see RGB values and a colour swatch of the current colour. Left-click to select. This option
is only available when using RGB as the selected colourspace.

Note: If the colour selected does not match the colourspace of the image, a preview will not be available for viewing
when using the SoftProof application.

Important: If a frame is selected in the Layout area and Marker is chosen from the Style dropdown menu, the frame
and image within will be replaced with the selected Marker.

Using Studio
Positioning Assets for Nesting

A media guide sheet will appear to scale (in light gray) in the Layout area when width and height dimensions have been
entered in the Media panel. This allows for clear and simple placement of assets for nesting.

When submitted to print, everything on the media guide sheet is printed. If only a width is entered (for example, using
roll media), once an asset is placed in the Layout area the media guide sheet will automatically lengthen to fit the job. As
more assets are placed, the sheet will extend to display the total nesting area.

Note: It is not necessary to have dimensions entered for the media when creating a manual nest in Studio. When
submitted, the nest will print to the selected media from the top left origin point, printing as much of the width or
length of the nest as the paper in the printer will permit. The remainder will be cropped.

Creating a Nest
Studio allows for single or multiple assets to be dropped in to the Layout area.

. Select the assets (jobs) from the Asset panel.

. Drag and drop the assets in to the Layout area. Assets will appear at their native size unless placed in an empty
frame with specific properties (via template or Step and Repeat).

. Resize and adjust the frame and asset as required. This can be done via the Box Properties window or by using
the following mouse options:

J Left click (on a frame) - Selects the frame for editing, movement, locking or deletion. Selected frames are
highlighted by a magenta border.

. Left click (on empty Layout area) - Deselects all frames.

. Left click (hold) + drag (on empty Layout area) - Creates a temporary framing box for selecting multiple
frames. Any frames wholly or partially within the box when the mouse button is released will be selected.

. Left click (hold) + drag (on a frame) - Moves the selected frame around the Layout area. Release the mouse
button to drop and place the frame.

. Right click - Opens the contextual menu with options, depending on where in the Layout area the click
occurred.

. Double click (on a frame containing an asset) - Activates Crop mode for the selected frame. A frame in Crop
mode will appear with a green border (see Cropping Assets for more information).

d Spacebar + Left click (hold) - Activates the Grip tool which allows for panning around the Layout area. The
mouse cursor will change to a hand when in this mode.
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Resizing Options
The following resizing options are available when clicking at the borders of a frame.

. Left click + drag - Enlarge or shrink the frame. Proportions are maintained. Resize is anchored at the opposing
edge or corner of the frame.

*  ALT + Left click + drag — Enlarge or shrink the frame. Proportions are maintained. Resize is anchored at the
centre of the frame.

. Shift + Left click + drag - Free resizing of the frame, ignoring locked width/height ratios. Assets within the
frame will fit or fill the resized frame depending upon frame settings. Resize is anchored at the opposing edge
or corner of the frame.

. CTRL + Left Click + drag (Windows) - Snaps the frame proportions to the asset’s native proportions and
resizes. Resize is anchored at the opposing edge or corner of the frame.

. CMD + Left click + drag (Mac) - Snaps the frame proportions to the asset’s native proportions and resizes.
Resize is anchored at the opposing edge or corner of the frame.

Cropping Assets

Crop mode is activated or deactivated by double-clicking anywhere within a
frame containing an asset image, or by selecting a frame and clicking the Crop
mode button in the toolbar.

When activated the frame changes from magenta to green and a second frame
with an orange border is assigned to the asset. Cropping can only be done one
frame at a time. Multi-select image cropping is not available.

. . . Asset before and after cropping
Either the frame or asset can be selected and moved, or resized as required.

Double-clicking the frames again will show how the asset will be cropped. If the frame is resized larger than the asset
within, the space around the asset will also be printed to the size of the entire frame.

Cloaking and Nesting with Large Format Flatbed Devices

One of Studio’s primary functions is the laying out of jobs for print using large
format flatbed printers.

When activated, the Cloaking feature locks images and frames after they have
been submitted as a nest to the printer. Cloaked images appear shadowed in the
Layout area, are static and non-editable unless decloaked. This allows for easy
placement and printing of new jobs on to blank, available areas of the flatbed
media. Cloaked images are not reprinted when a new nest is submitted for
printing.

Cloaking - Before and after submitting to print

If desired, it is certainly possible to place jobs over others that have already been printed. Any new image will print
exactly where it is placed, regardless of whether or not anything has already been printed in that area.

Important: The cloaking feature is disabled by default. It is not recommended for use with printers using roll media
unless the device has the ability to roll back to previously unused areas of media.

Tiling with Media
Studio’s tiling feature allows users to set the total document area and automatically create a tile grid based on pre-
configured print media dimensions and overlap.

Tiling is useful for billboard printing, or any type of printing where the image is larger than the available print media
(paper). ‘ — '

To tile a job:

e Activate the Tiling mode by ticking the Tiling option in the Media
panel.

. Click on the Settings button to configure the tiling parameters.

. Enter the width and height (optional) of the area to be tiled. If a height
is not entered the tiling document height will automatically match the
height of the asset to be tiled.

. Enter any overlap size if required.
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In the Media panel, enter the width and height (optional) of the printer media to be used. This is the tile size. If
a height is not entered, such as when using roll paper, the tile height will match that of the tiling document.

The tiled area will be outlined by a red border.

Once tiling has been configured, place the asset to be tiled in the Layout area and resize as required.

Submit the job to print when ready. The print option will appear as Print Tiles in the Studio menu.

Note: Cropmarks and alignment marks are automatically added to any tiling jobs when submitted via Studio.

Studio Rendering Effects
There are various rendering effects available when using Studio. They will not be visible in the Layout area and will
only affect the job when it is rendered, ready for printing. Any effects can be previewed using SoftProof once the job has
been rendered and nested.

The available rendering effects are:

Cropmarks - Available as a checkbox within the Studio application. Enabling this will place cropmarks around
the selected frame. This effect will adjust the placement of the job on the media to compensate for adding
cropmarks during the rendering phase. The type of cropmark to be used is configured in the Studio Settings.
Convolution Matrix - Available via the Jobticket (see Workbench data types). Allows you to design your own
filter effect according to a pre-defined mathematical operation known as convolution. This effect is not
available when using the C5 Client.

Image Overlay - When enabled, this effect allows a Blackmagic Image, JPEG, PNG, PPM, Photoshop or TIFF file
to be placed anywhere on the job. Settings include width, height and opacity for the overlayed image plus
options to allow it to stretch and rotate with the job. Available via the Jobticket.

Mirror - Available via the Jobticket. Mirrors the job.

Negative - Available via the Jobticket. Allows for the job to be negated or inverted. Useful for printing to film
using a white ink printer.

Watermark - Available via the Jobticket. Allows for the placement of a watermark across the job. This effect is
not available when using the C5 Client.

ColourKeys and Screenprinting mode are also available when using Studio, accessible via the Jobticket and Media used
for processing the job files.
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Touch Console

The Touch Console application offers enhanced control and usability of the SoftProof application through the use of a
touch screen. Ideal for press room environments, the separate touch screen acts as the console, controlling jobs that are
loaded and softproofed on the main screen. Individual jobs or entire publications can be quickly located for proofing.

A Touch Console Settings menu saves valuable time, enabling the operator to choose default navigation options; the
queues the Touch Console will search for jobs; and whether the console switches automatically to the Main control
screen, the SoftProof view navigator, or the page navigator (for publications) once a job or jobs have loaded.

A Mode Bar allows instant switching between control
interfaces from the main Image and Navigation control,
through to Ink Keys and Channels; the Virtual Loupe;
Press Configurations; Page Navigation; Notes and
Tabbed Views.

When the Touch Console is launched, a blank screen
will appear on both monitors (the touch screen and the
main monitor) with instructions to select which
monitor is the touch screen. Simply touch whichever
screen is to be the Touch Console to begin.

The Interface

The interface occupies the whole of the touch screen. ‘ """ =

At the top is a banner advising which section the user is

in at the time. The title banner will change to reflect the different modes in use. The bottom of the screen displays the
various modes to use with SoftProof. Return to the starting point at any time by pressing the Home button.

Using the Touch Console
When first starting, Home is the default position. View the jobs in the system by selecting one of the mode buttons along
the bottom of the screen:

. Publications - View a list of jobs that are part of a publication only.

. Books - View a list of jobs that make up a Book as defined by the Bookfilter and BookMonitor application. This
is available for Veripress/Blackmagic Softproofing Add-on Only.

*  Jobs - View a list of jobs that are not part of a publication only.

*  All-View alist of all jobs in the system.

. Search - Open a virtual keyboard on the touch screen allowing a character based search of all available jobs,
publications or books. See TouchConsole Menu > Search Order for details on setting which job types are
available to search. Note: The Search virtual keyboard can be configured to other input languages (see Touch
Console Settings). The default input language of the operating system must be set to the same language.

Note: Search strings can include one of more asterisk (*) wildcard characters to search for publications/books/jobs
using partial matches. The asterisk (*) is accessed via Shift+8 on the virtual keyboard. For example, ‘daily*08’ will
display any matches including ‘daily’, ‘08’ with anything in between the two, whereas ‘daily 08’ would only show results
including that exact string.

Jobs must be in the print queue to be displayed, i.e., they must have completed rendering. It will not show any jobs
Waiting to Render or in a Held status.

Once a mode has been selected, the screen will change to display the appropriate list of jobs with the available sorting
and viewing options:

Sort Name Sort Name Sort Time Sort Time View

Ascending Descending Ascending Descending EImEeE Rendered \View/Filpbook

Actions available include:

. Select - Touch your finger on a job in the list and it becomes selected. The mode options change to display View
Imaged, View Rendered and View Flipbook.
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Scroll - Touch your finger on the list and drag it up or down the screen. Lift your finger off and position it again
to scroll further.

Fast Scroll - Touch your finger on the list and drag it fast up or down and let go in a “throwing” action. To stop
the list at any point, touch a job on the screen.

Scrollbar (optional) - If enabled, drag your finger down the overlaid scrollbar to move up and down the list.
Moving your finger left-right will change the position of the scrollbar itself.

When the required job has been located and a viewing mode selected, the Touch Console will open the Main, Navigate
or Pages control panel.

Main Navigate Loupe Press Config Show Pages Show Tabs Calibrate Close

Actions and modes of the Touch Console will adjust to give the options normally associated with the SoftProof
application. Selecting View Flipbook will load the job into the standard Flipbook application with relevant actions and
modes on the Touch Console.

Modes available include:

Main

Main - The default main screen displayed when a job is first loaded. This is a control screen for macro-
manipulation of jobs. Includes functions such as image inversion and rotation, back page show through, image
size on screen and so on.

Navigate - A control screen for closer examination of proofs - features controls for the viewed image size (fit
width/height, original 100%, printed size) and zoom controls.

Loupe - Opens the Virtual Loupe on the main screen, with controls for the Touch Console.

Press Config - Opens a list of available Press configurations to apply to the SoftProof. This will switch to
Camera Config when an RGB image is opened.

Show Pages - Opens a modified Page Navigator for instant page-to-page viewing.

Show Tabs - Displays a list of job currently loaded in SoftProof Tabs.

Calibrate — Opens a control screen with Calibration and Calcheck options for the main SoftProof display.

Close - Closes the current job, publication or tab.

A job can be manipulated in various ways once loaded, just as with the conventional controls for the SoftProof
application. Some actions will only apply if certain types of jobs are viewed. The actions are colour coded to help group
them into like actions. Buttons can be shown or hidden using the Touch Console settings.

Text Tab Image Tab Tools Status Full Screen & Window / Display
e £ SO T wiror | | Asocrop | | sueie | | IV, < Image manipulation
"‘w“""" Next Page. Notes ) Next Tab & Navigation

< Overlaying objects &

Page

Boundary viewing publications

Show Sl | ..o | I e < Fitting methods & tools

Channels Pixels

Text Tab - Toggles the text job name tabs for multiple loaded images in the SoftProof screen.
Image Tab - Toggles the job thumbnails in the SoftProof screen.
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. Tools - Toggles the Tool Palette in the SoftProof screen. The Palette must be enabled in the SoftProof
application for this to function.

. Status - Toggles the status bar in the SoftProof window. Note: If the monitor is Calcheck Managed and the
current Press has a Calcheck fail (red cross) status, the Status Bar cannot be hidden.

. Full Screen - View the SoftProof window in full screen view or the user-defined view.

. 90 CW/180/90 CCW/ - Rotate the currently viewed proof in the desired direction.

. Invert - Invert the image displayed.

. Mirror - Mirror the image displayed.

. Auto Crop - Remove white space from around a job. There must be a completely clear area on any one side of
the job.

. Blueline - Replace all colours with varying shades of blue to see any traps.

i Revert Channels - Revert to the original channel values.

i Previous/Next Page - Move to the previous or next page when viewing a publication.

d Notes - Show or hide any notes embedded in the job (see SoftProof - Notes for more information).

d Previous/Next Tab - Move to the previous or next tab when viewing multiple tabbed jobs.

i Page Boundary - Toggle a red line showing the page/image boundary of the proof.

d Signature - Overlays the signature used to de-impose the job/page if it was submitted for de-imposition. This is
only enabled when viewing a de-imposed job/publication.

. Deimposed Pages (Veripress/Blackmagic Softproofing Add-on Only) - De-impose a job submitted as an
imposition on-the-fly into separate pages, defined by the signature attached to the job and return it to its
original state. (see RIPMonitor - Submit as Imposition for more information).

. Back Page - Display the reverse (back) page through the page currently loaded as if the final print was being
held up to light. The Back Page Opacity setting in the Press Settings controls the amount of show through.

. Spread - View the spread of the selected page, for example, pages 2 and 3 as a spread.

. Show Channels - Opens a simplified Channel Viewer touch console interface, featuring a coloured and labeled
button for each process and spot ink channel. Selecting each button will toggle the ink channel on or off. If the
Channel Viewer (see SoftProof) is open, the channel’s on/off state will be reflected in the panel. Touch the Main
button in the Mode Bar to return to the Main screen.

* Ink Keys - Opens the Ink Key Viewer for the current proof on the main SoftProof display. A custom set of
controls on the Touch Console allows for switching between Channels and Keys with ease. The following
control buttons are available:

. Excess Ink Area - Displays areas exceeding the Maximum Ink Weight setting as defined in the currently
selected Press configuration.

. Sheet Placement - Toggles the Sheet Placement view in the Ink Key Viewer, placing the page on the press plate
and displaying the Ink Keys as defined in the Press Config.

. Print Run - Opens a virtual number pad to enter the size of the print run. Used with Ink Weight to calculate the
total ink weight for the entire run of the page.

. Ink Weight - Opens a virtual number pad to enter the average weight of the process inks used in grams per
square metre (g/m2). Used with Print Run to calculate the total ink weight for the entire print run of the page.

. Calculate Ink Weights - Calculates and displays the total ink weight used for each process ink channel for a
complete print run of the loaded page. Totals are based on the entered Ink Weight and Print Run values.

. Find Note - If any Notes are attached to the currently viewed job/page/spread, this button will open a list of
the Notes in the Touch Console. Select a Note to navigate to its location on the proof. Finding a Note will toggle
the Notes button to show all notes.

. Show All - Show the whole job within the SoftProof window.

. Print Size — Show the job in the SoftProof window at print size.

*  Actual Pixels - Show the job in a one screen pixel to one job pixel ratio (i.e., 100% zoom).

. This view mode has the quickest load time as no resampling for
scaling is required.

*  Fit Width/Height - Fit the job to the width or height of the
SoftProof window.

Navigate

In Navigate mode, it is possible to pan around the image and change the
zoom or fitting method. A thumbnail of the image is loaded into the centre
action area of the console.

Touch the thumbnail to jump to that location on the image in the
SoftProof; or touch-drag around the thumbnail to pan around the proof.
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On either side of the thumbnail are Touch Console buttons controlling the scaling of the softproof on the main display,
including Full screen/100% (actual pixels), Fit Width/Fit Height, Zoom Out/Zoom In, Show All/Print Size.

Optional Previous Page/Next Page buttons are also available if selected in Touch Console Settings - Navigate option.

Loupe

The Loupe mode positions a loupe on the SoftProof window. The Touch Console action pane acts like a drawing tablet.
Touch and drag your finger on the touch screen to move the loupe over your image.

Buttons around the edges of the console control the Loupe’s features:

Smaller / Bigger - Decrease or increase the size of the loupe.
Zoom In / Out - Increase or decrease the magnification of the loupe.

For Veripress/Blackmagic Softproofing Add-On users only:

Solo Previous / Next Channel - These controls allow individual Ink Channels of the job to be viewed within the
Loupe, acting as the Show Channels function. The buttons cycle through each individual channel then show all
channels (default view).

Toggle HUD - Toggles the Heads Up Display in the Loupe window, showing the CMYK dot percentages at the
centered cross-hair or within the average % box.

Screened Pixel Readout - Toggles the HUD between cross-hair point measurement of ink percentages and a
square for measuring area average dot percentages. The square resizes depending on the zoom % to always
cover an area equal to a full halftone cell at the LPI defined in SoftProof Settings.

Calibrate
The Calibration control screen allows operators to initiate Monitor Calibration and Calchecks for the main SoftProof

display.

Calibrate - Opens the Displays application and begins the calibration process for the main SoftProof display.
Once calibrated, the monitor ICC profile is automatically saved as the operating system default, replacing the
previous ICC profile.

Note: When calibrating or calchecking, the Spectrophotometer assigned in the Displays application for either
task should be connected and ready for use. If the instrument is different to the assigned one an error will
occur, ceasing the operation. It is recommended to check the appropriate Spectrophotometers have been
assigned before using the Calibrate or Calcheck functions (see Applications > Displays).

Calcheck - This option will open the Displays application, starting a Calcheck of the softproof display to the
standard patch set in the chart assigned to the current Press. On completion, the Calcheck status of the monitor
is updated with a tick/cross. This button is only available if the currently selected Press Config has an assigned
Calcheck Chart.

Note on Spot Colours: When performing a calcheck of the softproofing display, any special/spot colours included in
the currently loaded job are measured and included in the Calcheck for the purposes of a pass or fail.

View FlipBook (Veripress/Blackmagic Softproofing Add-On Only)
View FlipBook opens the selected publication or book in the FlipBook application. Once a publication is opened,
FlipBook controls will appear on the console:

View 3D - Toggle between 2D and 3D views. —

View Calendar - Toggle between left to right and calendar flip page l? r[ = m
turning. ) — —
Show Borders i | i il
Rendered Thumbnails - Toggle between imaged and rendered BBJ«— =

thumbnails for pages in FlipBook. -
Full Screen - Enable full screen mode. \L[
Decrement/Increment Start Page, Even/Odd Top Page, Read
Direction 1->2 / 2<-1 buttons.

Top Section and Page Navigator buttons allow sections of the -
FlipBook window to be toggled on or off.

Previous/Next Page - Flip through the pages.

Zoom In/Out - Adjust the zoom level of the loaded FlipBook.
Adjust Camera Angle - Toggle a popup slider to change the viewing angle.
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Reset Camera - Reset the camera to the default angle.

Main - Return to the FlipBook control panel screen.

Press Config - Change the press settings for FlipBook.

Pages - Open a Show Pages panel to skip to the desired page.
Close - Close the FlipBook window.

Touch Console Menu
The Touch Console menu has the following options:

Font Options - Control the font size for the Touch Console text.

Queue Order - Select which Output queues are made available for view/proofing in the Publications and Jobs
lists on the Touch Console.

Bookfilter Order (Veripress/Blackmagic Softproofing Add-On Only) - Select which BookFilter queues are made
available for view/proofing in the Books list.

Search order - Select whether Publications, Jobs, and/or Books are available to the search function in the
Home panel of the Touch Console. Search results are displayed grouped by search order, e.g. Books,
Publications then Jobs.

TouchConsole Settings - See below for more information.

Touch Console Settings — e
Default job viewing and touch screen navigation options can be configured using (G SchProot
the Touch Console Settings. There are two tabs - TouchConsole and SoftProof: Seroliar ™ cnable
() Default Left () Default Right
Touch Console Thumbnals 4 Publications ©jobs &4 AN
*  ScrollBar - Enable or disable the scrollbar and set the default side it Pl enoed adieed. 8 Stk
appears on (Right or Left). m::;:d — -
d Thumbnails - Enable or disable viewing thumbnails for Publications, R
Jobs or All selection lists. P p—
. View - Enable or disable View Imaged (default), View Rendered and/or e
View Flipbook options for opening jobs or publications for softproofing.
*  Note: If only one of the View Images or View Rendered is selected, the rvers T
Touch Console button will simply be labelled “View”. If all options are TowhConsoie TR
disabled, View Imaged will be selected as the default option. oy Seren On s (B
. Button Size - Set the size of the Touch Console buttons in mm/inches. M‘::::'v?.i:: (i
. Note: The Touch Console application must be closed and restarted for Ao o Pop At s
settings to take effect.
. Virtual Keyboard - Select an input language/keyboard layout for the
Touch Console search keyboard.
Cancel [ ok |

SoftProof

Entry Screen on Load - Select the control screen the Touch Console will default to when loading a new

job/page:

Main - The console defaults to the Main screen on load.

Navigate - The console defaults to the Navigate screen on load.

Pages - The console defaults to the Show Pages screen on load.

Navigate Option - Navigate Pages (checkbox) - Show/hide the Previous/Next Page buttons in the Touch

Console Navigate control screen.

Duplicate Page Settings (Veripress/Blackmagic Softproofing Add-On Only) - When viewing a publication with

duplicate (purple) pages, choose from these page load options:

Manual Select - When a page with duplicates is selected in the Show Pages screen, the page to view must be

manually selected. This is the default mode of a non-Veripress Touch e
I - |

Console.
Select Newest Page - Useful in publishing workflows where page A
updates/revisions are common. This option will automatically display the
latest version of the page.

Publication Load Page (Veripress/Blackmagic Softproofing Add-On Only) -
Set the page to be viewed on load when viewing a publication from the
following options:

Manual Select - When a publication is selected for softproofing the Touch
Console opens and the Show Pages screen allows the user to select the
page to be viewed first.
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First Available Page - Publications are loaded on the first available (lowest numbered) page.

Show Sections - When enabled, section buttons are displayed in the Touch Console Show Pages screen. This
function allows loaded multi-section publications to be viewed one section at a time, displaying the page range
within each section.

Note: An option to Edit the Touch Console User Interface is available via the File and contextual menus in the SoftProof
application for Veripress/Blackmagic Softproofing Add-On users only (below).

Edit Touch Console Ul - Opens an Edit Interface window to allow for the configuration of the enabled (visible)
buttons for control of SoftProof in the Main screen of the Touch Console.

Enable or disable buttons by selecting them. Those disabled will appear with a red cross and will be excluded
from the Touch Console when using it to view softproofs.

The Toolbar has a Preview checkbox, when ticked the edit interface will 10 e

show the Touch Console buttons as they will appear after saving. While in

Preview mode, the button titles can be edited to reflect local terminology.

Click on the text to open the name field. Hit Enter to save the name

change.
The Reset button re-enables all buttons and restores default button

names. » | [ ] [~

[¥<] (][] €] ]
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Serendipity Client Menu Items

The Serendipity Client menus provide access to direct job submission options, system settings and extra functions.

Application Menu (Windows/Linux) or Serendipity Client Menu (Mac OS X)

Preferences - Select this menu option to open the Client Settings (Preferences) for the Serendipity Client, containing
default values and preferences configured for the Client and its applications and modules. See the System Settings >
Client Settings section of this manual for further information.

Submit Menu
Submit Files
Select one or more files to send to a Media and Pagesetup for processing.

Selecting Open will present the Submit dialog window displaying a list of Pagesetups available. Additional Media and
Jobticket tabs are also displayed.

Choose the Pagesetup/Media and optional Jobticket combination to submit any files to for processing and click Submit.
The files will be copied into the system for processing.

Flow control can be enabled to hold the job after imaging or rendering. The number of copies can be set, or jobs can be
placed as pages in a publication.

Submit Window
The Submit window is comprised of a settings e o~ 0;:;:’ CUa N "
preview panel to the left; a main panel for Ut e G AT Ace ‘
selecting a Pagesetup/Media/Jobticket o fg"gﬁw
combination; and a submission control panel. Stos ol [ gggg?ﬁmj

RGE Input & tpson WI7900

mOnitons (ACODSRGR1998.icC & Epson7900HTM-luster
Selected Settings Preview Panel Press '{:,W," g;‘é}“;am

e cissns ||| @ Neoow wssna
This panel displays the currently selected i i & o e
Pagesetup, Media and optional Jobticket items. A i I ; g;:?g‘m“‘“
summary appears when a Jobticket is attached to T&c"?:“i“,m.mmm] i
display any custom settings to be used when
processing the job. T T e
B Flow Controt; () Hold atver imaging (¥ Hold after rendaring [ Nest (] Rotate 90

The panel can be hidden by clicking on the c QR a
information icon at the bottom of the screen. o 1877 Cance ] ([

Pagesetup/Media/Jobticket
The Pagesetup Panel lists all available Pagesetups. Select one from the list to submit a job.

The Pagesetup / Pool buttons (top right when in Pagesetup panel) toggle between available Pagesetups and Pagesetup
Pools. When Pool is selected the Media list button is disabled. Jobs submitted to a Pool always use the Pagesetup default
Media.

The Media Panel lists any Media items compatible with the selected Pagesetup. Select a Media to which the job will be
submitted. If a Media is not selected, the default Media shown in the Settings preview panel is used.

The Jobticket Panel lists all available Jobticket items. Select a Jobticket to use when submitting a job. If a Jobticket is not
selected, the default system settings will be used. If a Jobticket is already assigned to the selected Pagesetup, its settings
will be used.

A configuration (Edit) button is available within Jobticket to make any custom changes to an existing Jobticket, or to
create a new one. Options include:

. Defaults — Load the system default Jobticket settings.

. Save - Save the edited Jobticket to the database. A dialog box opens with options to save over the existing
Jobticket or rename it and save as a new one. Once saved, the user is returned to the Jobticket list.

. Discard - Close the Jobticket Edit window and return to the Jobticket list, discarding any changes.

. Done - Save the edited settings to a temporary Jobticket for the job currently being submitted.
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Submit Options
The lower section of the Submit window contains the flow control, copies and publication options available for any
submitted files.

Flow Control

. Hold after Imaging - Hold the job after the imaging stage has completed.

. Hold after Rendering - Hold the job after both imaging and rendering stages have completed.

. Nest - Submit the job for imaging and rendering then on to be nested with other jobs. Nesting criteria are
defined in the Output (see Workbench > Output).

. Rotate 90 - Rotate the job 90 degrees. This will override any rotation settings in a Jobticket.

. No. of copies - Enter the number of copies of the job to be output (printed).
. Lock button - Locks the number of copies to be output (printed) for any files submitted until unlocked and
changed.

Publication

. Publication Name - Optional. Enter a publication name to which the submitted file will be assigned. The job
will be viewable in the Publication view of the QueueManager.

. First Page - Enter the page number for the submitted file in the publication. If submitting multiple files the
page numbering will start at the defined page and increase sequentially for each job.

Submit - Press Submit to send the job for processing using the selected options.

Cancel - Cancel the job submission, closing the Submit window.

Note: The Serendipity Client stores the last Pagesetup, Media and Jobticket selections so they need not be selected
every time a job is submitted.

Submit Files For De-Imposition

Also available via the RIPMonitor, this option allows you to submit files directly for de-imposition, rather than from a
RIP queue. After selecting one or more files, the Submit window will appear to enable selection of a Pagesetup, Media
and optional Jobticket, or Pagesetup Pool. A Signature Group can also be assigned to de-impose the files (see
Workbench - Signature Groups for more information).

Submit Files As Imposition

Also available via the RIPMonitor, this option allows you to submit files directly as an imposition, rather than from a
RIP queue. This will submit an imposed job in its original form, but attaches a Signature Group (via popup chooser) to
allow the job to be de-imposed on the fly using the Deimposed Pages button in the Veripress SoftProof Touch Console
(see Touch Console for more information). Available for Veripress/Blackmagic Softproofing Add-On only.

Submit Files as Asset
Select files to send to the Studio application Asset queue. Submitted Assets appear in the QueueManager queue as
thumbnails, but are not processed until submitted for printing from the Studio application (see Applications - Studio
for more information).

Submit ICC Target

This is the standard option that should be used when calibrating a printer Media and submitting an ICC target to
generate an output ICC profile. Files submitted using this option utilise the Paper Profile, Linearisation LUT and
Correction LUT in the Media but are not ICC corrected.

Note: This is the standard option for submitting an (EPS or TIFF) ICC target chart used for creating an output ICC
profile when calibrating a printer Media.

Submit ICC Target Without Colour Correction
Submit an ICC Target to a selected Pagesetup/Media/Jobticket combination. All ICC options and colour correction
curves are disabled.
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Note: This option works in a similar way to “Submit ICC Target” however, all Linearisation data will be disabled at the
time of submission, unlike Submit ICC Target which enables colour correction curves. The job info will display
Calibration Target, ICC Disabled in the Properties field.

Test Prints
Send a Blackmagic Test Print to one or more Pagesetups/Medias. Select which test print(s) to submit by ticking the
checkboxes beside each file name in the Submission area of the Submit window.

Note: You can add your own files to the lib/testprints directory for use as test prints. Any files you have permission to
use that are placed in this directory will appear for selection in the Test Prints chooser window.

Test Prints as ICC Target
Submit one or more internal test images as an ICC target (as per option above). This allows users to store a commonly
used ICC Target chart in the “/lib/testprints” folder for easy access when calibrating Media.
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Server Menu

Server Settings

Select this menu option to open the System Settings (Preferences) for the Serendipity Server. The Systems Settings
section contains default values and preferences configured for the Server. See the Server Settings section below for
further information on each panel.

Connect to Server

This allows the Serendipity Client to connect to a Blackmagic Server running on the network. The Refresh button will
search for and display any active Servers. Alternatively, you can enter the name or IP address of the Server in the
Server Address field under the Manual tab.

If there are multiple Servers (Masters) running on the network, the list is cached on the first “Connect to Server”
selection. A dropdown list of available Servers is accessible via the Auto Detect tab. If a new Server appears after this
time, the Refresh button must be pressed to find and add it to the list. Likewise, if a Server becomes unavailable, the
connection will fail and the list will require a refresh.

When the Serendipity Client is started, it will attempt to connect to the last Blackmagic Server accessed by default.

Accounts Admin

Accounts Admin allows an authorised administrator to create, modify and manage User accounts and User Groups.
Users can be reassigned to groups dependent upon the operating privileges granted to each User Group. See the
Accounts Admin/Secure Mode section below for further information.

Log Out (Secure Mode only)

This menu item only appears while Blackmagic is in Secure Mode (see Accounts Admin/Secure mode for more
information). Selecting Log Out while using Blackmagic in Secure Mode simultaneously logs out the current user and
generates the Login window. At this point, the options available are to enter a username and password; Choose Server
before login; and to Quit the Blackmagic Client.

While the Login window is displayed, the Blackmagic Client is effectively LOCKED to all users. The Server will continue
to operate as normal.

Chatterbox

Chat to other users connected to the same Server. The Chatterbox window will display the Clients connected to the
Server. If the user has entered a nickname in the System Settings, this name is displayed; otherwise the machine name
is used. If the user’s name cannot be selected, the user has selected the Away option and is not available.

Broadcast Message

This allows messages to be sent to all users connected with a Client to the same Server. Selecting the Broadcast option
displays a message window to type into and send. The message is displayed on the users window for a short time and
will automatically dismiss if it is not acknowledged by clicking OK.

Download PPD

This option downloads the Megarip PPD from the Server to the desired location. A chooser will appear to navigate to
the location for saving the PPD file on the drive. This saves having to get the PPD off the disk. Use the PPD when
installing a local printer. When installed, the Megarip PPD (Postscript Printer Description) is selected as the printer
driver when setting up a Blackmagic Published Pagesetup as a print destination for third party applications (see
Workbench - Pagesetup and the Publish to a Windows Printer sections for more information).

Serendipity Blackmagic User Manual - Version 6.0 142



Accounts Admin / Secure Mode

Blackmagic gives users the option to login using Secure Mode, which allows the administrator to create accounts for
users and groups, with each group configured to allow or deny its users
access to particular applications and functions.

When Secure Mode is active, users are required to enter a username and sBrendlpity Blackmagic

password whenever the Client is started or users are changed. The
username and password are both case sensitive.

golem.swdevel.serendipity-software.com.au:9100

The Accounts Admin menu option is selected in order to display the panels

for configuring any Users and Groups and these should be created prior to A
activating Secure Mode. Password:
The Log Out option only appears once Secure Mode has been activated. @) e GhooseServers

Selecting this while using Blackmagic in Secure Mode simultaneously logs
the current user out and generates the Login window with options to login as a new user and select a Server to connect
to, or Quit the application. While the Login window is displayed, the Client is effectively locked to all users. The Server
will continue to operate normally.

Setting up Users and User Groups
Blackmagic’s Secure Mode is set inactive by default. The software will continue to function normally whether or not
Secure Mode is activated.

Important Note: It is recommended all users and groups requiring access be setup BEFORE activating Secure Mode.
Secure Mode cannot be activated until at least one (1) user has been created. This would usually be the Admin account,
as this is automatically created when the Accounts Admin option is selected for the first time.

. Select Server Menu > Accounts Admin... to display the configuration panels.

Activating Secure Mode
Once the initial user account(s) have been setup, Secure Mode can be activated by checking the tick box located via
Accounts Admin menu > Accounts Admin Settings.

Secure Mode can only be activated or deactivated by an administrator (a
member of the Admin group). 600 Accounts Admin Settings

Settings

|_| Secure mode

. Secure mode - Enable or disable Secure Mode.

. Mail Server - Enter the details of the mail server for error notification
emails when using Secure Mode.

* Sender Email Address - Enter the details of the Sender (From) Cancel | [0k ]
address for error notification emails.

Mail Server: ||

Sender Email Address:

Configuration Panels
Users Panel
The fields within the Users panel are:

. Name - The username of the account. This is case sensitive.

. User ID - This is a numerical ID assigned automatically but may be
changed by the administrator.

. Password / Verify — The password is entered and stored here. New
passwords must be verified by entering the details in each field. The
password is also case sensitive.

. Permission - The level of permission for the user is created here. Click Edit
to make changes to the user read/write/execute permissions. Note: The
Group (second line) and “Everyone” permissions in the Edit popup
determine whether jobs submitted by a wuser are able to be
seen/edited/deleted in the QueueManager by other users in the same user
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group, or by users outside the group.

Email - Enter the users email address here.

Comment - Allows the administrator to enter a note on the particular user account if necessary.

Group (dropdown) - Assign a user group to the user account.

User Privileges - Privileges other than those in the user’s group can be added here.

Notifications - Select which email notifications the user is to receive by clicking the + icon or remove any via
the - icon. Notifications are available for Job Spooling failure, Job Autodetection failure, Job Imaging/Rendering
failure, Job Printing failure, Dongle removal, Server Crash, Media Remaining warnings and Software Updates
available.

To create a User:

Click the + icon in the bottom left of the window. To delete a user, click the -
icon (@ Users @i Groups
Enter a username in the Name field.

Enter a User ID number or leave the default value.

Create a password for the user and verify the details. The password boxes will always display black dots
irrespective of the length of your password.

Edit the permission level to the required access level.

Enter the user’s email address (if notifications are required).

Add a comment against the user if necessary.

Assign a Group for the user. A default group “users” is assigned automatically unless another is selected. The
“users” group allows access to the Client but no other functions except job submission. The user may be
assigned to multiple groups via the Groups tab if limited access is required (for accessing specific applications
and/or functions).

Add any extra privileges to the user if required. This will only show privileges not included in the group
selected for the user.

Add any notifications to the user if required.

Apply the changes or select Revert to cancel.

Groups Panel

An admin User and Group are created by default with access to all permissions and privileges when the Accounts
Admin option is selected for the first time. The admin user and group cannot be deleted. It is recommended this be
the only group with access to the Accounts Admin application.

The fields within the Groups panel are:

Name - The name of the Group. T |
Group ID - This is assigned automatically but may be changed by s
the administrator.

Comment - Allows you to enter a note on the particular user

group if necessary

Group Privileges - This is a list of available privileges relating to

functions within Blackmagic.

Members - A list of Usernames and IDs belonging to the Group.

To create a Group:

Click the + icon in the bottom left of the window. To delete a group, click the - icon.

Enter a name in the Name field.

To add privileges, click the + icon in the Group Privileges panel. A popup list will appear with all available
items. To add, highlight the privilege/s and click OK.

Click Apply to save any changes to the group or Revert to cancel.

Assigning Users to a Group
Users are assigned to the groups via the Users or Groups panel.

Once you have created the user group, click on the Users panel.

Select the User Name from the list of users.
Select the Group to assign the user to from the Groups dropdown menu.
Click Apply to save any changes or Revert to cancel.
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Once the user group has been created, click on the Groups panel (if not there already).

. Select the Group from the list on the left.

J In the Members panel, click the + button.
. Select any users to be added to the Group.
. When finished, click Apply.

Hosts Panel

The Hosts panel allows for the configuration of automatic Client logins for selected host computers or network IP
addresses when using Secure Mode.

& Users i@ Groups | Hosts |

Name: Test
Host
Test Hostname/IP: 192.168.0.30

Automatic Login: | g guest )

The fields available are:

. Name - Enter a name for the Host setup.

. Hostname/IP - Enter the Hostname or IP address of the computer the user will automatically connect to.

. Automatic Login - Disable or Select a User from the dropdown list. Only one user may be selected per Host
setup.

Activating Secure Mode
Secure Mode should be activated after any users and/or groups have been created. Only an administrator or member
of the admin group can activate or deactivate Secure Mode.

To activate:

. Select Accounts Admin menu > Accounts Admin Settings.

. Tick the checkbox at the top of the screen - Secure mode - to activate or deactivate.

. Click OK and close the settings when done.

. If activating Secure Mode, a login window will appear as soon as you close the Settings.

If Email Notifications are setup for users:

. Enter the mail server details in the Mail Server field. This is the outgoing SMTP server.
. Enter the email address for the Sender (From) field of the email in the Sender Email Address field.
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System Settings

The Systems Settings section contains default values and preferences configured for the Server and Client. The settings
are split into two (2) different sections - Server and Client.

Access the Client Settings via the Application menu (Win) or Serendipity Client menu (Mac).

Access the Server Settings via the Server menu.

Client Settings
The Client settings are divided into three (3) tabbed categories: Colour, General and Shortcuts.

Colour tab

Input CMYK Profile - Select a default Match ICC profile for accurate @2 Dl Settings

display of CMYK data. {EDN Ceveral | Shortuts

CMS Dithering - Disabled by default. Enable for smoother results  Input CMYK Profe... | - /Resources e/ ISOco4.V2_ckice
whenever conversion between 16-bits to 8-bits is required. b
Force Relative Colourimetric Media White - Various ICC profiling Version 3.4 spot colour handing
packages and some older ICC v2 profiles included an Lab value for o

media (paper) white in the Relative Colourimetric Intent LUT. This Mt Setngs

has the effect of printing a paper layer when printing with Relative Calcheck wanaged (¥ Use Natve Protie
Colourimetric rendering intent. When enabled, this option ignores

the Lab value for paper in the Relative LUT, leaving paper white areas Resovtion

unprinted. DU oo Mgz Rasx 12 2

Version 3.4 spot colour handling - This is a compatibility setting for S ”

users with spot colour setups, upgraded from Blackmagic v3.4 or
earlier to get consistent results from spot jobs. It is recommended as
a temporary setting only and setups should be recreated using the
improved and more accurate (post v3.4) spot colour handling.

Cahlbration expires

Never

x? cancet | [ ok |

Monitor Settings

Calcheck Managed - Enabling this will display the current calibration status of the selected monitor. When
selected, there will be a small icon showing a green tick or a red cross. This icon is shown in the bottom right
corner of the SoftProof window. Its status depends on the expiration time of the monitor calibration (as set
below) and the Calcheck status.

Use Native Profile — Enable this to use the operating system defined ICC profile for colour management. The
Client will use the monitor profile as setup for the operating system, i.e., Mac OS will use what is in the Display
Preferences Colour tab, Windows will use the Display Adapter Settings.

Profile - Select a monitor ICC profile for the display the Client is running on. The profiles are used so any colour
element viewed on the display is shown as accurately as possible. This includes SoftProof and any colour
swatch. It is recommended the monitor be calibrated and set to the same match profile as is used for the
softproofing Pagesetup.

Resolution — Choose the default resolution to use for the monitors. This is used in SoftProof for calculating
various fit methods. Options include:

Use System Settings - The Client will calculate the system’s monitor resolution.

Custom Resolution - Specify your own resolution.

Calibration Expires - Set a reminder to popup when a calibration needs updating.

Additional Monitors

Specific settings may be set for each monitor when in a multi-monitor environment. The @ @
Client Settings will show additional sections with Monitor 2, Monitor 3 etc listed. To identify

which monitor is which, press the monitor indicator button to display a graphic in the middle

of the screen for the relevant monitor.

Calcheck Managed
The Calcheck Managed option (under Colour Management) constantly reports the status of the monitor used for
softproofing.

When this option is enabled a small tick or cross icon representing the Calcheck
status will be displayed at the bottom right of the SoftProof window in the status | ™ Auto SoftProof Press

bar.
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General tab

Language - Select your preferred language from those available.
This displays all Client and log messages in the chosen language.
The default is English. A restart is required if the language setting is
changed.

Default Font - Set the font and size to be used by the Client.

Undo Levels - Set the number of levels for Undo. The default is zero
(0), which means no restriction.

Default Units - Set the measurement units used by the Client and
all of the Applications/Modules.

Show Tooltips - Enable or disable tooltips within the Client.

Turn Sound FX Off — Check this to disable the sound effects. Sounds

a

0 Client Settings

Colour e

General User Interface Settings
Language: | Default
Default Font... System Default
Undo Levelss 0
Default Units: | in

¥ Show Tooltips (¥ Turn Sound FX Off
Instant Messaging

NickName:
Resource

Memory Cache Maximum Size: 0

Shortcuts

L M8

Reset

are used for things such as drag and drop, and error message alerts.

] Temp... 05 Default Reser
. Nickname - Enter a nickname to use when accessing the
Chatterbox application.
. Memory Cache Maximum Size - Set the maximum cache size for the
SoftProof application. The default is zero (0), where the Server " e | o)

chooses the default depending on system configuration.
. Temp (button) - Set the temporary path for scratch/temp files on the local drive. Useful if using SSD (solid
state drive) as operations will perform faster.
. Reset - Reset the location of the temp directory to the operating system default.

Shortcuts tab
This tab displays a list of the Applications and Modules for which keyboard
shortcuts can be created. eno

Client Settings

Colour  General Il

A Shorteut

Adplcation
Accounts Admin
Archives
BookMonitor
Calcheck
Clientiog
Clustering
ClusterStatus
Densitometer
Displays
DropZone
FlipBook.

Jobs
Lineariser
MegiaStatus
Manitor

Press Agent
QueseManager
QueuveStatus
RiPMonitor
ServerLog
SoftProof
Spectro
Status

Studio

Note: It is the responsibility of the user to check the created shortcuts do not
conflict with any other Blackmagic, third party software, or operating system
shortcuts/hotkeys.

To add a shortcut:

. Highlight the selected application or module in the list.

. Use the Edit option in the context menu (right click) or click in the
Shortcut field to the right of the application/module name.

. Type in the key or key combination for the shortcut and press Enter.

Thumbnail
Touch Console

The shortcuts will now appear in the Application and/or Modules menu of
the Client.

X? Cancel | 0K
To remove a shortcut:
. Highlight the selected application or module in the list.

. Use the Clear option in the context menu (right click); or
o Click in the Shortcut field and delete the shortcut.
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Server Settings
Server settings are saved to the Server and are common to all connected Clients. The Server settings are divided into
four (4) tabbed categories - Process, Colour, Options and Paths.

Process tab

Colour Tab

Tasks - Control the number of processes the machine will handle, i.e., the number of Imaging and Rendering
tasks simultaneously run on the Server. The defaults are 1/1. Up to
one imaging and rendering task can be set per CPU core the Server
machine possesses. In practice, it is recommended the combined
number of imaging and rendering tasks be set to no more than the

) 0 Server Settings

Proc Colour  Options  Paths

Tasks: Image 1 v Render 1

Compression: | Standard

number of cores. For example, 4 CPU cores = 2 Image/2 Render. Mui-reoluton generation: | one
Compression - Set the compression level for the intermediate file ER R PR REtE 10 8Ly
formats (the imaged and rendered files). Choose from Fast, Standard, — B
Better, or Best. The default is Standard. @ Detaun obiicker

v Immutable jobtickets

Multi-resolution generation - When enabled, the Server generates
imaged and rendered preview files that include a pre-calculated
pyramid of preview images (at power of 2 intervals), resulting in
much faster zooming when softproofing.

Note: This option slightly increases image and render times and
increases the disk size of the preview by approximately one third.
Options include: v Cancel | (oK)
None

Fast - Default option. Suitable for the majority of workflows, this option slightly increases image and render
times and increases the disk size of the preview images by approximately one-third.

High Quality - This option can be used in the rare circumstance that moire or unwanted antialiasing appears in
a SoftProof preview. This option further increases image and render times, file size and results in slightly
slower zooming.

Maximum Print Preview Resolution - Set the maximum resolution for the rendered preview. The default is 196
dpi.

Low Quality Thumbnail - Selecting this produces a lower quality thumbnail. This is faster but some detail may
be lost in the thumbnail.

Default Jobticket - Assign a system default Jobticket. This Jobticket is used when submitting to a Pagesetup
without an assigned Jobticket, or when no Jobticket has been previously selected in the Submit window. This is
the Jobticket assigned when the “Apply Defaults” option is selected in the Submit window Jobticket editor.
Immutable Jobtickets - When enabled, jobs in the QueueManager retain the Jobticket options they had when
they were first submitted, even if the job’s ticket is subsequently changed. If the job is reprinted or re-rendered
it will do so with the original Jobticket options. Jobticket information can be viewed by displaying the Job Info
window for any submitted jobs.

Note: When selecting “Render with new Jobticket”, the immutable jobticket option is overridden.

- XaNo) Secver Settings

Process [JESid] Options  Paths

Default ICC Profies

Default ICC Profiles - Select the default ICC profiles used when first

creating a new Jobticket (Input profiles) and Media (Output profiles).  Inout KB Pofie. | monliors/AdObeRGR198cc

ICC Engine Accuracy - Select Faster or Better, depending on o lnput CUYK Profle .| fogra-aona-testsu..outed v2_ecir3a cc
preferences. + Outout RGB Profie .. | monitors/sRGB.v4_ICC_preference.cc
CMS Dithering - Disabled by default. Use CMS Dithering for smoother e e
results whenever conversion between 16 bits to 8 bits is required. 1CC Engine Accuracy: | teter

System Specials - Select a default Special Colour Set for plate Soncl ol SATE
matching. This is used by the RIPMonitor and polling service for plate S soecls —._JBMECARE B
assigning. Colours in this set are automatically assigned in the  tokaoun Spscis ‘

RIPMonitor.

Unknown Specials - Select a Special Colour Set (optional) to which A S i ia QoK SN

unknown special/spot colours included in PDF or Postscript jobs can

be automatically added. % Carcel | (EoRa)

Version 3.4 spot colour handling - This is a compatibility setting for

users with Spot colour setups, upgraded from Blackmagic v3.4 or earlier to get consistent results from spot
jobs. It is recommended as a temporary setting only and setups should be recreated using the improved and
more accurate (post v3.4) spot colour handling.

Apply ICC Correction to CMYK Specials - Select this to apply ICC correction to CMYK Specials.
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Options tab 800

Force Relative Colourimetric Media White - Various ICC profiling packages and some older ICC v2 profiles
included an Lab value for media (paper) white in the Relative Colourimetric Intent LUT. This has the effect of
printing a paper layer when printing with Relative Colourimetric rendering intent. When enabled, this option
ignores the Lab value for paper in the Relative LUT, leaving paper white areas unprinted.

8nNno Server Settings

Default Units - Set the units used by the Server. Options are mm,
cm, inches, points, picas, metres or feet.

Polling Service Refresh - Set the interval between poll service
checks, i.e.,, how long between checks to see if any RIPs require
polling. The default is 50 seconds if the times are left at 0.

Server Back Log - Number of days to keep the log. Older days are
trimmed when the Server starts. Zero (0) means the log will not
be trimmed.

Minimum Broadcast Interval - Set the interval between the Server
sending out updates to connected Clients. The default interval is

Process Colour

Default Units:
Polling Service Refresh:
Server Back Log:

Minimum Broadcast Interval:

Maximum Memory For PS RIP:

Maximum Memory For Rotation:

Paths

in
Oh LEom <50s
0

2s

Output unknown files to printer
Publish Asset queue

Log printed jobs

Web server

(4 Calcheck Histary

Job Statistics

OMB

OMB

2sec. High-end systems with good networking are able to set the
interval to Osec for slightly improved image/render times when
processing large numbers of jobs. Sites using the Client remotely
connected via the internet should set a longer polling interval of
10-20sec.

Output Unknown Files to Printer - Output any unknown files direct to a printer. If this is unchecked, any
unknown files will result in errors and will not be output.

Publish Asset Queue - Enabled by default. When disabled, the Asset queue destinations will be hidden from any
Output bonjour/zeroconf configuration options.

Log Printed Jobs - When enabled, this option will log completed print jobs in the Server log. The jobname and
dimensions are noted.

Web server - Disabled by default. Enable to allow access to the built-in web server. A Server restart is required
for any changes to take effect. When Job Statistics are enabled, this must also be enabled.

Calcheck History - Disabled by default. When enabled, all Job and Media calcheck results are stored in an
internal database. The function enables a History button in the Calcheck application used to view stored
results.

Note: The database is backed-up as part of Backup Server function (see Server Options > Help menu).

Job Statistics - Enable (along with the Web server option) to collect job statistics in an internal sqlite database
file.

Maximum Memory for PS RIP - Set the maximum memory used by the Postscript RIP. The default is 0OMB
(which uses the internal default amount).

Maximum Memory for Rotation - Set the maximum memory used for Rotation. The default is OMB (Server
chooses the default depending on system configuration).

x? Cancel = 0K

Paths tab

Paths lists the default location of the working paths the Server uses to ©@0o
process jobs.

Server Settings

| Process = Colour = Options | =10

[ Raster... | /Applications/Serendipity/bmagic/raster
Raster - Holds all the imaged, rendered and print jobs while they 1 Spool... ] /Applications/Serendipity/bmagic/spool
are live in the System. (1 Temp... JApplications/Serendipity/bmagic/tmp
Spool - The location where the job is spooled prior to 1 Drop... | /ApplicationsjSerendipity/bmagic/drop

processing.
Temp - After spooling, the job is moved to the temp directory where it is worked on.
Drop - The default location for the DropFolders.

The Raster directory holds all jobs while they are in the system and as such,

can be very large. If this is moved it needs to be placed on a disk with plenty
of space. A Server restart is required if any paths are changed in order for the
changes to take effect.

Server Working Path

All existing files in the new
working path directory will be
—— deleted at server restart.

Important Note: All existing files in the new working path directory are
deleted when the Server is restarted. Ensure the new working path directory

Do you wish to proceed?

(No )

" Yes
R

has no essential data. A warning message will popup to confirm whether to
proceed with the path change.
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Web Server

The Blackmagic Server has a built-in web server. Accessed via a web browser, the Web Server provides status
information about the Server and jobs currently in the system. It cannot be used for submitting or managing files in the
system.

Accessing the Web Server
To connect to the Web Server:

. Enter the IP address or machine name (if using DNS) of the computer running the Server in the browser
window, followed by a colon and the port number 8080. For e.g., 192.168.3.43:8080

/2% 0 192.168.3.43:8080

. Press Enter once the address has been typed in. When it connects, the browser address bar will look like this:

% M htep://192.168.3.43:8080/

. If you have a DNS Server, you can use the machine name instead:

/I‘ by http://papaya:8080/

. Once you are connected, the front page will appear with an options menu on the left:

. Queues - Shows all the queues configured on the Server you are connected to.
. Log file - Allows you to view the log file.

. System info - Displays information about the system.

. Support - Shows various support options & information.

Queues - Click on any of the queues to get information about jobs in that queue. Information about the job, including
name and current status will be shown.

Log File - To view the log file, select the option from the list on the left.

From here, you can select a particular time period to fetch from the Server. Once viewed, you can print the file or save it
to disk. The log can be printed, saved or exported from the browser.

System info - Choose this to display information about the system.

Product Info, Licensed Modules - available printers and input filters; and Available Destinations are shown.

Support - To access the Serendipity Support site, select this option from the menu. This is the same as if you accessed
the Serendipity Software website directly.

From here, you can download databases, release notes, manuals, updates, tutorials, FAQs and other helpful information.

You will need to have an active Internet connection for access to the support website function.
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Publishing a Pagesetup on Mac OS X (10.6.x)

Blackmagic Pagesetup’s can be set up as a Mac OS X system printer destination to allow jobs to be easily submitted via
the Print option of third party software or design packages.

Jobs printed to a Published Pagesetup will be automatically sent for processing and colour management in Blackmagic,
eliminating the need for dropfolders or manual file submission.

Note: Jobs printed via Blackmagic in this way must be in a file input format available to your Blackmagic version.

Installing the Serendipity Printer Drivers
The first step when Publishing a Pagesetup for the first time is to install the Serendipity Printer Drivers for Mac OS X.

The installation package is located on the Blackmagic 6.0 Installation DVD:

. Navigate to the /drivers/mac folder and run the file Serendipity Printer Drivers.pkg
*  An installer window will appear. Follow the prompts to complete the installation of the drivers. The installer
will require administrator access privileges.

Configuring a Pagesetup for Publishing as a TCP/IP System Printer
To configure a calibrated Pagesetup for Publishing:
Publish
. In the Workbench, select the Pagesetup from the list of available DropFolder
data typeS- |1 Location ... Default Default
. Go to the Publish panel and enable the checkbox for TCP Port:

. . Printer: Mac Windows
Activate port number option. RO = T
. Enter the TCP port number into the field and Save the Pagesetup. i
ow Control
Hold: After Imaging After Rendering

Port Numbers

[t is recommended that the port number assigned to a Pagesetup be a port
over 10000 to avoid any conflict with the operating system or an existing application. Each Pagesetup to be published
needs its own unique port number, for example, 10200, 10201, etc.

Nest

Media

When submitting jobs to a Published Pagesetup, the default Media assigned to the Pagesetup is used. If you wish to
publish to different media on the same printer, each Media required needs to be assigned to its own Pagesetup, with its
own unique port number.

Creating a TCP/IP Mac OS X System Printer
A system printer needs to be created and configured on the Mac OS X computer that is i
running the Blackmagic Server.

. Open the System Preferences for the Mac OS X. -

. Choose Print & Fax. P e

. Click the + icon at the bottom of the printer list panel to create a
new printer.

. Select the IP icon at the top of the Add Printer window.

. Protocol - Select HP Jetdirect - Socket from the dropdown menu.

*  Address - Enter the TCP/IP address and port information for the
printer setup in the following format: Computer

Prstns Solmare

Name: | Backmage Published Pageietust

[Paddress:PagesetupPortNumber (see image for example). The IP A -
address for the printer should not be used. T | e

*  Name - Enter the desired name for the printer. It should be easily Ca :
recognisable as a Published Pagesetup and/or the particular g |-
Pagesetup being published. e

. Print Using - Select Printer Software from the dropdown menu. o) &N

. A list of available Mac OS X system printer drivers will popup.
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Either scroll down the list and select Serendipity Blackmagic, or type “Serendipity” in the filter field and select
Serendipity Blackmagic and click OK.

Click Add to add the new printer. - -

Set the published Pagesetup “Printer” as the system default and/or share the — |=sie=sis —
printer on the network as required. e ——

Configuring a Pagesetup for Publishing as a Bonjour Printer
To configure the Pagesetup for Publishing:

Publish

In the Workbench, select the Pagesetup to be Published from the ke

list of available items. B Locsionsm), Oefaukt Cemul
Go to the Publish panel and enable the printer: Mac checkbox. printer: (] Mac Windows
This lists the Pagesetup in the Mac OS X system Bonjour TCP Port: [ Use port number

destinations as “Pagesetup name @ computer name”. Flow Control

Save the Pagesetup configuration when done. Hold: [ After Imaging After Rendering

Nest

Creating a Bonjour System Printer for Mac OS X
A system printer needs to be created and configured on the Mac OS X computer running the Blackmagic Server.

Open the System Preferences for Mac OS X.

Choose Print & Fax.

Select the Default icon at the top of the Add Printer window.
Choose the Pagesetup from the Printer Name list. The Pagesetup
will be listed as Kind: Bonjour and named “Pagesetup name @ e et T E
computer name”. G

Print Using - If you have installed the Serendipity Printer
Drivers, the Print Using field should auto-fill to show ——

Serendipity Blackmagic. Print Using: Serendipiy Blackmagic 0
If the Serendipity Printer Drivers have not been installed, cancel

the printer setup and install the drivers as per the above _ore printers _add_
instructions.

~ Add Printer

753
IR &1
——

Name: | 8lackmagic Bonjour Pagesetup

If the field does not auto-fill, choose Select Printer Software from — T

the dropdown menu. A list of available Mac OS X system printer el A
drivers will popup. Either scroll down the list and select — Sockommek Soreer Popseniee
Serendipity Blackmagic or type “Serendipity” in the filter field and Btc--aabld a G P e
select Serendipity Blackmagic. Click Add. Opmans 8 svopies
Name - Enter the desired name for the printer. It should be named -

to be easily recognisable as a Published Pagesetup and/or the

particular Pagesetup being published. B S e e o e o | (g s
Click Add to add the new printer. o " — .
Set the published Pagesetup “Printer” as the system default and/or o :
share the printer on the network as required. Bl ot ek v o g ®
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Publishing a Pagesetup on Windows 7

Blackmagic Pagesetup’s can be set up as Windows system printer destinations to allow jobs to be easily submitted via
the Print option of third party software or design packages.

Jobs printed to a Published Pagesetup will be automatically sent for processing and colour management in Blackmagic,
eliminating the need for dropfolders or manual file submission.

Note: Jobs printed via Blackmagic in this way must be in a file input format available to your Blackmagic version.

Megarip Printer Driver
The first step before proceeding is to enable access to the Megarip.inf driver file. The Megarip printer driver is a
proprietary Serendipity Software driver that Windows will use as the printer driver.

The file is located on the Serendipity Blackmagic installation DVD in the following directory:

/drivers/win/win_xp_vista_7/

Configuring the Pagesetup for Publishing as a System Printer

To configure a calibrated Pagesetup for Publishing:
Publish

. In the Workbench, select the Pagesetup from the list of available DropFolder
data types. 2 Location ... | Default Default|
. Go to the Publish panel and enable the checkbox for TCP Port: — T
Activate port number option. TCP Port: [ Use port number
*  Enter the TCP port number into the field and Save the Pagesetup. —
POI‘t Numbers Hold: :{::: Imaging After Rendering

It is recommended that the port number assigned to a Pagesetup be a port
over 10000 to avoid any conflict with the operating system or an existing application. Each Pagesetup to be published
needs its own unique port number, for example, 10200, 10201, etc.

Media

When submitting jobs to a Published Pagesetup, the default Media assigned to the Pagesetup is used. If you wish to
publish to different media on the same printer, each Media required needs to be assigned to its own Pagesetup, with its
own unique port number.

Creating a TCP/IP Windows System Printer R
A system printer needs to be created and configured on the Windows computer that ——
is running the Blackmagic Server.

. Select Windows Start Menu > Devices and Printers.

. Click on Add Printer. The Add Printer wizard will appear.

. Select Add a Local Printer and click Next.

. Select Create a New Port and Standard TCP/IP Port from the Type of Port
dropdown menu. Chocse s pricier pon

i Click Next.

. Type a Printer or Hostname Address:

. Device Type - TCP/IP Device

. Hostname or IP address - Enter the Network IP address of the
Windows computer running the Blackmagic Server. (e.g.,

inter port is a type of connection that allows your computer to exchange information with a prnter,

Standard TCP/IP Port

192.168.3.59). Hostname or P sdéress Ty
. Port Name - Enter a name for the Windows port (this is NOT the ... Negerg?Po ]
printer name). Querythe prnte and automuticlly select the diver o use

. Uncheck the option to Query the Printer and Automatically Select
the Driver to Use.

i Click Next.

i Additional Port Information Required:
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. Device Type - Custom.

. Click the Settings button. A configuration window will appear.

. Configure Standard TCP/IP Port Monitor:

. Protocol - Select Raw.

. Raw Settings:

. Port Number - Enter the unique TCP Port number assigned to the
Pagesetup to be published, e.g., 10201.

. Click OK. The window will close and return to the Additional Port

Additional port information required
P 1

The device it not found on the network. Be sure that

e i3 pre ¥
s Page is cormect.

4. The sddress on the prev

¥ you think the address is not comect, click Back to return to the previous page. Then correct the
address and perdorm another search on the network. If you are sure the address is comect, select the
dence type below.

Device Type

Standard

Information window.

i Click Next.

. Install the Printer Driver:

. If this is the first time installing a Blackmagic system printer, insert the
Blackmagic Installation DVD and select Have Disk.

. Navigate to the /drivers/win/win_xp_vista_7/ directory.

*  Select the Megarip.inf file and click Open. The Serendipity Megarip driver
should now be displayed.

i Click Next.

& Custom

Note: The above step can be skipped for any subsequent installs of Blackmagic
system printers. The driver can be chosen from the Windows printer driver list.

. Which Version of the Driver do you want to use:

. Select Use the driver that is currently installed (recommended) unless you
are replacing an older installed version of the Serendipity Megarip driver.

i Click Next.

i Type a Printer Name:

. Enter a name for the printer. This is the name that will appear in the
Windows Printers list and be available as a printer option when printing
from Windows applications. The name should be unique for the Published
Pagesetup.

° Click Next.

d Printer Sharing:

. Select Share this printer so that others on your network can find and use
it.

. Keep the default printer name or enter a share name.

i Click Next.

*  You've Successfully added “Printer Name”:

. Choose whether the Published Pagesetup destination is to be the default
system printer.

. If desired, click the Print a Test Page button. The test page job should
appear in the Blackmagic QueueManager.

. Click Finish to close the wizard.

Settings— |

Protocct

Raw Settings
Port Number:

LPR Settings

o Row

Home o1 IP Address

10201]

SHMP Status Enabled

Prot atest page
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Printing to a Published Pagesetup Printer across a Network
Printing from Mac OS X - Mac OS X, or Windows = Windows

Printing to a Published Pagesetup printer across a network where both computers (the machine sending the print and
the machine running the Blackmagic Server) share a common operating system is straight forward.

If network sharing has been enabled for the system printer destination created for use with the Blackmagic Pagesetup,
the printer will be available in the printer options of any other computer on the network.

Printing from Mac OS X > Windows, or Windows - Mac 0S X
Printing from a computer on the same network, but with a different operating system to the computer running the
Blackmagic Server requires the creation of a new system printer on the computer wishing to print to Blackmagic.

This is done by following the appropriate steps outlined previously for the relevant operating system.
The only alteration is when entering the TCP/IP address and the TCP port number:

Enter the network TCP/IP address of the computer on which the Blackmagic Server is running, i.e., the machine you wish
to print to.

Enter the TCP Port Number assigned to the Published Pagesetup you wish to print to.
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Troubleshooting

Here are some suggestions of where to look if you run into trouble and experience problems when using a Cluster.

Jobs Not Processing Through a Cluster Node
The possible reasons for this are:

The Cluster Node is not configured to image, render or both. Check the ClusterStatus to see if either of the processing
tasks have been disabled. To enable them, open the Clustering application and enable the appropriate task.

The Cluster Node has a Processing Pool attached and the Pagesetup you are submitting jobs to is not contained within
the Pool. You can either unselect the Pool or add the Pagesetup to the Pagesetup Pool.

The Cluster Node has gone offline. To check, open the Clustering application and check the node. If the Clustering
application is already open, click the Refresh button. This will check for node status. If the node appears grayed out or
disabled, this indicates the node is not currently online.

Here the Cluster Node called “pomelo” is currently offline. In this >'ave Nodes

case, you would check the node server is up, the machine is still 'PvA"%""ls;Z e e SR '75;";'; "D"'a“r‘
connected to the network and can see the Master. If there is a @I;nagi;'lg‘ ‘ TSt

problem with the node, check the error log. One the problem is # Renderin

resolved, click the Refresh button or close and reopen the Clustering v MI 168:3:3% 'pomelo.swrevel..... 96303 Das
application. 4 Rnlii':ing

The Node and Master are different versions. The node should always
be upgraded when the Master is to maintain the same versions in a Cluster.

Cluster Nodes Errors Log

The Cluster Nodes create an error log, which logs all the messages from the node. This is located in the Blackmagic
installation directory on the node’s own machine and is called “errors.log”. This can be viewed with a normal text editor
and can help to track a problem, or it can be sent to support for assistance in tracing a problem.

A Node Cannot Be Found
Once you have started your node successfully, you should be able to see it in the Clustering application. If not, you need
to add the node manually. If this fails, there are a few things to check:

*  Verify the node is still running and the clock is still counting up.

. Check the error log for any messages.

. Check that the Master machine can ping the node machine. If not, there may be a network issue and you will
need to contact your network administrator for assistance.

. Check the ports on the machines are open for the node to connect to the Master and they are not being used by
anything else. The port numbers for the node are as follows:

. 9103 /tcp - Server connects here and submits jobs via this port.

. 9103/udp - Listens to broadcasts so the Server can enumerate available Node Servers.

. Make sure the node is the same version as the Master. Nodes (Blackmagic Slaves) should always be upgraded
at the same time as the Master.
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Printing to a Pagesetup on Windows
Here are some suggestions of where to look if you run into trouble and experience problems when printing.

For all of the methods documented in this guide, test each step to see where the problems arise. For example, when a
printer is created, try printing a test page.

Printing From Mac to Windows
When printing from a Mac to a shared Windows printer, there are a couple of utilities available to verify whether or not
the printer is installed correctly and working. These are:

The CUPs printing system on the Mac has a web interface that lets you view and test
printers. To access this, do the following: /,\ G http://localhost:631/

. Open a web browser and enter the following address:
http://localhost:631

. This will connect to the local print system.

*  Choose Manage Printers or select the Printers tab and the list of 20 .
printers configured on the Mac will appear.

. Scroll down the list to locate the printer. A detailed description of
the printer is available here. e

. Print a test page to the Windows printer. This will determine if
the connection from the Mac to the Windows
device is valid. The test job should appear in
the Windows print spooler.

Saarch in Primters: =) (=

Maintenance

Print Test Page
. . . . . Clean Print Heads
As mentioned earlier, if a name is created with Print Self Test Page

Pause Printer

spaces or hyphens these are transposed to Reject Jobs

. . . Move All Jobs
underscores for thg actual p_rmtlng device. Through Caieat All ot
CUPs the actual device name is shown.

The description still contains the spaces but the actual device being printed to has underscores. Another way to check
the status is to use the terminal.

1. Open aterminal from the Applications > Utilities folder
In the terminal type: lpstat -p
This will report on all printers configured on the Mac.
2. Search for your printer in the list and verify the name. The format will be like:
printer my_printer_with_spaces is idle. Enabled since Jan 01 00:00

3. Try and print from the terminal. Locate a print file (run a test job with the correct driver and find the file in the
raster folder in the installation directory) and type the following on the command line:

lp -P<printer> <jobname>
For the example of a HP printer, we can type the following: Ipr -Php_t1100_via_tanglefoot Quickcal_230166.rtl
This should submit the rtl file created by the Server to the printer spooler.

You must be in the raster folder when the command is typed or if not, enter the full path to the file, for e.g,
Applications/Serendipity/Serendipity Blackmagic/raster/Quickcal_230166.rtl.
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The Mac Spooler Reports “NT_ACCESS_DENIED”

This means that the print system cannot access the printer. It may be that there are insufficient privileges for the user
trying to connect, the username and/or password could be incorrect, or the username and password part of the string
have been forgotten.

Client Error
When testing with Ipr or from Serendipity Blackmagic and the error “client-error-not-found” is seen, it means it is
unable to find the printer the file is being sent to. Check to make sure the name of the printer is correct.

Unable to Print to Remote Windows Printer
This can happen from Mac or Windows.

If you are on a Windows machine and are creating a new printer to connect to the remote printer but it fails to find the
path, make sure the remote printer is shared and the name is correct.
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Copyright Notices

PNG Library Copyright
Copyright © 1995, 1996 Guy Eric Schalnat, Group 42, Inc.

Contributing Authors: Andreas Dilger, Dave Martindale, Guy Eric Schalnat, Paul Schmidt, Tim Wegner.

The contributing authors would like to thank all those who helped with testing, bug fixes and patience. You know who
you are. This wouldn’t have been possible without all of you.

Thanks to Frank J. T. Wojcik for reviewing the documentation.

The PNG Reference Library is supplied “as is”. The Contributing Authors and Group 42, Inc. disclaim all warranties,
expressed or implied, including without limitation, the warranties of merchantability and of fitness for any purpose.
The Contributing Authors and Group 42, Inc. assume no liability for damages, direct or consequential, which may result
from the use of the PNG Reference Library.

Permission is hereby granted to use, copy, modify and distribute this source code, or portions hereof, for any purpose,
without fee, subject to the following restrictions:

The origin of this source code must not be misrepresented.
Altered versions must be plainly marked as such and must not be misrepresented as being the original source.

This Copyright Notice may not be removed or altered from any source or altered source distribution.

Compression Library Copyright
Copyright © 1995 Jean-loup Gailly and Mark Adler.

This software is provided “as is”, without any express or implied warranty. In no event will the authors be held liable
for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications and to alter it
and redistribute it freely, subject to the following restrictions:

The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you
use this software in a product, an acknowledgment in the product documentation would be appreciated but is not
required.

Altered source versions must be plainly marked as such, and must not be misrepresented as being the original
software.

This notice may not be removed or altered from any source distribution.
Jean-loup Gailly and Mark Adler.

gzip@prep.ai.mit.edu madler@alumni.caltech.edu

Independent JPEG Group’s Copyright

The authors make no warranty or representation, either express or implied, with respect to this software, its quality,
accuracy, merchantability, or fitness for a particular purpose. This software is provided “as is” and you, its user, assume
the entire risk as to its quality and accuracy.

This software is copyright © 1991, 1992, 1993, 1994, 1995, Thomas G. Lane. All Rights Reserved except as
specified below.

Permission is hereby granted to use, copy, modify and distribute this software (or portions thereof) for any purpose,
without fee, subject to these conditions:
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If any part of the source code for this software is distributed, then this README file must be included, with this
copyright an no-warranty notice unaltered; and any additions, deletions, or changes to the original files must be clearly
indicated in accompanying documentation.

If only executable code is distributed, then the accompanying documentation must state that “this software is based in
part on the work of the Independent JPEG Group”.

Permission for use of this software is granted only if the user accepts full responsibility for any undesirable
consequences; the authors accept NO LIABILITY for damages of any kind.

These conditions apply to any software derived from or based on the IJG code, not just to the unmodified library. If you
use our work, you ought to acknowledge us.

Permission is NOT granted for the use of any IJG author’s name or company name in advertising or publicity relating to
this software or products derived from it. This software may be referred to only as “the Independent JPEG Group’s
software”.

We specifically permit and encourage the use of this software as the basis of commercial products, provided that all
warranty or liability claims are assumed by the product vendor.

ansi2knr.c is included in this distribution by permission of L. Peter Deutsch, sole proprietor of its copyright holder,
Aladdin Enterprises of Menlo Park, CA. ansiZknr.c is NOT covered by the above copyright and conditions, but instead
by the usual distribution terms of the Free Software Foundation; principally, that you must include source code if you
redistribute it. (See the file ansiZknr.c for full details). However, since ansi2knr.c is not needed as part of any program
generated from the IJG code, this does not limit you more than the foregoing paragraphs do.

“The Graphics Interchange Format © is the Copyright property of CompuServe Incorporated. GIF (sm) is a Service Mark
property of CompuServe Incorporated.”

Copyright © 1980, 1993
The Regents of the University of California. All Rights Reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

All advertising materials mentioning features or use of this software must display the following acknowledgment:
This product includes software developed by the University of California, Berkeley and its contributors.

Neither the name of the University nor the names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright © 1990, 1994 Regents of the University of Michigan
All Rights Reserved.

Permission to use, copy, modify and distribute this software and its documentation for any purpose and without fee is
hereby granted, provided that the above copyright notice appears in all copies and that both that copyright notice and
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this permission notice appear in supporting documentation, and that the name of The University of Michigan not be
used in advertising or publicity pertaining to distribution of the software without specific, written prior permission.
This software is supplied as is without expressed or implied warranties of any kind.

This product includes software developed by the University of California, Berkeley and its contributors.

Code in sys/linux is developed by Alan Cox. You may redistribute it and/or modify it under the terms of the GNU
General Public License as published by the Free Software Foundation; either version 2 of the License, or (at your
option) any later version.

Research Systems Unix Group
The University of Michigan
C/0 Wesley Craig

535 W. William Street

Ann Arbor, Michigan
+1-313-764-2278
netatalk@umich.edu

GNU GENERAL PUBLIC LICENSE
Version 2, June 1991

Copyright © 1989, 1991 Free Software Foundation, Inc.

675 Mass Ave,
Cambridge,
MA 02139, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU
General Public License is intended to guarantee your freedom to share and change free software-to make sure the
software is free for all its users. This General Public License applies to most of the Free Software Foundation’s software
and to any other program whose authors commit to using it. (Some other Free Software Foundation software is
covered by the GNU Library General Public License instead). You can apply it to your programs, too. When we speak of
free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you
have the freedom to distribute copies of free software (and charge for this service if you wish), that you receive source
code or can get it if you want it, that you can change the software or use pieces of it in new free programs; and that you
know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the
rights that you have. You must make sure that they too, receive or can get the source code. And you must show them
these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal
permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients to
know that what they have is not the original, so that any problems introduced by others will not reflect on the original
author’s reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors
of a free program will individually obtain patent licenses, in effect making the program proprietary. To prevent this, we
have made it clear that any patent must be licensed for everyone’s free use or not licensed at all. The precise terms and
conditions for copying, distribution and modification follow.
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GNU GENERAL PUBLIC LICENSE
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

This License applies to any program or other work which contains a notice placed by the copyright holder saying it may
be distributed under the terms of this General Public License. The “Program”, below, refers to any such program or
work, and a “work based on the Program” means either the Program or any derivative work under copyright law: that
is to say, a work containing the Program or a portion of it, either verbatim or with modifications and/or translated into
another language. (Hereinafter, translation is included without limitation in the term “modification”). Each licensee is
addressed as “you”.

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope.
The act of running the Program is not restricted, and the output from the Program is covered only if its contents
constitute a work based on the Program (independent of having been made by running the Program). Whether that is
true depends on what the Program does.

You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium, provided
that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of
warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and give any other
recipients of the Program a copy of this License along with the Program.

You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program,
and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all
of these conditions:

You must cause the modified files to carry prominent notices stating that you changed the files and the date of any
change.

You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the
Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms of this License.

If the modified program normally reads commands interactively when run, you must cause it, when started running for
such interactive use in the most ordinary way, to print or display an announcement including an appropriate copyright
notice and a notice that there is no warranty (or else, saying that you provide a warranty) and that users may
redistribute the program under these conditions, and telling the user how to view a copy of this License. (Exception: if
the Program itself is interactive but does not normally print such an announcement, your work based on the Program is
not required to print an announcement).

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from
the Program, and can be reasonably considered independent and separate works in themselves, then this License, and
its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the same
sections as part of a whole which is a work based on the Program, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part
regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the
intent is to exercise the right to control the distribution of derivative or collective works based on the Program. In
addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the
Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this
License.

You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you also do one of the following:

Accompany it with the complete corresponding machine-readable source code, which must be distributed under the
terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,

Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your
cost of physically performing source distribution, a complete machine-readable copy of the corresponding source code,
to be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,

Accompany it with the information you received as to the offer to distribute corresponding source code. (This
alternative is allowed only for noncommercial distribution and only if you received the program in object code or
executable form with such an offer, in accord with Subsection b above).
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The source code for a work means the preferred form of the work for making modifications to it. For an executable
work, complete source code means all the source code for all modules it contains, plus any associated interface
definition files, plus the scripts used to control compilation and installation of the executable. However, as a special
exception, the source code distributed need not include anything that is normally distributed (in either source or binary
form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs,
unless that component itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then offering
equivalent access to copy the source code from the same place counts as distribution of the source code, even though
third parties are not compelled to copy the source along with the object code.

You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License. Any
attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically terminate your
rights under this License. However, parties who have received copies, or rights, from you under this License will not
have their Licenses terminated so long as such parties remain in full compliance.

You are not required to accept this License, since you have not signed it. However, nothing else grants you permission
to modify or distribute the Program or its derivative works. These actions are prohibited by law if you do not accept
this License. Therefore, by modifying or distributing the Program (or any work based on the Program), you indicate
your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the
Program or works based on it.

Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a
license from the original licensor to copy, distribute or modify the Program subject to these terms and conditions. You
may not impose any further restrictions on the recipients’ exercise of the rights granted herein. You are not responsible
for enforcing compliance by third parties to this License.

If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to
patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the
conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to
satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence
you may not distribute the Program at all. For example, if a patent license would not permit royalty-free redistribution
of the Program by all those who receive copies directly or indirectly through you, then the only way you could satisfy
both it and this License would be to refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the
section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest
validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution
system, which is implemented by public license practices. Many people have made generous contributions to the wide
range of software distributed through that system in reliance on consistent application of that system; it is up to the
author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot
impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted
interfaces, the original copyright holder who places the Program under this License may add an explicit geographical
distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus
excluded. In such case, this License incorporates the limitation as if written in the body of this License.

The Free Software Foundation may publish revised and/or new versions of the General Public License from time to
time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems
or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this License which
applies to it and “any later version”, you have the option of following the terms and conditions either of that version or
of any later version published by the Free Software Foundation. If the Program does not specify a version number of
this License, you may choose any version ever published by the Free Software Foundation.

If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different,
write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to
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the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of
preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software
generally.

NO WARRANTY

BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE
EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY
SERVICING, REPAIR OR CORRECTION.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER,
OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES
ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA
OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE
PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

Appendix: How to Apply These Terms to Your new Programs
If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve
this is to make it free software which everyone can redistribute and change under these terms.

To do so, attached the following notices to the program. It is safest to attach them to the start of each source file to most
effectively convey the exclusion of warranty; and each file should have at least the “copyright” line and a pointer to
where the full notice is found.

<one line to give the program’s name and a brief idea of what is does>
Copyright © 19yy <name of author>

This program is free software; you can redistribute it and/or modify it under the terms of the GNU General
Public License as published by the Free Software Foundation; either version 2 of the License, or (at your
option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the
implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General
Public License for more details.

You should have received a copy of the GNU General Public License along with this program; if not, write to the
Free Software Foundation, Inc., 675 Mass Ave, Cambridge, MA 02139, USA.

Also add information on how to contact you by electronic and paper mail.
If the program is interactive, make it output a short notice like this when it starts in an interactive mode:

Gnomovision version 69, Copyright © 19yy name of author
Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type “show w”. This is free software, and
you are welcome to redistribute it under certain conditions; type “show c” for details.

The hypothetical commands “show w” and “show c” should show the appropriate parts of the General Public License. Of
course, the commands you use may be called something other than “show w” and “show c”; they could even be mouse-
clicks or menu items-whatever suits your program.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a “copyright
disclaimer” for the program, if necessary. Here is a sample; alter the names:
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Yoyodyne Inc., hereby disclaims all copyright interest in the program “Gnomovision” (which makes passes at
compilers) written by James Hacker.

<signature of Ty Coon>, 1 April 1989

Ty Coon, President of Vice

This General Public License does not permit incorporating your program into proprietary programs. If your program is
a subroutine library, you may consider it more useful to permit linking proprietary applications with the library. If this
is what you want to do, use the GNU Library General Public License instead of this License.

Copyright
The XFree86 Project, Inc.

Copyright © 1994, 1995 The XFree86 Project, Inc. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the “Software”), to deal in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Software. THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
AND NONINFRINGEMENT. IN NO EVENT SHALL THE XFREE86 PROJECT BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of the XFree86 Project shall not be used in advertising or otherwise to
promote the sale, use or other dealings in this Software without prior written authorization from the XFree86 Project.

$XConsortium: CPYRIGHT.sgml,v 1.2/95/01/16 13:17:39 kaleb Exp $

Generated from XFree86: xc/programs/Xserver/hw/xfree86/doc/sgml/CPYRIGHT.sgml,v 3.3 1995/01/28 16:01:20
dawes Exp $

$XFree86: xc/programs/Xserver/hw/xfree86/doc/COPYRIGHT,v 3.8 1995/07/24 06:52:11 dawes Exp $

CIECAMO2 Copyright
Copyright (c) 2003 Billy Biggs <vektor@dumbterm.net>

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the following conditions: The above copyright notice and this
permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT
NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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